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Basic Safety Instructions

Always read through and comply with the following safety instructions!

All plants and locations of the Rohde & Schwarz group of companies make every effort to keep the safety
standards of our products up to date and to offer our customers the highest possible degree of safety. Our
products and the auxiliary equipment they require are designed, built and tested in accordance with the
safety standards that apply in each case. Compliance with these standards is continuously monitored by
our quality assurance system. The product described here has been designed, built and tested in
accordance with the attached EC Certificate of Conformity and has left the manufacturer’s plant in a
condition fully complying with safety standards. To maintain this condition and to ensure safe operation,
you must observe all instructions and warnings provided in this manual. If you have any questions
regarding these safety instructions, the Rohde & Schwarz group of companies will be happy to answer
them.

Furthermore, it is your responsibility to use the product in an appropriate manner. This product is designed
for use solely in industrial and laboratory environments or, if expressly permitted, also in the field and must
not be used in any way that may cause personal injury or property damage. You are responsible if the
product is used for any intention other than its designated purpose or in disregard of the manufacturer's
instructions. The manufacturer shall assume no responsibility for such use of the product.

The product is used for its designated purpose if it is used in accordance with its product documentation
and within its performance limits (see data sheet, documentation, the following safety instructions). Using
the product requires technical skills and a basic knowledge of English. It is therefore essential that only
skilled and specialized staff or thoroughly trained personnel with the required skills be allowed to use the
product. If personal safety gear is required for using Rohde & Schwarz products, this will be indicated at
the appropriate place in the product documentation. Keep the basic safety instructions and the product
documentation in a safe place and pass them on to the subsequent users.

Observing the safety instructions will help prevent personal injury or damage of any kind caused by
dangerous situations. Therefore, carefully read through and adhere to the following safety instructions
before and when using the product. It is also absolutely essential to observe the additional safety
instructions on personal safety, for example, that appear in relevant parts of the product documentation. In
these safety instructions, the word "product” refers to all merchandise sold and distributed by the Rohde &
Schwarz group of companies, including instruments, systems and all accessories.

Symbols and safety labels

A A&AMNAASG BN L

Notice, general Caution Danger of Warning! PE terminal Ground Ground Be careful when
danger location when electric Hot surface terminal handling
handling shock electrostatic
Observe prqduct heavy sensitive
documentation equipment devices

| O D — ~ ~ O

ON/OFF supply | Standby Direct current Alternating current | Direct/alternating | Device fully protected by
voltage indication (DC) (AC) current (DC/AC) double (reinforced) insulation
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Basic Safety Instructions

Tags and their meaning

The following signal words are used in the product documentation in order to warn the reader about risks
and dangers.

indicates a hazardous situation which, if not avoided, will result in death or
A DANGER serious injury.

indicates a hazardous situation which, if not avoided, could result in death or
serious injury.

A WARNING

indicates a hazardous situation which, if not avoided, could result in minor or
moderate injury.

indicates the possibility of incorrect operation which can result in damage to
NOTICE the product.

In the product documentation, the word ATTENTION is used synonymously.

A CAUTION

These tags are in accordance with the standard definition for civil applications in the European Economic
Area. Definitions that deviate from the standard definition may also exist in other economic areas or
military applications. It is therefore essential to make sure that the tags described here are always used
only in connection with the related product documentation and the related product. The use of tags in
connection with unrelated products or documentation can result in misinterpretation and in personal injury
or material damage.

Operating states and operating positions

The product may be operated only under the operating conditions and in the positions specified by the
manufacturer, without the product's ventilation being obstructed. If the manufacturer's specifications are
not observed, this can result in electric shock, fire and/or serious personal injury or death. Applicable local
or national safety regulations and rules for the prevention of accidents must be observed in all work
performed.

1. Unless otherwise specified, the following requirements apply to Rohde & Schwarz products:
predefined operating position is always with the housing floor facing down, IP protection 2X, pollution
severity 2, overvoltage category 2, use only indoors, max. operating altitude 2000 m above sea level,
max. transport altitude 4500 m above sea level. A tolerance of £10 % shall apply to the nominal
voltage and +5 % to the nominal frequency.

2. Do not place the product on surfaces, vehicles, cabinets or tables that for reasons of weight or stability
are unsuitable for this purpose. Always follow the manufacturer's installation instructions when
installing the product and fastening it to objects or structures (e.g. walls and shelves). An installation
that is not carried out as described in the product documentation could result in personal injury or
death.

3. Do not place the product on heat-generating devices such as radiators or fan heaters. The ambient
temperature must not exceed the maximum temperature specified in the product documentation or in
the data sheet. Product overheating can cause electric shock, fire and/or serious personal injury or
death.

1171.0000.42-05.00 Page 2



Basic Safety Instructions

Electrical safety

If the information on electrical safety is not observed either at all to the extent necessary, electric shock,
fire and/or serious personal injury or death may occur.

1. Prior to switching on the product, always ensure that the nominal voltage setting on the product
matches the nominal voltage of the AC supply network. If a different voltage is to be set, the power
fuse of the product may have to be changed accordingly.

2. Inthe case of products of safety class | with movable power cord and connector, operation is
permitted only on sockets with an earthing contact and protective earth connection.

3. Intentionally breaking the protective earth connection either in the feed line or in the product itself is
not permitted. Doing so can result in the danger of an electric shock from the product. If extension
cords or connector strips are implemented, they must be checked on a regular basis to ensure that
they are safe to use.

4. If the product does not have a power switch for disconnection from the AC supply network, the plug of
the connecting cable is regarded as the disconnecting device. In such cases, always ensure that the
power plug is easily reachable and accessible at all times (corresponding to the length of connecting
cable, approx. 2 m). Functional or electronic switches are not suitable for providing disconnection from
the AC supply network. If products without power switches are integrated into racks or systems, a
disconnecting device must be provided at the system level.

5. Never use the product if the power cable is damaged. Check the power cable on a regular basis to
ensure that it is in proper operating condition. By taking appropriate safety measures and carefully
laying the power cable, you can ensure that the cable will not be damaged and that no one can be
hurt by, for example, tripping over the cable or suffering an electric shock.

6. The product may be operated only from TN/TT supply networks fused with max. 16 A (higher fuse
only after consulting with the Rohde & Schwarz group of companies).

7. Do notinsert the plug into sockets that are dusty or dirty. Insert the plug firmly and all the way into the
socket. Otherwise, sparks that result in fire and/or injuries may occur.

8. Do not overload any sockets, extension cords or connector strips; doing so can cause fire or electric
shocks.

9. For measurements in circuits with voltages Vs > 30 V, suitable measures (e.g. appropriate
measuring equipment, fusing, current limiting, electrical separation, insulation) should be taken to
avoid any hazards.

10. Ensure that the connections with information technology equipment, e.g. PCs or other industrial
computers, comply with the IEC60950-1/EN60950-1 or IEC61010-1/EN 61010-1 standards that apply
in each case.

11. Unless expressly permitted, never remove the cover or any part of the housing while the product is in
operation. Doing so will expose circuits and components and can lead to injuries, fire or damage to the
product.

12. If a product is to be permanently installed, the connection between the PE terminal on site and the
product's PE conductor must be made first before any other connection is made. The product may be
installed and connected only by a licensed electrician.

13. For permanently installed equipment without built-in fuses, circuit breakers or similar protective
devices, the supply circuit must be fused in such a way that anyone who has access to the product, as
well as the product itself, is adequately protected from injury or damage.
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14.

15.

16.

17.

18.

Basic Safety Instructions

Use suitable overvoltage protection to ensure that no overvoltage (such as that caused by a bolt of
lightning) can reach the product. Otherwise, the person operating the product will be exposed to the
danger of an electric shock.

Any object that is not designed to be placed in the openings of the housing must not be used for this
purpose. Doing so can cause short circuits inside the product and/or electric shocks, fire or injuries.

Unless specified otherwise, products are not liquid-proof (see also section "Operating states and
operating positions", item 1. Therefore, the equipment must be protected against penetration by
liquids. If the necessary precautions are not taken, the user may suffer electric shock or the product
itself may be damaged, which can also lead to personal injury.

Never use the product under conditions in which condensation has formed or can form in or on the
product, e.g. if the product has been moved from a cold to a warm environment. Penetration by water
increases the risk of electric shock.

Prior to cleaning the product, disconnect it completely from the power supply (e.g. AC supply network
or battery). Use a soft, non-linting cloth to clean the product. Never use chemical cleaning agents such
as alcohol, acetone or diluents for cellulose lacquers.

Operation

1.

Operating the products requires special training and intense concentration. Make sure that persons
who use the products are physically, mentally and emotionally fit enough to do so; otherwise, injuries
or material damage may occur. It is the responsibility of the employer/operator to select suitable
personnel for operating the products.

Before you move or transport the product, read and observe the section titled "Transport".

As with all industrially manufactured goods, the use of substances that induce an allergic reaction
(allergens) such as nickel cannot be generally excluded. If you develop an allergic reaction (such as a
skin rash, frequent sneezing, red eyes or respiratory difficulties) when using a Rohde & Schwarz
product, consult a physician immediately to determine the cause and to prevent health problems or
stress.

Before you start processing the product mechanically and/or thermally, or before you take it apart, be
sure to read and pay special attention to the section titled "Waste disposal", item 1.

Depending on the function, certain products such as RF radio equipment can produce an elevated
level of electromagnetic radiation. Considering that unborn babies require increased protection,
pregnant women must be protected by appropriate measures. Persons with pacemakers may also be
exposed to risks from electromagnetic radiation. The employer/operator must evaluate workplaces
where there is a special risk of exposure to radiation and, if necessary, take measures to avert the
potential danger.

Should a fire occur, the product may release hazardous substances (gases, fluids, etc.) that can
cause health problems. Therefore, suitable measures must be taken, e.g. protective masks and
protective clothing must be worn.

If a laser product (e.g. a CD/DVD drive) is integrated into a Rohde & Schwarz product, absolutely no
other settings or functions may be used as described in the product documentation. The objective is to
prevent personal injury (e.g. due to laser beams).
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Basic Safety Instructions

Repair and service

1.

The product may be opened only by authorized, specially trained personnel. Before any work is
performed on the product or before the product is opened, it must be disconnected from the AC supply
network. Otherwise, personnel will be exposed to the risk of an electric shock.

Adjustments, replacement of parts, maintenance and repair may be performed only by electrical
experts authorized by Rohde & Schwarz. Only original parts may be used for replacing parts relevant
to safety (e.g. power switches, power transformers, fuses). A safety test must always be performed
after parts relevant to safety have been replaced (visual inspection, PE conductor test, insulation
resistance measurement, leakage current measurement, functional test). This helps ensure the
continued safety of the product.

Batteries and rechargeable batteries/cells

If the information regarding batteries and rechargeable batteries/cells is not observed either at all or to the
extent necessary, product users may be exposed to the risk of explosions, fire and/or serious personal
injury, and, in some cases, death. Batteries and rechargeable batteries with alkaline electrolytes (e.g.
lithium cells) must be handled in accordance with the EN 62133 standard.

1.
2.

Cells must not be taken apart or crushed.

Cells or batteries must not be exposed to heat or fire. Storage in direct sunlight must be avoided.
Keep cells and batteries clean and dry. Clean soiled connectors using a dry, clean cloth.

Cells or batteries must not be short-circuited. Cells or batteries must not be stored in a box orin a
drawer where they can short-circuit each other, or where they can be short-circuited by other
conductive materials. Cells and batteries must not be removed from their original packaging until they
are ready to be used.

Keep cells and batteries out of the hands of children. If a cell or a battery has been swallowed, seek
medical aid immediately.

Cells and batteries must not be exposed to any mechanical shocks that are stronger than permitted.

If a cell develops a leak, the fluid must not be allowed to come into contact with the skin or eyes. If
contact occurs, wash the affected area with plenty of water and seek medical aid.

Improperly replacing or charging cells or batteries that contain alkaline electrolytes (e.g. lithium cells)
can cause explosions. Replace cells or batteries only with the matching Rohde & Schwarz type (see
parts list) in order to ensure the safety of the product.

Cells and batteries must be recycled and kept separate from residual waste. Rechargeable batteries
and normal batteries that contain lead, mercury or cadmium are hazardous waste. Observe the
national regulations regarding waste disposal and recycling.

Transport

1.

The product may be very heavy. Therefore, the product must be handled with care. In some cases,
the user may require a suitable means of lifting or moving the product (e.g. with a lift-truck) to avoid
back or other physical injuries.
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Informaciones elementales de seguridad

2. Handles on the products are designed exclusively to enable personnel to transport the product. It is
therefore not permissible to use handles to fasten the product to or on transport equipment such as
cranes, fork lifts, wagons, etc. The user is responsible for securely fastening the products to or on the
means of transport or lifting. Observe the safety regulations of the manufacturer of the means of
transport or lifting. Noncompliance can result in personal injury or material damage.

3. If you use the product in a vehicle, it is the sole responsibility of the driver to drive the vehicle safely
and properly. The manufacturer assumes no responsibility for accidents or collisions. Never use the
product in a moving vehicle if doing so could distract the driver of the vehicle. Adequately secure the
product in the vehicle to prevent injuries or other damage in the event of an accident.

Waste disposal

1. If products or their components are mechanically and/or thermally processed in a manner that goes
beyond their intended use, hazardous substances (heavy-metal dust such as lead, beryllium, nickel)
may be released. For this reason, the product may only be disassembled by specially trained
personnel. Improper disassembly may be hazardous to your health. National waste disposal
regulations must be observed.

2. If handling the product releases hazardous substances or fuels that must be disposed of in a special
way, e.g. coolants or engine oils that must be replenished regularly, the safety instructions of the
manufacturer of the hazardous substances or fuels and the applicable regional waste disposal
regulations must be observed. Also observe the relevant safety instructions in the product
documentation. The improper disposal of hazardous substances or fuels can cause health problems
and lead to environmental damage.

Informaciones elementales de seguridad

Es imprescindible leer y observar las siguientes instrucciones e informaciones de seguridad!

El principio del grupo de empresas Rohde & Schwarz consiste en tener nuestros productos siempre al dia
con los estandares de seguridad y de ofrecer a nuestros clientes el maximo grado de seguridad. Nuestros
productos y todos los equipos adicionales son siempre fabricados y examinados segun las normas de
seguridad vigentes. Nuestro sistema de garantia de calidad controla constantemente que sean cumplidas
estas normas. El presente producto ha sido fabricado y examinado segun el certificado de conformidad
adjunto de la UE y ha salido de nuestra planta en estado impecable segun los estandares técnicos de
seguridad. Para poder preservar este estado y garantizar un funcionamiento libre de peligros, el usuario
debera atenerse a todas las indicaciones, informaciones de seguridad y notas de alerta. El grupo de
empresas Rohde & Schwarz esta siempre a su disposicion en caso de que tengan preguntas referentes a
estas informaciones de seguridad.

Ademas queda en la responsabilidad del usuario utilizar el producto en la forma debida. Este producto
estd destinado exclusivamente al uso en la industria y el laboratorio o, si ha sido expresamente
autorizado, para aplicaciones de campo y de ninguna manera debera ser utilizado de modo que alguna
persona/cosa pueda sufrir dafio. El uso del producto fuera de sus fines definidos o sin tener en cuenta las
instrucciones del fabricante queda en la responsabilidad del usuario. El fabricante no se hace en ninguna
forma responsable de consecuencias a causa del mal uso del producto.
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Informaciones elementales de seguridad

Se parte del uso correcto del producto para los fines definidos si el producto es utilizado conforme a las
indicaciones de la correspondiente documentacion del producto y dentro del margen de rendimiento
definido (ver hoja de datos, documentacion, informaciones de seguridad que siguen). El uso del producto
hace necesarios conocimientos técnicos y ciertos conocimientos del idioma inglés. Por eso se debe tener
en cuenta que el producto solo pueda ser operado por personal especializado o personas instruidas en
profundidad con las capacidades correspondientes. Si fuera necesaria indumentaria de seguridad para el
uso de productos de Rohde & Schwarz, encontraria la informacion debida en la documentacion del
producto en el capitulo correspondiente. Guarde bien las informaciones de seguridad elementales, asi
como la documentacion del producto, y entréguelas a usuarios posteriores.

Tener en cuenta las informaciones de seguridad sirve para evitar en lo posible lesiones o dafios por
peligros de toda clase. Por eso es imprescindible leer detalladamente y comprender por completo las
siguientes informaciones de seguridad antes de usar el producto, y respetarlas durante el uso del
producto. Deberan tenerse en cuenta todas las demas informaciones de seguridad, como p. €j. las
referentes a la proteccién de personas, que encontraran en el capitulo correspondiente de la
documentacion del producto y que también son de obligado cumplimiento. En las presentes
informaciones de seguridad se recogen todos los objetos que distribuye el grupo de empresas

Rohde & Schwarz bajo la denominacién de "producto”, entre ellos también aparatos, instalaciones asi
como toda clase de accesorios.

Simbolos y definiciones de seguridad

1 (i) 1

18 kg —
Aviso: punto de Atencién en Peligro de Adver- Conexién a Conexion | Conexién Aviso: Cuidado
peligro general el manejo de | choque tencia: conductor de | a tierra amasa en el manejo de
dispositivos eléctrico superficie proteccion dispositivos
Observar la o, de peso caliente sensibles a la
documentacion elevado electrostatica

del producto

(ESD)
| O <D —— N TN D
Tension de Indicacion de Corriente Corriente alterna | Corriente El aparato esta protegido
alimentacion de estado de continua (DC) (AC) continua / en su totalidad por un
PUESTAEN espera Corriente alterna | aislamiento doble
MARCHA / (Standby) (DC/AC) (reforzado)
PARADA
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Informaciones elementales de seguridad

Palabras de seiial y su significado

En la documentacion del producto se utilizan las siguientes palabras de sefal con el fin de advertir contra
riesgos y peligros.

PELIGRO identifica un peligro inminente con riesgo elevado que
A PELIGRO provocara muerte o lesiones graves si no se evita.
ADVERTENCIA identifica un posible peligro con riesgo medio de
A ADVERTENCIA provocar muerte o lesiones (graves) si no se evita.

ATENCION identifica un peligro con riesgo reducido de provocar

A ATENCION lesiones leves o0 moderadas si no se evita.
AVISO indica la posibilidad de utilizar mal el producto y, como
m consecuencia, danarlo.

En la documentacién del producto se emplea de forma sinénima el
término CUIDADO.

Las palabras de sefal corresponden a la definicion habitual para aplicaciones civiles en el area
economica europea. Pueden existir definiciones diferentes a esta definicidon en otras areas econémicas o
en aplicaciones militares. Por eso se debera tener en cuenta que las palabras de sefal aqui descritas
sean utilizadas siempre solamente en combinacion con la correspondiente documentacion del producto y
solamente en combinacién con el producto correspondiente. La utilizacién de las palabras de senal en
combinacion con productos o documentaciones que no les correspondan puede llevar a interpretaciones
equivocadas y tener por consecuencia dafios en personas u objetos.

Estados operativos y posiciones de funcionamiento

El producto solamente debe ser utilizado segun lo indicado por el fabricante respecto a los estados
operativos y posiciones de funcionamiento sin que se obstruya la ventilacion. Si no se siguen las
indicaciones del fabricante, pueden producirse choques eléctricos, incendios y/o lesiones graves con
posible consecuencia de muerte. En todos los trabajos deberan ser tenidas en cuenta las normas
nacionales y locales de seguridad del trabajo y de prevencion de accidentes.

1. Sino se convino de otra manera, es para los productos Rohde & Schwarz valido lo que sigue:
como posicion de funcionamiento se define por principio la posicién con el suelo de la caja para
abajo, modo de proteccion IP 2X, grado de suciedad 2, categoria de sobrecarga eléctrica 2, uso
solamente en estancias interiores, utilizacion hasta 2000 m sobre el nivel del mar, transporte hasta
4500 m sobre el nivel del mar. Se aplicara una tolerancia de £10 % sobre el voltaje nominal y de
+5 % sobre la frecuencia nominal.

2. No situe el producto encima de superficies, vehiculos, estantes o mesas, que por sus caracteristicas
de peso o de estabilidad no sean aptos para él. Siga siempre las instrucciones de instalacion del
fabricante cuando instale y asegure el producto en objetos o estructuras (p. ej. paredes y estantes). Si
se realiza la instalacién de modo distinto al indicado en la documentacién del producto, pueden
causarse lesiones o incluso la muerte.

3. No ponga el producto sobre aparatos que generen calor (p. €j. radiadores o calefactores). La
temperatura ambiente no debe superar la temperatura maxima especificada en la documentacion del
producto o en la hoja de datos. En caso de sobrecalentamiento del producto, pueden producirse
choques eléctricos, incendios y/o lesiones graves con posible consecuencia de muerte.
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Informaciones elementales de seguridad

Seguridad eléctrica

Si no se siguen (o se siguen de modo insuficiente) las indicaciones del fabricante en cuanto a seguridad
eléctrica, pueden producirse choques eléctricos, incendios y/o lesiones graves con posible consecuencia
de muerte.

1.

10.

11.

Antes de la puesta en marcha del producto se debera comprobar siempre que la tensién
preseleccionada en el producto coincida con la de la red de alimentacion eléctrica. Si es necesario
modificar el ajuste de tension, también se deberan cambiar en caso dado los fusibles
correspondientes del producto.

Los productos de la clase de proteccién | con alimentacion moévil y enchufe individual solamente
podran enchufarse a tomas de corriente con contacto de seguridad y con conductor de proteccion
conectado.

Queda prohibida la interrupcion intencionada del conductor de proteccion, tanto en la toma de
corriente como en el mismo producto. La interrupcién puede tener como consecuencia el riesgo de
que el producto sea fuente de choques eléctricos. Si se utilizan cables alargadores o regletas de
enchufe, debera garantizarse la realizacion de un examen regular de los mismos en cuanto a su
estado técnico de seguridad.

Si el producto no esta equipado con un interruptor para desconectarlo de la red, se debera considerar
el enchufe del cable de conexién como interruptor. En estos casos se debera asegurar que el enchufe
siempre sea de facil acceso (de acuerdo con la longitud del cable de conexion, aproximadamente

2 m). Los interruptores de funcion o electronicos no son aptos para el corte de la red eléctrica. Si los
productos sin interruptor estan integrados en bastidores o instalaciones, se debera colocar el
interruptor en el nivel de la instalacion.

No utilice nunca el producto si esta dafiado el cable de conexién a red. Compruebe regularmente el
correcto estado de los cables de conexion a red. Asegurese, mediante las medidas de proteccion y
de instalacion adecuadas, de que el cable de conexién a red no pueda ser danado o de que nadie
pueda ser danado por él, p. €j. al tropezar o por un choque eléctrico.

Solamente esta permitido el funcionamiento en redes de alimentacion TN/TT aseguradas con fusibles
de 16 A como maximo (utilizaciéon de fusibles de mayor amperaje solo previa consulta con el grupo de
empresas Rohde & Schwarz).

Nunca conecte el enchufe en tomas de corriente sucias o llenas de polvo. Introduzca el enchufe por
completo y fuertemente en la toma de corriente. La no observacion de estas medidas puede provocar
chispas, fuego y/o lesiones.

No sobrecargue las tomas de corriente, los cables alargadores o las regletas de enchufe ya que esto
podria causar fuego o choques eléctricos.

En las mediciones en circuitos de corriente con una tensidon Ug; > 30 V se deberan tomar las medidas
apropiadas para impedir cualquier peligro (p. €j. medios de medicién adecuados, seguros, limitaciéon
de tension, corte protector, aislamiento etc.).

Para la conexiéon con dispositivos informaticos como un PC o un ordenador industrial, debe
comprobarse que éstos cumplan los estandares IEC60950-1/EN60950-1 o IEC61010-1/EN 61010-1
validos en cada caso.

A menos que esté permitido expresamente, no retire nunca la tapa ni componentes de la carcasa
mientras el producto esté en servicio. Esto pone a descubierto los cables y componentes eléctricos y
puede causar lesiones, fuego o dafios en el producto.

1171.0000.42-05.00 Page 9



12.

13.

14.

15.

16.

17.

18.

Informaciones elementales de seguridad

Si un producto se instala en un lugar fijo, se debera primero conectar el conductor de proteccion fijo
con el conductor de proteccion del producto antes de hacer cualquier otra conexion. La instalacion y
la conexion deberan ser efectuadas por un electricista especializado.

En el caso de dispositivos fijos que no estén provistos de fusibles, interruptor automatico ni otros
mecanismos de seguridad similares, el circuito de alimentacién debe estar protegido de modo que
todas las personas que puedan acceder al producto, asi como el producto mismo, estén a salvo de
posibles dafnos.

Todo producto debe estar protegido contra sobretension (debida p. ej. a una caida del rayo) mediante
los correspondientes sistemas de proteccion. Si no, el personal que lo utilice quedara expuesto al
peligro de choque eléctrico.

No debe introducirse en los orificios de la caja del aparato ningin objeto que no esté destinado a ello.
Esto puede producir cortocircuitos en el producto y/o puede causar choques eléctricos, fuego o
lesiones.

Salvo indicacion contraria, los productos no estan impermeabilizados (ver también el capitulo
"Estados operativos y posiciones de funcionamiento”, punto 1). Por eso es necesario tomar las
medidas necesarias para evitar la entrada de liquidos. En caso contrario, existe peligro de choque
eléctrico para el usuario o de dafos en el producto, que también pueden redundar en peligro para las
personas.

No utilice el producto en condiciones en las que pueda producirse o ya se hayan producido
condensaciones sobre el producto o en el interior de éste, como p. €j. al desplazarlo de un lugar frio a
otro caliente. La entrada de agua aumenta el riesgo de choque eléctrico.

Antes de la limpieza, desconecte por completo el producto de la alimentacién de tension (p. ej. red de
alimentacion o bateria). Realice la limpieza de los aparatos con un pafio suave, que no se deshilache.
No utilice bajo ningun concepto productos de limpieza quimicos como alcohol, acetona o diluyentes
para lacas nitrocelulésicas.

Funcionamiento

1.

2.
3.

4.

El uso del producto requiere instrucciones especiales y una alta concentracion durante el manejo.
Debe asegurarse que las personas que manejen el producto estén a la altura de los requerimientos
necesarios en cuanto a aptitudes fisicas, psiquicas y emocionales, ya que de otra manera no se
pueden excluir lesiones o dafios de objetos. El empresario u operador es responsable de seleccionar
el personal usuario apto para el manejo del producto.

Antes de desplazar o transportar el producto, lea y tenga en cuenta el capitulo "Transporte".

Como con todo producto de fabricacion industrial no puede quedar excluida en general la posibilidad
de que se produzcan alergias provocadas por algunos materiales empleados, los llamados alérgenos
(p. €j. el niquel). Si durante el manejo de productos Rohde & Schwarz se producen reacciones
alérgicas, como p. €j. irritaciones cutaneas, estornudos continuos, enrojecimiento de la conjuntiva o
dificultades respiratorias, debe avisarse inmediatamente a un médico para investigar las causas y
evitar cualquier molestia o dafio a la salud.

Antes de la manipulacién mecanica y/o térmica o el desmontaje del producto, debe tenerse en cuenta
imprescindiblemente el capitulo "Eliminacion”, punto 1.
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5.

Informaciones elementales de seguridad

Ciertos productos, como p. €j. las instalaciones de radiocomunicacion RF, pueden a causa de su
funcion natural, emitir una radiacion electromagnética aumentada. Deben tomarse todas las medidas
necesarias para la proteccion de las mujeres embarazadas. También las personas con marcapasos
pueden correr peligro a causa de la radiacién electromagnética. El empresario/operador tiene la
obligacién de evaluar y sefializar las areas de trabajo en las que exista un riesgo elevado de
exposicion a radiaciones.

Tenga en cuenta que en caso de incendio pueden desprenderse del producto sustancias toxicas
(gases, liquidos etc.) que pueden generar dafos a la salud. Por eso, en caso de incendio deben
usarse medidas adecuadas, como p. e€j. mascaras antigas e indumentaria de proteccion.

En caso de que un producto Rohde & Schwarz contenga un producto laser (p. €j. un lector de
CD/DVD), no debe usarse ninguna otra configuracion o funcién aparte de las descritas en la
documentacién del producto, a fin de evitar lesiones (p. €j. debidas a irradiacion laser).

Reparaciéon y mantenimiento

1.

El producto solamente debe ser abierto por personal especializado con autorizacion para ello. Antes
de manipular el producto o abrirlo, es obligatorio desconectarlo de la tension de alimentacion, para
evitar toda posibilidad de choque eléctrico.

El ajuste, el cambio de partes, el mantenimiento y la reparaciéon deberan ser efectuadas solamente
por electricistas autorizados por Rohde & Schwarz. Si se reponen partes con importancia para los
aspectos de seguridad (p. €j. el enchufe, los transformadores o los fusibles), solamente podran ser
sustituidos por partes originales. Después de cada cambio de partes relevantes para la seguridad
debera realizarse un control de seguridad (control a primera vista, control del conductor de
proteccion, medicion de resistencia de aislamiento, medicién de la corriente de fuga, control de
funcionamiento). Con esto queda garantizada la seguridad del producto.

Baterias y acumuladores o celdas

Si no se siguen (o se siguen de modo insuficiente) las indicaciones en cuanto a las baterias y
acumuladores o celdas, pueden producirse explosiones, incendios y/o lesiones graves con posible
consecuencia de muerte. El manejo de baterias y acumuladores con electrolitos alcalinos (p. ej. celdas de
litio) debe seguir el estandar EN 62133.

1.
2.

No deben desmontarse, abrirse ni triturarse las celdas.

Las celdas o baterias no deben someterse a calor ni fuego. Debe evitarse el almacenamiento a la luz
directa del sol. Las celdas y baterias deben mantenerse limpias y secas. Limpiar las conexiones
sucias con un pafo seco Y limpio.

Las celdas o baterias no deben cortocircuitarse. Es peligroso almacenar las celdas o baterias en
estuches o cajones en cuyo interior puedan cortocircuitarse por contacto reciproco o por contacto con
otros materiales conductores. No deben extraerse las celdas o baterias de sus embalajes originales
hasta el momento en que vayan a utilizarse.

Mantener baterias y celdas fuera del alcance de los nifios. En caso de ingestién de una celda o
bateria, avisar inmediatamente a un médico.

Las celdas o baterias no deben someterse a impactos mecanicos fuertes indebidos.
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Informaciones elementales de seguridad

6. En caso de falta de estanqueidad de una celda, el liquido vertido no debe entrar en contacto con la

piel ni los ojos. Si se produce contacto, lavar con agua abundante la zona afectada y avisar a un
médico.

En caso de cambio o recarga inadecuados, las celdas o baterias que contienen electrolitos alcalinos
(p. €j. las celdas de litio) pueden explotar. Para garantizar la seguridad del producto, las celdas o
baterias solo deben ser sustituidas por el tipo Rohde & Schwarz correspondiente (ver lista de
recambios).

Las baterias y celdas deben reciclarse y no deben tirarse a la basura doméstica. Las baterias o
acumuladores que contienen plomo, mercurio o cadmio deben tratarse como residuos especiales.
Respete en esta relacién las normas nacionales de eliminacion y reciclaje.

Transporte

1.

El producto puede tener un peso elevado. Por eso es necesario desplazarlo o transportarlo con
precaucion y, si es necesario, usando un sistema de elevaciéon adecuado (p. ej. una carretilla
elevadora), a fin de evitar lesiones en la espalda u otros dafios personales.

Las asas instaladas en los productos sirven solamente de ayuda para el transporte del producto por
personas. Por eso no esta permitido utilizar las asas para la sujecion en o sobre medios de transporte
como p. ej. gruas, carretillas elevadoras de horquilla, carros etc. Es responsabilidad suya fijar los
productos de manera segura a los medios de transporte o elevacion. Para evitar dafos personales o
dafios en el producto, siga las instrucciones de seguridad del fabricante del medio de transporte o
elevacién utilizado.

Si se utiliza el producto dentro de un vehiculo, recae de manera exclusiva en el conductor la
responsabilidad de conducir el vehiculo de manera segura y adecuada. El fabricante no asumira
ninguna responsabilidad por accidentes o colisiones. No utilice nunca el producto dentro de un
vehiculo en movimiento si esto pudiera distraer al conductor. Asegure el producto dentro del vehiculo
debidamente para evitar, en caso de un accidente, lesiones u otra clase de dafos.

Eliminacion

1.

Si se trabaja de manera mecanica y/o térmica cualquier producto o componente mas alla del
funcionamiento previsto, pueden liberarse sustancias peligrosas (polvos con contenido de metales
pesados como p. ej. plomo, berilio o niquel). Por eso el producto solo debe ser desmontado por
personal especializado con formacion adecuada. Un desmontaje inadecuado puede ocasionar dafios
para la salud. Se deben tener en cuenta las directivas nacionales referentes a la eliminacion de
residuos.

En caso de que durante el trato del producto se formen sustancias peligrosas o combustibles que
deban tratarse como residuos especiales (p. j. refrigerantes o aceites de motor con intervalos de
cambio definidos), deben tenerse en cuenta las indicaciones de seguridad del fabricante de dichas
sustancias y las normas regionales de eliminacion de residuos. Tenga en cuenta también en caso
necesario las indicaciones de seguridad especiales contenidas en la documentacién del producto. La
eliminacién incorrecta de sustancias peligrosas o combustibles puede causar dafios a la salud o
dafios al medio ambiente.
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Kundeninformation zur Batterieverordnung (BattV)

Dieses Gerat enthalt eine schadstoffhaltige Batterie. Diese
darf nicht mit dem Hausmudill entsorgt werden.

Nach Ende der Lebensdauer darf die Entsorgung nur tber
eine Rohde&Schwarz-Kundendienststelle oder eine geeig-
nete Sammelstelle erfolgen.

Safety Regulations for Batteries
(according to BattV)

This equipment houses a battery containing harmful sub-
stances that must not be disposed of as normal household
waste.

After its useful life, the battery may only be disposed of at a
Rohde & Schwarz service center or at a suitable depot.

Normas de Seguridad para Baterias
(Segun BattV)

Este equipo lleva una bateria que contiene sustancias per-
judiciales, que no se debe desechar en los contenedores
de basura domeésticos.

Después de la vida util, la bateria solo se podra eliminar en
un centro de servicio de Rohde & Schwarz o en un
depdsito apropiado.

Consignes de sécurité pour batteries
(selon BattV)

Cet appareil est équipé d'une pile comprenant des sub-
stances nocives. Ne jamais la jeter dans une poubelle pour
ordures ménagéres.

Une pile usagée doit uniguement étre éliminée par un cen-
tre de service client de Rohde & Schwarz ou peut étre col-
lectée pour étre traitée spécialement comme déchets dan-
gereux.

D/E/ESP/F-2



Customer Information Regarding Product Disposal

The German Electrical and Electronic Equipment (ElektroG) Act is an implementation of
the following EC directives:

e 2002/96/EC on waste electrical and electronic equipment (WEEE) and
e 2002/95/EC on the restriction of the use of certain hazardous substances in
electrical and electronic equipment (RoHS).

Product labeling in accordance with EN 50419

Once the lifetime of a product has ended, this product must not be disposed of
in the standard domestic refuse. Even disposal via the municipal collection
points for waste electrical and electronic equipment is not permitted.

Rohde & Schwarz GmbH & Co. KG has developed a disposal concept for the
environmental-friendly disposal or recycling of waste material and fully assumes its
obligation as a producer to take back and dispose of electrical and electronic waste
in accordance with the ElektroG Act.

Please contact your local service representative to dispose of the product.

ROHDE&SCHWARZ
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Qualitatszertifikat
Certificate of quality
Certificat de qualité

Sehr geehrter Kunde,

Sie haben sich fur den Kauf eines
Rohde & Schwarz-Produktes ent-
schieden. Hiermit erhalten Sie ein
nach modernsten Fertigungsmethoden
hergestelltes Produkt. Es wurde nach
den Regeln unseres Qualitatsmanage-
mentsystems entwickelt, gefertigt
und gepruft. Das Rohde &Schwarz-
Qualitadtsmanagementsystem ist u.a.
nach ISO9001 und ISO 14001
zertifiziert.

Der Umwvelt verpflichtet

1 Energie-effiziente,
RoHS-konforme Produkte

1 Kontinuierliche Weiterentwicklung
nachhaltiger Umweltkonzepte

1 1ISO 14001-zertifiziertes
Umweltmanagementsystem

Dear Customer,

You have decided to buy a
Rohde & Schwarz product. You are
thus assured of receiving a product
that is manufactured using the most
modern methods available. This
product was developed, manufactured
and tested in compliance with our
quality management system stan-
dards. The Rohde & Schwarz quality
management system is certified
according to standards such as
ISO9001 and ISO 14001.

Environmental commitment

1 Energy-efficient products

1 Continuous improvement in
environmental sustainability

11SO 14001-certified environmental
management system

Certified Quality System

IS0 9001

Certified Environmental System

1S0 14001

Cher client,

Vous avez choisi d'acheter un pro-
duit Rohde & Schwarz. Vous disposez
donc d'un produit fabriqué d'apreés les
méthodes les plus avancées. Le déve-
loppement, la fabrication et les tests
respectent nos normes de gestion
qualité. Le systeme de gestion qualité
de Rohde &Schwarz a été homologué,
entre autres, conformément aux nor-
mes ISO9001 et ISO 14001.

Engagement écologique

1 Produits a efficience énergétique

1 Amélioration continue de la durabilité
environnementale

1 Systeme de gestion de I'environne-
ment certifié selon ISO 14001

1171.0200.11 V 04.01




CE Declaration of Conformity

Certificate No.: 2009-4

This is to certify that:

Equipment type Stock No. Designation
SMU200A 1141.2005.02 Vector Signal Generator

complies with the provisions of the Directive of the Council of the European Union on the
approximation of the laws of the Member States

- relating to electrical equipment for use within defined voltage limits
(2006/95/EC)

- relating to electromagnetic compatibility
(2004/108/EC)

Conformity is proven by compliance with the following standards:

EN 61010-1: 2001

EN 61326-1: 2006

EN 61326-2-1: 2006

EN 55011: 2007 + A2: 2007

EN 61000-3-2: 2006

EN 61000-3-3: 1995 + A1: 2001 + A2: 2005

For the assessment of electromagnetic compatibility, the limits of radio interference for Class
A equipment as well as the immunity to interference for operation in industry have been used
as a basis.

ROHDE & SCHWARZ GmbH & Co. KG
Miihldorfstr. 15, D-81671 Miinchen

Munich, 2010-02-05 Central Quality Management MF-QZ / Radde

CE E-1



Customer Support

Technical support — where and when you need it

For quick, expert help with any Rohde & Schwarz equipment, contact one of our Customer Support
Centers. A team of highly qualified engineers provides telephone support and will work with you to find a
solution to your query on any aspect of the operation, programming or applications of Rohde & Schwarz
equipment.

Up-to-date information and upgrades

To keep your instrument up-to-date and to be informed about new application notes related to your
instrument, please send an e-mail to the Customer Support Center stating your instrument and your wish.
We will take care that you will get the right information.

Europe, Africa, Middle East Phone +49 89 4129 12345
customersupport@rohde-schwarz.com

North America Phone 1-888-TEST-RSA (1-888-837-8772)
customer.support@rsa.rohde-schwarz.com

Latin America Phone +1-410-910-7988
customersupport.la@rohde-schwarz.com

Asia/Pacific Phone +6565 1304 88
customersupport.asia@rohde-schwarz.com

ROHDE&SCHWARZ

1171.0200.22-05.00
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Front Panel Tour

1 Preparing for Use

The following topics will help you to get familiar with the instrument and perform the first
steps:

e Front Panel Tour
e Rear Panel Tour
e Putting into Operation

This section explains the control elements and connectors of the Signal Generator R&S
SMU with the aid of the front and rear views and describes how to put the instrument into
operation. It also describes the connection of peripherals such as printer, keyboard or
mouse. Specifications of interfaces can be found in the data sheet.

The chapter 2, "Getting Started", on page 61 of this manual provides an overview of
the generator functions and introduces the operating concept. Detailed operating instruc-
tions and an overview of menus follow in chapter 3, "Manual Operation", on page 81.

For all reference information concerning manual and remote control of the instrument
refer to the online help system or its printed/printable version. A more detailed description
of the hardware connectors and interfaces is also part of the help system.

1.1 Front Panel Tour

The front panel of the R&S Signal Generator consists of the VGA display with the softkey
area, some utility keys (left side) and the hardkey area with connectors and control inter-
faces (right side). The subsequent sections provide brief explanations on the controls and
connectors, the hardkey area and the front panel.

® ROHDE&SCHWARZ  SMU 200A - VECTOR SIGNAL GENERATOR 1141.2005.02

—————————————— Aty LHEL ALE cAm wenu |
n.qa| 2115000 000 W‘GH: El PEPA| -6.68 dBm Leva [ -30.00[dem - — — - t 0 @
FreqB| 2115000 000 00 | GHz j PEPEB| -6.68 dBm LevB | -30.00(dBm - ’::zrl n::,!’gw :ﬁﬂﬁ B ?:sgfg'
uts | B: AL CAuto nfa =
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Fig. 1-1: Front panel view
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1.1.1  Utility Keys

The keys to the left of the display cause the R&S SMU to return to a definite instrument
state and provide information on the instrument and assistance.

For more information refer to chapter "Instrument Settings".

PRESET
Sets the instrument to a defined state (see chapter 1.3.4.4, "Default Settings",
on page 32).

LOCAL
Switches from remote control to local (manual) control.

SETUP
Opens the "Setup" dialog for configuring presettings.

For more information, see chapter 4.2.3, "General Configuration of Instrument - Setup
Key", on page 125.

HCOPY
Opens the "Hardcopy" menu for configuring and starting printing.

For more information, see chapter 4.2.5, "Generating a Hard Copy of the Display",
on page 148.

INFO
Displays status messages, error messages and warnings.

HELP
Displays context-sensitive help text.

1.1.2 Standby LEDs and Standby Key

=]
=

fT4N0EY - The standby LEDs and the ON/STANDBY key are located in the bottom left corner of the
front panel.

G

The ON/STANDBY key toggles the instrument between standby and ready state (indi-
cated by the standby LEDs).

The standby LEDs indicate the instrument states as follow:

e the green LED (left) is on when the instrument is ready for operation,

e the yellow LED (right) is on in the standby mode.
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See also chapter 1.3.4.1, "Standby and Ready state", on page 31.

1.1.3 Display

The display clearly shows all main settings and signal generator states.

The display is divided into the following sections:

e Frequency and level display with info line
— Frequency and level settings containing offset and peak envelope power (PEP).
In two-path instruments, frequency, level and PEP are displayed in two lines.

— Status messages

— Brief error messages.
To access an window with detailed information for a message, use the INFO key.

e Block diagram
The block diagram shows the current configuration and the signal flow in the gener-
ator with the aid of function blocks containing an on/off switch. Selecting a function
block opens a list of associated setting menus. Active menus, info windows and
graphs are displayed on top of the block diagram. The block diagram can be displayed
in the foreground anytime with the DIAGRAM key.

e "Winbar" with labelled softkeys

Open menus are indicated by a labelled button in the "Winbar". The buttons determine
the softkey functions for front-panel control. When a button or softkey is pressed, the
associated menu is displayed either in the foreground or minimized in the "Winbar".
If required, the WINBAR is covered by a row of buttons to which menu-specific func-
tions of the active menu are assigned. By pressing the WINBAR key, the "Winbar"
can be displayed in the foreground again. This allows the user to toggle between the
button and softkey functions.

For detailed information, see chapter 3.2, "Display"”, on page 85.

1.1.4 Setup Keys

The keys to the right of the display set parameters, select views and control the windows.

1.1.4.1 Keys for Setting Paramters

These keys provide direct access to the settings in the header of the instrument and can
be used for fast changing the state of the modulation and the RF signal.

[ FREQ ] [LE\.‘EL] [ FILE ]
RF MOD RECAL.
ON/OFF ONJOFF CULATE

For more information refer to chapter "Instrument Functions".

FREQ
Activates frequency entry.
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In the two-path mode, the frequency entry field that was active last is activated. Pressing
the key again activates frequency entry for the second path.

RF ON/OFF
Switches the RF signal on and off.

In the two-path mode, the RF ON/OFF key switches all RF signals off. A second stroke
restores the status that was active before the last switch-off.

"RF OFF" is displayed in the header next to the "Frequency" field.

LEVEL
Activates level entry.

In the two-path mode, the level entry field that was active last is activated. Pressing the
key a second time activates level entry for the second path.

MOD ON/OFF
Switches the modulations on and off.

In the two-path mode, the MOD ON/OFF key switches all modulations off. Pressing the
key again restores the status that was active before the last switch-off.

"MOD OFF" is displayed in the info line of the header next to the "Level" field.

FILE
Activates the menu for storing or loading files (see chapter 3.7, "File Management",
on page 110).

RECALCULATE
Starts the recalculation of instrument settings.

If time-consuming calculations are required, the active modulation is automatically
switched off and the calculation is interrupted to allow the user to make further settings.
Calculation is restarted by a keystroke and the modulation is switched on again after the
calculation is completed.

Display Keys

The keys on top of the rotary knob and the keys below the numeric key pad arrange
different windows on the display.

DIAGRAM
Brings the block diagram to the foreground. Active menus are minimized.

Active menus are indicated by the buttons in the "Winbar".

ESC

The function of this key depends on the current cursor position.

e C(Calls the next higher selection level.

e Closes the open window without accepting new entries; the old value or parameter
is retained.

e |n dialog boxes that contain a "Cancel" button it activates that button.
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Closes all kinds of dialog boxes, if the edit mode is not active.

Quits the edit mode, if the edit mode is active.

Switches between different entry fields of a menu.

Shifts the entry cursor from the header display to the previously active menu, or to
the previously highlighted block in the block diagram if no menu is active.

e Shifts the cursor from a function block in the diagram to the first item in the "Win-
bar". If no menus are open, the current cursor position remains unchanged.

TOGGLE

e Switches highlighted elements or a function block on and off.

e Switches between two or more settings, e.g. items of selection lists. At the end of a
list, the cursor is set on the first entry again.

MENU
Calls the menu tree.

CLOSE

Closes the active menu.

e If the entry mode is active, changes are cancelled.

e |[f settings in this menu require acknowledgement by means of an "Accept” button, a
query is displayed asking whether the changes made should be cancelled.

HIDE
Minimizes the active open menu. The associated button in the "Winbar" remains visible.

REARR
Automatic rearrangement of open menus.

WINBAR
Toggles between display and blanking of the "Winbar".

Keypad for data entry

The keys in the data entry keypad are used to enter alphanumeric data and units.

Data entry keys are only enabled while the cursor is placed on a data input field in a
dialog. Their function depends on the data type of the input field.
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Keys Description
0...9/abc Enters the corresponding numbers (in numeric input fields) or characters (character input
fields).

Inserts a decimal point (numeric input fields) or dot (character input fields) at the cursor posi-
tion. Multiple decimal points are not allowed.

+/- Changes the sign of a numeric parameter. In the case of an alphanumeric parameter, inserts
a hyphen at the cursor position.

Unit keys Selects a unit and thus determine the absolute value, or changes the unit, i.e. trigger a recal-
culation without changing the absolute value. The function depends on the time at which the
UNIT key is used during parameter entry (see chapter 3.4.5, "Working with Units ",

on page 98).

For unit-free values, the X1 key is equivalent to ENTER. It confirms the previous entry and
deactivates the input field.

Adds a blank in a character input field.

. # Enters special characters. Toggles through the available characters if the key is pressed sev-
eral times in a row.

A<->a Toggles between uppercase and lowercase characters.

A, B, C, D, E, | Enters hexadecimal values. The letters assigned to the keys are automatically active when
F an entry field with a hexadecimal value is active.

INSERT
Toggles between insert and overwrite mode (see also chapter 3.4.4, "Entering a Value",
on page 96 ).

BACKSPACE
Deletes the last character before the cursor position or the selected character sequence.

ENTER
Pressing the rotary knob has the same effect.

e Concludes the entry of dimensionless entries. For other entries, this key can be used
instead of the default unit key. The new value is accepted.

Confirms ("OK") and closes open input windows.

In a dialog box, selects the default or focused button.

In a dialog box, activates the edit mode for the focused area, if available.

In a dialog box, activates or deactivates the selected option of the focused area, if
the edit mode is active.

e Calls the next menu level.

1.1.6 Rotary Knob and Navigation Keys

The rotary knob and the arrow keys are alternative control elements for data variation
and navigation in the graphical user interface.

Operating Manual 1007.9845.32 — 16 20



R&S®SMU200A Preparing for Use

Front Panel Tour

ROTARY KNOB

The rotary knob has several functions:

e Increases (clockwise direction) or decreases (counter-clockwise direction) numeric
values at a defined step width in editing mode

Moves the cursor, e.g. to a function block in the block diagram

Scrolls within lists, tables or tree views

Acts like the ENTER key, when it is pressed.

e Shifts the selection bar within focused areas (e.qg. lists), if the edit mode is activated.

Note: Turning or pressing the rotary knob is equivalent to pressing the UP and DOWN
keys or the ENTER key in the keypad.

@ NAVIGATION KEYS
@ @ The navigation keys consist of 4 arrow keys which are used for navigation, alternatively
@ to the rotary knob.

UP/ DOWN The up and down arrow keys do the following:

KEYS e In a numeric edit dialog box, increase or decrease the instrument
parameter.
e |n a list, table, window or dialog box, scroll vertically.

LEFT/ RIGHT The left and right arrow keys do the following:
KEYS e |n an alphanumeric edit dialog box, move the cursor forward and
back.

e In alist, table, wondiw or dialog box, scroll horizontally.

1.1.7 Front Panel Connectors

The RF and I/O connectors and various additional interface connectors are located on
the front panel.

/ 1,Q
' | and Q inputs for external analog modulation signal in case of I/Q modulation.

This inputs are also used for external analog baseband signal (option R&S SMU-B17,
o Baseband Input).

For more information see:
e chapter 4.8.2, "Data and Signal Sources in Baseband", on page 328
e chapter 4.9.1.1, "Baseband Input Settings Menu", on page 444

. DATA
bata G- Signal for Path A only.

Input for external serial data signal in case of digital modulation.
Output for serial data signal in case of digital modulation.

For more information see:
e chapter 4.8.2, "Data and Signal Sources in Baseband", on page 328
e chapter 4.9.1.1, "Baseband Input Settings Menu", on page 444
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CLOCK

cLock G- Signal for Path A only.
Input for external clock signal (bit or symbol clock, multiple of symbol clock) for synchro-
nizing the external data signal in case of multivalent modulation. The active edge can be
set.
Output for clock signal (bit or symbol clock) in the internal mode.

e RF A,RF B
(o soe]  [oowe 2

“.  Outputs for RF signal of path A and path B.

A
@ @ NOTICE! Maximum Input Levels. Do not overload the RF output. The maximum permis-
(e )N sible back-feed is specified in the data sheet.

TRIGGER1<3 TRIGGER 1
Input for triggering digital modulations, standards and ARB.

For more information see chapterchapter 4.2.3.10, "Global Trigger/Clock/External Input
Settings", on page 135.

MARKER 1, 2
Outputs 1 and 2 for triggering and control of external devices with user-definable marker
signals.

The instrument provides four outputs for marker signals. Marker signals 1 to 3 are per-
manently assigned to the outputs; marker signal 4 can be routed to one of the four
USER outputs. The assigment is as follow:

Path A

e Marker 1,2: BNC connectors MARKER 1/ 2 on the front panel.

e Marker 3: MARKER 3 pin of AUX I/O connector on the rear panel.

e Marker 4: BNC connector USER 1 or USER 2/3/4 pins of AUX I/O connector on rear
panel.

Path B

e Marker 1: MARKER 1B output on rear panel.

o Marker 2/3: MARKER 2 B / 3 B pins of AUX I/O connector on rear panel.

e Marker 4: BNC connector USER 1 or USER 2/3/4 pins of AUX I/O connector on rear
panel.

For more information see chapter 4.2.3.10, "Global Trigger/Clock/External Input Set-

tings", on page 135.

UsSB USB
=] USB (universal serial bus) interfaces of type A (host USB).

e Connection of peripherals such as mouse or keyboard
e Connection of memory stick for file transmission
e Firmware update

Note: Another USB interface type A (host USB) and a USB interface type B (device USB
for data transmission) are available on the rear panel.

See also chapter 1.4.1, "Connecting USB Devices", on page 35.
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seNsoR SENSOR
Connector for R&S NRP-Zxx sensors.

With the aid of the "User Correction" function, a table with correction values for external
test assemblies can be automatically determined, e.g. for compensating the frequency
response of cables.

The power sensors are connected by inserting the male connector. To disconnect hold
the connector by its sleeve. Pulling on the sensor cable will not release the sensor con-
nector.

See also chapter 4.5.6, "NRP-Z Power Viewer", on page 206.

1.2 Rear Panel Tour

This section gives an overview of connectors on the rear panel of the instrument. Each
connector is briefly described and a reference is given to the chapters containing detailed
information. For technical data of the connectors refer to the data sheet.

If a connector of a two-path instrument is available for one path only (e.g. path A) or for
either of the two (path A or B), a note is made in the brief description.

BASEBAND DIGITAL OUT

IEEa  (ECE)
MONITOR USBIN

Fig. 1-2: Rear panel view

1.2.1 Description of the Connectors

LF
(path A only)

Output for internal LF modulation generator signal.

See also data sheet and chapter 4.5.12.1, "LF Generator Overview", on page 243,
chapter 4.5.12.2, "LF Output", on page 243.
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MARKER 1B

Output for user-programmable marker signal 1 of path B for triggering and control of
external devices. Marker outputs are permanently assigned (see "MARKER 1, 2"

on page 22).

MARKER 1/ MARKER 2
Rear Panel Connectors for path A (option R&S SMU-B81) and path B (option R&S SMU-
B82).

These options are recommended for use of the instrument in a 19" rack. Installing the
instrument in a 19" rack requires a rack adapter or an adapter for telescopic sliders (refer
to data sheet for order number).

Marker outputs are permanently assigned (see "MARKER 1, 2" on page 22).
See also chapter 1.3.2, "Placing or Mounting the Instrument", on page 29.

AC SUPPLY AND POWER SWITCH

When the R&S SMU is connected to the AC supply, it automatically sets itself to the
correct range for the applied voltage (range: see type label). There is no need to set the
voltage manually or change fuses.

The instrument comes with or without a power switch, depending on the design of the
otherwise technically equivalent power supply unit.

The power switch can be set to two positions:

e 0
The instrument is disconnected from the mains.

o |
The instrument is power-supplied. It is either ready for operation (STANDBY) or in
operating mode, depending on the position of the ON/STANDBY switch on the instru-
ment front.

See also data sheet and chapter 1.3.3, "Connecting the Instrument to the AC Supply",
on page 30.

10UT/QOUT
(path A or path B)

Direct output or Differential (non-inverting) output for analog 1/Q signal.
Option option R&S SMU-B16 is required.
See also chapter 4.7.3, "Output of the Baseband Signal - 1/Q Out", on page 307.

I OUT BAR/Q OUT BAR
(path A or path B)

Differential (inverting) output for analog 1/Q signal.

See also chapter 4.7.3, "Output of the Baseband Signal - 1/Q Out", on page 307.

I/Q/DATA/CLOCK
Rear Panel Connectors for path A (option R&S SMU-B81) and path B (option R&S SMU-
B82).

|
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This options are recommended for use of the instrument in a 19" rack. Installing the
instrument in a 19" rack requires a rack adapter or an adapter for telescopic sliders (refer
to data sheet for order number).

See also chapter 1.3.2, "Placing or Mounting the Instrument", on page 29.

Note: Option R&S SMU-B16 (Differential Outputs) and options R&S SMU-B81/B82 can-
not be fitted both, because they use the same connectors.

et REF OUT

. e ) Output of internal reference signal.

. See also chapter 4.5.4, "Reference Oscillator", on page 200.
REF IN &) REF IN
Input for external reference signal.

The external reference is used for both paths.

See also chapter 4.5.4, "Reference Oscillator”, on page 200.

EXT MOD
Input for external analog modulation signals.

See also "External Modulation Sources", on page 231.

IEC 625/IEEE 488
IEC-bus (IEEE 488) interface for remote control of the instrument.

See also chapter A.1, "GPIB Bus Interface", on page 857 and chapter 5.1.4, "GPIB
Interface (IEC/IEEE Bus Interface)", on page 459.

Note: In order to avoid electromagnetic interference (EMI) caused by open lines, always
terminate any connected IEC-bus cable with an instrument or a controller.

USB CONNECTORS TYPE A
USB (universal serial bus) interfaces of type A (host USB).

e Connection of peripherals such as mouse, keyboard, etc.
e Connection of memory stick for file transmission
e Firmware update

Further USB interface type A are available on the front panel.
See also chapter 1.4.1, "Connecting USB Devices", on page 35.

USE IN USB IN
i USB (universal serial bus) interface of type B (device USB).
This port is reserved for future extensions.
MONITOR MON|TOR
, @ Connector for external monitor (see chapter 1.4.2, "Connecting a Monitor",
- on page 36).

For description of this connector, refer to chapter A.3, "Monitor Connector (MONITOR)",
on page 860.
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AUX /O
h-——1

Parallel input/output for data signals as well as settable trigger and control signals of the
baseband. Input for device trigger.

Assignment of the AUX I/O interface and of USER pins can be configured in the "Setup
> Global Trigger/Clock/External Inputs" and "Setup > USER Marker / AUX I/O Settings".

Use this dialogs to configure also the arbitrary assignment of pins to path A or B.

Note: An adapter of the AUX I/O interface to coaxial BNC connectors is available as an
accessory (R&S SMU-Z5, see data sheet).

See also chapter 4.2.3.10, "Global Trigger/Clock/External Input Settings", on page 135
and chapter 4.2.3.12, "User Marker / AUX |/O Settings", on page 138.

For detailed description of the AUX I/O connector, refer to chapter A.2, "AUX 1/O Con-
nector", on page 858.

BERT

Input for data, clock and control signals for bit and block error rate measurements, level
0.0128..1.998V.

BASEBAND DIGITAL IN/OUT

Digital Interface:

e Input for external digital 1/Q signal (BBIN) in case of digital modulation (option R&S
SMU-B17, Baseband Input (digital/analog)).

e Output of the digital 1/Q signal (BBOUT) (option R&S SMU-B18 Digital I/Q Out).

7. 1=
BASEBAND DIGITAL OUT

BASEBAND DIGITAL IN

LAN CONNECTOR

Ethernet interface

For integrating signal generators in a network
Remote control of signal generator

Input of external asynchronous data

Remote access to the signal generator
Firmware update

See also:
e chapter 1.6, "Setting Up a Network (LAN) Connection", on page 38
e chapter 5.1.3, "LAN Interface", on page 457

RFA/RFB

Rear Panel Connectors for path A (option R&S SMU-B81) and path B (option R&S SMU-
B82). This options are recommended for use of the instrument in a 19" rack. Installing
the instrument in a 19" rack requires a rack adapter or an adapter for telescopic sliders
(refer to data sheet for order number).

See also chapter 1.3.2, "Placing or Mounting the Instrument”, on page 29.

LOIN, LO OUT

Local oscillator input and output:

e LO IN: Input for external LO signals

e | O OUT: Output for internal LO signals.
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See also chapter 4.5.5, "Local Oscillator - LO Coupling", on page 202.

CLOCK OUT
Output for internal clock signal.

This connector is used for path A only. The internal clock signal of path B can be output
at one of the USER interfaces.

See also chapter 4.8.2.4, "Clock Signals", on page 331.

INSTR TRIG
Input for external trigger of analog modulations, sweeps and list mode. HOP input for
control of the frequency hop mode with external source in the list mode.

This connector is used for path A only. The instrument trigger input for path B is part of
the AUX /O interface.

See also chapter 4.5.14, "List Mode", on page 265 and chapter 4.5.13.1, "Overview",
on page 244.

USER
Input/output for configurable signals for triggering and control.

The following signals can be applied to the connector:
Marker 4

Clock Out (bit or symbol)

CW mode Out

No signal (blank) marker

HOP

Note: With exception of the Clock Out signal, the signals for triggering and control apply
for both paths.

TRIGGER 1/2
TRIGGER 2: Input for external triggering of digital modulations and standards and ARB.

TRIGGER 1: Rear Panel Connectors for path A (option R&S SMU-B81) and path B
(option R&S SMU-B82).

This options are recommended for use of the instrument in a 19" rack. Installing the
instrument in a 19" rack requires a rack adapter or an adapter for telescopic sliders (refer
to data sheet for Order No.).

See also chapter 1.3.2, "Placing or Mounting the Instrument”, on page 29.

1.3 Putting into Operation

This section describes the basic steps to be taken when setting up the R&S SMU for the
first time.

|
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A WARNING

Shock hazard

Do not open the instrument casing. As a rule, normal operation of the instrument does
not require opening the casing. Observe the general safety instructions and regulations
at the beginning of the manual.

Risk of instrument damage

Note that the general safety instructions also contain information on operating conditions
that will prevent damage to the instrument. The instrument's data sheet may contain
additional operating conditions.

Risk of instrument damage

Before switching on the instrument, make sure that the following conditions are met:
e Instrument casing is closed and all fasteners are tightened.

e All fan openings are unobstructed and the airflow perforations are unimpeded. The
minimum distance from the wall is 10 cm.

e The instrument is dry and shows no sign of condensation.

e The instrument is operated in the horizontal position on an even surface.

e The ambient temperature does not exceed the range specified in the data sheet.
e Signal levels at the input connectors are all within the specified ranges.

e Signal outputs are correctly connected and are not overloaded.

Failure to meet these conditions may cause damage to the instrument or other devices
in the test setup.

Risk of electrostatic discharge

Protect the work area against electrostatic discharge to avoid damage to electronic com-
ponents in the modules. For details, refer to the safety instructions at the beginning of
this manual.

|
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<O)\ EMI impact on measurement results

/' Electromagnetic interference (EMI) can affect the measurement results. To avoid any

impact, make sure that the following conditions are met:

Use suitable double-shielded cables.
e Do not use USB connecting cables exceeding 1 m in length.

Use only USB devices that remain within the permissible EMI limits.

Always terminate any connected IEC-bus cables with an instrument or controller.

Outputs and lines have to be terminated properly with 50 Ohms.

For digital interfaces only the cable R&S SMU-Z6 is permitted for connection. The asso-
ciated cable is available under part number 1415.0201.02.

1.3.1

Unpacking and Checking the Instrument

To remove the instrument from its packaging and check the equipment for completeness
proceed as follows:

1. Pull off the polyethylene protection pads from the instrument's rear feet and then
carefully remove the pads from the instrument handles at the front.

2. Pull off the corrugated cardboard cover that protects the rear of the instrument.

3. Carefully unthread the corrugated cardboard cover at the front that protects the
instrument handles and remove it.

4. Check the equipment for completeness using the delivery note and the accessory
lists for the various items.

5. Check the instrument for any damage. If there is damage, immediately contact the
carrier who delivered the instrument. Make sure not to discard the box and packing
material.

O\ Packing material

/ Retain the original packing material. If the instrument needs to be transported or shipped

at a later date, you can use the material to prevent control elements and connectors from
being damaged.

1.3.2

Placing or Mounting the Instrument

The R&S SMU is designed for use under laboratory conditions, either on a bench top or
in a rack using a rack adapter kit (order number see data sheet).

|
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Bench Top Operation

If the R&S SMU is operated on a bench top, the surface should be flat. The instrument
can be used in horizontal position, standing on its feet, or with the support feet on the
bottom extended.

CAUTION

Risk of injury
The feet may fold in if they are not folded out completely or if the instrument is shifted.

Fold the feet completely in or completely out to ensure stability of the instrument and
personal safety. To avoid injuries, never shift the instrument when its feet are folded out.

When the instrument is standing on its folded-out feet, do not work under the instrument
and do not put anything under it, otherwise injuries or material damage could occur.

The feet may break if they are overloaded. The overall load on the folded-out feet must
not exceed 500 N.

Rackmounting

The R&S SMU can be installed in a rack using a rack adapter kit (Order No. see data
sheet). The installation instructions are part of the adapter kit.

Risk of instrument damage

For rack installation, make sure that all fan openings are unobstructed and that the airflow
perforations are unimpeded. This helps to prevent the instrument from overheating.

1.3.3

134

Connecting the Instrument to the AC Supply

The R&S SMU is automatically adapted to the AC voltage supplied. There is no need to
set the voltage manually or change fuses. The AC SUPPLY AND POWER SWITCH is
at the rear of the unit.

» Connect the instrument to the AC power source using the AC power cable delivered
with the instrument.

Note: The instrument is in compliance with safety class EN61010-1.
Connect the instrument only to a socket with earthing contact.

Starting the Instrument

The R&S SMU comes with or without a power switch, depending on the design of the
otherwise technically equivalent power supply unit.

|
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Switching off the AC power

You can leave the AC power on permanently to preserve your last instrument settings.
Switching off is required only if the instrument must be completely disconnected from all
power supplies.

Starting up instruments with power switch
1. Connect the instrument to the AC supply.

2. To turn the power on, press the main power switch to position | (On).

After power-up, the instrument is in standby or ready state, depending on the state
of the ON/STANDBY key at the front panel of the instrument when the instrument
was switched off for the last time.

3. In case the instrument is in standby mode, i.e. the yellow LED is on, press the ON/
STANDBY key to switch the instrument to ready state.

Starting up instruments without power switch

1. Connect the instrument to the AC supply.

After connection to the AC supply, the instrument is in standby or ready state,
depending on the state of the ON/STANDBY key at the front panel of the instrument
when the instrument was switched off for the last time.

2. In case the instrument is in standby mode, i.e. the yellow LED is on, press the ON/
STANDBY key to switch the instrument to ready state.

1.3.4.1 Standby and Ready state
on sTanper - The ON/STANDBY key is located in the bottom left corner of the front panel.

I
Switching between standby and ready state

» Press the ON/STANDBY key briefly to switch the instrument from the standby to
ready state or vice versa.

In ready state, the left, green LED is on. The instrument is ready for operation. All
modules are power-supplied and the R&S SMU initiates its startup procedure.

In standby state, the right, yellow LED is on. The standby power only supplies the
power switch circuits and the oven-controlled crystal oscillator to keep it at its oper-
ating temperature. In this state it is safe to switch off the AC power and disconnect
the instrument from the power supply.

1.3.4.2 Start Display and Booting

After power-on, the start display indicates for a few seconds the installed BIOS version
and the processor characteristics.

|
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The instrument boots the operating system, starts the instrument firmware and automat-
ically performs a selftest. If the previous session was terminated regularly, the instrument
uses the last setup with the relevant instrument settings.

Once the startup procedure has been terminated, the block diagram opened in the pre-
vious session is displayed and the instrument is ready for operation.

Use the PRESET key to return the instrument to its definite reset/preset state, if the cur-
rent setup is not anymore relevant.

To customize the start settings, use the "File" dialog.

Rebooting the instrument

Press the STANDBY key for approx. 5 s. to reboot the instrument, if the software stops
unexpectedly.

1.3.4.3

1.3.4.4

Function Check

The signal generator automatically monitors the main functions when the instrument is
switched on and continuously during operation.

A detected fault is indicated by a "ERROR" message displayed in the info line together
with a brief error description. For in-depth identification of the error, press the INFO key.
In response, a description of the error(s) is displayed.

For more information, refer to chapter 8, "Error Messages", on page 849.

Additionaly to the automatic monitoring, the R&S SMU offers the following capabilities to
ensure correct functioning:

e Internal Adjustments
Press the SETUP key and select "System > Internal Adjustments" to access the dia-
log for preforming and configuring of the adjustments settings. A maximum level
accuracy can be obtained, for instance.

e Selftest
A selftest is provided for service purposes. The selftest is a protected test procedure,
which can be accessed if protection level 1 is disabled.

e Test points
If required for service purposes, internal test points can be queried. This testis a
protected test procedure, which can be accessed if protection level 4 is disabled. The
corresponding procedure is described in the Service Manual.

Default Settings

When the instrument is switched on, it is not the preset state that is active, but rather the
instrument state that was set before the instrument was switched off. It is also recomen-
ded that you use the PRESET key to return the instrument to its defined preset state

every time a new configuration is required or the current setup is not anymore relevant.

|
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The R&S SMU offers a three-stage preset concept:

Preset of the settings belonging to a digital standard or associated with one dialog.
Most of the dialog boxes provide a special "Set to Default" button that resets directly
the settings associated to the corresponding dialog, e.g. all digital modulation settings
in the "Custom Digital Mod" dialog.

These settings are identical to those which are called up using the PRESET key.

Preset the instrument to a predefined state

The PRESET key calls up a defined instrument setup. All parameters and switching
states are preset (also those of inactive operating modes). The default instrument
settings provide a reproducible initial basis for all other settings. However, functions
that concern the integration of the instrument into a measurement setup are not
changed, e.g. GPIB bus address or reference oscillator source settings.

In remote control it is possible to preset the settings of the two instrument's paths
separately (see section "Preset Commands").

Preset the instrument to its factory settings

The instrument can also be forced to load its default factory settings. To access the
corresponding dialog box, press the SETUP key and select the "Factory Preset".
For more information and an overview of the settings affected by the factory preset
function, see chapter 4.2.3.18, "Factory Preset", on page 146.

Overview of the Most Important Preset States

The following list gives an overview of the presets for the most important generator set-
tings. The other presets can be found in the preset tables of the individual menus and
the information accompanying the remote commands.

"RF frequency" = 1 GHz

"RF level" RF output switched off
"Offsets" = 0

"Modulations State" = Off

Uninterrupted level settings are switched off
"Level Attenuator Mode" = AUTO

Internal level control "Level ALC" = AUTO
User correction "Level Ucor" = OFF

"LF output State" = Off

"Sweep State" = Off

"List mode State" = Off

Settings that are not affected by the PRESET key

Reference frequency settings ("Ref Oscillator" menu)

Power on settings ("Level/EMF" menu)

Network settings ("Setup" menu)

GPIB address ("Setup" menu)

Password and settings protected by passwords ("Setup" menu)
Start/Stop Gui Update ("Setup" menu)

Display and keyboard settings ("Setup" menu)
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@ User-defined instrument states can be stored and called up in the "File" dialog.

1.3.5 Shutting Down the Instrument

To shut down the R&S SMU, proceed as described below.

Risk of losing data

If you switch off the running instrument using the rear panel switch or by disconnecting
the power cord, the instrument loses its current settings. Furthermore, program data may
be lost.

Always first press the ON/STANDBY key to shut down the application properly.

1. Press the ON/STANDBY key to save the current setup, shut down the operating
system and set the instrument to standby state.

The yellow LED must be on.

2. To turn the power off:

a) For instruments with power switch, press the main power switch to position 0

(Off).

b) For instruments without power switch, pull the power cable at the rear of the
instrument.

Tip:

Switching off the AC power

You can leave the AC power on permanently to preserve your last instrument settings.
Switching off is required only if the instrument must be completely disconnected from
all power supplies.

None of the front-panel LEDs should be on.

1.4 Connecting External Accessories

The equivalent USB ports on the front and/or rear panel of the R&S SMU can be used to
connect a variety of accessories.

In addition the instrument provides interfaces for monitor connection and network inte-
gration (see chapter 1.4.2, "Connecting a Monitor", on page 36 and chapter 1.6.1,
"Connecting the Instrument to the Network", on page 39).
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Connecting USB Devices

The USB interfaces on the front and (optionally) rear panels of the R&S SMU allow you
to connect USB devices directly to the instrument. This number can be increased as
necessary by using USB hubs. Due to the large number of available USB devices, there
is almost no limit to the expansions that are possible with the R&S SMU.

The following list shows various USB devices that can be useful:

e Memory stick for easy transfer of data to/from a computer (e.g. firmware updates)
e CD-ROM drives for easy installation of firmware applications

e Keyboard or mouse to simplify the entry of data, comments, file names, etc.

e Printer for printing out measurement results

e Power sensors, e.g. of the NRP Zxy family

Installing USB devices is easy under Windows XP, because all USB devices are

plug&play. After a device is connected to the USB interface, Windows XP automatically
searches for a suitable device driver.

If Windows XP does not find a suitable driver, it will prompt you to specify a directory that
contains the driver software. If the driver software is on a CD, connect a USB CD-ROM
drive to the instrument before proceeding.

When a USB device is subsequently disconnected from the R&S SMU, Windows XP
immediately detects the change in hardware configuration and deactivates the corre-
sponding driver.

All USB devices can be connected to or disconnected from the instrument during oper-
ation.
Connecting a memory stick or CD-ROM drive

If installation of a memory stick or CD-ROM drive is successful, Windows XP informs you
that the device is ready to use. The device is made available as a new drive ("D:") and
is displayed under Windows Explorer. The name of the drive is manufacturer-dependent.

Connecting a keyboard

The keyboard is detected automatically when it is connected. The default input language
is English — US.

Use the "Start > Control Panel > Keyboard" or the "Regional and Language Options"
menu of Windows XP to configure the keyboard properties. To access Windows XP,
press the Windows key on the external keyboard.

Connecting a mouse

The mouse is detected automatically when it is connected.

Use the "Start > Control Panel > Mouse" menu of Windows XP to configure the mouse
properties. To access Windows XP, press the Windows key on the external keyboard.

|
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Connecting a printer

When printing a file, the instrument checks whether a printer is connected and turned on
and whether the appropriate printer driver is installed. If required, printer driver installation
is initiated using Windows XP's "Add Printer" wizard. A printer driver needs to be installed
only once.

You can load updated and improved driver versions or new drivers from an installation
disk, USB memory stick or another external storage medium. If the instrument is inte-
grated in a network, you can also install driver data stored in a network directory. Use the
"Add Printer" wizard on the "Start > Settings > Printer and Faxes" menu to install the
driver. To access Windows XP, press the Windows key on the external keyboard.

Connecting a Monitor
An external monitor with an analog interface can be connected to the MONITOR con-

nector on the rear panel of the instrument. Per default, the external monitor connector is
disabled and has to be enabled before operation.

\ Connecting external devices
/ Before connecting any external device such as a monitor, make sure that the instrument

is switched off (or in standby mode). Otherwise, correct operation cannot be assured.
This does not apply to USB devices.

1.5

1. Shut down the instrument.

None of the front-panel LEDs should be on.

2. Plug in the monitor cable to the MONITOR connector on the rear panel of the instru-
ment.

3. Start up the instrument.
The green LED must be on.

The external monitor is detected.
The entire display of the instrument, containing the status bar, the block diagram and
the winbar is displayed on the monitor additionally. Further settings are not required.

The MONITOR interface is described in "Appendix A: Hardware Interfaces" in the Oper-
ating Manual.

Windows Operating System

The instrument contains the Windows XP operating system which has been configured
according to the instrument's features and needs. To ensure that the instrument software
functions properly, certain rules must be adhered to concerning the operating system.

|
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Risk of causing instrument unusability

The instrument is equipped with the Windows XP operating system. Additional software
can therefore be installed on the instrument. The use and installation of additional soft-
ware may impair instrument function. Thus, run only programs that Rohde & Schwarz
has tested for compatibility with the instrument software.

The drivers and programs used on the instrument under Windows XP have been adapted
to the instrument. Existing instrument software must always be modified using only
update software released by Rohde & Schwarz.

The following program packages have been tested:

o R&S Power Viewer - virtual power meter for displaying results of the Power Sensor
R&S NRP-Zxx

e Windows XP Remote Desktop
e Symantec Norton AntiVirus — Virus-protection software

In certain cases, the use of these programs can impair the performance of the instrument.

1.5.1 Virus Protection

Users must take appropriate steps to protect their instruments from infection. Beside the
use of strong firewall settings and regularly scanning any removable storage device used
with a R&S instrument, it is also recommended that anti-virus software be installed on
the instrument. While Rohde & Schwarz does NOT recommend running anti-virus soft-
ware in the background ("on- access" mode) on Windows-based instruments, due to
potentially degrading instrument performance, it does recommend running it during non-
critical hours.

For details and recommendations, see the R&S White Paper "Malware Protection" avail-
able at http://www2.rohde-schwarz.com/en/service_and_support/Downloads/Applica-
tion_Notes/?type=20&downid=5699.

1.5.2 Service Packs and Updates

Microsoft regularly creates security updates and other patches to protect Windows-
based operating systems. These are released through the Microsoft Update website and
associated update server. Instruments using Windows, especially those that connect to
a network, should be updated regularly.

For more details and information on configuring automatic updates see the R&S White
Paper "Malware Protection" (available at http://www2.rohde-schwarz.com/en/ser-
vice_and_support/Downloads/Application_Notes/?type=20&downid=5699).

Changes in the system setup are only required when peripherals like keyboard or a printer
are installed or if the network configuration does not comply with the default settings (see
chapter 1.6.1, "Connecting the Instrument to the Network", on page 39). After the R&S
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SMU is started, the operating system boots and the instrument firmware is started auto-
matically.

1.5.3 Login

Windows XP requires that users identify themselves by entering a user name and pass-
word in a login window. The instrument provides a factory-installed auto login function,
i.e. login is carried out automatically in the background. The ID used for autologin has
administrator rights so that printer and network installations are possible. The user name
and password are set to "instrument”.

1.5.4 Accessing the Start Menu

The Windows XP "Start" menu provides access to the Windows XP functionality and
installed programs. To open the "Start" menu, press the Windows key or the CTRL + ESC
key combination on your keyboard.

All necessary system settings can be made in the "Start > Control Panel" menu (for
required settings refer to the Windows XP manual and to the hardware description).

@ Accessing Operating System
The operating system can only be accessed if an external keyboard and/or a mouse is

connected. Windows XP provides an on-screen keyboard that can be operated using a
mouse, thus enabling operation by mouse only. An external keyboard is recommened for
extensive entries.

Energy saving mode

An energy saving mode is a default setting in the instrument. The hard disk switches to
power-save mode if it is not accessed for 30 minutes. The energy-saving mode is exited
by accessing the hard disk again.

1.6 Setting Up a Network (LAN) Connection

The R&S SMU is equipped with a network interface and can be connected to an Ethernet
LAN (local area network). Provided the appropriate rights have been assigned by the
network administrator and the Window XP firewall configuration is adapted accordingly,
the interface can be used, for example:

e To transfer data between a controller and the tester, e.g. in order to run a remote
control program. See chapter "Remote Control"

e To access or control the measurement from a remote computer using the "Remote
Desktop" application (or a similar tool)

e To connect external network devices (e.g. printers)
e To transfer data from a remote computer and back, e.g. using network folders
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This section describes how to configure the LAN interface. It includes the following topics:

e chapter 1.6.1, "Connecting the Instrument to the Network", on page 39
e chapter 1.6.2, "Assigning the IP Address", on page 40

LXI
@ The R&S SMU complies with LXI Class C. LXI gives you direct access to the LAN settings
described below.

ON\ Accessing Operating System

/ The operating system can only be accessed if an external keyboard and/or a mouse is

connected. Windows XP provides an on-screen keyboard that can be operated using a
mouse, thus enabling operation by mouse only. An external keyboard is recommened for
extensive entries.

1.6.1 Connecting the Instrument to the Network

There are two methods to establish a LAN connection to the instrument:

e A non-dedicated network (Ethernet) connection from the instrument to an existing
network made with an ordinary RJ-45 network cable. The instrument is assigned an
IP address and can coexist with a computer and with other hosts on the same net-
work.

e A dedicated network connection (Point-to-point connection) between the instrument
and a single computer made with a (crossover) RJ-45 network cable. The computer
must be equipped with a network adapter and is directly connected to the instrument.
The use of hubs, switches, or gateways is not required, however, data transfer is still
performed using the TCP/IP protocol. An IP address has to be assigned to the instru-
ment and the computer, see chapter 1.6.2, "Assigning the IP Address",
on page 40.

The R&S SMU uses the IP addresses 192.168.xxx.yyy for this purposes, where xxx
and yyy may take values between 1...254; the subnet mask is always 255.255.255.0.

Risk of network failure

Before connecting the instrument to the network or configuring the network, consult your
network administrator. Errors may affect the entire network.

» To establish a non-dedicated network connection, connect a commercial RJ-45 cable
to one of the LAN ports.
To establish a dedicated connection, connect a (crossover) RJ-45 cable between the
instrument and a single PC.

If the instrument is connected to the LAN, Windows XP automatically detects the network
connection and activates the required drivers.
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The network card can be operated with a 10/100/1000 Mbps Ethernet IEEE 802.3u inter-
face.

1.6.2 Assigning the IP Address

Depending on the network capacities, the TCP/IP address information for the instrument
can be obtained in different ways.

e |f the network supports dynamic TCP/IP configuration using the Dynamic Host Con-
figuration Protocol (DHCP), all address information can be assigned automatically.

e Ifthe network does not support DHCP, or if the instrument is set to use alternate TCP/
IP configuration, the addresses must be set manually.

By default, the instrument is configured to use dynamic TCP/IP configuration and obtain
all address information automatically. This means that it is safe to establish a physical
connection to the LAN without any previous instrument configuration.

Risk of network errors

Connection errors can affect the entire network. If your network does not support DHCP,
or if you choose to disable dynamic TCP/IP configuration, you must assign valid address
information before connecting the instrument to the LAN. Contact your network admin-
istrator to obtain a valid IP address.

Assigning the IP address manually

1. Obtain the IP address and subnet mask for the R&S SMU and the IP address for the
local default gateway from your network administrator. If necessary, also obtain the
name of your DNS domain and the IP addresses of the DNS and WINS servers on
your network. If you use more than one LAN connector, you need separate address
information for each connector.

Press the "Windows" key to access the operating system.
Open the "Control Panel" by selecting "Start > Settings > Control Panel".

Select "Network Connections".

o &~ wDn

Right-click "Local Area Connection" and select "Properties" from the context-sensi-
tive menu, or
click "Local Area Connection" and then "File > Properties".

6. On the "General" tab, click "Internet Protocol (TCP/IP)" and then select "Properties".

7. Select "Use the following IP address" and enter the address information as obtained
from the network administrator.
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8. Ifnecessary, you can also select "Use the following DNS server addresses" and enter
your own DNS addresses.

For more information refer to the Windows XP Help.

1.6.3 Using computer names

Alternatively to the IP address, each PC or instrument connected in a LAN can be
accessed via an unambiguous computer name. Each instrument is delivered with an
assigned computer name, but this name can be changed.

Querying and changing a computer name
1. Press the "Windows" key to access the operating system.

2. Select "Start > My Computer > Properties > Computer Name".

The computer name is displayed under "Full Computer Name".

3. To change the computer name, select "Change", enter the new computer name and
confirm the entry.

1.6.4 Changing the Windows Firewall Settings

A firewall protects an instrument by preventing unauthorized users from gaining access
to it through a network. Rohde & Schwarz highly recommends the use of the firewall on
your instrument. R&S instruments are shipped with the Windows firewall enabled and
preconfigured in such a way that all ports and connections for remote control are enabled.
For more details on firewall configuration see the R&S White Paper "Malware Protection”
(available at http://www2.rohde-schwarz.com/en/service_and_support/Downloads/
Application_Notes/?type=20&downid=5699) and the Windows XP help system.

Note that changing firewall settings requires administrator rights.

N\ To transfer waveform files generated on an external PC using R&S WinlQSIM2, you have
/ to disable the firewall.

Risk of Unauthorized Access

Disabling the firewall or allowing exceptions may make your instrument more vulnerable
to viruses and intruders.

It is recommended that you restore the default firewall configuration after completing a
task which requires modified settings.
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1.6.5 Working with Directories

Access to network drives depends on access rights and whether the drives in question
have been enabled. The complete integration of the R&S Signal Generator into a larger
network with the necessary allocation of rights is highly complex and normally performed
by a network administrator.

However, the hard disk of a computer also connected to the network can be accessed
from the instrument relatively easily. The only precondition is that the directory on the
remote computer that the instrument should access is enabled for remote access. Sub-
sequently, this directory is accessed from the instrument using a Windows XP search
function. This procedure is also of importance for a point-to-point connection, for instance
in order to start a firmware update for which the files have been stored on the hard disk
of the remote computer.

N\ The computer and the instrument must both be provided with a computer name and an
IP address (see chapter 1.6.2, "Assigning the IP Address", on page 40).

Enabling directories on the remote computer

\ The menu name may deviate from the name specified in the operating sequence,
/ depending on the language and on the operating system used on the computer.

1. On the remote computer, in Windows Explorer, click the directory to be enabled.
2. From the context menu, select "Properties".

3. Select the "Sharing" tab and enable "Share this folder".

Accessing the enabled directory

1. On the instrument, select "Start > Search > For Files and Folders > Printers, Com-
puters > A Computer in the Network".

2. Enter the computer name and press ENTER to start the search.
The computer and its name appears in the results list.

3. Click the computer's name to display the enabled directory.

Note: If a user name and password are requested when you click the computer, the
login name and password used on the computer must be entered.

The files in this directory can be accessed by the instrument.

1.7 Remote Access via an External Controller

The R&S SMU can be remote accessed from a remote computer (external controller) via
a network link. This allows convenient operation of the instrument from the desktop
although the instrument is integrated in a rack somewhere else.
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For an overview of the instrument's operating concept and the different ways to control
and operate the instrument, see chapter 2.1, "Brief Introduction to the Instrument's Con-
cept", on page 61.

There are different ways to establish a remote access connection to the signal generator
but all of them require an established LAN connection between the instrument and the
remote computer. The simplest way to remote access the instrument is to use a Web
browser, such as Windows Internet Explorer or Mozilla Firefox for instance. Alternatively
a remote access via a special application can be used. Two free-of-charge programs are
available for setting up the remote access connection: the Windows application Remote
Desktop for PCs with Window operating system and the program Ultr@VNC for PCs with
Linux/Unix or Windows operating system. Using of each of this two applications requires
additional istallation.

See table 1-1 for an overview of the different ways to establish a remote access con-
nection to the signal generator.

Table 1-1: Remote access via an external computer

Remote access via Installation of the additional appli-
LAN cation
connce-
tion on the instru- on the remote
ment computer
Web Browser required no no

e.g. Windows Internet Explorer or Mozilla Firefox

see chapter 1.7.1, "Using a Web Browser for Remote
Access", on page 44

Remote Desktop required no required

Windows application for PCs with Window operating sys-
tem

see chapter 1.7.2, "Remote Desktop Connection”,
on page 45

Ultr@VNC required required VNC Viewer

for PCs with Linux/Unix or Windows operating system required

see chapter 1.7.3, "Remote Access via UItr@VNC",
on page 47

When the connection is set up with Remote Desktop, the device firmware of the signal
generator is disabled. Direct control on the instrument is not possible while manual
remote-control is active. The access of an external PC is indicated by the logon screen
of Windows XP Embedded which identifies the accessing user.

When the connection is set up with Ultr@VNC, direct control on the instrument is possible
while remote access is established.

For return to direct operation on the instrument, the connection must be cut. After cutting
the connection, it is still enabled and can be established again any time. The connection
is disabled only after deactivation of the program.

This section gives an information on how to use the Web browser for remote access, how
to install the applications for remote access and how to establish the connection between
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the instrument and an external computer with Windows operating system. Remote
access via an external computer with Linux/Unix operating system is performed accord-

ingly.

Accessing Operating System

The operating system can only be accessed if an external keyboard and/or a mouse is

connected. Windows XP provides an on-screen keyboard that can be operated using a
mouse, thus enabling operation by mouse only. An external keyboard is recommened for
extensive entries.

Default password
Remote-access and file access require the user "instrument" with default password
"instrument".

1.7.1 Using a Web Browser for Remote Access

The instrument can be remote-accessed via any Web browser, like Windows Internet
Explorer or Mozilla Firefox for instance.

To remote access the instrument via Web browser:

1. Connect the instrument and the remote computer to a LAN, see chapter 1.6.1, "Con-
necting the Instrument to the Network", on page 39.

2. Instal the Java Runtime Environment JRE on the remote computer.

3. Type the instruments' IP address in the address field of the Web browser on your PC,
e.g. http://10.111.11.1

The "VNC Authentication" screen appears.

{= TightVNC applet - Windows Internet Explorer

o = v @] httpeff1011110.1f "
File Edt ‘“iew Favortes Tools Help

W A | @ TightVNC applet

 cpvons | 15e0 | e |

VNC Authentication

Password: 0K

4. Enter the password and select "OK".

|
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The default password is "instrument”.

After the connection is established, the current signal generator screen with the block
diagram is displayed and the instrument can be remote-accessed from the remote
computer.

1.7.2 Remote Desktop Connection

Remote Desktop is a Windows application which can be used to access and control the
instrument from a remote computer through a LAN connection. While the instrument is
in operation, the instrument screen contents are displayed on the remote computer, and
Remote Desktop provides access to all of the applications, files, and network resources
of the instrument. Thus, remote operation of the instrument is possible.

Risk of Unauthorized Access

If the Windows Remote Desktop application is enabled on the instrument (go to "Start >
Settings > Control Panel > System"), any user in the network who knows the computer
name and login data can access it. To prevent this, make sure that the Remote Desktop
application on the instrument is disabled.

To set up a Remote Desktop connection
1. Enable remote desktop control on the instrument.

2. Connect the instrument and the remote computer to a LAN, see chapter 1.6.1, "Con-
necting the Instrument to the Network", on page 39.

3. Setup the Remote Desktop connection between the remote computer and the instru-
ment.

\ Remote Desktop Client

’ With Windows XP, Remote Desktop Client is part of the operating system and can be
accessed via "Start > Programs > Accessories > [Communications >] Remote Desktop
Connection.".

For other versions of Windows, Microsoft offers the Remote Desktop Client as an add-
on.

Enabling remote desktop control on the instrument

1. Press the "Windows" key to access the operating system.

2. Open the Control Panel by selecting "Start > Settings > Control Panel".
3. Select "System" and switch to the "Remote" tab.
4

Under "Remote Desktop", activate the "Allow users to connect remotely to this com-
puter" option.

|
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Note: Remote Desktop access and firewall settings.
When you enable or disable the Windows Remote Desktop option (in the "System
Properties"), the associated firewall settings are adapted automatically.

5. If necessary, click "Select Remote Users" and select users who are to be given
access to the R&S SMU via Remote Desktop. The user account under which con-
figuration is carried out is automatically enabled for Remote Desktop.

Setting up the Remote Desktop connection on the remote computer

1. Onthe remote computer, select "Start > Programs > Accessories > [Communications
>] Remote Desktop Connection."

2. Enter the instrument's name or IP address in the dialog box (see also chapter 1.6.2,
"Assigning the IP Address", on page 40).

3. Enter the user ID and password for the instrument (see also chapter 1.5, "Windows
Operating System", on page 36).

4. Click "Connect".

When the connection has been set up, the instrument's screen appears on the remote
computer.

\ Disabled Direct Control

/ While remote access is active, the direct control of the instrument is disabled.

Remote access is indicated on the instrument by the logon screen of the operating sys-
tem. The logon screen identifies the accessing user.

For simultaneous remote access of several instruments from the same PC, a separate
Remote Desktop session must be opened for each instrument.

For detailed information about Remote Desktop and the connection refer to the Windows
XP Help.

Helpful settings for Remote Desktop

The following settings for the Remote Desktop connection can make working on the
remote PC more convenient.

1. When setting up the connection to the instrument, you can configure the connection
settings in the "Remote Desktop Connection" dialog box.
Click the "Options >>" button.

The dialog box is expanded to display the configuration data.

2. Customize the settings:

e On the "Experience" tab:
— Select the appropriate connection to optimize the connection speed.
— To improve the performance, you can deactivate options you do not require
under "Allow the following".
e On the "Local Resources" tab:

|
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— If you need to access drives of the remote PC from the instrument (e.g. in
order to store settings or to copy files from the PC to the instrument), activate
the "Disk drives" option. Windows XP will then map drives of the remote PC
to the corresponding network drives. When a connection is established, a
warning is displayed on the PC indicating that the drives are enabled for
access from the instrument.

— To use printers connected to the remote PC while accessing them from the
instrument, activate the "Printers" options. Do not change the remaining set-
tings.

e On the "Display" tab:

— Under "Remote desktop size", set the size of the R&S SMU window on the
desktop of the remote PC.

— Activate the "Display the connection bar when in full screen mode" option.
A bar showing the network address of the instrument is displayed on the
screen which you can use to reduce, minimize or close the window.

e On the "General” tab:
You can save the connection settings for later use using the "Save As" button.

Terminating Remote Desktop Control

A Remote Desktop connection can be terminated either on the R&S SMU or on the
remote PC. The connection can be established again any time as long as remote control
is enabled on the instrument. Consider the notice above concerning unauthorized access
due to Remote Desktop!

1. To terminate the connection on the instrument, click "Disconnect" in the remote-con-
trol message menu of the R&S SMU.

2. To terminate the connection on the remote PC, close the "Remote Desktop" window,
or select "Start > Disconnect".

Disabling Remote Desktop Control

To disable the remote access, deactivate the Remote Desktop on the instrument.

» Under "Remote Desktop", disable the "Allow users to connect remotely to this com-
puter" option and confirm with "OK".

The connection is disabled, it is no longer possible to access the instrument via
Remote Desktop.

Remote Access via Ultr@VNC

Ultr@VNC is an application which can be used to access and control the instrument from
a remote computer through a LAN connection. The program is included in operating sys-
tem Linux/Unix. It is available as a free-of-charge download on the internet for operating
system Window XP (http://www.uvnc.com/download/index.html) and on the instrument's
CD-ROM.

|
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Risk of Unauthorized Access

If the VNC application is enabled on the instrument, any user in the network who knows
the computer name and login data can access it. To prevent this, make sure that the VNC
server service on the instrument is disabled.

Setting up a VNC connection

1.

Connect the instrument and the remote computer to a LAN, see chapter 1.6.1, "Con-
necting the Instrument to the Network", on page 39.

Install the Ultr@VNC application and enable it on the instrument.

In the ICF firewall, enable communication on the network via Ultr@VNC program.
See "Configuring Internet Connection Firewall for VNC Connection" on page 50.

Install the VNC Viewer on the remote computer with Windows operating system, see
"Installing the VNC Viewer on a Windows PC" on page 51.

Set up the VNC connection between the instrument and:

a) the remote computer with Linux/Unix operating system, see "Setting up the VNC
connection on the Linux/Unix remote computer" on page 52;

b) the remote computer with Windows operating system, see "Setting up the VNC
connection on the Windows remote computer" on page 52.

Enabled Direct Control
The direct control of the instrument is not disabled and the instrument can be controled
from the front panel and via the remote computer alternately.

Installing the Ultr@VNC application

1.

Download the program from the internet and copy it to a directory that can be
accessed.

On the instrument, shut down firmware using the ALT+F4 key combination.

Double click on the setup file to start the installation.
The setup wizard leads through the installation. This description focus only on the
relevant settings.
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Select Components
‘which components should be installed?

Select the components you want bo instal: clear the components
install. Click Mexst when you are ready to continue.

[Fullinstalation

wou do not want to

[¥]

UltraWhC Server
UltraWMC Yigwer

1.8 ME
1.0 MB

[l traVNE Hepeater

]

Current zelection requires at least 2 7 MB of disk space

[ <Back

Mext »

] [ Cancel ]

b) In the "Additional Task Panel", enable all entries.

Select Additional Tasks
‘which additional tasks should be pesfoimed?

Release 1.0.0 RC 18, then chck Next

Server configuration:
Hen
Start or restart Ur@WNC service
Additional icons:

Create a Ulr@WM L Wiewer deskiop icon
Create a Ulr@VNC Server deskiop icon
Create a UlrE?MC Bepeater deskiop icon
File Associations:

[+] Associate vne fles with UREYNC Views:

Select the additional task s you would ke Setup to perform while instaling LriE/NE

[ <Beck

Mest > ] [

Cangel ]

A successful installation is indicated by a

WInVHC x|

The service may be starked from the Control Panel, and wil

|
i
\j]) The WinYNC service was successfully registered :
automatically be run the next time this machine is reset '

|

|

|

I

message.

At the same time a warning is displayed stating that a password must be set.

WinVHC Error

%]

. Properties dislog now to allow one ko be entered.

WARNING : This machine has no defaul password sef. WinWHC wil present the Default

Select "OK".

The "Default Local System Properties” panel opens.
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WinVHC: Default Local System Properties =0
Incoming Connections Connection Settings
¥ Accept Socket Connections I” Force Yiew Only [disable Viewers Inputs)

Password: I 1 I” Disable Local Inputs (Keyboard & Mouse)

Display Number or Ports to use & Auto Flicnoceskioppalizapcy
" Display N" |0
" Ports  Main: [5300

Update Handling

I Pall Full Screen  Fast] r \l?vu'lll::“ns%lel
- indows Unly

| I Poll Foreground Window—| _ 50 "F oY

[~ Poll Window Under Cursor ~ Received Only

MS Logon

¥ Enable Java Viewer [Http Connection)

¥ Enable Xdmcp (X11 Connection) ' System HookDII

¥ Yideo Hook Driver

~When Last Client Di I Low Accuracy [ Turbo Speed ]
@ DELTE DSM Plugin
" Lock Workstation [W2K] I~ Use JNn Plugin detected... j Config

£ Logoff Workstation

-Share only the ¥Window Named :

Misc.

¥ Enable Blank Monitor on Viewer Request I"| Share |

v Enable File Transfer Query on i

I Log debug infos to the Win¥NC.log file ’7 I~ Display Query Window Timenul:’:l— 5

I~ Allow Loopback Connections
Default Server Screen 14 I‘l_ 0K Apply | Cancel |

5. Enter a password with a length of at least five digits.
This password is used on the remote computer to access the instrument. Other set-
tings may be changed according to the user-specific security requirements.

After the installation the Ultr@VNC program is automatically started together with the
operating system. On mouse over, the IP address of the instrument is indicated.
This IP address and the user-defined password are the prerequisites to enable
remote access on the remote computer. Terminated connection is indicated by
changed icon color.

Configuring Internet Connection Firewall for VNC Connection

To enable remote access of an instrument in a local network via VNC connection, the
connection must be specifically permitted in the firewall.

1. Press the "Windows" key to access the operating system and select "Start > Settings
> Control Panel > Windows Firewall" to open the "Windows Firewall".

2. Select "Exceptions > Add Program... > Run Ultr@VNC SERVER" and confirm with
"OK"_

|
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-

-
Add a Program @

To allaw communications with a program by adding it to the Exceptions list,
select the program, or click Browese to search for one that is not listed.
Programs:
% Calculator
Iﬁ 15 logon test utiity
& Motepad
On-Screen Keyboard
Paint
5™ Fiun U@V NE Repeater
SFun Lilti=iE SERVER

& Fun UI@VNC VIEWER
M Upgrade

&? ‘windaws Explorer

[ wordPad

Browse. ..

3. Inthe "Exceptions" tab, enable "Run Ultr@VNC SERVER".

@ Windows Firewall '

| General | Exceptions | Advanced|

‘windows Firewall is turned off, Y'our computer is at rigk of attacks and intrusions
from outside sowces such as the Intemet. We recommend that you click the
General tab and select On,

Programs and Services:

Name

Component of Software Platform: ComponentE nvironmentServer

[ File and Printer Sharing

[ Message Queuing

[ Remote Assistance

O Rtemote Desklop

2)Run Uli@VNE SERVER |
O UPRP Framework

[ AddProgiam.. | [ 4ddPor. J[ Edt. || Deee

Display a notification when Windows Fiewall blocks a program

‘what are the risks of allawing exceptions?

Installing the VNC Viewer on a Windows PC

1. Download the Ultr@VNC program form internet and follow the installation instruc-
tions.
Only the program component VNC Viewer is required.
Note: The VNC Viewer program is included in the download for the installation of the
Ultr@VNC program on the signal generator if "Full installation" was selected in the
"Select Component" panel. In this case, the program ultr@vncviewer.exe can
be copied to the Windows PC.

2. Install VNC Viewer program component on the remote computer.
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Setting up the VNC connection on the Linux/Unix remote computer

The VNC program is available per default for Linux/Unix operating systems.

1.

Start a Web browser on the remote computer and enter the IP address of the instru-
ment.

Enter the following address:
vnc://<IP-address of the instrument>, e.g. vnc.//192.168.1.1.

A dialog is opend and the pssword for the remote VNC connection is requested.

Enter the password as defined in the "Default Local System Properties" panel of the
Ultr@VNC program and select "Log On".

The connection is established, the instrument is remote accessed and the current
signal generator screen with the block diagram is displayed. The individual functions
are operated using the mouse and keyboard.

In contrast to remote access via Remote Desktop, the direct control of the instrument
is not disabled and the instrument can be controled from the front panel and via the
remote computer alternately.

Setting up the VNC connection on the Windows remote computer

1.

Start VNC Viewer program component on the PC, select "VNC Server" and enter IP
address of the instrument.

Connection

M Server [192716811
wr

[ host:display or host:port )

x|
r Quick Dptions:
= ALTO [Auto selec! best sattings) Connect |

£ LLTRA [>2#bits] - Experimental

" LAN [» 1Mbit/] - Max Colors
 MEDIUM  [> 128Kbit/s] - Max Colors

£ MODEM  (19- 128Kbit/s) - 256 Colors

£ S [« 13kKbit/s] - 256 Colars, Fuzzy

Cancel

[ Wiew Only ™ Auto Scaling Options... |
71 Use DSMPhgin INU Flugin detected. .. v| Config
I~ Prosp/Repester |

2. To initialize the connection, select "Connect".

A message requesting the password appears.

¥NC Authentication

Log On I Cancel |

Enter the password as defined in the "Default Local System Properties" panel of the
Ultr@VNC program and select "Log On".

The connection is established, the instrument is remote accessed and the current
signal generator screen with the block diagram is displayed. The individual functions
are operated using the mouse and keyboard.

|
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Enabled Direct Control
The direct control of the instrument is not disabled and the instrument can be controled
from the front panel and via the remote computer alternately.

Terminating VNC Connection

The remote access via VNC connection can be terminated either on the R&S SMU or on
the external PC. Terminating the connection does not disable it. It can be established
again any time. See the notice above concerning unauthorized access due to VNC con-
nection!

1. Terminate the connection on the R&S SMU

a) Press the "Windows" key to access the operating system.
b) Right-click on the VNC icon on the task bar and select "Kill all clients".

2. Toterminate the connection on the external Linux/Unix PC, close the internet browser
or close the signal generator window.

3. To terminate the connection on the external Windows PC, close the VNC Viewer
program.

The connection is terminated. The color of the VNC icon in the status bar of the
instrument changes.
A message on the external PC indicates the disconnection.

Disabling Remote Access via Ultr@VNC

The VNC connection can be disabled by removing the program on the instrument or by
deactivating the VNC Server service.

1. Remove the VNC program

a) Press the "Windows" key to access the operating system and open the "Add or
Remove Programs" by selecting "Start > Settings > Control Panel > Add or
Remove Programs".

b) Remove the VNC program.

2. Deactivate the VNC Server service

a) Press the "Windows" key to access the operating system and open the "Ser-
vices" by selecting "Start > Settings > Control Panel > Services".
b) Deactivate the VNC Server service.

The connection is disabled, the VNC icon disappears from the task bar of the instru-
ment.

1.8 Using Virus-Protection Software

Virus-protection software Symantec Antivirus 10.1.7.7000 has been successfully tested
for compatibility with the instrument software on R&S Signal Generator.
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However, Symantec Antivirus may affect the behaviour of the instrument in terms of set-
tling time or stability. Symantec Antivirus 10.1.7.7000 has been subjected to detailed tests
with R&S Signal Generator and a page file of 1024 MB. The system remains very reliable.
However, rare impact on the settling time has been experienced ( slight degradations of
settling time in 2% of samples out of specification).

Preparing the Installation of Symantec Antivirus

The installation is performed in the Windows XP operating system.

\ Accessing Operating System

/ The operating system can only be accessed if an external keyboard and/or a mouse is

connected. Windows XP provides an on-screen keyboard that can be operated using a
mouse, thus enabling operation by mouse only. An external keyboard is recommened for
extensive entries.

1. Press the "Windows" key to access the operating system and open the "System"
dialog by selecting "Start > Settings > Control Panel > System".

2. Inthe "System" dialog, select the "Advanced > Performance > Settings > Change".

3. Enable "Drive D: [DATA]" and "System managed size", confirm with "Set" and close

the dialog.
Virtual Memory Q%]
Drive [Wolume Label] Paging File Size {ME)
C: [FIRMWARE]
Di [DATA]
E:  [USBSTICK]
Paging file size For selected drive
Dirive: D: [DaTa]
Space available: 11557 MB
) Custom size:

Initial size (MB):

Maxirurn size (MB):

() Mo paging File Set
Total paging file size for all drives

Minimum allowed: 2MB

Recommendad: 381 M8

Currently allocated: 0MB

-

The Symantec Antivirus program can be installed.

1.9 LXI Configuration

LAN eXtensions for Instrumentation (LXI) is an instrumentation platform for measuring
instruments and test systems that is based on standard Ethernet technology. LXI is
intended to be the LAN-based successor to GPIB, combining the advantages of Ethernet
with the simplicity and familiarity of GPIB.
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Like GPIB, LXI determines and standardizes the way the instrument behaves in a LAN.
The LXI implementation by the R&S Signal Generators allows you to change certain LAN
settings, to reset the LAN connection as well as function for easy instrument identification.

LXI classes and LXI functionality

LXI-compliantinstruments are divided into three classes, A, B and C, with the functionality
of the classes hierarchically based one upon the other:

Class A
L | hardware trigoger bus

Class B
|EEE 1588 synchronization

Class C

. Ethernet LAN interface
. Weh server

+ W11 protocol

. %1 instrument driver

e Class C instruments are characterized by a common LAN implementation, including
an ICMP ping responder for diagnostics. The instruments can be configured via a
web browser; a LAN Configuration Initialize (LCl) mechanism resets the LAN con-
figuration. The LXI class C instruments shall also support automatic detection in a
LAN via the VXI-11 discovery protocol and programming by means of VI drivers.

e Class B adds IEEE 1588 Precision Time Protocol (PTP) and peer-to-peer commu-
nication to the base class. IEEE 1588 allows all instruments on the same network to
automatically synchronize to the most accurate clock available and then provide time
stamps or time-based synchronization signals to all instruments with exceptional
accuracy.

e Class A instruments are additionally equipped with the eight-channel hardware trig-
ger bus (LVDS interface) defined in the LXI standard.

For information about the LXI standard refer to the LXI website at http://www.Ixistan-
dard.org. See also "News from Rohde & Schwarz, article 2006/I1 - 190".

Instruments of classes A and B can generate and receive software triggers via LAN mes-
sages and communicate with each other without involving the controller.

The R&S SMU complies with LXI class C and provides an integrated "LXI Status" dialog
for LXI status indication and reset of the LAN configuration (LAN Configuration Initialize,
LCI). To accesss the LXI Status dialog, press the SETUP key and select "Remote > LXI
Status".

For further information, see section "LXI Status" in the Operating Manual.

|
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Firmware update
After a firmware update, shut-down and re-start the instrument in order to enable the full
LXI functionality.

Default state of the network settings

According to the LXI standard, an LCI must set the following parameters to a default state.

Parameter Value

TCP/IP Mode DHCP + Auto IP Address
Dynamic DNS Enabled

ICMP Ping Enabled

Password for LAN configuration LxiWeblfc

The LCI for the R&S SMU also resets the following parameters:

Parameter Value

Hostname <Instrument-specific host name>
Description Vector Signal Generator
Negotiation Auto Detect

VXI-11 Discovery Enabled

The LAN settings are configured using the instrument's "LXI Browser Interface".

1.9.1 LXI Browser Interface

The instrument's LXI browser interface works correctly with all W3C compliant browsers.
Typing the instrument's host name or IP address in the address field of the browser on
your PC, e.g. http://10.113.10.203, opens the "Instrument Home Page" (welcome page).

6 Do not add the missing zeros in the IP address, while opening the Instrument Home Page.
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LXI

Instrument Home Page

Instrument Properties

Lan Configuration Instrument Model R&S SMU 2004
Status Manufacturer Rohde & Schwarz GmbH & Co. KG
Help Serial Number 999014
e Description g;ﬁj&gﬁ;g;&r?ﬂedm Signal Generator
www.rohde-schwarz.com LXIClass c
LXIVersion 11
Host Naime 10.111.10.920
MAC Address 00:E0:33:62:01:56
TCPAP Address 10.111.10.130

Firmware Revision

Current Time
Current Time source
VISA resource string

Device Indicator

Status

Mo errar

02.05.104 beta (Release) (2008-04-18; 15:04:42),
Compass 2.1.65.0 (Release)

Thureday, 2008/04/24, 14:23:12
Operating System
TCPIPz10.111.10.130inst0INSTR

| THEETIVE (ress

2008 ROHDE&SCHWARZ. All rights reserve

The "Instrument Home Page" displays the device information required by the LXI stand-
ard including the VISA resource string in read-only format.

» Press the "Inactive (press to toggle)" button to indicate the device.

Pressing this button causes a LAN Status indicator on the instrument's home page

to flash (if active).

A green LXI status symbol on the instrument's home page indicates that a LAN con-
nection has been established; a red LED indicates that no LAN cable is connected.
The status of the LAN connection is also indicated by the "LAN Status indicator” in
the "LXI Status" dialogbox.
The "Device Indicator" setting is not password-protected.

For further information, see section "LXI Status" in the Operating Manual.

The navigation pane of the browser interface contains the following control elements:

e "LAN Configuration" opens the LAN Configuration page.

e "LXIGlossary" opens a document with a glossary of terms related to the LXI standard.

e "Status" displays information about the LXI status of the instrument.

1.9.2 LAN Configuration

The "LAN Configuration" web page displays all mandatory LAN parameters and allows
their modification.

|
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LAN Configuration

LXI LAN Parameters
Home
Lan Configuratio Hostname 10.111.10.130
Advanced Config )
Ping Client Domain
Siatue Description Rohde & Schwarz Vector Signal Generator Sh
Help TCPAP Mode DHCF + Auto IP Address |
ey IP Address 10.111.10.130
www.rohde-schwarz.com Subnet Mask 255.255.0.0
Default Gateway 10.111.01
10.0.2.168
DNS Server(s)
10.0.23.159
. NS O Disabled

© Enabled

[E=eseamni ey (Password
required])

Status

No error

© 2008 ROHDE&SCHWARL Al rights reserved

The "TCP/IP Mode" configuration field controls how the IP address for the instrument
gets assigned (see also chapter 1.6.2, "Assigning the IP Address", on page 40). For the
manual configuration mode, the static IP address, subnet mask, and default gateway are
used to configure the LAN. The automatic configuration mode uses DHCP server or
Dynamic Link Local Addressing (Automatic IP) to obtain the instrument IP address.

Changing the LAN configuration is password-protected. The password is LxiWeblfc
(notice upper and lower case characters). This password cannot be changed in the cur-
rent firmware version.

The links at the bottom of the "LAN Configuration" page open other pages:

e "Ping Client" provides the ping utility to verify the connection between the instrument
and other devices.

e "Advanced LAN Configuration" provides LAN settings that are not declared manda-
tory by the LXI standard.

1.9.2.1 Advanced LAN Configuration

The "Advanced LAN Configuration" menu provides LAN settings that are not declared
mandatory by the LXI standard.

|
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LXi

LXI Configuration

Advanced LAN Configuration

LAN Parameters

Home
Lan Configuration Negotiation o Detect v/

o
Ping Client ICMP Ping ) Disabled

Status & Enabled

Help

® Disabled

'VXI-11 Discovery a
) Enabled

Glossary Rese (Password
www.rohde.schwarz.com required)

Status

No errar
© 2008 ROHDE&SCHWARL All rights reserved.

The "Advanced LAN Configuration" parameters are used as follows:

e The "Negotiation" configuration field provides different Ethernet speed and duplex
mode settings. In general, the "Auto Detect" mode is sufficient.

e "ICMP Ping" must be enabled to use the ping utility.

e "VXI-11"is the protocol that is used to detect the instrument in the LAN. According
to the standard, LXI devices must use VXI-11 to provide a detection mechanism;
other additional detection mechanisms are permitted.

Ping

Ping is a utility that verifies the connection between the LXI-compliant instrument and
another device. The ping command uses the 1CMP echo request and echo reply packets
to determine whether the LAN connection is functional. Ping is useful for diagnosing IP
network or router failures. The ping utility is not password-protected.

To initiate a ping between the LXI-compliant instrument and a second connected device:

1.

Enable "ICMP Ping" on the "Advanced LAN Configuration" page (enabled after an
LCI).

Enter the IP address of the second device without the ping command and without
any further parameters into the "Destination Address" field (e.g. 70.713.10.203).

Click "Submit".

|
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¥ Lan Configuration
Advanced Config
Ping Client
Status

Help

Glossary
www.rohde-schwarz.com

Ping Client

Ping Parameter

Destination
Address

Pinging 10.111.10.130 with 32 bytes of data:

Reply from 10.111.10.130: bytes=3Z time<lms
TTLF128
Reply from 10.111.10.130: bytes=32 time<lms
TTL=128
Reply from 10.111,10.130: bytes=3Z time<lms
TTL=128
Reply from 10.111.10.130: bytes=32 time<lue
TI=128

LXI Configuration
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2 Getting Started

This section helps you to get familiar with the R&S SMU and provides an introduction to
the general concept of the instrument with a sample of the possible application fields as
well as a description of the main blocks in the signal generation flow.

This section also explains the operating concept in general and includes a brief intro-
duction to operation by a step-by-step description of the configuration. The example is
intended to provide a quick overview of the settings provided. No additional equipment
is required.

2.1 Brief Introduction to the Instrument's Concept

The R&S SMU combines up to two independent signal generators in one cabinet and
offers unrivaled RF and baseband characteristics. Due to its modular design, the instru-
ment can be optimally adapted to the requirements of different applications. Both RF
paths can be equipped with one of the available frequency options with different upper
frequency limit. Up to two generators can also be installed in the baseband section. They
generate complex signals in realtime and are equipped with an arbitrary waveform gen-
erator.

The R&S SMU provides an entirely digital baseband section for generating 1/Q signals
and an RF section with 1/Q modulator. The instrument uses 1/Q (vector) modulation. Dig-
ital data streams are converted to an I/Q baseband signal. The baseband signal is then
D/A-converted and modulated onto the target RF carrier frequency with the aid of an 1/Q
modulator.

N\ The R&S SMU may contain two paths; through the user docmentation, the first being is
/) called path A and the second path B, respectively.

For a detailed description of the blocks in the baseband and RF sections, refer to chap-
ter 2.3, "Baseband Section", on page 67 and chapter 2.4, "RF Section", on page 71
respectively.

The operating concept of the R&S SMU employs the following three ways of instrument
control:

e Manual operation

e Remote control

e Remote access

Manual Operation

The R&S SMU can be entirely operated from the front panel. Peripherals such as mouse
or keyboard can be connected but are not essential.

The R&S SMU is equipped with an intuitive user interface. The central element of the
display is the block diagram that shows the signal flow and processing from the left on
the display to most right, i.e. the generated signal can be seen at a glance.
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Each block represents a functional unit of the instrument. Thus the user always knows
the position at which a parameter has an effect in the signal flow. The main settings of a
block are indicated in the block. The interconnection of employed inputs and outputs is
also shown. The user is thus always informed about the connection of inputs and outputs
in the signal flow and where they can be configured. A window is opened for each menu
where parameters can be set. When the window is opened, an entry is made in the
"Winbar" below the display. All open menus are of equal priority (not modal) and can be
accessed any time.

The block diagram in the figure below shows a fully equipped instrument.

Freq A 1.000 000 00O 00 |GHz | |wr orr PER A [-30,00 dBm LevA|-30.00 [dem -
Freq B 1.000 000 000 00 |6z ~| |mr orr PepB|-30.00 dBm Levd|-30.00 |abm -|
I A: ALC-Auto | B: ALC-Aulo Info
i}
out
(€2
Baseband A Fading A WGN/IMP A 1/Q Mod A RF/A Mod A
| RF A
config... I config... I = config... I config... | config... I L e
[~ On " On I” On I~ On " On
DigMod Std Del IMP
BB Input Graphics BERT
config... I config... __| config... I
" on I~ on " on
Graph A+B BERT
Baseband B Fading B WGN/IMP B 1/Q Mod B [RF/A Mod B
config... | | config... I — config... I config... | | | config... I _/_89
" On " On I” On I~ On " On
DigMod Std Del IMP

BERT

| | | | | | | |

Fig. 2-1: Block diagram of a fully equipped two-path R&S Signal Generator

With the aid of the rotary knob, the user can navigate in the block diagram and the dialogs,
and can operate the instrument with one hand. The cursor is moved line by line through
the block diagram or dialog. Turning the button clockwise advances the cursor. The
selected block can be activated or deactivated with the TOGGLE key. Active blocks are
highlighted by a colored background.

The instrument comprises a comprehensive info and help system. Context-sensitive help
can be called any time with the HELP (F1) key. The help system indicates the currently
selected parameter and offers additional services such as cross references, index and
contents. The content of the help system corresponds to the operating manual of the
instrument.

Warning and conflict messages caused by incorrect operation as well as further infor-
mation are displayed in the "Info" line. A complete list of existing conflicts is displayed
when the INFO (CTRL+I) key is pressed. Additional information on entries can be reques-
ted from the help system. The history function permits display of all messages.

Assistants simplify the completion of tables. After data entry in the assistant, the table is
modified only after the "Accept" button has been pressed. Pressing the "Accept" button
also stores the assistant data.

|
Operating Manual 1007.9845.32 — 16 62



R&S®SMU200A

Getting Started

2.2

2.21

Applications of the Instrument

For an introduction into the manual operating of the instrument, detailed operating
instructions and an overview of menus refer to chapter 3, "Manual Operation”,
on page 81.

For an indepth description of the dialog boxes and the instrument functions refer to sec-
tionchapter 4.1, "Overview of Instrument Functions", on page 121.

Remote Control

Remote control is an operation of the instrument by means of remote control commands
or programs that automatize repeating settings. The instrument is connected to a com-
puter running the program.

This way of operation and the instructions how to set up a connection for remote control
are described in the chapter 5, "Remote Control Basics", on page 455. The description
of the remote control commands is provided in chapter 6, "Remote Control Com-
mands", on page 495.

Remote Access

Remote access is the operating of the instrument from a remote computer. Both the R&S
SMU and the computer are connected in a LAN.

Remote access in contrast to remote control does not use remote-control commands
but a separate software which is installed on the remote computer. After its start, the
software simulates the user interface of the instrument. The instrument can thus be oper-
ated from the remote computer as on the unititself. The individual functions are operated
using the mouse and keyboard. Specific instrument functions can be executed using
specific key combinations on the keyboard or a front panel key emulation that can be
operated with the mouse.

This way of operation and the instructions how to set up a connection for remote access
are described in chapter 1.7, "Remote Access via an External Controller", on page 42.

Applications of the Instrument

The modular design of the R&S SMU allows the instrument to be equipped with two paths.
This allows a multitude of applications to be performed for which several signal genera-
tors were previously required. A few examples are given below.

Generation of digitally modulated signal

The main field of application of the R&S SMU is the generation of digitally modulated
signals. In the instrument, a digitally modulated signal can be generated in several ways.

Internally generated 1/Q signal

The 1/Q signal is generated internally in the R&S SMU. One or two baseband generators
can be installed. The signals produced by the two generators can be added (possibly with
frequency offset).

|
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In this case the instrument must be equipped with
e at least one baseband generator (option R&S SMU-B10) and
e atleast one baseband main module (option R&S SMU-B13).

Fading scenarios can be created with the aid of a fading module (option R&S SMU-B14,
Fading Simulator).

1.000 000 000 00 |ov: -| per 96,50 som Lev -30.00 |aom ~|
| ALG-Auto Info

Freq

Marker L]

2: Ratio
3: Ratio
4 Ratio ‘@9

AWGNIIMP

conti--. £onng-..

[~ On

Graphics |

config...

I~ on

Fig. 2-2: Operation of I/Q modulator with 1/Q signals from the internal baseband section

Externally generated 1/Q signal

The 1/Q signal is generated by an external instrument and coupled in via the baseband
input module (option R&S SMU-B17, Baseband Input). The baseband input module is
capable of processing analog I/Q signals. If options are installed for internal baseband
generation, external and internal baseband signals can be added (possibly with fre-
quency offset). In this operating mode, the fading module can also process external 1/Q
signals.
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fen | 1.000 000 000 00 [eve <]fore per| 30,00 wom 230,00 oo -]

| ALC-Auto Info

| Baseband

config... |

[ On
DigMod

[ RF/AMod |

rd v I~ On

rd

" Graphics |

config... |

config...

[~ On
Graph A

Fig. 2-3: Operation of I/Q modulator with external I/Q signals applied to the baseband section

Analog Wideband 1/Q operation

An external analog I/Q signal is directly applied to the I/Q modulator of the R&S SMU. In
this mode, the entire bandwidth of the 1/Q modulator can be utilized. The various capa-
bilities of the baseband section (AWGN, addition of signals, etc) are disabled, however.

eea 1,000 000 000 00 |ev | pee 3000 som Lev -30.00 |aom |
| ALC-Auto Info

2 Ratio
3 Ratio
4: Ratio

[ AWGNIMP

sonfia.-.

[~ On

:

i Graphics

config...

[~ on

Fig. 2-4: Operation of I/Q modulator with external analog I/Q signals directly applied to the I/Q modulator

2.2.2 Two Baseband Generators, One RF Path

Examples of the possible applications of an instrument equipped with two baseband
generators and one RF path are:

e Addition of real time signals of different standards, e.g. GSM/EDGE and 3GPP FDD
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e Generation of multicarrier signals with real time components
e Simulation of antenna diversity

rea 1,000 000 000 00 [ov -|forr per| 30,00 sm 1o 30,00 [som -|
| ALC-Auto Info
air
e
Baseband A IMP 1fa Mod RFiA Mod
config... config... config... config... RF
[ — 9_)
[~ on ar=AEF> [~ on I~ on [~ Oon
DigMod
Baseband B Graphics
config... config...
I~ on I~ on

Fig. 2-5: Operation of R&S Signal Generator with two baseband generators and one RF path

2.2.3 One Baseband Path and Two RF Paths

An examples of the possible applications of an instrument equipped with one baseband
path and two RF paths is:

e Generation of a modulated signal on path A and a CW interferer on path B.

FreqA | 1.000 000 000 00 |GHz - pspa|_3o_uu dBm mn|-;m_|||| |(IBm j
FreqB | 1.000 000 000 00 |GHz ~ PEPB [-30.00 ¢Bm LevB|-30.00 [dBm -
I A ALC-Auto | B: ALC-Auto Info

Marker
1 OniOft Ratio
(5> 2 onioff Ratio
3 OniOff Ratio
4 OniOft Ratio

IMpP

config... |

" on

Fig. 2-6: Operation of R&S Signal Generator with one baseband generator and two RF paths
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2.2.4 Fully Equipped Two-Path Instrument

Examples of the possible applications of a fully equipped two-path instrument are:
e Generation of a wanted signal and an interfering signal for receiver tests

e Generation of multicarrier signals with extremely wide bandwidth (>80 MHz)

e Generation of fading scenarios with external 1/Q signal

Freq Al 1.000 000 000 00 |6z ~| |rr orr PEPA[-30.00 dBm LevA|.30.00 [abm -|
Freq n| 1.000 000 000 00 |GHz j RF OFF PEP B |-3|1 dBm Lev n| -30.00 Ide j
I A ALC-Auto | B: ALC-Auto Info
]
our
=
Baseband A Fading A [AWGN/IMP A 1YQ Mod A RF/A Mod A
config... I config... I_ config... I i config... | config... I_/ Ay
" On 7~ I On " on I~ On " On
DigMod Std Del IMP
BB Input Graphics BERT
config... I config... __| config... I
I~ On [T " On
Graph A+B BERT
Baseband B Fading B AWGN/IMP B 1YQ Mod B RF/A Mod B
config... config... I __+ | config... I config... | | | config... I = P
" On I On " on " On " On
DigMod Std Del IMP

BERT

| | | | | | | |

Fig. 2-7: Fully equipped two-path instrument

2.3 Baseband Section

The baseband section of the R&S Signal Generator is fully digital and contains the hard-
ware for generating and processing I/Q signals.

The baseband section may contain two paths.

For detailed information on available options, refer to the R&S SMU data sheet and the
R&S SMU configuration guide.

Up-to-date information is available at R&S SMU homepage on the internet http://
www2.rohde-schwarz.com/product/smu200a.html.
Baseband generator (option R&S SMU-B10)

The generator produces baseband signals. It contains modules for real time signal gen-
eration and an arbitrary waveform generator (ARB).

The different baseband options feature a different ARB memory size (see data sheet).
But apart from the memory size, all options have the same functionality and are installed
alternatively.
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One or two baseband generators can be fitted in an R&S SMU and operated separately.
Signals from the baseband generators can be routed from path A to B and vice versa,
and added (possibly with frequency offset).

The option Baseband Generator contains real time Custom Digital Modulation and ARB.
Software options providing various digital standards are offered in addition. Option R&S
SMU-K40, for instance, generates signals to GSM/EDGE standard, option R&S SMU-
K42 signals to 3GPP FDD standard.

Baseband input module (option R&S SMU-B17)

With the aid of this module, external 1/Q signals can be applied to the baseband section
of the R&S SMU. The 1/Q signals can be further processed in the baseband section (e.g.
fading, addition of noise). If the R&S SMU is equipped for internal baseband signal gen-
erators, external and internal baseband signals can be added. The output of the base-
band input module can be connected to baseband path A or path B (if available) provided
at least one baseband main module or one fading module is installed. Otherwise the
baseband input module is permanently linked to path A.

The R&S SMU-B17 option can be used together with the R&S® EX-IQ-BOX digital inter-
face module, providing a versatile digital baseband interface with various formats.

Baseband main module (option R&S SMU-B13)

The baseband main module can be installed twice, for each of both paths A and B
respectively.

At the end of the baseband path, the digital signal is converted to an analog 1/Q signal.
The analog 1/Q signal is fed to the I/Q modulator of the RF path. This module also routes
signals to the analog I/Q outputs. The module is absolutely required for coupling out the
baseband signal from the baseband section.

At this stage routing from A to B or vice versa is no longer possible. If a two-path RF
section is available, two baseband main modules are required if the signals from the
baseband section are to be output to the two RF paths.

This module also offers digital I/Q impairment functions. The I/Q signal can be deliberately
corrupted, e.g. for testing the receiver quality.

Additional White Gaussian Noise (option R&S SMU-K62)

Additive white noise, which may be required for instance for measurements on mobile
radio base stations, can be produced with the AWGN software option (R&S SMU-K62).
Fading module (option R&S SMU-B14)

This module enables fading effects to be produced on baseband signals in real time. In
the case of TDMA fading, up to 20 fading paths (40 fading paths with option R&S SMU-
B15) can be created simultaneously.

Provided two RF paths are installed, option R&S SMU-B15 permits also real two-channel
fading irrespective of the RF carrier spacing of the two channels.

|
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Baseband A

config...

[~ On
DigMod

BB Input

config... I

[~ On

Baseband Section

Software option R&S SMU-B71 comprises the 3GPP dynamic fading configurations
moving propagation and birth-death propagation as well as the fine delay fading config-
urations offering enhanced delay resolution.

Digital output module (option R&S SMU-B18)

The R&S SMU can be equipped with a standardized digital I/Q interface (LVDS) for online
transfer of digital I/Q data. The digital output module (option R&S SMU-B18) enables the
digital output of the 1/Q baseband signal.

The R&S SMU-B18 option can be used together with the R&S® EX-IQ-BOX digital inter-
face module, providing a versatile digital baseband interface with various formats.

Description of Individual Diagram Blocks of the Baseband Section

The baseband section of the R&S SMU comprises two paths (paths A and B). Therefore,
if two baseband generators are available, two baseband signals can be processed inde-
pendently of each other. Routing from path A to path B and vice versa is also possible,
but not after the "IMP" or "AWGN/IMP" block.

Each function block can be activated or deactivated with the "ON" check box (on/off tog-
gling).

The ON/OFF TOGGLE key at the front panel (see "TOGGLE" on page 19) switches the
currently selected block on or off.

A detailed description of the blocks is provided below.

Baseband A block
In this block, the (first) baseband source is configured and activated. The block is dis-
played only if a baseband generator is available in the instrument.

Depending on the installed software options, various digital standards, user-configured
digital real time modulation or the built-in waveform generator (ARB) can be selected.
The selected modulation is displayed in the block.

The TOGGLE ON/OFF key switches the selected modulation (digital standard, digital
modulation or ARB) on or off.

External Baseband In block

This block controls the baseband input module for external 1/Q signals. The block is dis-
played only if the baseband input module (option R&S SMU-B17) is installed. External I/
Q signals can be applied to the analog I/Q input. The output of the baseband input module
can be connected to baseband path A or (if available) path B provided at least one base-
band main module or one fading module is installed. Otherwise the baseband input mod-
ule is permanently linked to path A. (The reason is that the baseband input module does
not contain a router chip. For switchover, at least one baseband module with a router
chip is required).

The TOGGLE ON/OFF key switches the input of external modulation signal on or off.

|
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Baseband B Baseband B block

config___ Configures the second baseband source (if installed). The block is displayed only if the
™ on instrument contains two baseband generators. Depending on the installed software

Dighod option, various digital standards, user-configured digital real time modulation or the built-

in waveform generator (ARB) can be selected.

Note: If two baseband generators are installed and two signals of the same standard
(e.g. GSM/EDGE) should be output simultaneously, the two associated software options
must also be installed (in this case R&S SMU-K40).

If only one R&S SMU-K40 is installed and GSM/EDGE is selected in the first baseband
generator, the second baseband generator is disabled for GSM/EDGE.

However, a software option is not tied to a specific baseband generator. In our example,
either the first or the second baseband generator can output a GSM/EDGE signal.

Fading A Fading block
config... | This block controls the fading module. It is displayed only if a fading simulator (option
I~ On R&S SMU-B14) is installed. Signal routing at the output of the fading module is also
Std Del configured in this block.

For instance, two-channel fading can be selected if the instrument contains two RF paths
and two faders (option path extension, R&S SMU-B15).

The TOGGLE ON/OFF key switches the fading simulation on or off.

Note: Under certain signal routing conditions only one fader can be activated

awcNime A AWGN/IMP A block
config. . This block is displayed only if a baseband main module is installed.

L In this block (digital) I/Q impairments for the baseband path can be set. With the aid of

the software for AWGN generation (option R&S SMU-K62), an (additive) noise signal can
be produced.

AWGN and impairments can be activated independently of each other in the appropriate
menus. The settings are displayed in the block. The entire block can be activated or
deactivated. If the block is deactivated, the signal passes through the block unchanged.

In addition, the differential I/Q output is configured in this block (option R&S SMU-B16).

The TOGGLE ON/OFF key switches the active functions of the block on or off. The func-
tions (AWGN, impairments or both) are activated in the respective menus.

aweNime 8] AWGN/IMP B block
config._. This block is displayed only if two baseband main modules (option R&S SMU-B13) are
™ On installed. In this block (digital) I/Q impairments for baseband path B can be set. With the
aid of the software for AWGN generation (option R&S SMU-K62), an (additive) noise
signal can be produced in path B.

If a noise signal should be applied to path A and B simultaneously, two software options
R&S SMU-K62 are required.

Graphics Graphics block
config... With this block, the baseband signal (of path A or B) can be graphically displayed in real
I~ On time. The block is displayed only if at least one baseband main module is installed.

The TOGGLE ON/OFF key opens or closes the graphics window.

|
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BERT BERT block
config... | In this block an integrated bit and block error rate tester can be set. The bit error tester
" on makes it possible to evaluate a signal demodulated and decoded by a DUT by measuring
the bit error rate. The data used to drive the DUT can be generated by the R&S SMU or

an user-defined external source. In addition, the block error rate measurement can be
used to verify CRC checksums.

The TOGGLE ON/OFF key switches the active function(s) of the block on or off. The
functions (BERT and BLER) are activated in the respective menus.

2.4 RF Section

The RF section of the R&S SMU may also contain two paths.

An RF path is configured by installing a frequency option that comprises all required
modules.

N\ One of the following options must be installed.

Frequency options (Path A)

e R&S SMU-B102 (up to 2.2 GHz)
e R&S SMU-B103 (up to 3 GHz)

e R&S SMU-B104 (up to 4 GHz)
e R&S SMU-B106 (up to 6 GHz)

Frequency options (Path B)
e R&S SMU-B202 (up to 2 GHz)
e R&S SMU-B203 (up to 3 GHz)

N\ RF path B can be I/Q-modulated only if the baseband section is equipped with two Base-
/ band Main Modules R&S SMU-B13.

In addition, each RF path can be equipped with
e high-power option for higher output levels (R&S SMU-B31/B36)

For detailed information on available options, refer to the R&S SMU data sheet and the
R&S SMU Configuration guide.

Up-to-date information is available at R&S SMU homepage on the internet http://
www2.rohde-schwarz.com/product/smu200a.html).
2.41 Description of Individual Diagram Blocks of the RF Section

This section gives an overview of the available blocks and a detailed descritption of their
functions.

|
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1/Q Mod A 1/Q Mod A block
config... The (first) I/Q modulator is configured in this block. Also the Analog Wideband 1/Q mode
™ on can be selected here, which allows external 1/Q signals to be directly applied to the I/Q
(D 5 modulator, i.e. not via the baseband section. If no baseband modules are installed, 1/Q

modulation is possible only in the Analog Wideband 1/Q mode.

This block can be used to select whether the signal of path A or path B is applied to the
analog 1/Q outputs.

| and Q components can also be swapped (I/Q Swap). (Analog) I/Q impairments can be
set in addition. Unlike the impairments in the "AWGN/IMP" block, impairments in the "I/
Q Mod" block also affect the externally applied signals in the Analog Wideband I/Q mode.

The status display in the block shows whether 1/Q impairments and/or I/Q swap is active.
I/Q modulation is switched on or off with the TOGGLE ON/OFF key.

Note: An I/Q modulator provided in the R&S SMU is automatically activated when a
connected baseband source is switched on. The I/Q modulator can also be separately
switched on and off (select the "I/Q Mod" block and press the TOGGLE ON/OFF key).
This permits the following configuration to be obtained with a single-path R&S SMU.
The baseband source generates an 1/Q signal that is output via the analog I/Q output. At
the same time, the RF section generates an unmodulated carrier.

1/Q Mod B 1/Q Mod B block
config_. This block controls the 1/Q modulator of RF path B. It is displayed only if a second RF
™ on path and two baseband main modules are installed.

Note: The I/Q modulator B can only be driven by modulation signals from the R&S SMU
baseband section. Operation with external analog I/Q signals is not possible.

RF/A Mod A RF/A Mod A block

config... | L. RSFA In this block, the RF parameters and the analog modulation modes of path A are set.

[~ Oon

AN The active analog modulation modes are displayed in the block. The TOGGLE ON/

OFF key switches the RF signal on and off. When the RF signal is switched off, the switch
before the RF output symbol is open.

RF settings include:

e Frequency and reference frequency

e Attenuator settings.
If required, switching to the high-power mode if a high-power option is installed for
path A.
Frequency and level sweep
List Mode settings. In this mode, extremely fast frequency and level settings can be
made.

Note: Numeric values for frequency and level are entered best and quickest with the aid
of the FREQ and LEVEL keys.

Available analog modulation modes:

e Amplitude modulation

Broadband amplitude modulation

Frequency modulation (option R&S SMU-B20/B22)
Phase modulation (option R&S SMU-B20/B22)
Pulse modulation.

|
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Note: For modulation modes that can be simultaneously used, refer to the R&S SMU

data sheet.
RF/A Mod B RF/A Mod B
config.. | L RSFE' In this block, settings are made for analog modulation and RF parameters of path B. This
™ on block is displayed only if a second RF path is installed.

Available analog modulation modes:
e Amplitude modulation
e Pulse modulation.

2.5 Example of Setup

This section provides an example on how to configure the instrument to generate and
display a simple QPSK-modulated signal.

Configuring and displaying a QPSK-modulated signal

To generate and display a QPSK-modulated signal, proceed as follow:

1. Activate default (preset) state.
Press the PRESET key to set a defined instrument state.

frea 1000 000 000 00 [ore | vee| 30,00 o 1o 30,00 [aom -|
| ALC-Auto Info
i)
aur
=
Baseband AWGNIIMP 17Q Mod RFIA Mod
config... config... config... config... RF
[~ on [~ on [~ on [~ on
DigMod

Graphics

config...

[~ on

2. Select and activate digital modulation

|
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a) Turn the rotary knob and select the "Baseband A" block.

frea 1000 000 000 00 [or= -| per| 30,00 o ted 30,00 [aom -|
| ALC-Auto Info
le)
our
=
Baseband AWGNIIMP 17Q Mod RFIA Mod
config... config... config... config... RF
L, (D
" on [~ on " on [~ on
DigMod

Graphics

config...

[~ on

b) Press the rotary knob to open the menu where the digital modulation can be
selected (different modulation modes are available depending on the options

installed).
s 1.000 000 000 00 [ov <| ¢er 30,00 wom 130,00 |som -]
[ ALC-Auto Infa
=]
our
&2
AWGNIIMP Q Mod RFIA Mod
GSMEDGE...
CDMA standards —] config... config... config...
i F:).:?St—E‘> [~ on [~ Oon [~ on
Custom Digital Mod...
ARB...

Multicarrier CW...

Graphics
config...

[~ on

1 —
74

Operating Manual 1007.9845.32 — 16



R&S®SMU200A Getting Started

Example of Setup

c) Turn the rotary knob and highlight "Custom Digital Mod...".

— TDMA standards —
GSMEDGE...
— CDMA standards —]
3GPP FDD...
misc
i Custom Digital Mod... :
ARB...
Multicarrier CW...

Press the rotary knob to open the "Custom Dig. Mod." dialog.

1.000 000 000 00 [ow -
|

Freq

_30_00 dBm Lev

-30.00 |aom -|

ALC-Auto Info
& Custom Dig. Mod.
[}
our
Set o Default
SavelRecall User.__ -@)
Data Source 11a Mod RFIA Mod
Data Source PRBS =
config... config...
PRBS Type PRBS 9 -
[~ on [~ on
List Management...
Set acc to standard | GSM ~
Symbol Rate 270.833 333 |ksym/s ¥
Coding GSM =
. Graphics
Modulation Type MSK v
ifig.._
o o config
Filter ™ on
Filter |Gauss j
BT | 0.30
! i

oawos | | | | | | | |

d) Turn the rotary knob to select parameter "Symbol Rate", press the rotary knob to
allow editing and enter the preffered symbol rate with the aid of the numeric key-
pad and the unit keys.

& Custom Dig. Mod. A

-
State Off —
Set to Default
Save/Recall User...
————————Data Source————
Data Source | PRBS =
PRBS Type |PRBS 9 =
List Management__
Set acc to standard | User j
|ISymhu| Rate | 1.000 000 000 | Msymis ﬂ'
Coding | GSM |
Modulati
Modulation Type | MSK =
More.__.
Filter
Filter |Gauss j
BT [ 0.30 -
-
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e) Turn the rotary knob to select parameter "Coding".
Press the button to open the selection list.
Turn the rotary knob to select "Off" and press the knob to activate the selected
item.

State Off —

Set to Default
Save/Recall User._..

Data Source
Data Source |PRBS j
PRBS Type |PRBS 8 |
List Management...
Set acc to standard | User ﬂ
Symbol Rate | 1.000 000 000 |Msymis ~|

| Coding | GSM
F } -
) Differential T
Modulation Type Phase Differential
Differential + Gray [
More.... Gray
GSM i
NADC
Filter Galppe
PHS
EFU TETRA |3

f) Use the rotary knob in the same way to set "Modulation Type" QPSK and "Fil-
ter" Root Cosine with "Roll Off Factor" 0.3.

& Custom Dig. Mod. A

State Off —
Set to Default
Save/Recall User...
Data Source
Data Source |PRBS ﬂ
PRBS Type |PRBS 8 |
List Management...
Set acc to standard | User |
Symbol Rate | 270833333 [ksymis ~|
Coding | GSM |
Modulati
Modulation Type | apPsk |
More. .
Filter
Filter | Root Cosine =
Roll Off Factor | o0.30] -
-

|
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g) Finally, select "State" and press the rotary knob to switch on the digital modula-
tion.

E# Custom Dig. Mod. A

[aw o |
Set to Default
Save/Recall User._..
——— Data Source
Data Source |PRBS j
PRBS Type |PRBS 8 |
List Management...
Set acc to standard | User ﬂ
Symbol Rate | 270.833 333 [ksymis ~|
Coding | GSM |
Modulati
Modulation Type | aPsk |
More...
Filter
Filter | Root Cosine =
Roll Off Factor | 0.30 -
-

h) Press the DIAGRAM key to display the complete block diagram.

roa1.000 000 000 00 o -/ wrre vee| 30,00 o e 30,00 [aom -|
| ALC-Auto Info
ES-: g
4Ral:2 69 , , . .

conng. conng RF

[~ On [~ On

Graphics

config...

[~ on

oues | | | | | | |

To indicate the active state, the "Baseband" block is displayed in blue.
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i) The entry in the Winbar indicates that the "Custom Dig. Mod." menu is still open
in the background.
To display the menu in the foreground, press the softkey below the button in the

"Windbar".
Gsz Per| -28.00 ¢em rev(-30.00 |ﬂBm j

ALC-Auto Info

Freq

1.000 000 000 00
|

& Custom Dig. Mod.

[State

our
Set o Default
SavelRecall User.__ -@)

Data SBource

Data Source PRBS =
PRBS Type PRBS 9 =
List Management...

Set acc to standard | User 2

Symbol Rate 1.000 000 000 |Msymis ~

RFJA Mod

config...

[~ on

Coding OFF 2

. Graphics
Modulation Type QPSK v

ifig.._
o o config
Filier ™ on

Filter |Ruul Cosine j
Roll Off Factor | 0.30

i =

oues | | | | | | |

Press the HIDE key to minimize the menu again.

The "1/Q Mod" block is automatically activated.
The "RF/A Mod" is not yet active, which means that no RF signal is output.

3. Set frequency and level and activate RF signal

a) Press the FREQ key to activate the editing mode for frequency entry. The "Fre-
quency" entry field in the header section of the display is highlighted.

Fed 2,000 000 000 00 |+ J

Enter the frequency using the numeric keypad and terminate the entry by press-
ing a unit key.
b) Press the LEVEL key and enter the level settings in the same way.

o] -5.00 [n ]

c) Press the DIAGRAM key to display the complete block diagram.
d) Turn the rotary knob to select the "RF/A Mod" block.
Press the TOGGLE ON/OFF key to activate the "RF/A Mod" block.

The QPSK modulation signal is now present at the RF output.
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|Freq

2.000 000 000 00 |0+ - | el -4.00 dom Loy -5.00 |eom -|

| ALC-Auto Info

Marker licy
1: Ratia our

2; Ratio
3: Ratie
4: Ratis @)

0 1 AWGNI/IMP
e

config...

[~ on

:

i Graphics

config...

[~ Oon

wawes | | | | | | |

4. Select graphics display of 1/Q signal

a) Turn the rotary knob to select the "Graphics" block and open the respective menu.

& Graphics Settings BEIE
I Path A
State Off
Gr -
Smart Graphics [~ On
i Mode 1Q =~
s
Sample Rate Mode | Auto -
Sample rate 0100

b) Select "State On" with the rotary knob to activate display of the 1/Q diagram.

=i Az il al)

Inphase i(t)

AR

=1
150 200 250 300 350 400 450 500 550 600

Quadrat. q(t)

1
150 200 250 300 350 400 450 500 550 600
t/ Tsymbol

Run Zoom oul ‘ Show ref ] antuwl‘

Operating Manual 1007.9845.32 — 16 79






R&S®SMU200A Manual Operation

Key Features

3 Manual Operation

The R&S SMU can be operated intuitively either via the interactive block diagram or via
a menu tree. All menus are in the form of windows that can be operated in the same way.
Rotary knob, keys and softkeys, or alternatively a mouse, allow direct and therefore con-
venient access to entries and settings.

The clear-cut display shows the current signal generator state. Graphs, spectra, vector
diagrams, etc. can be called for a visual check of the output signal. Numerous help func-
tions support the user in signal configuration.

This section describes the concept of manual operation of the signal generator. This
includes a description of the general structure of a dialog box, working with dialog boxes
and the block diagram and the setting of parameters.

For an in-depth description of the dialog boxes and the instrument functions refer to sec-
tion "Instrument Functions".

3.1 Key Features

The manual operating concept of the R&S SMU enables the user to make settings as
intuitively as possible and at the same time gives a permanent overview of characteristics
of the generated signal and of the current instrument state. Numerous online help func-
tions support user settings.

Block diagram
The block diagram is the core of the operating concept.

A graphics display shows the current configuration and the signal flow in the form of a
block diagram. All graphical elements can be accessed for operation. An element is
selected by means of the arrow keys and the associated setting function is called by
pressing Enter. Required menus and graphs are displayed on the block diagram which
is displayed again in the foreground whenever the DIAGRAM (CTRL+D) key is pressed.

Permanent frequency and level display

The main characteristics of the RF signal, frequency and level, are permanently displayed
in the header section of the screen and can be directly set in the display fields after the
FREQ (CTRL+F) or LEVEL (CTRL+L) key is pressed. Status messages for the output
signal are displayed in addition to frequency and level.

Freq AI 1.000 000 DOD 00 |esz PEPAI 30.00 dBm LevA|—3I]_I]I] IdBm v[

Operation via Graphical User Interface

¢ Functional blocks
Menus are assigned to the specific function blocks in the block diagram. The function
blocks represent elements of signal generation. Function blocks displayed with a blue
frame can be directly switched on and off by means of the TOGGLE ON/OFF (CTRL
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Key Features

+T) key. The menus of the highlighted function blocks can be called by pressing the
ENTER key.
— Example:
The "Baseband" block contains all menus required for baseband signal configu-
ration.
Baseband A

config...

[~ On
DigMod

In this block all digital standards and the digital modulation can be selected.

[— TDMA standards —
GSMEDGE...
— CDMA standards —]
3GPP FDD...
misc
i Custom Digital Mod... :
ARB...
Multicarrier CW...

e Signal flow
The signal flow between the function blocks and the employed inputs and outputs are
also shown.

harker

use
config...

o
e Menu tree
The menu tree can be opened and closed with the MENU (CTRL+M) key. The menu

tree is organized in the same way as the directories under Windows. The function
blocks correspond to the first directory level, the menus to subdirectories.

1: =lat timing
2 slat timing

- TDMA standards -
GSMEDGE...
- CDMA standards -
- 3GPP FDD...

Operation corresponds to the Windows concept

To offer the user a familiar environment, operation is very similar to operation of Windows
user interfaces. All menus and tables are made up of known elements, such as selection
lists, check boxes and entry fields.

A blue frame indicates that the selected item is active. In the highlighted element, entries
can be made.

Rotary knob

|
Operating Manual 1007.9845.32 — 16 82



R&S®SMU200A Manual Operation

Key Features

y o . Operation is possible via front-panel keys, an external keyboard and the mouse. How-
ever, most of the settings can be easily made with the rotary knob:

e Turning the rotary knob shifts the entry focus to the target element.

e Pressing the rotary knob activates the selected entry field.
Depending on the parameter, the submenu is called, the numeric value varied, the
list entry selected or the check box activated or deactivated.

e If avalue is entered, the entry is stored by another click on the rotary knob and the
editing mode is exited.

Clear settings with the aid of independent subdialogs

A separate window is opened for each dialog and subdialog. The dialogs can be operated
independently of each other, i.e. none of the dialogs requires that settings in other dialogs
be completed before it can be closed. This ensures flexible operation at all times.

State

Mode Auto v

Start Level -30.00 |dBm ~
Stop Level -10.00 | dBm ~

. Symbol Rate
Custom Digital Mod...

ARB...

Multicarrier CW...
--- Frequency Offset -
0Hz
--- Path Gain ---

Ignore 174 sym {slot lengtl

Set To Default

G5

Mode

Modulation

Save/Recall Frame... | Filter

Winbar
The Winbar gives an overview of menus and simplifies their access.

The menus are displayed on top of the block diagram but they can be "hidden" with the
aid of the HIDE (CTRL+H) key, i.e. displayed in the form of a button in the "Winbar" at
the lower end of the screen.

They can be displayed again in full size by a keystroke (REARR (CTRL+A) key). This
makes room on the screen for other displays that may be required but the setting menus
can be still accessed any time.

GSM;'E,DEE & ;.evel Sweep k‘ ‘ ‘ ‘ ‘

Menu ‘ GSM/EDGE A ‘ M

Keys with assigned simple functions
Most keys on the front panel of the R&S SMU directly perform a simple function.

Since a great number of settings can thus be made by a keystroke, operation is easy.
For instance, the CLOSE (ESC) key closes the active menu; with the RF ON/OFF (CTRL
+R) key the RF output signal can be switched on or off.

An exception are keys that call a menu such as the MENU (CTRL+M) key which opens
the complete menu tree of the instrument, the SETUP (CTRL+E) key which opens the
menus for general instrument settings or the FILE (CTRL+S) key which opens the menu
for file management.

|
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Key Features

Help functions for user support
Numerous help functions support the user in signal configuration.

e Value ranges
The valid setting range is displayed for each numeric parameter. This requires a short
wait after activation of the entry field. The range is then displayed automatically after
a few seconds.

Roll Off Factor .30
More._ Min = 0.05
Max= 099
Power Ramp Conir replace mode )Cosine [ 1.00 sym

If the entered value is outside the permissible range, the next permissible value is
automatically set and a message is output.

e Context-sensitive help
Context-sensitive help for each parameter can be called with the HELP or F1 key.

Operating the R&S Vector Signal Generator > Instrument Function > Baseband Signal -
Baseband Block > Digital Modulation - Custom Digital Modulation > Custom Digital Mod User
Interface = General Settings > State - Digital Modulation

State - Digital Modulation

Enables/disables digital modulation.
Switching on digital modulation turns off all the other digital standards.
In case of two-path instruments, this affects the same path.

The digital modulation is generated in realtime (no precalculated signal), and therefore all
parameter changes (in the ON state) directly affect the output signal.

SCPI command:

e Comprehensive online help
Each help page is part of a comprehensive online help function which can be called
by means of an index, a content tree or the "Previous/Next" buttons.

Info line with messages for indication of the current instrument state

A great variety of different messages such as status messages, error messages, warn-
ings or information are displayed in the header field of the screen. With the aid of the
INFO (CTRL+I) key, help pages can be called for most of the messages. They provide
background information on the message and indicate operating steps that may be
required. All messages are explained in the online help which can be called with the
HELP (F1) key.

Frea 8 | 1.000 000 000 00 |oHz -| |rForF PEPB -30.00 ¢Bm LevB -30.00 dom ~

| A ListMode, UCorr, ALC-Auto | B: ALC-Auio Info

Graphical display of data structure

The structure of the baseband signal is graphically displayed in the respective menus;
the individual signal elements can be graphically selected for processing.
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Frame: Select Slot to Configure

Graphics editor for definition of control signals

Control signals are also graphically configured.

B Slot Marker GSM A (Frame 1 : Slot 0) =13

Tail Data s TSC S Data Tail
3 57 1 26 1 57 3
il I [ [
onfigure Control Signal. Select Ramp to edit
| = I|

| 1 1 1 1 1 1 1

—Total List Length—j 0 50 100 Position / Bit
Length 157

Marker 1 Cursor Zoom Save—
Preset Type All down 1 || posit |_ Data Zoom In Save

ti 59
osition 57
Preset Edit Table... i isi

_presat_| PostioninData 56 || Bits Visible 150

Graphical display of output signal in a diagram

The output signal can be graphically displayed in a number of diagrams. This allows a
fast check of signal characteristics. Zoom functions and the insertion of a reference trace
permit in-depth evaluation without an external analyzer being required.

A Ai(H, all /

Inphase ift)

0 200 40y 60y 80y 1000

Gluadrat. q(t)

a 200 40y 60p a00 100y

3.2 Display

The display shows the current signal generator state and offers graphical elements for
direct operation. It is divided into three sections:

e The frequency and level display with info line indicates the main output signal param-
eters and reports the current state with status, error and warning messages.
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Display

e The block diagram shows the instrument configuration, the signal characteristic as
well as the inputs and outputs used and permits interactive operation via graphics
elements. Active menus and graphs are displayed on top of the block diagram.

e Winbar with labelled softkeys for menu display.

The block diagram in the figure below shows a fully equipped instrument.

Froa o] 1.000 000 000 00 |GHz | |wr ore Pep A[-30.00 @B LevA|-30.00 [abm -]
Freq B 1.000 000 000 00 |GHz ~| | orF PEP B [-30.00 dBm LevB)|-30.00 [dBm -
I A ALC-Auto | B: ALC-Aulo Info
[le]
our
(€2
Baseband A Fading A WGN/IMP A 1/Q Mod A [RF/A Mod A
| RE A
config... I config... I config... I config... I config... I -
== = J— >
" On ] I On " on [~ On " On
DigMod Std Del IMP
BB Input Graphics BERT
config... I config... __| config... I
I~ On " On " On
Graph A+B BERT
Baseband B Fading B AWGN/IMP B 1/Q Mod B RF/A Mod B
config... config... I — config... I config... | | | config... I _/_8)
I~ On "I T On " on I~ On " On
DigMod Std Del IMP

BERT

| | | | | | | |

Fig. 3-1: Block diagram of a fully equipped two-path R&S Signal Generator

Settings Displayed in the Header Section

Frequency/level settings and a few status messages (see chapter 3.2.2, "Status Infor-
mation and Messages", on page 87) are displayed in the header field of the screen.
The display may vary depending on the instrument's operating mode:

e In the case of two-path instruments, the RF information for the two paths is displayed
in two lines.

e In the sweep mode, the current frequency or level of the output signal is displayed.
The status message "SweepMode" is displayed in the info line.

e In the list mode, neither the current frequency nor level is displayed, the indication is
dimmed.

e If user correction is active, the status message "UCorr" is displayed in the info line.

e In the case of digital modulation, "Freq" indicates the frequency, "PEP" the peak
envelope power and "Level" the average level.

O The value displayed in the "Freq" and "Level" filed does not consider any offset set.

/ For more information see chapter 4.5.2, "RF Frequency Settings", on page 192 and

chapter 4.5.7.1, "Overview RF Level Settings", on page 212.
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3.2.2 Status Information and Messages

The status information and messages are displayed in the header section of the screen.
The messages differ with respect to their importance (errors, warnings, info) and the time
of their appearance (brief and permanent messages). They require different treatment
by the user. Further information on all messages can be called in the info window (see
chapter 3.2.3, "Info Window", on page 88).

Refer to chapter 8, "Error Messages", on page 849 for an overview of all status infor-
mation and messages as well as instructions for error elimination.

3.2.2.1 Status Information

The status information gives the user an overview of the main operating states and set-
tings of the instrument. The states are indicated for information only and do not neces-
sitate any action by the user.

Status information is displayed between the frequency and level fields, at the left of the
info line or in the info line itself.

On two-path instruments, all states that can occur independently in the two paths are
displayed separately for each path. The associated path is indicated in the info line.

Freq A | 1.000 001 000 00 |GH2 j orREQ SEVEL IpEp A 20,00 dBm LevaA|-29.00 dpm -
REF

Fread | 1.000 000 000 00 |oHz -| |RF oFF PEPB | -30.00 dBm LevB)-30.00 |dom -
| A AI:C—Auto | B: ALC-Auto Info

3.2.2.2 Messages

Messages indicate errors in the instrument. They are displayed in the info line in different
colors depending on their importance and display duration. Errors (e.g. no calibration

data) are displayed in red, information (e.g. file not found) and warnings in black. Warn-
ings indicate less significant errors (e.g. the instrument operates outside specified data).

3.2.2.3 Volatile messages

Brief messages report automatic settings in the instrument (e.g. switching off of incom-
patible types of modulation) or on illegal entries that are not accepted by the instrument
(e.g. range violations). They are displayed in the info line on a yellow background. They
are displayed on top of status information or permanent messages.

Volatile messages do not normally demand user actions and disappear automatically
after a brief period of time. They are stored in the history, however.

These messages can be read from remote using SYST:ERR? or SYST:ERR:ALL?.

|
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3.2.3

Display

Permanent Messages

Permanent messages are displayed if an error occurs that impairs further instrument
operation, e.g. a hardware fault. The error signalled by a permanent message must be
eliminated before correct instrument operation can be ensured.

The message is displayed until the error is eliminated. It covers the status display in the
info line. After error elimination, the message automatically disappears and is also recor-
ded in the history.

These messages can be read from remote using SYST:SERR?.

Info Window

A few operating states and the current message are displayed in the info line.

The INFO window with a list of current permanent messages and a detailed description
of each message can be opened with the INFO (CTRL+I) key.

| A: UCor, ALC-Auto | B: ALC-Auto Cinfo 1 |nfo line

| :n:vlsm [ Tex = List of current
messages with

Err
Emr short message

* Infa 0 SawRel Manager Infa: aperation camplate -Recall completed text.

- No pending errors.

Detailed
description for
highlighted
message

Show
o | (ot | oo =

The upper section of the info window contains a list of all current permanent messages
in the order of their occurrence, i.e. the most recent message is displayed first. In the
lower section of the window, additional information on the highlighted message is dis-
played. A history of all messages that have occurred since instrument switch-on can be
called with the "History" key. The most recent message is displayed first.

The messages are color-coded according to their level. Device-specific messages are
red, info and remote control error are black. The level is also indicated in the "Lev" column
(Err, Sys or Info). Column "SCPI" indicates the SCPI error code.

With the aid of the softkey buttons, error messages can be cleared and a history of all
messages called.

Delete
Clears the highlighted message.

This button is available only if the history of the messages is displayed.

Delete All
Clears all messages.

This button is available only if the history of the messages is displayed.

Del. volatile
Clears all volatile messages.

|
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This button is available only if the history of the messages is displayed.

SCPI command:

SYSTem:ERRor:ALL on page 810

Each time a SYST:ERR:ALL? query is sent, the error queue is returned and at the same
time cleared.

History

Calls the list of all messages that have occurred since instrument switch-on. The most
recent messages are displayed at the top of the list. When the button is pressed again,
the list of current messages is displayed.

SCPI command:

SYSTem:ERRor [ :NEXT] on page 811 or STATus : QUEue [ : NEXT] on page 806

Each time a SYST:ERR? or STAT : QUE ? query is sent, the oldest entry in the error queue
is returned and at the same time cleared in the list.

Block Diagram

The block diagram shows provided options, signal configuration and the currently
selected signal flow of the generator with inputs and outputs used. Signal generation can
be completely operated from the block diagram. The highlighted function block can be
directly switched on and off with the TOGGLE ON/OFF (CTRL+T) key. Pressing the Enter
opens the associated setting menu.

Clock Marker 1: Pulse

2: Pattern =B
3. On/Off Ratio (= out
4. On/Off Ratio
AWGHN/IMP A|
config... config... config... REA
fon > . | ot | %
TRIGGER 1 I on v/
& NP
Graphics
config...
I~ on
Graph A+B
Baseband B AWGN/IMP B| 1/Q Mod B RF/A Mod B
config... | .| config... | config... | config... | RFB
" on v I~ on I~ on ™ on
MSK Imp

Function Blocks in the Block Diagram

Each block represents a function of signal generation. The function is indicated in the
headline of the block. In the check box, the respective function can be quickly activated/
deactivated with the TOGGLE ON/OFF (CTRL+T) key. After activation, the block is dis-
played in blue. Status information is displayed below the check box. It is different for the
different blocks.

Pressing the rotary knob (front panel) or the "Config..." button (mouse) opens the asso-
ciated setting menu.

|
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In all function blocks where the signal flow can be influenced, the top menu level for setting
signal routing parameters is offered.

Example: Baseband block

— TDMA standards —
GSMEDGE...

— CDMA standards —
JIGPP FDD...
misc

Custom Digital Mod... |
ARB...

Multicarrier CW...

In this block, the digital modulation signal, the digital standards, arbitrary waveform gen-
eration and multicarrier CW are set. The status information of the "Baseband" block indi-
cates the selected modulation and associated additional information, e.g. the number of
channels.

Signal Flow and Input/Output Symbols in the Block Diagram

The input/output symbols in the block diagram show the currently used inputs and outputs
of the signal generator. Unused inputs and outputs are not shown. The lines indicate the
signal flow.

Symbols and labels refer to the corresponding inputs and outputs on the front and rear
panel of the signal generator. The direction - input or output - is indicated by an arrow.
Example:

ARA The symbols indicate the inputs for the analog | and Q signal.
12 I

In case of configurable user inputs/outputs, the name and the current assignment are
indicated: Marker signals 1 to 3 of the two paths are assigned to fixed output User 1
interface, configured as output for the clock signal of path B.

If several markers are active, the marker characteristics are listed next to the marker
symbol of the active markers.

Symbols and lines are displayed in different colors depending on their function.

|
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AWGN/IMP A

config...
[~ On

==

e The baseband signal is indicated by a three line arrow, the I- and Q-components of
the signal by a single-line arrow.

e Addition of signals is indicated by the summation sign.
e Connections are indicated by a "solder point".

e Black is used for the generated signal.

e Green is used for control signals.

The signal flow is configured in the individual menus. User interfaces are configured in:
e the "Setup > USER Marker /AUX 1/O Settings" dialog and
e the "Setup > Global Trigger/Clock/External Inputs" dialog.

3.2.5 Winbar and Softkeys

The "Winbar" with eight buttons is displayed below the block diagram. Labelled buttons
represent open menus, the label indicates the menu. If several menus are open, the
button of the currently active menu is displayed in a lighter colour. The buttons also assign
functions to the softkeys of the next lower level for front-panel operation. Up to eight
menus may be open simultaneously. When the ninth menu is opened, the menu that was
opened first is automatically closed.

GSM;TE.DG_E A Level Sweep k‘ ‘ ‘ ‘ ‘

Menu ‘ GSMIEDGE A ‘ W

Some menus, e.g. data and list editor menus, cover the "Winbar" and assign menu-spe-
cific functions to the front-panel softkeys by way of the menu buttons.

Any of the open menus can be activated either with the respective button in the "Win-
bar" or the front-panel softkey. In combination with the keys for menu operation
(CLOSE (ESC), HIDE (CTRL+H) and REARR (CRTL+A)), convenient menu operation
can be ensured.

Working with menus and dialog boxes is described in chapter 3.3, "Accessing Dialogs",
on page 93.

3.2.6 Structure of the Dialogs

The parameters are set in the menus. Menus are accessed either via the function blocks
in the diagram or by means of the MENU (CTRL+M) key. The menus are displayed on
top of the block diagram.

If the menu buttons assign menu-specific functions to the softkeys, the "Winbar" is hidden.

|
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Working with menus and dialog boxes is described in chapter 3.3, "Accessing Dialogs”,
on page 93; the setting of parameters in chapter 3.4, "Setting Parameters”,
on page 94.

The menus are in Windows format. The menus differ in details depending on their function
but they consist of the same main elements. Each menu consists of a menu header and
one or more menu areas with various fields for setting parameters.

The header line contains the name of the menu and the buttons for minimizing and closing
the menu. To operate the buttons, use the mouse or the front keys HIDE (CTRL+H) and
CLOSE (ESC).

Several fields of associated but separately set parameters are organized in menu areas.
A menu area is framed and labelled with the function common to all parameters.

Example: Impairments

Impairments
State [
I Leakage | 0.00 % |
Q Leakage | 0.00 % |
Imbalance | 0.00 % |
Quadrature Offset | 0.00 ||:Ieg ﬂ

Each of the setting fields is assigned a parameter name. The kind of setting varies
depending on the parameter to be set. Some settings can only be made in a specific
configuration. If setting is not permitted with the specific configuration selected, the
respective item is disabled and displayed in gray and the entry or selection field cannot
be accessed.

3.2.7 Graphical Display of Output Signal Characteristics
The graphical display of the output signal enables the user to rapidly check signal char-
acteristics without connecting an analyzer. Zoom functions and the display of a reference
trace allow in-depth evaluation. The diagram is displayed on top of the block diagram. It

can be minimized and called in the same way as a menu.

Example: 1/Q diagram

AR, gt /

Inphase ift)

0 200 40y 60p 80y 100

Guadrat. qft)

[ 200 40y B0y a0y 100p
tisec

Zoom i = Show Copy
Fim out I ime | ref torel
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To access the "Graphics Settings" dialog for selecting the graphics display of the output
signal, select the "Graphics" function block in the diagram or press the MENU (CTRL+M)
key.

Operation of the graphics windows is analogous to menu operation.

The menu and the individual graphical displays are described in chapter 4.3, "Graphical
Display - Graphics", on page 160.

3.3 Accessing Dialogs
The MENU (CTRL+M) key opens the complete menu tree. Selecting a functional block
and pressing the ENTER key opens the menu associated with this block.

An alternatively way to access a dialog is to use the Winbar buttons or front-panel softkeys
or to use the HIDE (CTRI+H), CLOSE (ESC), DIAGRAM (CTRL+D) and REARR (CTRL
+A) keys on the front panel.

For a quick access to the dialogs, use one of the following alternative methods.

Displaying the block diagram or a dialog in the foreground

1. Press the DIAGRAM (CTRL+D) key to move the cursor to the block diagram.

All active menus are minimized and displayed in the form of Winbar buttons.

2. Press the associated softkey (CTRL+F1 .. F8) to display the dialog in the foreground
again.

Accessing the menu tree

» Press the MENU (CTRL+M) key to open the complete menu tree.

Calling the File, Setup or Hardcopy dialogs

» Use the FILE (CTRL+S), SETUP (CTRL+E) or HCOPY (CTRL+Y) keys to open the
respective dialog.

Minimizing an active menu

» Use the HIDE (CTRL+H) key to minimize an active menu.

It is displayed in the form of a Winbar button.

Automatically arranging displayed menus

» Press the REARR (CTRL+A) key to rearrange all open menus so that they overlap
as little as possible.
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Activating the Windbar

» Use the WINBAR (CTRL+W) key to toggle the cursor between a button of the "Win-
bar" and the block diagram.

The button that was active last in the Winbar is highlighted.

Closing an active menu

» Press the CLOSE key to close an active menu.

Tip: If the cursor is at the highest menu level, you can also use the ESC key to close
the active menu.
Accessing the header area

» Press the FREQ (CTRL+F) and LEVEL (CTRL+L) keys to activate the "Frequency"
or "Level" entry fields in the header area.

Keyboard Shortcuts

Keyboard shortcuts (e.g. "Ctrl + D" for the displaying the block diagram in the foreground)
provide direct access to all utility dialogs of the instrument (see chapter 3.8, "Legend of
Front-Panel Controls", on page 116).

3.4

Setting Parameters

The R&S SMU offers several and sometimes alternative possibilities for setting param-
eters. Operation is possible from the front panel, with the aid of a mouse and/or from a
PC keyboard.

The examples whitin this description focus on the operation from the front panel.

O

For more information, refer to:

e chapter 3.8, "Legend of Front-Panel Controls", on page 116 for an overview of key
functions and a cross-reference between the front panel keys and the keyboard
shortcuts

e section "Instrument Functions" for a detailed description of key functions.

Most of the parameters are set in the different menus. The R&S SMU provides alternative
ways for accessing the dialogs. Turn the rotary knob and navigate to the corresponding
block in the block diagram and press the knob to open the dialog or perform a mouse
click on the "Config..." button.

An exception are the "Setup”, "File" and "Hcopy" dialogs. In the "Setup" dialog, general
settings are made which are not directly concerned with signal generation, e.g. setting of
the GPIB-bus address. In the "File" dialog, files and lists are managed; in the "Hcopy"

|
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dialog, printout is configured and hardcopies can be made. These menus can only be
called with the SETUP (CTRL+E), FILE (CTRL+S) and HCOPY (CTRL+Y) keys.

Frequency and level are directly set in the header area of the display using the FREQ
and LEVEL keys.

Specific settings can also be made directly in the block diagram, e.g. activating a function
block by means of the TOGGLE ON/OFF (CTRL+T) key or switching the RF output on
and off with the aid of the RF ON/OFF (CTRL+R) key. Changes affecting the signal flow
are immediately visible in the graphics display.

The R&S SMU uses the Windows XP® operating system. Settings at system level are
only rarely required, e.g. installation of a new printer driver. For convenient operation of
Windows XP®, a keyboard and a mouse are required.

This section provides an information about the parameter handling that comprises of the
following main steps:

e chapter 3.4.1, "Working with the Cursor", on page 95

e chapter 3.4.2, "Selecting a Control Element", on page 96

e chapter 3.4.3, "Switching Parameters On/Off", on page 96

e chapter 3.4.4, "Entering a Value", on page 96

e chapter 3.4.5, "Working with Units ", on page 98

e chapter 3.4.6, "Selecting a Value from a List", on page 99

e chapter 3.4.7, "Terminating Entries with Confirmation", on page 99

e chapter 3.4.8, "Restoring the Previous Value", on page 100

3.4.1 Working with the Cursor

After the instrument is switched on, the cursor is always on the first function block of the
diagram (default setting).

Moving the cursor on the display

» To move the cursor, use one of the following alternative methods:

a) Use the rotary knob or the arrow keys.

b) Use the appropriate softkeys (CTRL+F1..F8) to move the cursor to the "Win-
bar".
If the "Winbar" is covered by a menu, press the WINBAR (CTRL+W) key to display
it in the foreground.

c) Use the ESC key.

Tip: Be aware that the function of the ESC key depends on the current cursor position.
The function of this key depends on the current cursor position.

Calls the next higher selection level.

Closes the open window without accepting new entries; the old value or param-
eter is retained.

In dialog boxes that contain a "Cancel" button it activates that button.

Closes all kinds of dialog boxes, if the edit mode is not active.

Quits the edit mode, if the edit mode is active.
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3.4.3

3.4.4

Setting Parameters

Switches between different entry fields of a menu.
Shifts the entry cursor from the header display to the previously active menu, or
to the previously highlighted block in the block diagram if no menu is active.

e Shifts the cursor from a function block in the diagram to the first item in the
"Winbar". If no menus are open, the current cursor position remains unchanged.

Moving the coursor to the heading area

» Pressthe FREQ (CTRL+F)or LEVEL (CTRL+L) key to move the cursor to the header
area.

Selecting a Control Element
Control elements are always selected in the same way no matter whether a function block

in the diagram, a menu in the menu tree, a parameter in the menu or an entry in a list or
table is concerned.

» To activate an element, put the cursor on it.

ISource |Interna| vil

An active element is highlighted by a blue frame.

Switching Parameters On/Off

A parameter can be activated and deactivated using a button or a check box.

1. Select the parameter.
2. To change the state of a parameter, use the "Enter" function of the different control
media:

e Press the rotary knob
e Press ENTER
e Press the TOGGLE ON OFF (CTRL+T) key.

Colour and label of a button change, the check box is ticked or the tick is removed.

Entering a Value

Numeric and alphanumeric values can be edited in the entry fields. In the editing mode,
cursors of different colour are used. A blue cursor indicates the overwrite mode, a green
cursor the insert mode.

@

Changing between the Insert and Overwrite mode
The insert mode is the default setting.
Use the INSERT key to toggle between the insert and overwrite mode.
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Numeric and alphanumeric values can either be newly entered or the existing value can
be changed. Incorrect entries are cleared with the BACKSPACE key.

Entering a new numerical value

1.
2.

Select the parameter.
Press a numeric key to activate the editing mode.

The previous value is cleared and the new value can be entered.

Editing a value in the insert mode (default setting)

1.

Press the rotary knob (= Enter) to activate the editing mode.

If the cursor is placed at the right of the total value, the insert mode is always active.

Set the cursor to the left of the number to be changed using the LEFT/RIGHT arrow
keys.

The cursor is displayed in green.

Click on a numeric key to insert a new value.

l{symbol Rate | 270.833 33 [ksymis =] {fsymbol Rate | 270.883 33 [Kksymis =]

-
flsymbol Rate | 270.628 333 [ksynus ~]|  [fsymboi Rate | 270.888 33 [ksymis =]

Editing a value in the overwrite mode

1.
2.

Activate the editing mode.

Set the cursor on the numeric digit to be changed using the LEFT/RIGHT arrow keys.

The cursor is displayed in blue and the number to be replaced is highlighted.

Click on a numeric key to overwrite the highlighted value.

{fsymboi Rate | 270.883 33 [ksymis =[] Hsymboi Rate T 270,668 33 | koymis ;!I

Varying a value

1.
2.

Activate the editing mode.

Set the cursor to the left of the number to be changed using the LEFT/RIGHT arrow
keys.

The value at the cursor position is varied.
To vary the selected value, use the UP/DOWN arrow key or turn the rotary knob.

The value is increased or decreased.

Entering a new alphanumerical value

1.
2.

Select the parameter.
Press an alphanumeric key to start the editing mode.

The new value is entered.

|
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Editing an alphanumerical value

An existing value, e.g. a file name, can be changed in the insert mode (see example) or
in the overwrite mode.

1. Select the paramter and activate the editing mode.

2. Set the cursor to the left of the alphanumerical value using the LEFT/RIGHT arrow
keys.

Tip: If hexadecimal values are to be entered, the numeric front-panel keys are auto-
matically changed to hexadecimal values.

3. Click on an alphanumeric key to insert a new alphanumerical value.
File Name: File Name:
MccwList.mecw | MccwList1D.meew |

Terminating the entry of a numeric value

To terminate the entry of a numeric value:
1. Press the rotary knob (= Enter).
2. Press a UNIT key on the front panel.

3. Select a "Unit" in the selection field next to the parameter value.

Working with Units

The unit of a parameter is displayed next to the value. When the parameter is edited, the
unit is selected either from the list or by means of the front-panel keys. When the entry
is completed, the unit can be changed. In this case the value remains unchanged but is
automatically adapted to the new unit.

While operating the instrument by means of a mouse, assign the unit to the selected
parameter before entering its value.

Assigning a unit
To assign a unit to a value, use one of the following alternatives:

1. Press a UNIT key on the front panel.

B
|symbot Rate [ 14| ksymis ||+ .' = |fsymbol Rate | 14.000 000 00 |Msymss =}
w

2. Select a "Unit" in the selection field next to the parameter value.
Press the ENTER key.

The unit displayed in the entry field next to the value is assigned.

|
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Changing a unit

To subsequently change a unit, i.e. after the entry has been terminated and when the
editing mode is not active, use one of the following alternatives:

1. Press a UNIT key on the front panel.
2. Select"Unit" in the selection field next to the parameter value.

The value remains unchanged but the display is automatically adapted to the new
unit, i.e. the value is recalculated to suit the new unit.

1 =]
[Isymbol Rate [ 27083333 [ksymss =] + =[fsymbol Rate [ 0270 833 33 [Msymis -]

The new unit is indicated in the value field of the menu.

Selecting a Value from a List

Selection lists provide a list of predefined values for the selected parameter.

IMude | Framed (Single) j]
|Unframed |

SavefRecall Frame...

- Framed (Double)
Modulation... F BT oF »,

To select a item from a list, proceed as follow:
1. Press ENTER key to open the list.

2. Use one of the following alternatives to navigate through the list:

a) Turn the rotary knob or use the UP/DOWN arrow keys.
The selected item is highlighted.

b) Press TOGGLE ON/OFF key several times until the preferred entry is displayed
in the selection field.

3. To confirm the selection, press the ENTER key.

Terminating Entries with Confirmation

The instrument behaves different by the termination of entries deppending on the param-
eter type and the way this parameter is set.

Confirming settings

» To confirm the settings, press the rotary knob or one of the UNIT keys (see also
chapter 3.4.5, "Working with Units ", on page 98) .

Note: Variations by means of the rotary knob are immediately set.

|
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Confirming multiple values

In some cases, like for instance when configuring the carriers for a multicarrier CW signal
in a carrier table, it is useful first to enter few values and to confirm them together. Such
settings require additional confirmation. Not yet confirmed settings are displayed on a
yellow background as an indication that the currently displayed values do not represent
the target signal.

» To confirm these settings, select the "Accept" button.

Confirming parameters with On/Off state

Most of the instrument functions with enabled and disabled states are calculated and
effective only after this functions have been enabled. However, there are functions like
the frequency variation of the reference oscillator for instance, that are immediately set
after confirmation.

» To confirm a parameter with On/Off state, enable the parameter.

If time-consuming calculations are required, signal generation is automatically switched
off and calculation is interrupted to allow the user to make further settings. Calculation is
restarted with the RECALCULATE key and the modulation is switched on again when
the calculation is completed.

Preventing recalculation

If an instrument function requires several parameter settings, switch the function off to
prevent a recalculation.

Enable the function after the entire configuration of the settings have been compleated.
The signal is recalculated only once.

3.4.8

Restoring the Previous Value
Parameter variations with the rotary knob are immediately set and therefore not reversi-
ble.

Normally, values cannot be restored in the case of mouse control because no explicit
confirmation is required in this case and entries are automatically confirmed when the
entry or selection field is exited.

Restoring values

In the case of front-panel control or operation from the keyboard, previous values can be
restored as long as the new value is not confirmed, i.e. the entry is not completed.

> To restore the values, press the ESC key.

Restoring values that require confirmation

All settings that are not confirmed with the "Accept" button but require this additional
confirmation can be restored.

1. Press the ESC key.

|
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A confirmation query is displayed.

M warning

You changed some parameter{s) which require a new calculation of the signal.
Do you really want to abort your changes without ACCEPT ?

0K Cancel

2. Confirm with "OK" to abort the changes.
Select "Cancel" to return to the dialog. The previous selected settings are displayed.

Restoring values after an extended calculation has been started

Calculation and setting might require different period of time. Many settings are made
without noticeable calculation times; such operations are indicated by a "BUSY" message
displayed in the status field of the header section.

A window with a progress indicates that the instrument performs an extended calculation
that requires longer calculation time. The termination of such a calculation restores the
previous values.

» Press the ABORT button to terminate the calculation.

All previous values are restored.

3.5 Editors

The R&S SMU provides user-friendly editors for defining data lists as well as control and
marker signals. Lists containing frequency and level value pairs are used for the list mode
and the user-defined level correction.

Internally generated data lists can be used for digital modulation and digital standards;
the same applies to internally defined control and marker signals.

The lists are saved to files and may thus have any length. The file name of the lists and
the directory to which the files are saved are user-selectable. The file prefix is different
for each list type and is permanently assigned by the system.

For information about file handling and overview of the automatically assigned file pre-
fixes, refer to chapter 3.7, "File Management”, on page 110.

3.5.1 Working with List Editor

The "User Correction" and "List Mode" dialogs provide a list editor for defining the fre-
quency/level value pairs.

|
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Editing list mode data lists

1.

To access a list editor and open an existing data list for editing, use the cursor keys
to select the associated button "Edit User Correction Data..." or "Edit List Mode
Data..." (if available) in the individual menu.

The selected list is displayed and the cursor marks the first row of the "Frequency/
Hz" column.

& Edit List Mode Data lital

Power |
dBm

0.25

Frequency f
Hz

1 000 000 0D00.00
1 000 000 000.00 0.24
1 000 000 000.00 0.23
1 000 000 0D00.00 0.22
1 000 000 0D00.00 0.21

1 000 000 D0OD.00 0.20

1 000 000 000.01 0.19

1 000 000 000.00 0.18

1 000 000 000.00 017

1 Nnn nnn nnn nn n1ik ﬂ

- v
Goto ‘ l_‘l,z\s:(:) ‘ Save As___ ‘ Save

If no list has been selected, a blank list of only one row is displayed.

Press the LEFT/RIGHT arrow keys to change between the colums.
Use the UP/DOWN arrow keys to mark a row.

Use the numeric keys to enter the value for the value pairs in the "Frequency/Hz" and
"Power/dBm" table columns. A blank row is inserted at the end of the list.

An existing list can be edited in the insert or overwrite mode; use the INSERT key to
toggle between this two modes.

Terminate the entry by pressing a UNIT key.

To select a row, select the "GoTo" button and press the ENTER key.
Use the numeric keys to enter the row index in the entry field and press the
ENTER key to confirm the entry.

The cursor moves to the selected row.

To insert a new row in the table, select the row above which the new row is to be
inserted and select "Insert Row(s)".

A row is inserted above the currently marked row.
If no row has been selected, a row is inserted at the beginning of the list.

Use the "Save"/"Save As..." function to save the edited list under its current name or
under a new name.

Enter the file name in the "File Select" dialog and select the directory (see chap-
ter 3.7.1, "File Select Dialog", on page 111).

Only complete value pairs are taken into consideration; rows containing an entry in
only one column are ignored.

|
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Creating a new list mode data list

A new list can be created under a new name either by generating a blank file in the "File
Select" menu (see section chapter 3.7, "File Management", on page 110) or by changing
an existing list which will then be saved under a new name.

1. To create an empty data list, select "RF > List Mode > List Mode Data... > New
List" or respectively "RF > User Correction > User Cor. Data... > New User Correction
Data" and enter the file name of the new data list.

2. To open the data list for editing, select the associated button "Edit User Correction
Data..." or "Edit List Mode Data..." in the individual menu.
Edit the list and save it under a new name.

3.5.2 Working with Data Editor

The "Data Editor" is used to internally generate binary data lists for digital modulation and
digital standards.

A list of binary values with a maximum length of 2*31 bits can be entered in the "Data
Editor". This value corresponds to a file size of approx. 268 Mbyte. While it is being pro-
cessed, the file is continuously automatically buffered. When the dialog is exited, the file
is automatically saved with the new values, i.e. there is no extra "Save" button. Depending
on the size of the file, saving may take some time.

Editing an existing data list

1. To access a data editor and open an existing data list for editing, use the arrow keys
to select the associated button "Edit Data List... " in the individual menu.

The selected data list is displayed.

B Data list E“E' g'

Offset 144, Len 144, dlist ins
01111 1111 1111 1111 1111 1111 1111 1111 1111 1111
40 1111 1111 1111 1111 1111 1000 0000 0000 OOOO OOOO
80 0001 1111 1111 0101 1111 1111 1111 1111 1000 0000

120 0000 1010 1000 0000 0000 o000 Ji

160

200

240

Start
Select

GoTo | Copy | Paste | HEX |

The cursor marks the start value of the list.

To increase readability, the bits are displayed in groups of four. The current cursor
position, the length of the list and the list file name are displayed above the list. The
offset starts with the value 0 which corresponds to the bit position on the left side of
the first row, i.e. the beginning of the list. On the left edge of the editor, the last three
offset positions are specified at the beginning of the row.

2. Use the numeric keys to enter the values 0 or 1.
An existing list can be edited in the insert or overwrite mode. Use the INSERT key to
toggle between these two modes.
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3. To delete a value, use the arrow keys to mark the bit that follows the value to be
deleted.
Press the INSERT key to activate the insert mode. Values cannot be deleted in the
overwrite mode.
Press the BACKSPACE key.

The value before the marked bit is deleted.

4. To select a bit position, select the "GoTo" button and press the ENTER key.
Enter the bit position in the "GoTo Offset" entry field by means of the numeric keys
and confirm the entry.

The cursor marks the bit at the selected position.

5. To copy and paste any range of bits at any position in the list:

a) Use the the arrow keys to mark the start bit of the selection.

b) Select the "Start Select" button and use the the arrow keys to mark the selection.
c) Click the "Copy" button.

d) Navigate to the insert possition and select "Paste".

The selected and copied bits are pasted after the selected position.

6. To display and edit the values in hexadecimal form, select the "Hex" button.

Each four bits are displayed as a hexadecimal value: To increase readability, the
hexadecimal values in turn are displayed in pairs of two. The hex functions are auto-
matically assigned to the numeric keys at the front panel.

7. To save the data list, press the ESC key.

The list is saved automatically when the dialog is closed.

Creating a new data list

1. To create an empty data list, in the individual menu select "List Management > Select
Data List to Edit... > Create Data List" and enter the file name of the new data list.

2. Toopen the data list for editing, select the associated button "Edit Data List..." in the
individual menu.

3.5.3 Working with Control and Marker List Editor

The control and marker signals for digital modulation and digital standards can be very
conveniently graphically defined in a "Control and Marker List Editor". The available
marker signals — and, with custom digital modulation, the CW, Hop, Burst Gate and Lev
Att control signals — can be defined in this editor.

While it is being processed, the file is continuously automatically buffered. Depending on
the size of the file, saving may take some time.

The various functions of the editor are explained in the individual menus. This section
focuses to the general use of the graphic editor.
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Example:

The following figure shows the "Slot Marker Definition Editor" of the "GSM/EDGE" dialog
as an example.

B Slot Marker GSM A (Frame 1 : Slot 0) =3
Tail Data s TSC s Data Tail
3 57 1 26 1 57 3
nal Select RamE to edit
Marker 1 v I 1 I|
Marker 2 ¥ -
Marker 3 [ -
Marker 4 [~ -
| 1 1 | 1 1 | 1 1 1 |
—Total List Length—— | 0 50 100 Position / Bit
Length 157
Marker 1 Cursor Zoom Save—
Preset Type All down 11| posit Data ZoomIn Save
ti 59
osition 57
Preset Edit Table... i isi
_presat_| PostioninData 56 || Bits Visible 150

The upper area displays the signal for which the marker signals are to be defined. On the
left side, the available signals (marker and control signals) are listed and colour-coded.

Auxiliary functions are offered in the lower editor area, e.g. presetting for the ramps in
the marker signal, cursor positioning by entering the bit position and possible editing by
means of value entries in a table.

The actual graphic definition of the control signals occurs in the center area of the editor.
Each control signal is represented by means of a colored line along the bit axis. A cursor
can be shifted alongside this line and marks the position where a ramp is to be set. The
color of the cursor changes depending on the current function.

Use the ENTER key to switch over between the colors (and therefore functions):

e black: marks the bit position on the marker line

e yellow: sets a ramp

e green: activates the marked ramp for shifting.

Accessing control and marker list

1. To access the control list editor (e.g. "CList Dig Mod") and open an existing list for
editing, use the arrow keys to select "Custom Digital Mod > List Management > Edit
Control List".
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EZ CList Dig Mod|A - c:/clist
Configure Control Si nals—.

Marker 1 I -
Marker 2 r - 3
Marker 3 r -
Marker 4 r - 3
Burst Gate -

Level Attenuation - ;

Select RamE to edit

CW Mod

|

(RTRTTRTEA (RTRRTRINA (XTRRTRIEA (RTRRTRINA (XTRRTRRTA (RRTRTRNTA (RRTRTRRTA (NRTRTRRTA (RRIRTRRTA SONIRRTH
0 100 200 300 400 500 600 700 Position / Symbal

Total List Length————

Length 1000

Marker Cursor Zoom Save——
Preset Type All down ~| || Position |881 Zoom In Save
Preset Edit Table... Visible 150 Save As...

To access the slot marker list editor (e.g. "Slot Marker") and open an existing list for
editing, use the arrow keys to select "GSM/EDGE > Burst Editor > Slot Marker Def-
inition".

Editing an existing control or marker list

1.

Activate control/marker signal line for editing.
Use the arrow keys to mark the editable graphic area and press the ENTER key.
Select the control/marker signal line to be edit and press the ENTER key.

The cursor is active for the selected line.

Define the cursor position.
Select the parameter "Cursor Position", specify the position by means of the numeric
keys and confirm the entry.

The cursor is positioned according to the entry. If the entered value exceeds the
selected length of the definition range, the length is adjusted automatically.

Configure the control and marker signals (see "Handling of Ramps" on page 107).

Define length of control list ("Custom Dig Mod" only).
Select the "Total List Length" entry field and press the ENTER key. Enter the length
by means of the numeric keys and confirm the entry.

The control list length is defined.

Zoom displayed range ("Custom Dig Mod" only) in long control lists.

To zoom the displayed area around the current "Cursor Position", select the param-
eter "Visible/Bits Visible", enter the number of symbols/bits to be displayed by means
of the numeric keys and confirm the entry.

Select the "Zoom In" button and press the ENTER key.

The selected number of symbols/bits around the current cursor position are dis-
played.
Ramps outside the displayed area are not lost by zooming.

Use the "Save"/"Save As..." function to save the edited control/marker list under its
current name or under a new name.
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Enter the file name in the "Create File" dialog and select the directory (see chap-
ter 3.7.1, "File Select Dialog", on page 111).

Handling of Ramps

1.

Set a new ramp
Use the arrow keys or use the parameter "Cursor Position" to move the cursor to the
position where the ramp is to be inserted. Press the ENTER key.

The ramp transition of the newly set ramp depends on the current status (high or low)
of the control signal. If the signal is low, a ramp with low-high transition is generated;
if the signal is high, a ramp with high-low transition is generated.

Sy S— |

When ramps are set between existing ramps, the transition of the new ramp is also
defined by the status of the signal before the new ramp. For this reason, a ramp that
has already been set can be assigned low-low or high-high transition (as in the
example), i.e. it will have no effect on the control signal in this configuration. However,
the ramp remains saved, and its position is indicated by a dashed line.

l — 1| n
1 _—
If another change produces effective transition, this ramp will be regenerated.

o T i |

Shift a ramp

An existing ramp can be shifted to any positions. The transitions are adjusted accord-
ingly.

Use the arrow keys to move the cursor to the ramp position; the cursor changes
colour.

Press the ENTER key. The cursor again changes colour. The ramp will now be shifted
by means of the cursor. Press the ENTER key. The ramp will be set at the current
position.

The ramp transition depends on the status (high or low) of the control/marker signal
before the ramp.

Delete a ramp

Use the arrow keys to move the cursor to the ramp position; the cursor changes
colour.

Press the BACKSPACE key.

The ramp will be deleted. The ramp transitions of the other ramps are adapted to the
changed signal status (high or low).

4. Setthe ramps in a table

|
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Select the "Edit Table..." button and define the positions and states of the ramps for
the selected marker.
Confirm the entries with "Accept".

Preset a marker signal
Select the "Preset" button to preset the marker signal.

The ramps of the selected marker are adjusted according to the selected "Preset
Type".

Creating a new control list

A new control list can be created under a new name either by generating a blank file or
by changing an existing list which will then be saved under a new name.

1.

To create an empty control list, select "BB > Cust Dig Mod > List Management... >
Select Control List to Edit > Create Control List" and enter the file name of the new
control list.

To open the control list for editing, select the associated button "BB > Cust Dig Mod
> List Management... > Select Control List to Edit > Edit Control List..." and select an
existing control list.

3.6 How to Use the Help System

The R&S SMU is equipped with a context-sensitive help function. A help page is available
for each parameter and can be called any time during instrument operation.

Compiled online help systems are also available for all functions of the R&S SMU on the
CD-ROM supplied with the instrument. This help program can be called on any controller
with Internet Explorer version V4.0 and higher.

Calling context-sensitive and general help

» To display the general help dialog box, press the HELP (F1) key.

The help dialog is displayed. A topic containing information about the current menu
or the currently opened dialog box and its function is displayed.

|
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& Help - State - Digital Modulation

m Operating the R&S Vector Signal Generator > | Function > Baseband Signal -
SetToDefi | Baseband Block > Digital Modulation - Custom Digital Modulation > Custom Digital Mod User
0 SaveiRecal | |nterface > General Settings > State - Digital Modulation
i ﬂ Data Sourct
+-0J Standard, §
+Eiﬁ Modulation
+-3 Modulation
Ed G riter Enables/disables digital modulation.
+-03 Power Ram
40 List Managq | Switching on digital modulation turns off all the other digital standards.
+-) Data List E
i ﬂ Control and|
+-03 Power Ram | The digital modulation is generated in realtime (no precalculated signal), and therefore all
+-03 Triggerian | parameter changes (in the ON state) directly affect the output signal.
(5, Arbitrary Wavefort
+ EL External Baseband Sit
E[L Remote Control Basics
+-El Remote Control Commang
+-(3 Maintenance
+ EL Error Messages Top
+ E[L Hardware Interfaces
| Listof Commands

| | »

State - Digital Modulation

In case of two-path instruments, this affects the same path.

SCPI command:

GoTolndex | find | Back | Scroll Left Scroll Right Zoom In Zoom Out

Contents of the help dialog box

The help dialog box contains two main areas:
e "Contents" - contains a table of help contents
e "Topic" - contains a specific help topic

The help system provides additionally an "Index" and a "Find" area, as well as "Zoom"
functions that are accessed by means of the corresponding buttons.

Navigating in the table of contents

1. To move through the displayed contents entries, use the UP/DOWN keys. Entries
that contain further entries are marked with a plus sign.

2. To display a help topic, press the "ENTER" key.
The corresponding help topic is displayed.

Navigating in the help topics

1. To scroll through a page, use the UP/DOWN arrow keys.

2. To jump to the linked topic, press the link text.

3. Use the "Previous" or "Next" links to jump to the corresponding topic.

4. Use the "Scroll Right" or "Scroll Left" buttons to shift the indicated area of the navi-
gation window to the left or right.

Using the Index

1. Select the "Go to Index" button.

2. Enter the first characters of the topic you are interested in. The entries starting with
these characters are displayed.

3. Press the ENTER key to change the focus.
4. Use the UP/DOWN keys to navigate and select the suitable keyword.
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5. Press the ENTER key to display the help topic.
The corresponding help topic is displayed.

Closing the help window

» Press the HELP (F1) key.

3.7 File Management

The R&S SMU uses files to save all instrument data, i.e. system and user data.

The user data includes saved instrument settings, data for the different digital standards,
lists for the List mode and the user correction as well as the waveforms for the arbitrary
waveform generator.

The files are stored on the hard disk of the instrument. Drive D: \ can be used to save
user-defined data; any directory structure can be created on D: \. Some default directo-
ries are predefined, but can be changed at any time. The C: \ drive is a protected system
drive. The files on this drive contain data that must not be changed. Therefore, this drive
should not be accessed, since reconstruction of the system partition will lead to data loss.
To prevent inadvertent deletion or overwriting of system files, this drive is not specified
in the file menus. It can be accessed if a protection level (see section "Protection Level"
in the Operating Manual) is revoked.

Files can be exchanged either via a memory stick or a connected network. A memory
stick is connected to the USB interface and is assigned the E: drive. In the case of a
connected network, all network drives that can be accessed are available. The files are
accessed in a "Save/Recall" dialog in the individual menus.

The files are differentiated according to their extensions; each type of file is assigned a
specific file content. The extension is usually of no consequence to the user since access
to the files occurs in the individual menus where only the relevant type of file is available.
See chapter 3.7.2.1, "Extensions for User Files", on page 114 for an overview of the
supported file extensions.

The user data can be roughly divided into the following data types:

e Settings
Settings, e.g. the frame setting of the GSM/EDGE standard, can be loaded and cur-
rent setting saved to the specified file.

o Lists
Lists, e.g. user correction lists, can be loaded. They can be generated either exter-
nally or internally. For internal generation, a new list must be created in the "File
Select" dialog which will then be edited in the list editor of the individual menu.

e Complex modulation and control data
User data of this type can be loaded. It can be generated either externally or internally.
For internal generation, a new list must be created which will then be edited in the
data and control list editor. These functions are offered in the "Data List Manage-
ment" dialog of the individual modulation menu.

e \Waveforms
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Waveforms are generated externally (e.g. by means of the R&S WinlQSIM2 program
that is supplied together with the optional Baseband Generator R&S SMU-B10) and
can be loaded in the "Arbitrary Waveform Generation" dialog.

@ Softkeys are assigned to some of the functions and can be used for convinient operation.

For more information, refer to:

e chapter 3.8, "Legend of Front-Panel Controls", on page 116 for an overview of key
functions and a cross-reference between the front panel keys and the keyboard
shortcuts

e to section "Instrument Functions" for a detailed description of key functions.

Accessing files with user data

1. Toaccess an editable user datafile, select the "Save/Recall" or "File Manger" function
in the individual dialog.

Recall Settings
Sawve Settings
File Manager...

2. To access a loadable data file, select the "Select/New" or "File Manager" function in
the individual dialog.

Select User Correction Data
New User Correction Data
File Manager...

3. To access the "File Manager" function, press the SETUP (CTRL+E) key and select
"Save/Recall > File Manager".

A "File Select" window for loading, saving or creating a file or the "File Manager"
dialog for managing all files is displayed.

Saving and loading of all instrument settings
All instrument settings are saved and loaded in the "File" menu.
To access the "File" menu, press the FILE (CTRL+S) key.

For more information, see chapter 4.2.8, "Storing and Loading Instrument Data - File
Key", on page 154.

3.7.1 File Select Dialog

The "Save/Recall" dialaog displays the available drives and directories. In the upper part,
"Recent Data Sets", the files last used are listed.

|
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& Save/Recall 1[5 | &= saverRecan =3
Select Operation Save Select Operation Recall ~
d:i_userllists/ARB [Gl_userfists/ARE. |
B+ _user = 5 iist Ll
ow st A L B Qists &
I 2 ists . =ars )
@ ARB | preset_settings
E[L7W|mﬁx ﬁ_wm\ax
-3 ARE = =03 ARB hd||
File Name: Exclude Frequencyl ™ Exclude Level
t_setti
preser semngs II Recall | Recall | Recall | Recall File |
| Save | save save | File | ! 2 SN[
Save
2 Manager...

The available drives and directories and the files of the selected directory are displayed.
The currently selected path is displayed above the window. Only the relevant files without
file extensions are displayed. If the area is opened several times, the path last selected
is displayed. When a file is saved or created, its name is user-selectable; the extension
is assigned automatically and cannot be entered. The file is saved to the selected path.

In addition to the files saved by the user, some menus also offer files containing prede-
fined contents. These files are saved to a specific directory on system drive; for this rea-
son, this directory cannot be chosen from the "File Select" menu.

Example:

The following example shows the "File Select" menu of the GSM/EDGE digital standard
when "Recall Predefined Frames" is selected.

Recall Predefined Frame
Recall User Frame
Save User Frame

B Recall Predefined Frame E| |E|E|

7 recent data sets
Edged

EdgeAll

GsmEdge
NormalBurst0
NormalBurstall

Select | File
Manager...

Working with the File Select dialog

File Manager...

1. Access the "File Select" dialog (see "Accessing files with user data" on page 111).
2. Navigate in the "File Select" dialog.

3. Load an existing file.
In the "Recall Settings" dialog, mark a file and press the "Select" button.

4. Save afile.
In the "Save Settings" dialog, enter file name in the "File Name:" field.
Select the directory to which the file is to be saved and then select the "Save" button.
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5. Create a new file.
To create a new file, use the "Save Settings" functionality, i.e. specify file name and
directory and save the file.

The created file is empty; it must be filled with the necessary values in the individual
editor.

3.7.2 File Manager

The "File Manager" allows general file management such as copying, shifting, renaming
and deleting files as well as generating new directories.

Thus, also externally created files, for example waveforms created by using the
R&S®WinlQSIM2 program, can be saved to the R&S SMU by copying them from a mem-
ory stick or a network to the internal hard disk.

File Type All Files (%) -
= th“ tﬁ Ies{")t State [+ Iy =
nstrument State (*.savrc]
% _Zf"l:s ARB Waveform (*.wv)
£ - NRP Setting {*.nrp)
G _gsm List Mode List (*Isw)
E"Q _lists User Correction {*.uco)
(3 cust_dig_mod ARB Multicarrier Settings {*.arb_multcarr)
ﬁ fading ARB Multisegment Info (*.inf_mswv)
G m ARB Sequencing List (*.wvs)
(3 gps DigMod Data List (*.dm_igd) -
(3 wimax
ﬁ winlQsim2
-0 _sirius
IZ—ZIQ _user
3 nist
=% lists
5 arB
clist_digmod.dm_igc
i list_mode.lsw
- ucor.uco
w0 _wimax -
Create New
Cut Copy | Paste | Rename Delete | T

Use the "File Type" to select a file type form the list. This can be used to process either
all files (all files (*) selection) or a specific selection of files. See chapter 3.7.2.1, "Exten-
sions for User Files", on page 114 for an overview of the supported file extensions. The
available drives and directories and the files of the selected directory are displayed. The
currently selected path is displayed above the windows. If the area is opened several
times, the path last selected is displayed. Unlike the "File Select" window, the "File Man-
ager" displays the full file names including extensions.

Working with the File Manager dialog

1. Accessing the "File Manager" dialog (see "Accessing files with user data"
on page 111).

2. Navigating in the "File Manager" dialog.
Operation is similar to the operation of menus with several areas.

3. Moving, duplicating, deleting or renaming files
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To move a file, select the file and press the "Cut" button. Mark the directory to which
the file is to be moved and select the "Paste" button. If the target directory already
contains a file with the same name, a confirmation query is displayed to confirm
overwriting of this file.
Perform the similar steps and cut/copy/rename/delete the file.

Tip: The operation corresponds to the Windows concept.

4. Creating a new directory
Mark drive or directory level where the new directory is to be created, select the
"Create New Directory" button and enter the name of the new directory in the entry
window that opens. Confirm with ENTER.

3.7.21

Extensions for User Files

The following table list all available file extensions for user files. The currently available
files on the instrument depends on the installed options.

Table 3-1: List of the automatically assigned file extensions in the instrument

Function/Digital List type Contents File suffix
Standard
Instrument State Settings Instrument settings *.savrcl
"User Correction" List User-defined level correction values *.uco
"List Mode" List User-defined frequency/level value pairs *.lsw
"Frequency Settings User-defined frequency response correction file | *.frc
Response Correc-
tion"
"Arbitrary Waveform | Waveform ARB waveforms * LWV
Generator” ARB multi segment waveforms
Waveform ARB multi carrier settings *.arb mult
carr
Configuration | Configuration file for creation of multisegment *.inf mswv
data ARB waveforms
Play List ARB Sequencing List * L WVS
"DM" Data List Digital modulation data *.dm_ iqd
*.tdm
Control List Data to control digital modulation *.dm_iqgc
Settings Digital modulation settings *.dm
User Standard | Digital modulation user standard *.dm stu
User Mapping | Digital modulation user mapping * . vam
User Filter Digital modulation user filter *.vaf
"NRP Settings" Settings NRP Settings *.nrp
EX-1Q-Box User Settings | EX-IQ-Box User Defined Settings * . igbox
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Function/Digital List type Contents File suffix
Standard
"Fading" Fading Fading data *.fad
"GSM/EDGE" Settings GSM/EDGE settings * . gsm
Slot User-defined slot data *.gsm_slu
Frame User-defined frame data *.gsm_fu
Slot Higher symbol rate slot *.gsm_hslu
Frame Higher symbol rate frame *.gsm_hfu
"Bluetooth" Bluetooth Set- | Complete setting of the Bluetooth menu *.bto
tings
"TETRA" TETRA Set- Complete setting of the TETRA menu * . tetra
tings
"3GPP FDD" Settings Complete setting of the 3GPP (FDD) menu *.3g
Settings Channel coding enhanced DPCH channels *.
(downlink) 3g_ccod dl s
Settings Channel coding enhanced DPDCH channels *.3g ccod ul
(uplink)
"CDMA2000" Settings Complete setting of the CDMA2000 menu * . cdma2k
"TD-SCDMA2000" | Settings Complete setting of the TD-SCDMA2000 menu | *.tdscdma
Settings Test Model for TD-SCDMA2000 * . tdtmd
1xEV-DO Settings Complete setting of the 1xEV-DO menu *.evdo
"IEEE 802.11 Settings Complete setting of the IEEE 802.11 WLAN *.wlan
WLAN" menu
"IEEE 802.11 n Settings Complete setting of the IEEE 802.11n WLAN *.wlann
WLAN" menu
Settings Beamforming data * . pmf
"IEEE 802.16 Settings Complete setting of the IEEE 802.16 WiMAX * . wimax
WiMAX" menu
"EUTRA/LTE" Settings Complete setting of the EUTRA/LTE menu * _eutra
Settings TDD Settings *.lte tdd
Settings User-defined IQ-File * . iqw
"GPS" Settings Complete setting of the GPS/A-GPS menu *.gps
Settings GPS Almanac Settings * . txt
*.alm
*.al3
Settings GPS Waypoints File * . txt
Settings GPS Generated Almanac File *rs_al
*.rs_yuma
Settings GPS lonospheric File *.rs ion

|
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Function/Digital List type Contents File suffix
Standard
Settings GPS Navigation Data *.rs_nav
Settings GPS UTC File *.rs_utc
*.rs_acq
"FM-Stereo" Settings Complete setting of the FM-Stereo menu * . fmstereo
Settings FM-Stereo Group Type Settings *.fm_gt
Settings FM-Stereo Group Hex Type Settings *.fm ghex
Waveform File | Waveform File * . wav
"Sirius" Settings Complete setting of the Sirirus menu * . sirius
"XM-Radio" Settings Complete setting of the XM-Radio menu * . xmradio
Settings XM-Radio TWTA Data * . twta
"DVB" Settings Complete setting of the DVB menu *.dvb
Settings DVB Transport Stream * . gts
*.ts
*.trp
"DAB/T-DMB" Settings Complete setting of the DAB/T-DMB menu *.dab
Settings DAB ETI Files *.eti
*.xeti

3.8

Legend of Front-Panel Controls

The following table lists all key functions available on the front panel. Key combinations
used on the PC keyboard to trigger key functions on the instrument front panel are also
described. Keyboard labels are described in alphabetical order.

In addition, a front panel key emulation and an on-screen keyboard can be used for
manual operation by mouse only.

Table 3-2: Cross-reference between the front panel keys and keyboard shortcuts

Front-panel key

Key of PC keyboard

Function

Turning the rotary knob

Tab key (towards the right)
Shift + Tab (towards the left)

Sets the cursor with the rotary knob.

a unit.

and level step width.

Pressing the rotary Enter Pressing the rotary knob confirms an entry; it has the
knob same function as the ENTER key.

Arrow keys Arrow keys Moves the cursor.

*1/dB(m) ALT + F12 Confirms entries in the base unit and values without

Selects dBm for the RF level and dB for level offset

|
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Front-panel key Key of PC keyboard Function

RV - L # Enters a period/decimal point. Enters a special char-
acter.

+/- | A<->a -/ (shift+) a—z Enters the sign.
Switches between upper-case and lower-case let-
ters.

0-9/a..z CTRL+0-9/a...zCTRL Enters the number/letter.

BACKSPACE Backspace Clears the last entry (number, sign or decimal point)

CLOSE CTRL+ G Closes an active menu.

DIAGRAM CTRL+ D Sets the cursor on the block diagram and hides all
menus.

ENTER Enter Terminates an entry.

ESC ESC Selects the next higher menu/selection level. When

the editing mode is exited with ESC, the previous
value is restored.

FILE CTRL + S Activates the menu for storing instrument settings.

FREQ CTRL+ F Activates the frequency entry.

G/n/ dBuV ALT +F9 Selects the unit Giga/Nano, dBuV for the RF level
and dBu for the LF level.

HCOPY CTRL+Y Opens the menu for configuring and starting a hard-
copy.

HELP F1 Opens/closes context-sensitive help.

HIDE CTRL+H Minimizes the active menu. Pressing the respective

button in the Winbar opens the menu again.

INFO CTRL +1 Opens/closes the info window

INSERT Ins Activates the insert mode.

k/m /uv ALT + F11 Selects the units Kilo/Milli and uV for RF levels.

LEVEL CTRL +L Activates the level entry.

LOCAL CTRL+Q Switches the instrument from remote control to man-
ual control.

M/u / uV ALT + F10 Selects the units Mega/Micro and uV for RF levels.

MENU CTRL +M Calls the menu selection list.

MOD ON/OFF CTRL+O Switches modulation on/off. "MOD OFF" is indicated

in the status line.

TOGGLE CTRL+T Switches a block or parameter on/off.

Toggles between the different possibilities of setting
a selection parameter.

PRESET CTRL +P Restores a defined basic instrument setup.

REARR CTRL+A Adjusts the size of the active menu to use the whole
height of the dislay.

|
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Front-panel key Key of PC keyboard Function
RECALCULATE CTRL+C Starts recalculation of the signal.
RF ON/OFF CTRL+R Switches the RF output signal on/off. "RF OFF" is

indicated in the status line.

Both RF output signals are always deactivated in the
case of two-path instruments.

SETUP CTRL+E Opens the setup menu for general instrument set-
tings.

Softkeys CTRL +F1-F8 Triggers the function assigned to the softkey.

WINBAR CTRL +W Displays the Winbar in the foreground/background.

3.8.1 Front Panel Key Emulation

The R&S SMU provides a front panel key emulation to enable execution of the front panel
key functions by mouse e.g. for remote access. The emulation is called by a right mouse
click. The front panel key functions are executed by a mouse click on the associated
button.

Freg Diagram ‘

Level Menu ‘

File

Rearr. ‘

RF OnfOff | WinBar

Mod OnjOfr

Help ‘

Preset

Local

S

Hardcopy

uH

3.8.2 On-screen Keyboard
In addition, the Windows XP operating system provides a keyboard emulation that can
be used for system settings if no external keyboard but a mouse is available.

To access the on-Screen Keyboard, select "Start > Programs > Accessories > Accessi-
bility > On-Screen Keyboard".
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4 Instrument Function

4.1 Overview of Instrument Functions

This chapter explains the functions of the R&S SMU and the options available in the
setting menus. The associated SCPI command is specified for each parameter (where
applicable).

The description begins with the general instrument settings which do not directly affect
signal generation. The maijority of these settings can be accessed by means of front-
panel softkey menus and not by means of function block menus.

One exception is, for example, the signal graphics which are called up in the "Graph-
ics" block.

The signal generation functions are then described, beginning with the RF section func-
tions which affect the RF signal and the analog modulations and which are compiled in
the "RF/A Mod" block of the block diagram.

This is followed by an explanation of all functions which are in the signal flow prior to
being fed into the RF block and which do not affect the internal generation of a baseband
signal - I/Q modulation, noise generation and impairment of the digital signal, fading and
the input of external baseband signals. These functions are accessed by means of the
function blocks "Baseband Input", "Fading", "I/Q Mod" and "AWGN/IMP".

The remaining (and largest) part of the chapter describes the functions used for the inter-
nal generation of the signals in the baseband (these functions are provided in the "Base-
band" block).

The general instrument settings include various functions, such as:

e Setting a defined basic setup using the PRESET key
see chapter 4.2.2, "Default Instrument Settings - Preset Key", on page 124

e Switching from remote control to manual control using the LOCAL key
see chapter 4.2.4, "Switching to Manual Control - Local Key", on page 147

e Configuring the generator and its interfaces in the "Setup" menu - e.g. setting the
GPIB address, starting an adjustment, querying instrument data
see chapter 4.2.3, "General Configuration of Instrument - Setup Key", on page 125

e Generating a hardcopy of the display using the HCOPY key
see chapter 4.2.5, "Generating a Hard Copy of the Display", on page 148

e Calling up the online help using the HELP key
see chapter 4.2.7, "Help System - Help Key", on page 153

e Querying messages using the INFO key
see chapter 4.2.6, "Messages - Info Key", on page 153

e | oading and storing complete instrument settings in the "File" menu
see chapter 4.2.8, "Storing and Loading Instrument Data - File Key", on page 154

e Calling up the baseband signal graphics in the "Graphics" function block
see chapter 4.3, "Graphical Display - Graphics", on page 160
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The integrated bit error rate and block error tester is configured and activated in the
"BERT" function block:

e Bit error rate and block error measurement
see chapter 4.4, "Bit and Block Error Rate Measurements - BERT Block",
on page 171

The RF signal is configured and the analog modulations activated in the "RF/A Mod"
function block:

e CW mode
see chapter 4.5.1, "Overview of RF Signal", on page 190

e List mode
see chapter 4.5.14, "List Mode", on page 265

e Sweep mode
see chapter 4.5.13.1, "Overview", on page 244

e Analog modulations
see chapter 4.5.11.1, "Overview", on page 230

In the "I/Q-Mod" function block, 1/Q modulation is possible with external analog signals
and internally generated baseband signals.

e |/Q modulator
see chapter 4.6, "I/Q Modulation - 1/Q Mod Block", on page 274

Noise can be added to the baseband signal and the baseband signal can be impaired
before input into the 1/Q modulator. It is therefore possible to output a baseband signal
with impairments via the I/Q-OUT outputs ("AWGN/IMP" function block). Impairment is
also possible during 1/Q modulation ("I/Q Mod" function block).
e |mpairing the signal

see chapter 4.7.1, "Impairments”, on page 288
e Adding noise

see chapter 4.7.2, "AWGN - Noise Generator", on page 299

e Fading the signal
see description "Fading Simulation - Fader Block"

The baseband signal is available at the 1/0 outputs.

e OQutput of the baseband signal
see chapter 4.7.3, "Output of the Baseband Signal - I/Q Out", on page 307

The R&S Signal Generator offers various possibilities for generating digital modulation
signals in compliance with the definitions of digital standards or with characteristics which
can to a large extent be freely defined. The range of software options for this is being
extended continuously.

e Baseband signals - Introduction
see chapter 4.8, "Baseband Signal - Baseband Block", on page 320

e External Baseband signals
see chapter 4.9, "External Baseband Signal - Baseband Input”, on page 442

e Digital modulation
see chapter 4.8.3, "Digital Modulation - Custom Digital Modulation", on page 338

e Arbitrary waveform generator ARB
see chapter 4.8.4, "Arbitrary Waveform Generator ARB", on page 382

|
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e Multi Carrier CW signals
see chapter 4.8.5, "Multi Carrier Continuous Wave", on page 428

e Digital standard GSM/EDGE
see description "Digital Standard GSM/EDGE"

e Digital standard 3GPP FDD (WCDMA)

see description "Digital Standard 3GPP FDD (WCDMA)
e Digital standard CDMA2000®

see description "Digital Standard CDMA2000®"
e Digital standard TD-SCDMA

see description "Digital Standard TD-SCDMA"
e Digital standard 1xEV-DO

see description "Digital Standard 1xEV-DO"
e Digital standard IEEE 802.11 (a/b/g) (WLAN)

see description "Digital Standard IEEE 802.11 (a/b/g) (WLAN)"
e Digital standard IEEE 802.11n (WLAN-N)

see description "Digital Standard IEEE 802.-11n (WLAN-N)"
e Digital standard IEEE 802.16 (WiMAX)

see description "Digital Standard IEEE 802.16 (WiMAX)"
e Digital Standard EUTRA/LTE

see description “Digital Standard EUTRA/LTE”
e Digital standard GPS/A-GPS

see description "Digital Standard GPS"
e Digital Standard XM Radio

see description “Digital Standard XM Radio”
e FM Stereo/RDS

see description “FM Stereo/RDS”
e Digital Standard DVB-H

see description “Digital Standard DVB-H”

e Digital Standard DAB / T-DMB
see description “Digital Standard DVB / T-DMB”

In addition, external baseband signals can be fed into the baseband path with the aid of
the external Digital Interface Module R&S EX-IQ-BOX.

e Digital Interface Module
see description "Digital Interface Module R&S EX-1IQ-BOX".

|
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4.2 General Instrument Settings

4.2.1 Overview of General Instrument Settings

This section describes the settings which do not directly affect signal generation. Most of
these settings can only be accessed by means of menus which are opened using keys
or key combinations on the external keyboard or keys on the front panel key emulation.

This does not apply to the graphical representation of output signals which is activated
in the "Graphics" function block, or settings which can additionally be called up in the
menus of the function blocks, e.g. input configuration which is possible in the "Setup"”
menu and in almost every menu of the "Baseband" function block.

See also chapter 3.8, "Legend of Front-Panel Controls", on page 116.

The general instrument settings therefore affect various functions, such as storing instru-
ment settings using the FILE key or setting the GPIB address in the menu of the
SETUP key. The order in which the descriptions are given corresponds to the layout of
the keys on the front panel of the R&S SMU (from top left to bottom right).

4.2.2 Default Instrument Settings - Preset Key

The PRESET key calls up a defined instrument setup. All parameters and switching
states are preset (also those of inactive operating modes). The default instrument settings
provide a reproducible initial basis for all other settings.

However, functions that concern the integration of the instrument into a measurement
setup are not changed, e.g. GPIB address or reference oscillator source settings.

In addition, only those settings associated with the menu can be reset directly in the
individual menus, e.g. all digital modulation settings in the "Custom Digital Mod" menu.
These settings are identical to those which are called up using the PRESET key.

When the instrument is switched on, it is not the preset state that is active, but rather the
instrument state that was set before the instrument was switched on.

User-defined instrument states can be stored and called up in the "File" menu.

@ Resetting the instrument to the factory state is possible with the Factory Preset function.

Preset
Presets all parameters and switching states.

The following list gives an overview of the presets for the most important generator set-
tings. The other presets can be found in the preset tables of the individual menus and
the information accompanying the remote commands.

e "RF frequency" = 1 GHz

e "RF level" RF output switched off

e "Offsets"=0
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e "Modulations State" = Off

Uninterrupted level settings are switched off
"Level Attenuator Mode" = AUTO

Internal level control "Level ALC" = AUTO
User correction "Level Ucor" = OFF

"LF output State" = Off

"Sweep State" = Off

"List mode State" = Off

Settings that are not affected by the PRESET key

Reference frequency settings ("Ref Oscillator" menu)

Power on settings ("Level/EMF" menu)

Network settings ("Setup" menu)

GPIB address ("Setup" menu)

Password and settings protected by passwords ("Setup" menu)
Start/Stop Gui Update ("Setup" menu)

Display and keyboard settings ("Setup" menu)

Note: In remote control it is possible to preset the settings of the two instrument path
separately (see chapter 6.2, "Preset Commands", on page 499).
Resetting the instrument to the factory state is possible in the Factory Preset dialog.

SCPI command:
*RST on page 498

4.2.3 General Configuration of Instrument - Setup Key

= Setup The SETUP key opens the "Setup" dialog.

System

Reference Oscillator.. 1 he "Setup" dialog is divided into several sections.
Internal Adjustments...
Hardware Config...

Software/Opfions... e The "Test" section is used to perform function tests.

e The "System" section is used to set general instrument parameters.

e The "Environment" section is used to configure the controller interfaces.

e The "Remote" section is used to configure the remote control interfaces.

e The "Protection" is used to set the protection level for service functions.

e The "Settings" section contains the "Save/Recall" dialog.

Most submenus of this key can be accessed only via the SETUP key or the menu tree
( MENU key), with the following exceptions:

e The "Reference Oscillator" dialog can also be called up in the "RF" block and is
therefore described in the section on this block (see chapter 4.5.4, "Reference Oscil-
lator", on page 200).

e The "Save/Recall" dialog can also be called up with the FILE key and is therefore
described in the section on this key (see chapter 4.2.8, "Storing and Loading Instru-
ment Data - File Key", on page 154.

e The "Global Trigger/Clock/ External Inputs" dialog is also available in all modulation
menus of the "Baseband" function block where it can be called up with the "Global
Trigger/Clock Settings" button in the corresponding "Trigger/Marker/Clock" dialog.
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See also chapter 4.2.3.10, "Global Trigger/Clock/External Input Settings",
on page 135.

4.2.3.1 Internal Adjustments

The R&S Signal Generator is extremely accurate thanks to the integrated procedures for
adjustments.

All internal adjustments for which no external measuring equipment is needed can be
started in the "Internal Adjustments..." dialog. The adjustments with external measuring
equipment are described in the Service Manual (on CD ROM, supplied with the instru-
ment).

Adjustment is recommended if the temperature range in which the instrument is operated
changes, or prior to all applications which require maximum level and frequency accu-
racy.

During adjustment a bar indicates the status of progress. If an error occurs, adjustment
is terminated and an error message is output in the info line.

Risk of invalid adjustment

In order to achieve correct adjustment of the instrument, make sure that the instrument
is warm before performing adjustments. The warm-up time is 30 minutes.

In the case of two-path instruments, adjustment can be performed separately for the two
paths.

To access the "Internal Adjustments" dialog, press the SETUP or MENU key under
"System".

The adjustments offered also depend on the installed options.

& Internal Adjustments |Z| |E| rzl

I Adijust All I

High Accuracy Level Adjustment [~ On

Path IA VI

Adjust Synthesis /FM / @M |

Level
Adjust Level |

Use ext. Level CorrectionData | On

Adjust 1/Q Modulator
.. Current Frequency |

.. Full Range |

Adjust BB Input
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Adjust All

Starts all internal adjustments for which no external measuring equipment is needed. The
adjustments with external measuring equipment are described in the Service Manual
(supplied).

With two-path instruments, adjustment is performed for both paths.

SCPI command:
:CALibration:ALL[:MEASure] on page 528

High Accuracy Level Adjustment
Enables/disables level adjustment with high accuracy.

SCPI command:
:CALibration<hw>:LEVel :HACCuracy|[:STATe] on page 530

Path (Internal Adjustments)
Selects the path for which the following adjustments are to be performed. With remote
control, the path is selected using the numerical suffix under CALibrate.

SCPI command:
n.a.

Adjust Synthesis
Performs all adjustments which affect the frequency.

The adjustment affects the selected path.

This includes adjustment of option R&S SMU-B20/B22, FM/PhiM Modulator / and Low
Phase Noise.

SCPI command:
:CALibration<hw>:FREQuency [ :MEASure] on page 529

Adjust Level
Performs all adjustments which affect the level. The acquired correction values improve
the settling time and the signal quality.

The adjustment affects the selected path.

SCPI command:
:CALibration<hw>:LEVel [ :MEASure] on page 530

Use ext. Level Correction Data
Switch on or off use of external level correction data (see service manual, chapter 2,
"Adjustment"). This switch can be used in case of corrupt external level correction data.

The adjustment affects the selected path.

SCPI command:
:CALibration<hw>:LEVel:STATe on page 530

Adjust I/Q Modulator Current Frequency

Starts the adjustment for the 1/Q modulator for the currently set frequency, I/Q swap, and
baseband gain. The I/Q modulator is adjusted with respect to carrier leakage, 1/Q imbal-
ance and quadrature.
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Adjustment for only the set frequency is considerably faster than adjustment across the
entire frequency range. This is possible with "Full Range".

SCPI command:
:CALibration<hw>:IQModulator:LOCal on page 529

Adjust I/Q Modulator Full Range
Starts the adjustment for the I/Q modulator for the entire frequency range. The 1/Q mod-
ulator is adjusted with respect to carrier leakage, 1/Q imbalance and quadrature.

SCPI command:
:CALibration<hw>:IQModulator:FULL on page 529

Adjust Baseband Input
Starts the adjustment for the baseband input. The 1/Q input is adjusted with respect to
DC offset and gain.

SCPI command:
:CALibration<hw>:BBIN[:MEASure] on page 528

4.2.3.2 Hardware Config

In the "Hardware Config" dialog, the installed assemblies together with their variants and
revision states can be displayed for servicing purposes.

To open the "Hardware Config" dialog, select "System" and press the SETUP or

MENU key.
& |Hardware Config, r;||§|§|
Counter +
Operation Time / h 588
Power On Count 314

Common Assembly

I Assembly Part Number | Serial Mumber | Revision | Slot j

Section "Counter” in the upper part of the menu shows the "Operation Time" (in hours)
and the number of power-on ("Power On Counter").

The second part of the menu is a table that lists the installed assemblies. It is divided into
the sections:

e "Common Assembly"

e "RF Assembly"

e "Baseband Assembly"

Operation Time / h
Displays the operation time in hours.

SCPI command:
:DIAGnostic:INFO:0TIMe on page 533
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Power On Count
Displays the number of power-on.

SCPI command:
:DIAGnostic:INFO:POCount on page 533

Assembly

The tables list the installed assemblies.

"Path" Shows the path to which the assembly belongs.
"Assembly" Assembly name

"Part Number" Part Number of assembly

"Serial Number"Serial Number of assembly

"Revision" Revision state of assembly

"Slot" Indicates whether the assembly is connected to the serial bus or PCl bus.

SCPI command:
:DIAGnostic<hw>:BGINfo on page 532

Software / Options

The "Software/Options" dialog shows the firmware version of the instrument software as
well as all installed hardware and software options.

\ Software options purchased at a later stage can be activated with a keycode. The acti-
/ vation code is supplied with the software option. How to install options is described in

Chapter 4 of the Service Manual (supplied with the instrument).

The installation of hardware options purchased at a later stage is also described in Chap-
ter 4 of the Service Manual (supplied with the instrument). Most hardware options need
to be installed at an authorized Rohde&Schwarz service shop.

To access the "Software/Options" dialog, select "System" and press the SETUP or
MENU key.

The menu is devided into the following sections:

e "Firmware"

e "Hardware Options"

e "Software Options"

e "WinlQSIM"

e "Loaded Modules"

CoX)

Firmware

Package Yersion

iSMU Base Software 01.05.14.00 (Release) {01/15/2004; 10:18:23)
RE&S Software Platform 1.40.5.1 (Release)

|
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Firmware
The Firmware section of the menu shows the firmware version and the version of the
software platform.

Note: Your instrument is delivered with the latest firmware version available. Firmware
updates as well as the Release Notes describing the improvements and modifications
are provided on the Internet at the download site of the Rohde & Schwarz Signal gener-
ator home page. This home page always offers the latest information on your signal gen-
erator, e.g. also on changes of the firmware update procedure.

SCPI command:
n.a.

Hardware Options / Software Options
The tables in the sections "Hardware", "Software" and "WinlQSIM2" list the installed
hardware and software options.

"Option" Short name of option
"Designation” Name of Option

"Licenses" Number of licenses.
The licenses for the software options are "floating licenses". This means
that in the case of two-path instruments just one license is required to
use the option for either of the two paths. However, two licenses must
be purchased to use an option on both paths simultaneously.

"Expiration For regular options, "Permanent" is indicated in this column. Some
Date" options are available as trial versions. This column shows their expiration
date. After this date, the option is no longer available on the instrument.

SCPI command:
*OPT on page 497
*TDN on page 496

Loaded Modules
Section "Loaded Modules" is provided for service purposes. It lists all loaded software
modules with their versions and offers a short description of each module.

SCPI command:
n.a.

Gui Update
The "Start/Stop Gui Update" dialog provides the possibility to switch off update of the
displayed parameters in order to increase speed for certain settings.

The indicated values are not updated and may therefore differ from the intern, used val-
ues.

|
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E|Start / Stop Gui Update

Gui Update is _

Please, be aware:
I "Gui Update is OFF™, the values of displayed parameters could differ from their internal, used values.
This mode is mainly provided to support unjittered signal output, f.e. in fast sweep or list mode.

If remote state is active, the <Local> key or <Goto Local> command changes the value of "Gui Update is™ to ON.

On/Off GUI Update
Switchs on/off update of the displayed parameters.

Switching off the update of the displayed parameters increases the speed for certain
settings.

Note: It is especially recommended to switch off the GUI update for optimum sweep
performance with short dwell times and for fast settling times.

SCPI command:
:SYSTem:DISPlay:UPDate on page 809

4.2.3.5 Install SW-Option

Newly purchased software options are enabled in the "Install SW-Options" menu. They
are ready to operate after they are enabled by means of a key code supplied with the
option.

B Install SW-Option Al=13

IOptinnKey ﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂl

Only if the R&S Signal Generator is equipped with an older firmware version, a firmware
update prior to enabling the software option may be required. The information on the valid
firmware versions for the purchased software option is provided together with the option.
The firmware update is described in the service manual instrument, chapter 4 (on CD
ROM, supplied with the instrument).

4.2.3.6 NRP-Z Info/Update

In the "NRP-Z Info/Update..." dialog, the connected power sensors are indicated together
with their serial number, revision state and features. The software of a connected sensor
can be updated to a new version.

To access the "NRP-Z Info/Update..." dialog, select "System" and press the SETUP or
MENU key.
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& NRP-Z Info / Update

Current Sensors
Sensor Type | Serial Number | Revision | Peak | K28 Support

Update:
1 - Mot Found j Run Update |
None Select NRP File |

Current Sensors
Section "Current Sensors" lists the sensors that are connected to the generator and indi-
cates their serial number, the revision state and some features.

SCPI command:
n.a.

Update

Section "Update" provides access to the file system in order to select a file for an R&S
NRP sensor update (Button "Select NRP File"), the selected file is indicated to the left of
the button. On the left side, the sensor to be updated is selected.

Button "Run Update" starts the update. If the update is interrupted for example by acci-
dently pulling off the sensor, selection "Rescue” is offered to restart the update process.
Prerequisite is that no other sensor is connected to the instrument.

The procedure is as follows:

e Do not reconnect the sensor but keep it ready to be connected
Select "Rescue" in the left sensor selection field

Activate "Run Update"

Confirm query in message box

Connect sensor within 4 seconds

The update starts, a bar informs about the progress.

SCPI command:

SENSe<ch>[:POWer] : TYPE on page 570
SENSe<ch>[:POWer] : SVERsion on page 570
SENSe<ch>[:POWer] : SNUMber on page 569

4.2.3.7 Update

After a firmware update it is occasionally required to also update the "PCI-FPGA". This
is enabled in the "Update" dialog.

At the first start of the new firmware, a message appears during the boot process if a
"PCI-FPGA" update is required. Execute a PCI-FPGA update by pressing the "PCI-
FPGA" button.
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Impairment of instrument functions

To avoid impairment of instrument functions, the update of the "PCI-FPGA" must not be
cancelled and the instrument must not be switched off during this update.

X

I PCI-FPGA I

4.2.3.8 Selftest

A selftest is provided for service purposes. The selftest is a protected test procedure,
which can be accessed if protection level 1 is disabled. The protection dialog is called in
the "Setup" menu (see chapter 4.2.3.15, "Protection”, on page 144).

B2 Selftest

I Execute Fader Selftest I

Execute Baseband Connection Selftest |

Execute BBIN Sefftest |

External LYDS Test

BBOUT: LVDS Rate | 1l]|J|MHz +| T Test - BBIN: Get Rx Bit Error |

The following tests are only available via remote control:
® :TEST:CONNector:AUXio on page 816

® :TEST<hw>:DIRect on page 816

Execute Fader Selftest

Performs a selftest on the fading simulator and the hardware options of the fading sim-
ulator extension. The result (succeeded or failed) is displayed in the status field next to
the "Fader Selftest" button.

SCPI command:
:TEST: FADer on page 817

Execute Baseband Connection Selftest

Performs a connection test on each of the internal digital baseband links. This implies all
installed options as baseband inputs, motherboard, universal coding generators, fading
simulators, and baseband outputs.The result (succeeded or failed) is displayed in the
status field next to the "Execute Baseband Connection Selftest" button.

SCPI command:
:TEST:BB:CONNection on page 815
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Execute BBIN A/B Selftest

Performs a selftest on the baseband input hardware options. Several analog diagnostics
points are checked to verify the correct function of the module. The result (succeeded or
failed) is displayed in the status field next to the "Execute BBIN: x Selftest" button.

SCPI command:
:TEST:BBIN on page 815

BBOUT LVDS Rate
Sets the interface speed.

The "External LVDS Test" is used to check the correct data transmission of the digital
baseband outputs (BBOUT) and the correct data reception of the digital baseband inputs
(BBIN).

An external cable connection is needed to perform this test successfully. An output must
be connected to an input with the digital I/Q cable. Always an input/output pair is tested
together. The input and the output can be on the same instrument, or alternatively on two
different instruments. Given an arbitrary cable connection, the appropriate Tx test can be
activated with different interface speeds (LVDS rate).

On the connected input, this test sequence is received and can be compared with the
expected test signal.

SCPI command:
: TEST<hw>:BBOut : LRATe on page 815

Tx Test

Activates the transmission of a known pseudo-random sequence (On).
SCPI command:

:TEST<hw>:BBOut:TTESt [: STATe] on page 816

BBIN Get Rx Bit Error
Performs a bit error rate test of the received test signal. The result (succeeded or failed
is displayed in the status field next to the "BBIN: GET Rx Bit Error" button.

SCPI command:
:TEST<hw>:BBIN:RBERror on page 815

Check Front Panel

The "Check Front Panel" dialog is used to check whether the front panel keys are func-
tioning correctly. The menu displays all the front panel keys arranged in the same way
as on the front panel. The respective function is executed by pressing the associated key.

|
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Preset Freq Level File Diagram Menu
Local RF Ofo |Mod Ofo| Recalc. ESC | Toggle
Setup
dardcop T 8 9 Gin
Info 4 5 1 Mip Ruoll L. | Roll r.
Help 1 2 3 kfim
0 . +f- 1 Up
Insert Backsp.| Enter Left Down Right |
Close
Hide
Rearr.
winBar
Soft 1 |Suﬂ2|30ﬂ3|80ﬂ4|Suﬂ5|SDﬂﬁ|SDﬂT|SDﬂB|

4.2.3.10 Global Trigger/Clock/External Input Settings

The "Global Trigger/Clock/External Inputs" menu can be opened using the SETUP or
MENU key under the "Setup" menu as well as in all clock and trigger menus of the
"Baseband" function block.

This menu is used to determine the physical characteristics of the input connectors for
trigger, clock and control signals.

The user inputs/outputs (BNC connector and pins of the AUX I/O connector) are assigned
in the dialog "User Marker AUX 1/O".

A common trigger threshold and input impedance is effective for all trigger and control
signal inputs (Path A and Path B). The settings influence the digital modulations, the
generation of waveforms or multicarrier signals, and all digital standards. Irrespective of
this, a common threshold and input impedance is effective for the serial and parallel data
input (Path A only). These data sources are available for digital modulation ("Custom
Digital Modulation").

The instrument trigger setting influences all sweeps and is effective in the List mode
(Instrument Trigger, Path A and Path B).

|
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& Global Trigger/Clock/External Inputs E“§|E|

IThreshoId Data Input (Ser/Par) I 1.00 IV "II

Threshold Trigger/Control Input mﬂ
Impedance Data Input (Ser/Par) IW,
Impedance Trigger/Control Input IW,
Baseband Trigger Input Slope lm
Instrument Trigger Input Slope lm
Clock Input Slope IWL,

Clock Output (BNC Rear Panel)

Clock Source I Basebhand A Yl
Clock Mode I Symbol 'l

Threshold Data Input
Sets the high/low threshold in volts for the serial and parallel data input.

The serial data is input at the DATA connector of the instrument. The parallel data is input
via the DATA pins of the AUX /O interface.

SCPI command:
[ :SOURce] : INPut : DATA: THReshold on page 736

Threshold Trigger/Control Input
Sets the high/low threshold in volts for the trigger and control signal inputs of the base-
band section.

The setting affects the TRIGGER 1 and TRIGGER 2 inputs (BNC connectors) and the
CW, BURST and LEV_ATT inputs of the AUX I/O interface.

SCPI command:
[:SOURce] : INPut: TRIGger: LEVel on page 737

Impedance Data Input
Selects the input impedance for the serial and parallel data inputs.

50 Ohm/GND should be selected for high clock rates.

The serial data is input at the DATA connector of the instrument. The parallel data is input
via the DATA pins of the AUX /O interface.

SCPI command:
[ :SOURce] : INPut : DATA: IMPedance on page 736

Impedance Trigger/Control Input
Selects the input impedance for the external trigger and control signal inputs.

50 Ohm/GND should be selected for high clock rates.

The setting affects the TRIGGER 1 and TRIGGER 2 inputs (BNC connectors) and the
CW, BURST and LEV_ATT inputs of the AUX I/O interface.

SCPI command:
[ :SOURce] : INPut: TRIGger: IMPedance on page 737
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Baseband Trigger Input Slope
Selects the polarity of the active slope of an externally applied trigger signal.

This setting affects the TRIGGER inputs (BNC connectors).

SCPI command:
[ :SOURce] : INPut : TRIGger : BBANd: SLOPe on page 737

Trigger Input Slope
Sets the polarity of the active slope of an applied instrument trigger.

In the case of two-path instruments this setting is valid for both paths. It affects the INSTR
TRIG for path A and the INST TRIG B input of the AUX /O interface for path B.

"Positive" The rising edge of the trigger signal is active.
"Negative" The falling edge of the trigger signal is active.

SCPI command:
[ :SOURce] : INPut: TRIGger: SLOPe on page 738

Clock Input Slope
Sets the polarity of the active slope of an externally applied bit clock pulse or symbol clock
pulse.

This setting affects the CLOCK input (BNC connector).
An external clock signal can only be supplied for Path A.

SCPI command:
:CLOCk: INPut:SLOPe on page 531

Clock Output Source

Indicates the path for which the clock signal at the CLOCK OUT connector is to be output
(always Path A).

This setting is only possible for two-path instruments.

SCPI command:
:CLOCk:0UTPut : SOURce on page 531

Clock Output Mode
Sets the output of bit or symbol clock pulses at the CLOCK OUT connector at the rear
panel.

SCPI command:
:CLOCk : OUTPut : MODE on page 531

4.2.3.11 Display/Keyboard Settings

In the "Display/Keyboard Settings" menu the power-save mode and external keyboard
settings are made. It is opened using the SETUP or MENU key under "Environment".

|
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& Display/Keyboard Settings E_||E|E|
Display Settings

Screen Saver ¥ Active
Wait time Iﬁl Min vl
Help Language IEninsh vl

Keyboard Settings:

Layout IEninshtUS} vl

Screen Saver Active
Activates/deactivates the screen-save mode of the display.

If activated, the display including backlight is completely switched off after the elapse of
the "Wait Time" when no entries via front panel, external mouse or external keyboard are
made.

This mode is recommended for preserving the display especially if the instrument is
exclusively operated via remote control.

SCPI command:
:DISPlay:PSAVe[:STATe] on page 534

Wait Time
Enters the idle time that must elapse before the display lamp is shut off when no entries
are made.

SCPI command:
:DISPlay:PSAVe:HOLDof f on page 534

Help Language
Selects the help language.

The online help is provided in English and Chinese.

SCPI command:
n.a.

Layout (Keyboard)
Selects the keyboard layout for the selected keyboard language.

The assignment of some keys depends on the selected layout and language.

SCPI command:
:KBOard:LAYout on page 545
:KBOard:LANGuage on page 545

4.2.3.12 User Marker / AUX I/O Settings
The R&S Signal Generator provides four "USER" interfaces which can be freely assigned
a selection of signals and which can be configured as both inputs and outputs.

The following table gives an overview of the signals that can be applied at the USER
connector.

|
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For two-path instruments, these signals are available for Path A or B.
Table 4-1: USER Connector Signals

Signal Description

"Marker 4" A broad selection of suitable marker signals is offered in the marker
menus of the "Baseband" block. In addition, they can be freely config-
ured in the "Custom Dig Mod > Control List Editor" and "GSM/EDGE >
Slot Marker Editor". The selected markers are activated when switching
on the "Baseband" block. When using markers defined in a control list
("Marker" = "CList") the related control list must be loaded in addition
("Custom Dig Mod").

"CW Mode Out" This signal marks the CW mode in which digital modulation ("Custom
Dig Mod") is deactivated and the RF signal is output in unmodulated
form. The CW signal is defined in a control list and activated by loading
the control list and setting the "Modulation<-> CW Switching State" to
On in the "More" submenu.

With standards where it is possible to change between various modu-
lation modes, the signal indicates the active modulation mode (standard
GSM: signal high (1) = modulation mode GMSK and signal low (0) =
modulation mode 8PSK EDGE). In this cases, the signal is generated
automatically when the standard is switched on.

"No Signal (Blank) Marker" This signal marks the blank time in the List mode. The signal is generated
automatically when the list mode is switched on.

"HOP" This signal marks the hop trigger for frequency hopping in the List mode
for "Custom Digital Mod". The hop signal is defined in a control list and
activated by loading the control list in the "Custom Dig Mod" menu.

"Trigger" This signal marks the trigger event caused by the selected trigger signal
(internally or externally).

Separate trigger signals are available for Path A and B.

The trigger is defined in the respective trigger submenu of the "Base-
band" block menus.

Additional signals for Path B are available in the case of two-path instruments. The cor-
responding signals for Path A are applied at the pins of the "AUX I/0" interface and at
the BNC connector CLOCK.

|
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Table 4-2: USER Connector Signals (Path B)

Signal Description

"Clock Out" output Path B; bit or symbol clock pulse

This signal corresponds to the clock signal for digital modulations. The
signal is generated automatically when the standard is switched on.

"LEV_ATT" input/output Path B

With active envelope curve control, this signal determines whether or
not the signal level is attenuated.

With external envelope curve control, the interface is input, otherwise
output. The envelope curve control is activated in the "Custom Digital
Modulation > Power Ramp Control" dialog.

The internal "LEV_ATT" control signal is defined in a control list which
must be loaded in the main menu.

"BURST" This signal corresponds to the control signal for envelope curve control.

With external envelope curve control, the interface is input, otherwise
output. The envelope curve control is activated in the "Custom Digital
Modulation > Power Ramp Control" dialog.

The internal "BURST" control signal is defined in a control list which must
be loaded in the main menu.

To access the "User Marker / AUX I/O" dialog:
1. Select "Setup > Environment > Global Trigger/Clock/External Inputs" or

2. In the "Baseband" function block select any digital standard, e.g. "GSM/EDGE" and
select "Trigger > Global Trigger/Clock/External Inputs".

The signals are assigned to the USER interfaces in the "Mapping Configuration" section.
The pin assignment of the AUX I/Oconnector is also displayed. An adapter between the
AUX /O interface and coaxial BNC connections is available as an accessory (accessories
for R&S Signal Generator-Z5, see data sheet).

The polarity of the blank marker is selected in the "No Signal (Blank) Marker" section.
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&5 User Marker / AUX 1/0 M=
Mapping Configuration

IMap Output Connector User 1 (BNC) To I General Purpose Input L[I

——AUX IO Connector: SMU Rear Panel

S S S S S S S S S S S S S
sof Bl (01— [ sl el ot e o d o o o [ _|
29-38: PARDATA 0-9

49: SYMB CLCK 28:INST TRG B
27: CW MODE

47: BIT CLK 26: LEV ATT
46: EXT TUNE 1-25: GROUND
45: BURST

Map Output Connector User 2 (AUX 1/0) To | General Purpose Input j

Map Output Connector User 3 (AUX I/0) To | No Signal (Blank) A ~|

Map Output Connector User 4 (AUX 1/0) To ITrigger A j

No Signal (Blank) Marker
Polarity I Positive j

AUX 1/0 Connector
An illustration of the AUX I/O interface is shown. The inputs are indicated by a
"depressed" pin B, outputs by a non-depressed pin Tl

The assignment is shown in tabular form underneath the interface. The colors indicate
the signal type. A distinction is made between control signals (yellow), marker signals
(green), data (orange), freely selectable signals at the user pins (blue), ground (gray),
and unused pins (black).

If no path letter is specified, the pin is assigned to the signals of Path A. Pins with signals
from Path B are indicated by a "B" to the right of the signal name. This does not apply to
the EXT TUNE input via which the signal for external impairment of the reference fre-
quency is supplied; this impairment signal applies to both paths.

For detailed description of the AUX I/O connector, refer to chapter A.2, "AUX /O Con-
nector", on page 858.

User Connector Signal

Selects the signal for USER interface 1 (BNC), 2, 3 or 4 (AUX I/O). The signals which are
available for selection are given in table 4-1.

SCPI command:

:OUTPut :USER<ch>:SOURce on page 562

Polarity (No Signal Marker)
Selects the polarity of the No Signal Marker.

If Positive is selected, the signal is high (2.5 V) when the marker is active; if Negative is
selected, the signal is low (0 V).

SCPI command:
:0UTPut:BLANk:POLarity on page 559
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4.2.3.13 Remote Channel Settings

The "Remote Channel Settings" dialog provides access to the settings for remote control.
The dialog is opened using the SETUP or MENU key under "Remote".

& Remote Channel Settings E”E”g'
‘OPT String:

I SMU-B10, SMU-B10, SMU-B13, SMU-B13, suu_||

GPIB channel address I 28

Visa Resource Strings:

TCPIPI TCPIP:10.113.10.392INSTR

GPIB I GPIB::28:INSTR

Local

GPIB channel address
Sets the GPIB address of the instrument.

SCPI command:
:SYSTem:COMMunicate:GPIB[:SELF] : ADDRess on page 808

Visa Resource Strings
Indicates the visa resource strings, used for remote control of the instrument. A separate
string is provided for remote control via the different interfaces.

SCPI command:
:SYSTem:COMMunicate:NETWork:RESource on page 808
:SYSTem:COMMunicate:GPIB:RESource on page 809

Local (Remote Channel Settings)
Switches the instrument to operate in local control mode.

Switching from remote to local control mode can be also done with one of the following
actions:

e manually with the LOCAL key on the front panel

e with the interface command &GTL via the remote-control interface

e with the key combination CTRL + Q.

SCPI command:
&GTL

4.2.3.14 LXI Status

The "LXI - LAN eXtensions for Instruments - Status..." dialog displays the settings and
status of the LAN and allows to reset the LAN connection.

For more information about LXI, see chapter 1.9, "LX| Configuration", on page 54.

|
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& LX1 - LAN eXtensions for Instruments - Status E“E|

LAN Status: & ‘)//(I
Hostname | mu600h9e
MAC Address | 0014 22 28 7B 1D
IP Address | 010.113.010.163
LAN Reset
LAN Status

The LED indicates the LXI status.

The LAN Status is also indicated with the LED "LAN Status" on the front panel of the
instrument.

"green"” normal operation
"green (flash- device identification
ingll

"red" LAN fault

SCPI command:
n.a.

LAN Reset
Initiates the network configuration reset mechanism for the instrument and resets the
hostname, MAC address, and IP address.

Alternatively, the LAN RESET button on the front panel of the instrument can be used.
To initiate the network configuration reset, press the button longer than 4 sec and wait
for the signal tone.

According to the LXI standard, an LAN Reset must place the following network settings
to a default state:

Parameter Value

TCP/IP Mode DHCP + Auto IP Address
Dynamic DNS Enabled

ICMP Ping Enabled

Password for LAN configuration LxiWeblfc

The LAN Reset for the R&S Signal Generator also resets the following parameters:

Parameter
Hostname Instrument-specific host name
Description Vector Signal Generator

|
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Parameter
Negotiation Auto Detect
VXI-11 Discovery Enabled

The LAN settings are configured using the instrument's LXI Browser Interface described
in chapter 1.9, "LXI Configuration”, on page 54.

To open the "Instrument Home Page" (welcome page), type the instrument's computer
name (host name) or IP address in the address field of the browser on your PC, e.g.
http://10.111.10.175.

Note: Do not add the missing zeros in the IP address, while opening the Instrument Home
Page.

SCPI command:
n.a.

Protection

The "Protection" menu provides access to the unlocking of protected service functions
(authorized personnel of R&S Service Departments only). To deactivate the protection,
the correct password has to be entered. After the instrument has been switched on, the
protection levels 1 to 5 are automatically activated.

g3 Protection

Protection Level 1 on IPasswurd lil
On Password | =
On Password lm
Password | srrreesress
Password lm

=

Protection Level 2

=

Protection Level 3

<l
(=}
=

Protection Level 4

<]
(=]
=1

Protection Level 5

Protection Level/Password
Protection Level 1 can be activated to expand the functionality of the internal adjustment
and to access the selftests.

The password is 123456.

SCPI command:
:SYSTem: PROTect<ch>[:STATe] on page 812

Security

The "Security" dialog provides access to the passwords and mass storage security set-
tings. To open this menu, use the SETUP or MENU key under "Protection”.

The menu is divided into the password sections and the security settings section. In the
password section, the passwords for securing a controlled access to the instrument are
defined and changed.
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A change of passwords for the operating system and security password requires the entry
of the old and new password and the conformation of the new password. All settings are
only accepted after the "Change Password" button is pressed.

& Security EI|§|E|
Change Security Password
fold Passwora | |

New Password |

Confirm Password |

Change Password I

Security Settings

USB Device IEnahIe VI
Lan Connections IEnahIe vl

Security Passwurl:ll

Accept |

Old Password (Security Password)
Enters the currently used security password. The default password is '123456'.

Note: It is highly recommended to change the default security password before connect-
ing the instrument to the network.

The security password is required when changing the status of the USB and LAN inter-
face.

SCPI command:
n.a.

New Password (Security Password)
Enters the new security password.

The security password may contain decimal characters only.

SCPI command:
n.a.

Confirm Password (Security Password)
Enters the new password for conformation.

The new password is only valid after the "Change Password" button is pressed.

SCPI command:
n.a.

Change Password (Security Password)
Changes the password accordingly.

SCPI command:
n.a.

USB Device
Enables/disables the USB interfaces.

Operating Manual 1007.9845.32 — 16 145



R&S®SMU200A

Instrument Function

4.2.3.17

4.2.3.18

General Instrument Settings

The instrument does not recognize any device connected to the USB interface when the
interface is disabled.

The setting requires the entry of the security password and is only accepted after the
"Accept" button is pressed.

SCPI command:
n.a.

LAN Connection
Enables/disables the LAN interfaces.

It is not possible to access the instrument via LAN while the LAN connection is disabled.

The setting requires the entry of the security password and is only accepted after the
"Accept" button is pressed.

SCPI command:
n.a.

Security Password
Enters the password that is required to enable or to disable the settings protected by a
security password. Default is '123456'.

Note: It is highly recommended to change the default security password before connect-
ing the instrument to the network.

All settings are only accepted after the "Accept” button is pressed.

SCPI command:
n.a.

Accept - Security
Accepts a new entry or selection and changes the settings accordingly.

SCPI command:
n.a.

Bluetooth Pin
Requires a USB Bluetooth adapter (recommended extra, see data sheet).

Enters the Bluetooth pin of an external Bluetooth device. The pin is required to enable
remote control via an external Bluetooth device.

SCPI command:
n.a.

Save/Recall
The "Save/Recall" submenu can also be called up with the FILE key and is therefore

described in the section of this key (see chapter 4.2.8, "Storing and Loading Instrument
Data - File Key", on page 154).

Factory Preset

The "Factory Preset" dialog provides a function to reset the instrument's settings to their
factory state. This function is activated by pressing the "Execute Factory Preset" button.

|
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& Factory Preset g |§| E|

l Execute Factory Preset | I

Factory Preset
Reset the instrument's settings to their factory state.

Note: Since Factory Preset resets the Remote Channel and network settings to the
default values, executing Factory Preset via remote control terminates the connection to
the instrument, if these settings had been configured to values different to the default
ones!

The factory preset function resets nearly all instrument settings. In addition to the regular
preset by means of the PRESET key, a "Factory Preset" resets also the following values:
e Reference frequency settings ("Ref Oscillator" menu)

Power on settings ("Level/EMF" menu)

Network settings including hostname ("Setup" menu)

Remote Channel settings including GPIB address ("Setup” menu)

Start/Stop Gui Update ("Setup" menu)

Display and keyboard settings ("Setup" menu).

To maintain security, password settings and all settings protected by these passwords
like disabled USB and LAN connections are not changed.

Not affected by the "Factory Preset" are also user data, lists or instrument settings files,
created for example by means of the Save/Recall function.

SCPI command:
:SYSTem: FPReset on page 501

4.2.3.19 Help

The "Help" dialog offers comprehensive online help for the R&S Signal Generator. A
desired topic can be selected via the table of contents (select "Manual") or the index
(select "Index").

For context-sensitive information about a marked parameter, press the HELP key. For a
description of the "Help" menu, refer to the section covering to the HELP key (see chap-
ter 4.2.7, "Help System - Help Key", on page 153).

4.2.4 Switching to Manual Control - Local Key

In remote control mode a status message appears in the display header. The rest of the
display remains unchanged and shows the current instrument status, i.e. the status which
exists under the remote control settings. The instrument can be operated (e.g. menus
can be opened). However, it is not possible to enter or change values.

|
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Frea 8 | 1.000 000 000 00 |o+= -] Per 8| -30.00
| A: ALC-Auto | B: ALC-Auto

hiztkeg

B Custom Dig. Mod. A EHEE

IStaIe on I -
Set to Default

SavefRecall User__.
Trig In 1 V 1)
_Q Data Source
Data Source |PRBS j

The status message additionally indicates whether the LOCAL key is disabled or enabled.

UsB

See also chapter 5.2.1, "Switching to Remote Control", on page 461.

If the "REMOTE" status message is shown, the LOCAL key switches the instrument from
remote control to manual control. The current command must be fully processed before
the mode is switched, otherwise the instrument switches immediately back to remote
control.

If the "REM-LLO" status message is displayed, the instrument can be switched from
remote control to manual control by means of remote control only (e.g. with the Visual
Basic command CALL IBLOC (generator%));the LOCAL key is disabled. The key is
disabled by remote control with the command LLO.

When switching from remote to manual control, the display update suppression function,
if active ("SETUP > GUI Update" is Off), is automatically deactivated ("SETUP > GUI
Update" is On).

4.2.5 Generating a Hard Copy of the Display
The "HCOPY" key opens a window for configuring the hardcopy setting, like output file

format, printer or path and file name. The parameters to be set change in dependency of
the selected output device.

B4 Hard Copy i : _ EZ Hard Copy.

a==] Destination m
Automatic Naming¥ On Automatic Naming
Options... | Options...

|
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Hardcopy Dialog

Destination
Selects if the hardcopy is printed or stored in a file (see also "Printer Options"
on page 150 or "File Options" on page 151).

SCPI command:
:HCOPy:DEVice on page 537

Options

Opens the Hardcopy Options dialog for configuring the hardcopy. Depending on the
selected destination either the printer or the file parameters can be set (see also "Printer
Options" on page 150 or "File Options" on page 151).

SCPI command:
n.a.

Printer
If device printer is selected some settings are already offered in the hardcopy dialog. All
configuration parameters are available in "Printer Options" on page 150.

File
Some configuration parameters are already offered in the Hardcopy dialog. All configu-
ration parameters are available in "File Options" on page 151.

Automatic Naming
Activates, deactivates automatic generation of the file name. Automatic naming is con-
figured in the "Options..." submenu, see "File Options" on page 151.

SCPI command:
:HCOPy:FILE[:NAME] : AUTO: STATe on page 543

File Info

Indicates the file name. The file name can be entered either manually via the file manager
(button "File...") or generated automatically (Automatic naming checkbox). Automatic
naming is configured in the "Options..." submenu.

SCPI command:
:HCOPy:FILE [ :NAME] on page 538
:HCOPy:FILE[:NAME] : AUTO: FILE on page 540

|
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& Hardcopy Options EHE@ & Hard Copy Options D-_| |E| &l
Printer Setup Image
IPrimer | Acrobat Distiller J | - I 510430 jl SO I BWP |
Page Layout Unit I cm vl Autornatic Haming
Orientation | Portrait | Path... | Ie;,r
Paper Size |Leter 16279 =] Delete All Image Files In Path ~ Clear Path |
Margins
Top I 2.50 | cm Bottom I 2.50 I cm l Prefix |7 Ismh\r
Left I 2.50 | cm Right I 2.50 I cm l Year [V Month [# L) i
Current Auto Number I 000
Resulting File Name | smbwv20080620000.bmp
Printer Options

Dialog for setting the printer parameters.

"Printer" Selects a printer from a list of available printers. The name of the selected
printer is indicated in the selection field. If the list is empty, no printer
driver is installed. In this case, a printer has to be installed via the Win-
dows XP operating system.

For more information, see chapter 1.4, "Connecting External Accesso-

ries", on page 34.

SCPI command:
:HCOPy:PRINter:LIST on page 543
:HCOPy:PRINter [:NAME] on page 544

"Unit" Defines the physical unit of the page size and margins used for the hard-

copy. The selectable units are inches or centimeter.

SCPI command:
:HCOPy:PRINter:PAGE:UNIT on page 545

"Orientation"  Defines the orientation of the printer page for the hardcopy.
"Portrait" - the page's height is greater than its width.

"Landscape" - the page's width is greater than its height.

SCPI command:
:HCOPy:PRINter:PAGE:ORIentation on page 544
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"Paper Size" Selects the size of the printer paper for the hardcopy. The currently
selectable paper formats are "Letter", "Legal", "Executive", "A4" and
"A5". For information on the paper format width and height values are
indicated additionally. Depending on the set physical unit by the param-
eter "Unit", width and height are expressed in cm or inches.

SCPI command:
:HCOPy:PRINter:PAGE:STIZE on page 544

"Margins" Defines the margins of the paper size for printing the hardcopy. "Top",
"bottom", "left" and "right" margin values have to be entered in this
sequence, separated by commas. Decimal places are separated by a
decimal point. Depending on the set physical unit by the parameter
"Unit", width and height are expressed in cm or inches.

SCPI command:
:HCOPy:PRINter:PAGE:MARGins on page 544

File Options
Dialog for setting the file parameters.

"Size" Defines the size of the bitmap in terms of pixels. The first value of the
size setting defines the width, the second value the height of the image.

SCPI command:
:HCOPy: IMAGe: STZE on page 543

"Format" Selects the image format. Several bitmap formats are available.

SCPI command:
:HCOPy:DEVice:LANGuage on page 538

"Automatic Determines the rules to create the file names and sets the directory the
Naming" files are saved into.
As default the automatically generated file name is composed of:
<Path>/<Prefix><YYYY><MM><DD><Number>.<Format>
Each component can be deactivated/activated separately to individually
design the file name. The resulting file name is indicated.

"Path..." Opens the "Select Hard Copy Destination Path" dialog to select a path
for storing the hardcopy.

Note: For selecting the destination path a file name must be entered as
well. Otherwise the error message "The name of a list may not be empty"
is displayed and the selection will be canceled.
Directory, path and file name are displayed in the infoline right to the
"Path" button.

SCPI command:

:HCOPy:FILE[:NAME] : AUTO:DIRectory on page 539

:HCOPy:FILE[ :NAME] : AUTO on page 539
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"Clear Path"  Deletes all image files with extensions bmp, img, png, xpm and csv in
the directory set for automatic naming.
Before deleting the image files a warning message is displayed requiring
the confirmation.

SCPI command:
:HCOPy:FILE[:NAME] : AUTO:DIRectory:CLEar on page 539

"Prefix" Activates the usage of the prefix in the automatic file name. The prefix is
entered in the field to the right of checkbox.

SCPI command:
:HCOPy:FILE[:NAME] :AUTO[:FILE] : PREFix:STATe on page 542

"Enter prefix" Enters the prefix for the automatically generated file name. The use of
the prefix is activated in the checkbox to the left.

SCPI command:
:HCOPy:FILE[:NAME] : AUTO[:FILE] : PREFix on page 542

"Date - Year/ Defines the components of the automatically generated file name. The
Month / Day" selectable parameters are year, month and day. If activated the current
year, month or day used in the file name.

SCPI command:

:HCOPy:FILE[:NAME] : AUTO[:FILE] : YEAR: STATe on page 542
:HCOPy:FILE[:NAME] : AUTO[:FILE] :MONTh:STATe on page 541
:HCOPy:FILE[:NAME] : AUTO[:FILE] : DAY : STATe on page 540

"Current Auto Indicates the number which is used in the automatically generated file
Number" name.

Note: On initially switching on the device the number will be reset to the
lowest possible value. Starting with number 0 the output directory will be
scanned for already existing files. As long as files with the same name
are existing the number will be increased by 1. The number will be auto-
matically set to a number so that the resulting file name will be unique
within the selected path. The current number will not be saved in the save
recall file but will be temporarily stored within the database. On subse-
quent saves the number will be increased.

SCPI command:
:HCOPy:FILE[:NAME] : AUTO [ : FILE] : NUMBer on page 541

"Resulting File Indicates the automatically generated file name.
Name"

SCPI command:
:HCOPy:FILE[:NAME] : AUTO: FILE on page 540

Print / Save
Triggers the generation of a hardcopy.

SCPI command:
:HCOPy [ :EXECute] on page 538

|
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4.2.6 Messages - Info Key

4.2.7

The INFO key opens a window containing a detailed description of every message dis-
played in the info bar, see chapter 3.2.3, "Info Window", on page 88 and chapter 8, "Error
Messages", on page 849.

Help System - Help Key

The HELP key opens a browser window containing a context-sensitive description of the
highlighted parameter.

& Help - State - Digital Modulation

=% Digital Modulation - Custol
i~ Overview and Required (
+- (3 Modulation Types - Cu
+-(3, Coding - Custom Digit
+- [ Baseband Filter - Cust
Conflicting Settings - Cus
=€) Custom Digital Mod U
-G General Settings
- Set To Default - Di
- Save/Recall - Digif
+-(3 Data Source
+-[3 Standard, Symbol

+ 5 Power Ramp

Operating the R&S Vector Signal Generator > Instrument Function = Baseband Signal -
Baseband Block > Digital Modulation - Custom Digital Modulation » Custom Digital Mod User
Interface > General Settings » State - Digital Modulation

State - Digital Modulation

Enables/disables digital modulation.
Switching on digital modulation turns off all the other digital standards.
In case of two-path instruments, this affects the same path.

The digital modulation is generated in realtime (no precalculated signal). and therefore all

+|31 Modulation parameter changes (in the ON state) directly affect the output signal.
+-(3 Modulation - CW § .
+ﬁl Filter SCPI command:

[:50URce<hw>] :BB:DM: STATe

+-[3 List Management
+-[3 Data List Editor
+-L Control and Marke
+-(3, Power Ramp Cont
+-[3 TriggerMarkericl

4 ﬁ;l »

GoTolndex |

ScrollLeft | ScroiRight |  Zoomin |  Zoomout |

The context-sensitive page which is opened with the HELP key is part of a comprehensive
help system. It is possible to move from this context-sensitive page to any page of the
help system. The following navigation aids are available:

e Internal links in the text
They open pages which are directly linked to the described function. In this way it is
possible, for example, to call up the description of the GPIB command for any par-
ticular function.

e Previous/Next links
The Previous/Next links allow scroll through the help pages. The sequence of the
described functions corresponds to their position in the menus.

e Back button
The Back button calls up the page last viewed.

e Contents in the navigation panel
The contents list is used to open the individual help pages. It has a hierarchical struc-
ture. The highlighted line indicates where the currently displayed page is within the
contents list.

e [ndex in the navigation panel
The index is used to call up all pages which contain the selected entry. The index has
an alphabetical structure and also contains all GPIB commands.

e Find
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The find function allows you to look for freely selectable terms in all help pages. A list
of the pages containing the entered term is displayed as the search result. The search
can be limited to words in the page title to increase the number of hits.

The softkeys are used to determine the entry focus for front panel operation, to select the
content of the navigation window and to change the font size. To determine the entry
focus for front panel operation the Cursors UP/Down are used. The links are highlighted
in blue, and can be selected and called up using the rotary knob.

Storing and Loading Instrument Data - File Key

The R&S SMU allows complete instrument settings to be stored in files on the hard disk.

Defined and complex instrument settings can then be reproduced at any time by loading
this data. If required, these settings can be loaded to various signal generators.

The corresponding menu is available under "Save/Recall" in the "Setup"” menu or acces-
sible by means of the FILE key. The instrument settings are saved in files which can be
stored in data directories.

Additionally there are intermediate memories in which the current instrument setting can
be stored and then called up again by just pressing a key. This provides fast switching
between different instrument settings.

Only settings which differ from the preset values and configuration data for the operating
elements (e.g. window positions) are stored. As a result the files remain relatively small.
Furthermore, instrument settings can easily be transferred between different equipped
signal generators since the files contain only relevant information. When loaded, the ref-
erenced settings are implemented and all non-referenced parameters are set to the
associated preset values.

If list data is part of the instrument settings, e.g. a list of user correction data, a reference
to this list is stored, not the list itself. The list is reactivated when the associated settings
are loaded, but the list may have been modified or deleted in the meantime or may not

be available on a different instrument. If the list has been modified, the new entries will

be used. An error message appears if an attempt is made to access a non-existing list

or to activate settings which are not supported by the instrument.

e Network settings and remote settings are not saved and restored.

e |ists are stored and loaded in the appropriate menus. For example, the user correc-
tion data list is created and stored in the "User Correction" menu.

When loading an instrument setting, it is possible to select whether the current frequency
and level setting is to be retained or whether the stored settings are to be activated. It is
possible to delete stored instrument settings. A file can be copied by loading it with
"Recall" and then storing it under a new name.

Settings can be transferred easily between instruments with different equipment options
and/or firmware versions because only the settings which differ from the preset values
are affected. When settings are loaded, only those which are possible on the instrument
are implemented. Error messages indicate the settings which cannot be implemented.

|
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Select Operation I Save vl
d:l_userllists/ARB
EQ _user -
PRt e
C = ists
- (5 _wimax
- ARB ~
File Name:
I preset_settings II
Save Save Save Save File
Immediate1 Immediate2 Immediate3 Manager...

General Instrument Settings

The stored file is transferred from one instrument to another using the memory stick or
by means of a network drive.

General file management functions such as copying and moving data are available in the
"File Manager" dialog.

File Menu

The settings available in the File menu "Save/Recall" depend on the operation selected
under "Select Operation".

& Save/Recall

FE&
I Save w I

For more information, see chapter 3.7.1, "File Select Dialog", on page 111.

Select Operation

Select Operation
Selects the file function.

"Save..." Calls the menu for storing the current instrument setting (see chap-
ter 4.2.8.2, "Storing Instrument Settings", on page 155).
"Recall..." Calls the menu for calling up a stored instrument setting (see chap-

ter 4.2.8.3, "Loading Instrument Settings", on page 156).

Storing Instrument Settings

If "Save" is selected under "Select Operation”, the File menu provides options for storing
the current instrument setting in a file.

& Save/Recall

Recent data sets
Displays the files last used. The entire path is shown in plain text.

SCPI command:
n.a.

Directory
Selects the directory in which the file is to be stored.
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The window opposite lists all settings files in this directory.
A new directory can be created in the "File Manager" dialog.

SCPI command:
:MMEMory:CDIRectory on page 551

File List
Displays the files which are in the selected directory.

If a file is highlighted, it is overwritten when the file is stored.

SCPI command:
:MMEMory:CATalog on page 550

File Name
Enter the file name of the file without file extension. This file is then created.

SCPI command:
n.a.

Save
Stores the current instrument settings under the specified path.

SCPI command:
*SAV on page 498
:MMEMory: STORe : STATe on page 556

Save Immediate x
Stores the current instrument setting in one of the three intermediate memories.

These instrument settings are retained until a different instrument setting is stored in the
intermediate memory. When the instrument is switched off, the contents of the inter-
mediate memories are retained.

SCPI command:
*SAV on page 498

File Manager
Calls the "File Management" menu.

Directories can be created and files managed in this menu (see chapter 4.2.8.4, "File
Manager", on page 158).

SCPI command:
n.a.

4.2.8.3 Loading Instrument Settings

If "Recall" is selected under "Select Operation”, the "File" menu provides options for
loading complete instrument settings. Here it is possible to select whether the current or
stored frequency and level settings are to be used.
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& Save/Recall E| |§|rg|

Select Operation IRecaII vl
at:l_userflists/ARB

oLt B

E--Q lists L

2% ARB

- preset_settings

ﬁ[ _wimax

- ARB M|
Exclude Frequencyl™ Exclude Levell™

Recall Recall Recall Recall File
Immediate1 Immediate2 Immediate3 Manager...

Recent data sets
Displays the files last used. The entire path is shown.

If the desired file is in the list, it can be selected.

SCPI command:
n.a.

Directory
Enter the directory in which the file with the instrument setting to be loaded is located.

The "Selected file" window lists all the files in this directory.

SCPI command:
:MMEMory:CDIRectory on page 551

File List
Selects the file with the desired instrument configuration.

SCPI command:
:MMEMory:CATalog on page 550

Exclude Frequency
The current frequency is retained when a stored instrument setting is loaded.

SCPI command:
[ :SOURce<hw>] : FREQuency [:CW| : FIXed] : RCL on page 728

Exclude Level
The current level is retained when a stored instrument setting is loaded.

SCPI command:
[ :SOURce<hw>] :POWer [:LEVel] [ : IMMediate] : RCL on page 783

Recall
Load the selected configuration.

If an instrument setting in which a sweep was activated is stored, the sweep is started
when the recall command is called.

If an instrument setting which accesses lists is stored, this list is also loaded.

|
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If the list has been deleted in the meantime, an error message appears when the instru-
ment setting is loaded. If the list has been overwritten in the meantime, the new entries
will be used.

SCPI command:
:MMEMory: LOAD: STATe on page 554
*RCTL on page 498

Recall Immediate x
Loads the selected configuration from one of the three intermediate memories.

If an instrument setting in which a sweep was activated is stored, the sweep is started
when the recall command is called.

If an instrument setting which accesses lists is stored, this list is also loaded.

If the list has been deleted in the meantime, an error message appears when the instru-
ment setting is loaded. If the list has been overwritten in the meantime, the new entries
will be used.

A message appears if no instrument configuration is stored in this memory.

SCPI command:
*RCTL on page 498

File Manager

The "File Manager" dialog provides all the functions required for file management. Direc-
tories can be created, and files copied, deleted and moved between the directories on
the drives (hard disk, memory stick and network drives).

& File Manager
File Type [Instrument State (~.savrcl) |
EIQ _user -
o @l ist
. =W lists
2% ARB
- preset_settings.savrcl
ﬁl _wimax
=03 ARB =
Create New
Cut | Copy | Paste Rename Delete Directory

For more information, see chapter 3.7.2, "File Manager", on page 113.

File Type
Selects the file types to be indicated. If a file type with a specific file extension is selected
only files with this extension are indicated in the selected directory.

SCPI command:
n.a.
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Directory and File Name

Selects the directory in which the file to be deleted or copied is located. The window lists
all files in this directory. The file to be deleted or copied can be highlighted. The path is
indicated above the directory window.

SCPI command:
:MMEMory:CDIRectory on page 551

Cut
Cuts the selected file. It can be pasted into a different directory using the "Paste" button.

SCPI command:
:MMEMory:DELete on page 554

Copy

Copies the selected file. It can be pasted into a different or the same directory using the
"Paste" button. When pasting the file into the same directory file name Copy of <file
name> is given automatically. When pasting the file into a different directory, the original
file name is kept.

SCPI command:
:MMEMory:COPY on page 551

Paste
Pastes the file that has been copied or cut before.

SCPI command:
n.a.

Rename
Renames the selected file or directory. The new name can be entered in the "New File-
name" dialog.

SCPI command:
:MMEMory : MOVE on page 555

Delete
Deletes the selected file. Before the file is deleted, a message appears prompting the
user to confirm deletion of the file.

SCPI command:
:MMEMory:DELete on page 554

Create New Directory
Creates a new directory. The name of the new directory can be entered in the "New
Directory" dialog.

Note: When the subdirectory is entered, it is possible to enter an absolute path name
(e.g. D: USER/MEAS) or the path relative to the current directory (e.g. . . /MEAS).

The directory is created as a subdirectory in the selected level.

SCPI command:
:MMEMory:MDIRectory on page 555
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4.3 Graphical Display - Graphics

The R&S Signal Generator can be used to graphically display the generated baseband
signal. A selection of different signal displays assists the user in assessing and checking
the increasingly complex modulation signals.

Most graphical displays are possible both for internally generated and externally applied
baseband signals.

V|

The Graphics function block is available for instruments with the option:

e R&S SMU-B13 (Baseband Main Module) and one of the options R&S SMU-B9/B10/
B11 (UniCod + ARB)

e R&S SMU-B17 (Baseband input)
e R&S SMU-B62 (Noise Generator)

It is the baseband signal actually generated that is recorded and displayed, and not a
signal calculated on the basis of the set parameters.

This graphical display allows the user to quickly view and check the current signal char-
acteristics and also gives an overview of the changes in the signal over time. The signal
quality can be permanently monitored. The results of parameter changes on the signal,
such as a change in modulation mode, or the effects of certain configurations, e.g. the
activation of several base stations in the case of (W)CDMA signals, can be analyzed
directly in the display. Freezing the signal and then zooming permit a detailed evaluation
of any signal segment. The definition and display of one or more reference curves makes
it possible to compare various signals (i.e. by comparing the CCDF (Complementary
Cumulative Distribution Function) with different channelization codes, or the spectra if
different filter parameters are selected).

An externally applied signal can be checked with respect to the anticipated signal char-
acteristics.

The displayed signal segment can be influenced by selecting the trigger that defines the
time for recording to start. With automatic triggering, the signal is tapped at the point in
the signal path that is best for the respective display. The displayed signal segment is
selected internally depending on the signal such that the signal characteristics of interest
(e.g. the useful signal) are displayed. This selection is appropriate for a representative
display of the complete signal.

In addition, a user-definable trigger is available with which the displayed signal segment
can be limited.

The time resolution can be set either automatically or manually, whereby for manual
setting the bandwidth for which the trace is to be displayed is selected. The transient
recorders used for signal recording have a variable recording depth which is specified
under the respective display.

|
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In addition to the large graphics window, the display can also be shown in a small window
("smart graphics"). This window is fitted into the block diagram as a block, and can be
used for basic checking purposes (e.g. whether the signal is still being generated).

il | -

In the case of two-path instruments, the baseband signals of both paths can be displayed
simultaneously.

4.3.1 Graphics Settings Menu

The "Graphics Settings" menu for selecting the graphical display of the output signal is
opened either in the "Graphics" function block or in the menu with the same name which
is opened using the MENU key.

The signal display can be selected and activated in the menu.

With two-path instruments, the settings for the two paths can be entered separately. The
signals can be displayed simultaneously in two separate windows.

Smart Graphics [~ On
Mode [[+] <
Trigger Source Software ~
Sample Rate Mode ’Autu—L|
Sample rate I—IHI]I]

State
Activates the selected graphical display.

After activation, the diagram selected with "Mode" is displayed in the block diagram.

At the bottom of each graphics window there are several buttons for freezing and zooming
the display and for activating a reference curve.

For more information, see chapter 4.3.2, "Bar of Graphics Window", on page 163.

SCPI command:
[ :SOURce<hw>] :BB:GRAPhics:STATe on page 669

Smart Graphics
Activates the "smart graphics".

The graphic is displayed in a small window which is roughly the size of a block. These
windows are displayed permanently in the block diagram until they are deactivated, and
allow basic checking of the signal. They do not contain any buttons.

|
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SCPI command:
[ :SOURce<hw>] :BB:GRAPhics:SMARt : STATe on page 668

Mode
Selects the graphical signal display. The display is not shown until it has been activated
with "Status On".

The individual signal displays are described in the chapter 4.3.3, "Signal Displays",
on page 165.

SCPI command:
[ :SOURce<hw>] :BB:GRAPhics:MODE on page 668

Trigger Source
Defines the trigger for the starting time of the graphic recording.

"Software" Recording of signals is started automatically in specified intervals.
This asynchronous method is appropriate when a representative display
of the complete signal is desired, as recording starts in a random time
reference to the signal.

"Marker 1" The starting point for recording signals is determined by marker 1 in the
menu of the active standard.
This synchronous method is appropriate when specific signal segments
are to be shown in greater detail. With periodic signals, a static image is
obtained by selecting a period length of marker 1 that is equal to the
signal period.
The displayed signal segment can be shifted as needed by entering a
marker delay in the Trigger/Marker menu of the active standard.

SCPI command:
[ : SOURce<hw>] :BB:GRAPhics:TRIGger : SOURce on page 670

Scrambling Code
(only if Code Domain (3GPP FDD DL) is selected)

Sets the scrambling code if the "Code Domain" display is selected. Since it is possible to
select a different scrambling code in the menu for each of the 4 base stations and it is
also possible to display an external signal, the scrambling code for which the display is
to be generated must be explicitly specified here.

SCPI command:
n.a.

Sample Rate Mode

Sets how the time resolution of the signal is determined. Maximum resolution corre-
sponds to a display covering the entire signal bandwidth. The higher the resolution is, the
shorter the length of the displayed signal segment will be for the specified recording
depth.

|
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"Auto" The resolution is set to an optimum value on the basis of the signal and
display type.

"Full Band- The resolution is set such that the display covers the entire signal band-

width" width.

"User" Under "Graphics Sample Rate", the user can determine the resolution

by setting the signal bandwidth for which the display is to be generated.

SCPI command:
[ : SOURce<hw>] :BB:GRAPhics:SRATe :MODE on page 668

Graphics Sample Rate
With "Auto" and "Full Bandwidth":

Displays the signal bandwidth for which the display is to be generated.
With "User™:

Selects the signal bandwidth for which the display is to be generated. The setting range
moves between the minimum and maximum bandwidth which is possible for the selected
display. The selection is made graphically by moving the pointer.

SCPI command:
[ :SOURce<hw>] :BB:GRAPhics:SRATe:USER on page 669

Bar of Graphics Window

At the bottom of each graphics window there are buttons for freezing and zooming the
display and for defining and activating a reference curve.

Zoom . Show Copy
| i out | Time | ref | to ref | |

Run
Freezes the current display.

Clicking the button again reactivates the normal, permanently updated display.

Freezing the display allows it to be analyzed more easily. Zooming the display at the
same time permits detailed evaluation of any signal segment.

SCPI command:
n.a.

Zoom In (only possible with mouse)

The mouse can be used to freely select any section to be zoomed. This section is selected
by pressing the left-hand mouse key and dragging a rectangular marquee. In this way a
display can be zoomed in several steps. The zoom is cancelled by clicking the "Zoom
Out" button.

|
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SCPI command:
n.a.

Zoom out
Cancels the zoom.

SCPI command:
n.a.

Time
(1/Q mode only)
Switches to seconds for time representation on the X axis of the 1/Q diagram.

SCPI command:
n.a.

Show ref
Displays the reference curve(s). All defined reference curves are displayed simultane-
ously (see the description of the "Copy to ref" button).

The reference curves are displayed together with the current signal. They allow visual
comparison of two or more signals with different settings, e.g. with different filters.

Power [ dB

-aM -4AM -3M -2M -1M 0 M 2M b1 /11 aM
(f-fc) I Hz

Clicking the button again hides the reference curves.
The reference curves must be defined beforehand using the "Copy to Ref" button.

SCPI command:
n.a.
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Copy to ref
Defines the current curve as the reference curve.

A window opens in which the curve can be given a comment and a color.

First of all the desired color is highlighted in the top window. If this color has already been
assigned to a reference curve, this curve is overwritten. The command is entered in the
bottom "Comment" section. This comment then appears next to the highlighted color.

Up to 5 reference curves can be defined and displayed simultaneously in different colors
together with the current signal.

& Reference Curves = =

<gmpty=
=empty=

Delete Add

Each reference curve is available until it is deleted.

"Display area" The comments entered for the defined reference curve are shown in the
display area next the assigned color. A maximum of five colors (and ref-
erence curves) are available. If no reference curve is assigned to a par-
ticular color, the comment <empty> is displayed.

"Comment" Enters a comment for the current curve which is to be defined as the
reference curve. This comment then appears next to the highlighted color
in the display area.

"Delete" Deletes the curve highlighted in the display area.
Curves which are no longer required can be deleted to reduce the num-
ber of reference curves displayed simultaneously.

"Assign" Defines the current curve as the reference curve.
The new reference curve is shown together with the entered comment
next to the selected color in the display area.

SCPI command:

n.a.

Signal Displays

All signal displays which are used for analyzing a baseband signal can be selected. A

number of signal displays are only available if the corresponding signal is generated, e.g.
Code Domain only available for (W)CDMA signals.

1/Q Diagram

The 1/Q diagram displays the inphase component (i[t]) and quadrature component (q[t])
of the 1/Q signal over time.
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The diagram is displayed in a window with two separate coordinate systems. The coor-
dinate systems have identical X and Y axes. The time (in number of symbols, chips or

samples depending on the signal) is plotted on the X axes, and the amplitude scaled to
the peak envelope power (PEP) is plotted on the Y axes (minimum scaled amplitude =

-1; maximum scaled amplitude = +1). The recording depth is 1 kSamples.

This signal is picked off at the output of the baseband main module ("Impairment” function
block), i.e. contained in the displayed signal is:

e impairment of the signal as defined by the user and the addition of noise.

e Fading of the signal as defined by the user

e an added external (Baseband Input)

e an added internal signal (from the second path).
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- | —— Show | Copy |

4.3.3.2 Vector Diagram

The Q component is displayed over the | component in the vector diagram. Each point

is determined by a vector. The amplitudes of the signal components scaled to the peak
envelope power (PEP) are plotted on the X and Y axis (minimum scaled amplitude = -1;
maximum scaled amplitude = +1).

This display shows the curves between the various states of modulation mapping. The
recording depth is 1 kSamples.

This signal is picked off at the output of the baseband main module ("Impairment” function
block), i.e. contained in the displayed signal is:

e impairment of the signal as defined by the user and the addition of noise.
e Fading of the signal as defined by the user
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e an added external (Baseband Input)
e an added internal signal (from the second path).

B A: Vector Diagram

quadrature q(t)

-0.7a -05 -025 0 025 058 075 1
inphase i(t)

Foom out

Show ref ‘ Copy to ref

Constellation Diagram

In the constellation diagram, the Q component is also displayed over the | component.
However, only the values at the constellation points (signal value at the ideal scanning
instant of the symbol) are displayed, i.e. for each symbol only 1 value in the form of a
circle is shown for the | and Q component.

The amplitudes of the signal components scaled to the peak envelope power (PEP) are
plotted on the X and Y axis (minimum scaled amplitude = -1; maximum scaled amplitude
= +1). The recording depth is 2kSamples.

This signal is picked off at the output of the baseband main module ("Impairment” function
block), i.e. contained in the displayed signal is:

e impairment of the signal as defined by the user and the addition of noise.

e Fading of the signal as defined by the user

e an added external (Baseband Input)

e an added internal signal (from the second path).

This display shows the various states of modulation mapping which occur in the signal.
The example shows the constellation diagram of a QPSK modulation signal.

|
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i|A: Constellation Diagram

quadrature q(t)

-0.75 -08 -025% 0 025 058 075 1
inphase i(t)

Foom out

Show ref ‘ Copy to ref

4.3.3.4 Eye Diagram

The eye diagram displays synchronized and superimposed sections of either the inphase
or quadrature components of the signal.

The display width (eye length) is set at 2 symbols; several hundred curve segments are
superimposed. The time (in the range -/+ 1 symbol) is plotted on the X axis, and the
amplitude scaled to the peak envelope power (PEP) is plotted on the Y axis (minimum
scaled amplitude = -1; maximum scaled amplitude = +1). The beginning of recording is
synchronous to the symbol and chip clock pulse. The recording depth is 2kSamples.

This signal is picked off at the output of the baseband main module ("Impairment” function
block), i.e. contained in the displayed signal is:

e impairment of the signal as defined by the user and the addition of noise.

e Fading of the signal as defined by the user

e an added external (Baseband Input)

e an added internal signal (from the second path).
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&5 A: Eye Diagram

quadrature q(t)

1 -08 -06 -04 -02 O 02 04 06 08 1
t/ Tsymbol
Foom out Show ref ‘ Copy to ref

CCDF Display

The Complementary Cumulative Distribution Function shows the probability with which
the output signal will exceed the average power.

The level over the average power is plotted from 0 to 20 dB on the X axis; the average
power (RMS) corresponds to the origin. The probability of exceeding the average power
is plotted between 0.0001% and 100% on the Y axis. The recording depth is 8kSamples.

This signal is picked off at the output of the baseband main module ("Impairment" function
block), i.e. contained in the displayed signal is:

e impairment of the signal as defined by the user and the addition of noise.

e Fading of the signal as defined by the user

e an added external (Baseband Input)

e an added internal signal (from the second path).
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With the spectrum display, the signal spectrum is calculated from the 1/Q signal by means

of Fast Fourier Transform (FFT).

The power density over frequency is displayed. The power density is plotted on the Y

axis, and the frequency is plotted symmetrically on the X axis (-sampling rate/2 to +sam-
pling rate/2). FFT Points indicates the number of 1/Q value pairs which are used for cal-
culating a (part-)FFT. AVG indicates the number of subspectra used for averaging. The

recording depth is 8kSamples.

This signal is picked off at the output of the baseband main module ("Impairment" function

block), i.e. contained in the displayed signal is:

e impairment of the signal as defined by the user and the addition of noise.

e Fading of the signal as defined by the user
e an added external (Baseband Input)
e an added internal signal (from the second path).

The spectrum display of the output signal is particularly suitable for checking multi carrier

signals.
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& A: Power, Spectrum, (FFT) points = 512, AVG = 16)
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4.4 Bit and Block Error Rate Measurements - BERT Block

The R&S Signal Generator contains an integrated bit error rate tester which makes it
possible to evaluate a signal demodulated and decoded by a DUT by measuring the bit
error rate. A known PRBS-modulated data sequence (PRBS = pseudo random binary
sequence) is sent to the DUT. The PRBS data sequence is decoded by the DUT and
sent to the R&S Signal Generator in the form of clock and data signals. The bit error rate
tester of the R&S Signal Generator synchronizes to the known PRBS sequence and
counts the bit errors. The quotient obtained by dividing the number of error bits by the
total number of bits is the BER.

In addition, a block error rate measurement can be used to verify CRC checksums. The
ratio of errored blocks to total blocks yields the block error rate.

The settings are shown in the block diagram in the "BERT" function block and in the menu
of the same name that is accessed via the MENU button.

The equipment layout for the basic unit (R&S Signal Generator with B10x frequency
option) includes the option R&S SMU-K80 (Bit Error Rate Tester).
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v

RFIA Mod B

config... I _
[~ On

BERT

The "BERT" interface is located on the rear panel. Besides the data and clock input, it
provides further inputs for masking data containing the PRBS sequence. The interface
description can be found in chapter A.4, "BERT Connector”, on page 860.

441 Testsetup

The following figure shows the test setup for the bit/block error rate measurement. The
data used to drive the DUT can be generated by the R&S Signal Generator or an user-
defined external source. The R&S Signal Generator can generate any externally com-
puted modulation signals that were created using e.g. R&S WinlQSIM2 software (see
chapter 4.8.4.1, "ARB User Interface", on page 386).

A known PRBS sequence must be used for the bit error rate measurement.

(PRBS) Data
[RF I 1Q)

R&S Vector
Signal Generator

BERT
Interface
. T 4 Diata Enable
Festart
Clack

Demodulated Data
Fig. 4-1: Test setup for bit or block error rate measurement.

The DUT is driven using a known data sequence. It demodulates the data and sends it
together with a clock signal to the R&S Signal Generator. The Data Enable signal marks
the user data of the signal. The restart signal for restarting the PRBS calculation is only
important for the bit error rate measurement.
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443

444

Bit and Block Error Rate Measurements - BERT Block

PRBS data

To be able to detect faulty bits by a BER measurement, the data generation polynomial
must be known. PRBS sequences are therefore used as the method for computing the
data (see chapter 4.8.2.1, "Internal PRBS Data and Data Patterns", on page 329). These
quasi-random bit sequences are repeated periodically, depending on the polynomial
selected. A randomly selected initial status yields exactly one subsequent status. The
initial status and therefore the subsequent status occur only once in the whole sequence.

Hence an advantage of the PRBS data is that the bit error detector must know only the
polynomial but not the entire sequence. At the start of a measurement, the feedback shift
register is filled once with the applied data sequence (which corresponds to the synchro-
nization time) and is subsequently switched from "fill" to "feedback". This creates a
defined initial status and generates exactly the same data that the applied data stream
should have. Faulty bits can thus be identified and counted by comparing the received
data with the results obtained from the shift register.

Creating a defined initial status makes it possible to start the analysis anywhere in the bit
stream, i.e. the bit-stream source and the analyzer need not be synchronized. Delays of
the DUT and transmission over long air paths, where the transmitter and the receiver are
located at separate sites, therefore do not present a problem.

CRC polynomial

In the block error rate measurement, the checksum (CRC) that contains the data signal
fed to the DUT is compared with the checksum that the block error rate tester calculates
from the feedback data. If the two checksums differ, a block error is counted. The quotient
obtained by dividing the number of faulty blocks by the total number of blocks is the block
error rate.

At the beginning of the data, the shift register is initialized with 0. All user data bits are
then shifted through the shift register. The CRC component is then read into a second
register and compared bit by bit with the result of the calculation.

CCITT CRC 16 : G(x) = x'® + x'2 + x5 + x' is the CRC polynomial supported.

The user data is marked by a signal that comes from the DUT and is fed to the "Data
Enable" input of the BERT interface.

Clock signal

Usually the clock signal is provided by the DUT. If not, the bit clock can be extracted from
the CLOCK output connector (only with "Custom Dig Mod" signals in realtime). If signals
complying with other digital standards are generated or if ARB waveforms are used, a
marker signal can be used as a clock. As the DUT causes a delay, the ratio of clock-to-
data travel times must always be taken into account and checked with an oscilloscope if
necessary. The R&S Signal Generator indicates the status of the clock and data lines
and of the synchronization in the menus.

|
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Ending the measurement

The measurement results usually lie in the range of 10-2 to 10-9 for the bit error rate, and
in the range of 102 to 10 for the block error rate. This means that a very large number
of bits or blocks may have to be tested before a faulty bit or block occurs. Because of the
large number of bits/blocks involved, the measurement time is usually very long. Since
32-bit-wide counters are used for the total number of bits/blocks and the number of error
bits, the maximum measurement time is 4.29 x 10° bits.

To keep the measurement times short for both small and large bit/block error rates, the
R&S Signal Generator provides a number of ways to end the measurement. In addition
to manually interrupting the count, two termination criteria can be selected:

1. reaching a user-defined number of checked data bits/blocks;

2. a maximum number of detected errors.

The measurement stops as soon as one of the two criteria has been met. The display
shows which of the two criteria caused the measurement to stop.

The BER/BLER measurement measures statistical bit/block errors, i.e. errors which do
not occur at regular intervals but at random. Although a single measurement determines
the exact number of errors in the measured interval, a statistically reliable BER/BLER
can only be obtained when a sufficient number of errors occur in the observed interval.
This is the only way to ensure that the single BER/BLER measurement result approaches
the true error rate with high probability.

Bit error rates of approximately 50 % indicate a faulty measurement.

Interrupt-free measurement

In the case of continuously generated signals that contain whole-number multiples of the
PRBS sequence, the measurement occurs without interruption. Only the data and clock
lines of the BERT interface are used for the measurement. The length of the random
sequence is 2 to the power of the degree of the polynomial minus 1. For example, PRBS9
length of 511 (2° equals 512 minus 1).

Restart function

The "Restart" function makes it possible to perform BER measurements with short signals
or with signals that are not continuously generated (and therefore do not contain any
whole-number multiples of PRBS sequences). An external signal at the BERT input halts
the measurement and restarts it when the data sequence begins, and the BER results of
the relevant (sub)sequences are integrated.
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start of PRBS generation

restart of PRB 5 generation
length of PRBS s=quence

restart of PRBS generation
¥ .

uzer data block uzer data block uzer data block

restart signal |_| |_|

Fig. 4-2: The length of the signal is too short for a complete PRBS sequence; PRBS generation is
restarted by the Restart signal when the signal begins anew.

Frames generated by the R&S Signal Generator or the R&S WinlQSIM2 software contain
continuous PRBS data, i.e. the PRBS sequence is continuously written to the user data
fields. Consequently, if the R&S Signal Generator is used as a data source, a restart is
only necessary if (e.g. when using a waveform) the total length of the signal does not
equal a whole-number multiple of a PRBS sequence.

150 b= , | 150 bits , ) 150 bits , ) 140 bits ,
alh user data glalh user data gla|h user data alalh user data q
t i t
FRBSS sequence
511 bis

Fig. 4-3: TDMA signal generated by the R&S Signal Generator with user data that contains the PRBS
data sequence. The PRBS sequence is continuously written to the user data fields.

4.4.8 Data Enable

In the case of the bit error rate measurement, the data signals usually contain not only
PRBS data but also other data (e.g. sync and preambles, see figure) that would result in
bit errors. The BER measurement for this data can then be interrupted using the "Data
Enable"signal. The "Data Enable" signal is fed in at the BERT input.

frame QCCEST header uzer data guard
data

clock UL Arrrr
data

enable l I

Fig. 4-4: TDMA signal with user data that contains the PRBS data sequence and various check fields
which should be ignored for the bit error rate measurement. Below that are the associated
clock and Data Enable signals.

In the case of the block error rate measurement, the "Data Enable" signal masks the user
data (see following figure).
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chata data oo
cata
enakle _ [

Fig. 4-5: Data Enable signal with block error rate measurement.

4.4.9 PatternlIgnore

Bit sequences of 32 bits or more with only "1" or "0", which some mobile radio standards
provide instead of frame data when faulty frames are detected, can also be excluded from
the measurement using the "Pattern Ignore" function (see figure).

Crop Outof DUT

L« ’L N

! !
PRES atGenerater [ L_[1TLIL J----] 111 I

FRES atDUT Output [ -———- I
L |
BER " active ! 0 Bis !
e —
. J
I 1

These bik are ingared

Fig. 4-6: Example of functionality of Pattern Ignore: 50 bits were set to "0" by the DUT. These 50 bits
plus the preceding "0" are ignored in the bit error rate measurement.

4.4.10 Bit Error Rate Menu

Bit Error Rate... The "Bit Error Rate" menu for configuring the bit error rate measurement is called either
SockFror®e 1 in the "BERT" function block or via the MENU button under "BERT"

The top section of the "Bit Error Rate" menu is used to switch on the bit error rate mea-
surement and display the results and current status of the measurement.

&5 Bit Error Rate

State

Bit Error Rate 0.00 E-12 IENG ~|

Data Bits [ 0

Errors I 0

Terminated By User

State: NOCLOCK  HNODATA  NO SYHC
] ] @

The "Configuration" section is used to select the type of measurement the data source
and the termination criteria.
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If the data is not cyclically continued, the measurement can be selectively interrupted and
restarted. Certain data sections and frames that have been marked as faulty can be
excluded from the measurement.

—————Configuration———
Mode]Single - Execute Single |
Max. Data Bits [ 10000000
Max. Errors 100
PRBS I PRBS 9 vI
Data Polarity Norm -
Clock Slope Pos -

External Restart _
Data Enable [Notused -]
Pattern Ignore IDﬂ—L,
Threshold (BER) [ o0|v -]
Impedance (BER) [1karenD -]

4.4.10.1 General Settings

State

Switches the bit error rate measurement on/off. Depending on the selection in the
"Mode" box, either a continuous measurement ("Auto") or a single measurement ("Sin-
gle") is carried out. A single measurement must be started by clicking the "Execute Sin-
gle" button.

SCPI command:

:BERT:STATe on page 525

Bit Error Rate
Displays the measured bit error rate.

The bit error rate is the ratio of occurred errors to transmitted data bits.
The display unit can be selected in the box to the right of the value.

"ENG" The bit error rate is output in exponential notation with the exponent -3
or —6.

"SCI" The bit error rate is output in scientific notation, i.e. standardized to one
place to the left of the decimal.

"%" The bit error rate is output in percent.

"opm" The bit error rate is output in parts per million.

SCPI command:
:BLER:RESult on page 517
:BERT:UNIT on page 526
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Data Bits
Displays the current number of data bits checked.

SCPI command:
:BERT:RESult on page 518

Errors
Displays the current number of occurred errors.

SCPI command:
:BERT:RESult on page 518

Terminated By
Displays the termination criterion for the measurement.

These criteria can be entered to keep the duration of the measurement short for low as
well as high bit error rates.

The last measurement result is displayed after the measurement has been terminated.

"User" The measurement was manually terminated by the user switching the
state to off.

"Number of The measurement was terminated because the specified number of data
Data Bits" bits was reached

"Number of The measurement was terminated because the specified number of
Errors" errors was reached.

SCPI command:
:BERT:STATe on page 525
:BERT:STOP on page 526

State
Displays the status of the measurement.

This enables the user to check whether the measurement functions. The status of the
data and clock lines and of synchronization is checked and displayed.

If a faulty status is displayed, the signals can be checked at the BERT interface using an

oscilloscope.
"Clock" The applied clock signal was detected.
"No Clock" The applied clock signal was not detected. Possible causes are:

e Clock recovery is not available (e.g. with tests of RF components).
If the signal is generated using the R&S Signal Generator, the bit
clock can be extracted from the CLOCK output connector (only with
"Custom Dig Mod" signals in realtime). If signals complying with other
digital standards are generated or if ARB waveforms are used, a
marker signal can be used as a clock. As the DUT causes a delay,
the ratio of clock-to-data travel times must always be taken into
account and checked with an oscilloscope if necessary.

e The wrong impedance for the applied clock rate was selected (see
"Impedance" parameter).

e The wrong threshold for the applied clock signal was selected (see
"Threshold").
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"Data" The applied data signal was detected.

"No Data" The applied data signal was not detected.
Only clocked-in signals are detected; if the clock signal is missing, then
data changes will also not be detected.

If the data is not detected despite the detected clock signal, this may be
caused by the following:

e The signal from the DUT is missing.

e The wrong impedance for the applied clock rate was selected (see
"Impedance" parameter).

e The wrong threshold for the applied data signal was selected (see
Threshold parameter).

"Sync" The measurement is synchronized.
"No Sync" The measurement is not synchronized.

Generally, a measurement cannot be synchronized until a clock and a
data signal have been detected. If synchronization still does not occur,
this may be caused by the following:

e The selected PRBS is not correct. For the bit error rate measurement,
the PRBS sequence on which the data is based must be set on the
bit error rate tester. If the PRBS is not correct, the BER measurement
cannot synchronize to the data (due to the incorrect polynomial).

e A wrong clock slope is used, which violates setup or hold times (see
"Clock Slope" parameter).

e The travel times of clock and data are unfavorable (e.g. clock slope
at data change). Check the relationship of clock to data using an
oscilloscope and optimize the travel times (e.g. clock slope when the
data signal applied is stable).

e Reflections on the clock line occur, clocking the data signal into the
BER measurement twice, e.g. on lines without termination. The R&S
Signal Generator input is not terminated.

e Incorrect polarity of data signal (or "Data Enable" signal).
In this case the PRBS cannot synchronize. Note that an inversion of
the output signal specified for some cases by the PRBS standard is
performed automatically upon PRBS selection. Manual inversion of
the data signal is therefore not required.

No Sync status and an error rate of approx. 50%:

e A bit error occurs during synchronization (e.g. nine data bits with
PRBS9). The BER measurement is set up incorrectly. This fault is
internally detected and automatically corrected.

e If data that is not cyclically continued (i.e. when a break in the
sequence occurs at the memory wrap-around), the measurement will
not be started at the right time. The signal on the "Restart" line ena-
bles the measurement to be started optimally at the beginning of the
sequence.

SCPI command:
:BERT:RESult on page 518
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4.410.2 Configuration

The "Configuration" section is used to select the type of measurement, the data source
and the termination criteria. If the data is not cyclically continued, the measurement can
be selectively interrupted and restarted. Certain data areas and frames that have been

marked as faulty can be excluded from the measurement.

Mode
Selects the type of measurement: single or continuous measurement.

"Auto" Continuous measurement of bit error rate.
If either or both of the termination criteria are met, the measurement in
progress is terminated and immediately a new one is started automati-
cally. Depending on the settings made, a measurement may take con-
siderable time. During the first measurement, intermediate results are
displayed. For the measurements that follow, only the final results are
shown. The parameters "Data Bits" and "Errors" are continuously upda-
ted and indicate the relative values for the measurement in progress.
To start a continuous measurement, use the command : BERT : STARE
on page 525. To stop a measurement, use the command : BERT :
STOP on page 526.

"Single" Single measurement of bit error rate. The measurement is started by
clicking the "Execute Single" button.
If a measurement is in progress, the current values for "Bit Error Rate",
"Errors" and "Data Bits" are cyclically displayed. The measurement is
terminated when either or both of the termination criteria have been
reached.
To start a new measurement, the "Execute Single" button must be clicked
again.

SCPI command:

:BERT :SEQuence on page 520

Max Data Bits
Enter the number of transmitted data bits to be checked before the measurement is ter-
minated.

This criterion terminates the BER measurement after the specified number of data bits,
even if very few errors or none at all have been detected. With a low number of bit errors,
the measurement result may be statistically unreliable.

If the measurement is terminated because the number of data bits entered here was
checked, "Number of Data Bits" appears to the right of "Terminated By".

Data excluded from the measurement by "Data Enable" or "Pattern Ignore" is not counted.

SCPI command:
:BERT:SETup:MCOunt on page 523

Max Errors
Enter the number of bit errors to occur before the measurement is terminated.

This criterion terminates the measurement relatively quickly if the error rate is high. The
measurement result is statistically reliable, since many errors were already counted.
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If the measurement is terminated because the number of bit errors entered here was
reached, Number of Errors appears to the right of Terminated By.

SCPI command:
:BERT:SETup :MERRor on page 523

PRBS
Selects the PRBS sequence. The data generated by the PRBS generator is used as a
reference for the measurement.

Note: Standard-compliant data inversion for PRBS15 and PRBS23 is performed auto-
matically when the PRBS is selected. "Data Polarity" remains unaffected.

SCPI command:
:BERT:SETup: TYPE on page 524

Data Polarity
Sets the polarity of the feedback data bits.

Note: Standard-compliant data inversion for PRBS15 and PRBS23 is performed auto-
matically when the PRBS is selected. "Data Polarity" remains unaffected.

"Norm" High level stands for logic 1, low level for logic 0.
"Inv" Low level stands for logic 1, high level for logic 0.

SCPI command:
:BERT:SETup:DATA[:POLarity] on page 521

Clock Slope

Sets the polarity of the active slope of the feedback clock.
"Pos" The positive slope of the clock signal is active.
"Neg" The negative slope of the clock signal is active.

SCPI command:
:BERT:SETup:CLOCk[:POLarity] on page 520

Impedance
Sets the input impedance of the BERT inputs "Clock", "Data", "Data Enable" and
"Restart".

For high clock rates, 50 Ohms should be selected.

SCPI command:
[ :SOURce ] : INPut : BERT : IMPedance On page 526

Threshold
Sets high/low threshold in volts for the BERT inputs "Clock", "Data", "Data Enable" and
"Restart".

The variable threshold makes it possible to align the BERT interface with the level of
different input signals. In addition, reflections and other interference can be suppressed
by selecting the appropriate threshold.

SCPI command:
[ :SOURce] : INPut : BERT : THReshold on page 527
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External Restart
Activates/deactivates an external restart of the BER measurement.

start of PRBS generation

restart of PRB 5 generation
length of PRBS s=quence

|restart of PRBS generation
¥ .

L}

uzer data block uzer data block uzer data block

restart signal |_| |_|

The length of the signal is too short for a complete PRBS sequence; PRBS generation
is restarted by the "Restart" signal when the signal begins anew.

"On" The reset signal for the BER measurement is fed via the "Restart" input
of the BERT interface.
If the PRBS cannpt be continued uninterruptedly, the BER measurement
must be stopped at the end of the data sequence and subsequently
restarted at the beginning of the new data sequence. The measurement
is stopped and started via a 0-1-0 slope of the restart signal. A transition
from logic 0 to 1 causes a partial result to be generated and the mea-
surement to be stopped. A transition from 1 to 0 starts the measurement
for the next subinterval. This measurement is synchronized anew.
If the R&S Signal Generator is used as a data source, a signal in which
a single 1 was coded at the end of the data sequence can be used as a
restart signal at the R&S Signal Generator marker output. This causes
the BER measurement to stop briefly at the end of the data sequence
and start again.
Partial results (number of data and error bits) are added up until the pre-
defined total number of data or error bits is reached or exceeded.
The measurement is reset by "Pattern Ignore" or "Data Enable", regard-
less of its status.

"Off" The reset signal for the BER measurement is generated internally.
This setting is suitable for PRBS sequences that run continuously and
thus ensure uninterrupted repetition.

SCPI command:
:BERT:SETup:RESTart:STATe on page 523

Data Enable
Activates/deactivates the use of the "Data Enable" signal and sets the polarity of this
signal if it is used.

The "Data Enable" signal marks the data that is actually to be evaluated for the BER
measurement. Any data in addition to the PRBS sequence is masked and thus not eval-
uated (e.g. sync, preambles, other channels, etc that are present in the data bits supplied
by the DUT).

The signal is fed in at the "Data Enable" input of the BERT interface. It is generated by
the DUT but can also be provided by the R&S Signal Generator in the form of a marker
signal.
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Note: If the data is not enabled, the BER measurement is stopped completely. The iden-
tification circuit for "Pattern Ignore" as well as the PRBS generator of the BER measure-
ment wait as long as data is not enabled. If the data is enabled, the measurement is
continued.

frame ACCESS header user data guard
data

dock  [MAAMALTUMALAAN AL AL A A
data
enahle l |

The figure shows a TDMA signal with user data that contains the PRBS data sequence
and various check fields which should be ignored for the bit error rate measurement.
Below that are the associated clock and "Data Enable" signals.

"Not Used" Any signal at the "Data Enable" input is ignored; all data at the BERT
data input is used for the measurement.

"High" The "Data Enable" signal is used. The only data measured is the data at
the BERT data input during a high level of the "Data Enable" signal. The
measurement is interrupted during a low level of the "Data Enable" sig-
nal.

"Low" The "Data Enable" signal is used. The only data measured is the data at
the BERT data input during a low level of the "Data Enable" signal. The
measurement is interrupted during a high level of the "Data Enable" sig-
nal.

SCPI command:
:BERT:SETup:DENable on page 521

Pattern Ignore
Activates/deactivates ignoring of pure "0" or "1" bit sequences at least 32 bits long. Acti-
vating "Pattern Ignore" excludes faulty frames from the measurement.

In the case of some mobile radio standards, pure "0" or "1" bit sequences are generated
when errors (e.g. an incorrect checksum) are detected within a frame. These sequences,
instead of the frame data, are provided for the BER measurement and signal that the
frame in question should not be used for the measurement.

The R&S Signal Generator ignores sequences of 32 bits or longer.

Note: While ignoring the bits, the PRBS generator for the BER measurement keeps run-
ning. Following the "0" or "1" sequence, the BER measurement is continued as if the
ignored sequence had contained PRBS data.

If "Pattern Ignore" is switched on, synchronization time is 32 bits longer.

If "Pattern Ignore" and "External Restart" are active at the same time, the measurement
terminates immediately when the restart signal is applied. None of the 32 bits within the
"Pattern Ignore" detector is evaluated.

If "Data Enable" and "Pattern Ignore" are active at the same time, "Data Enable" is given
priority, i.e. bits that are not enabled are not examined for "0" or "1" sequences.
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Example:

50 bits were set to "0" by the DUT. These 50 bits plus the preceding "0" are ignored in
the bit error rate measurement.
Drop Outof OUT

e o

[ I
PRBES & Generator -—-== |
[ 1

PRES 2 OUT Output - I
(M _ |
BER "actie" ! 50 Bits |
—_— —
. J
I 1

Thessa bits are ingored

"Off" Pattern Ignore is not active.

"All 1" Bit sequences consisting of 32 or more consecutive "1" data are not used
(i.e. ignored) for the BER measurement.

"All 0" Bit sequences consisting of 32 or more consecutive "0" data are not used
(i.e. ignored) for the BER measurement.

SCPI command:
:BERT:SETup: IGNore on page 522 :BERT : SETup: DENable on page 521

4.4.11 Block Error Rate Menu

Bit Error Rate... The "Block Error Rate" menu for configuring the block error rate measurement is called
SeckSILEEEL]  either in the "BERT" function block or via the MENU button under "BERT."

The top section of the "Block Error Rate" menu is used to switch on the block error rate
measurement and display the results and current status of the measurement.

& Block Error Rate E| |§| §|
s _ o |
Block Error Rate 0.00 E-12 IENG |

Received Blocks I o
Errors I 0

Terminated By User
State: NO CLOCK NO DATA NO SYNC

The "Configuration" section is used to select the type of measurement and the termination
criteria and to set the polarity of the input signals.
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—————————Configuration————
Mode|single - | Execute Single |
Max. Received Blocks [ 100000
Max. Errors 100

BLER Type ICRC 16 vl
CRC Order ILSBﬁrst vl

Data Polarity Norm -
Clock Slope Pos -
Data Enable Low i

Threshold {BER) I 1.00 I\.l’ vl
Impedance (BER) |1 k() GND vl

44111 General Settings

State
Switches the block error rate measurement on/off.

Depending on the setting in the "Mode" box, either a continuous measurement ("Auto")
or a single measurement ("Single") is carried out. A single measurement must be started
by clicking the "Execute Single" button.

SCPI command:
:BLER:STATe on page 525

Block Error Rate
Displays the measured block error rate.

The block error rate is the ratio of faulty blocks to total blocks.
The display unit can be selected in the box to the right of the value.

"ENG" The block error rate is output in exponential notation with the exponent
-3 or —6.

"SCI" The block error rate is output in scientific notation, i.e. standardized to
one place to the left of the decimal.

"%" The block error rate is output in percent.

"opm" The block error rate is output in parts per million.

SCPI command:
:BLER:UNIT on page 526

Received Blocks
Displays the current number of data blocks checked.

SCPI command:
:BLER:RESult on page 517

|
Operating Manual 1007.9845.32 — 16 185



R&S®SMU200A Instrument Function

Bit and Block Error Rate Measurements - BERT Block

Errors
Displays the current number of occurred errors.

SCPI command:
:BLER:RESult on page 517

Terminated By
Displays the termination criterion for the measurement.

These criteria can be entered to keep the duration of the measurement short for low as
well as high block error rates.

The last measurement result is displayed after the measurement has been terminated.

"User" The measurement was manually terminated by the user switching the
state to off.

SCPI command:
:BLER:STATe on page 525
:BLER:STOP on page 526

"Number of The measurement was terminated because the specified number of data
Data Blocks" blocks was reached.

"Number of The measurement was terminated because the specified number of
Errors" errors was reached.

SCPI command:
:BLER:RESult on page 517

State
Displays the status of the measurement.

A green LED indicates a correct status, a red LED a critical status.

This allows the user to check whether the measurement functions. The status of the data
and clock lines and of synchronization is checked and displayed.

If a faulty status is displayed, the signals can be checked at the BERT interface using an

oscilloscope.
"Clock" The applied clock signal was detected.
"No Clock" The applied clock signal was not detected.

Possible causes are:

e Clock recovery is not available (e.g. with tests of RF components).
If the signal is generated using the instrument family, the bit clock
can be extracted from the CLOCK output connector (only with "Cus-
tom Dig Mod" signals in realtime). If signals complying with other
digital standards are generated or if ARB waveforms are used, a
marker signal can be used as a clock. As the DUT causes a delay,
the ratio of clock-to-data travel times must always be taken into
account and checked with an oscilloscope if necessary.

e The wrong impedance for the applied clock rate was selected (see
"Impedance" parameter).

e The wrong threshold for the applied clock signal was selected (see
"Threshold" parameter).
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"Data" The applied data signal was detected.
"No Data" The applied data signal was not detected.
Possible causes are:
e The signal from the DUT is missing.

e The wrong impedance for the applied clock rate was selected (see
"Impedance" parameter).

e The wrong threshold for the applied data signal was selected (see
"Threshold" parameter)

"Sync" The measurement is synchronized.

"No Sync" The measurement is not synchronized.
Generally, a measurement cannot be synchronized until a clock and a
data signal have been detected. If synchronization still does not occur,
this may be caused by the following:

e A wrong clock slope is used, which violates setup or hold times (see
"Clock Slope" parameter).

e Reflections on the clock line occur and clock the data signal into the
BER measurement twice, e.g. on lines without termination. The R&S
Signal Generator input is not terminated.

e The travel times of clock and data are unfavorable (e.g. clock slope
with data change).
Check the relationship of clock to data using an oscilloscope and
optimize the travel times (e.g. clock slope when the data signal
applied is stable).

SCPI command:
:BLER:RESult on page 517

4.4.11.2 Configuration

The "Configuration" section is used to select the type of measurement and the termination
criteria and to set the polarity of the input signals.

Mode
Selects the type of measurement: single or continuous measurement.

"Auto" Continuous measurement of block error rate.
If either or both of the termination criteria are met, the current measure-
ment is terminated and immediately a new one is started automatically.
Depending on the settings made, a measurement may take considerable
time. During the first measurement, intermediate results are displayed.
For the measurements that follow, only the final results are shown. The
parameters "Received Blocks" and "Errors" are continuously updated
and indicate the relative values for the measurement in progress.
To start a continuous measurement, use the command :BLER: STARE
on page 525. To stop a measurement, use the command :BLER:
STOP on page 526.
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"Single" Single measurement of bit error rate. The measurement is started by
clicking the "Execute Single" button.
If a measurement is in progress, the current values for "Block Error
Rate", "Errors" and "Received Blocks" are cyclically displayed. The mea-
surement is terminated when either or both of the termination criteria
have been reached. To start a new measurement, the "Execute Single"
button must be clicked again.

SCPI command:
:BLER:SEQuence on page 520
:TRIGger :BLER[: IMMediate] on page 527

Max Received Blocks
Enter the number of transmitted data blocks to be checked before the measurement is
terminated.

This criterion will terminate the BLER measurement after the specified number of data
blocks, even if very few errors or none at all have been detected. With a low number of
block errors, the measurement result may be statistically unreliable.

If the measurement is terminated because the number of data blocks entered here was
checked, "Number of Data Blocks" appears to the right of "Terminated By".

SCPI command:
:BLER:SETup:MCOunt on page 523

Max Errors
Enter the number of block errors to occur before the measurement is terminated.

This criterion terminates the measurement relatively quickly if the error rate is high. The
measurement result is statistically reliable, since many errors were already counted.

If the measurement is terminated because the number of block errors entered here was
reached, "Number of Errors" appears to the right of "Terminated By".

SCPI command:
:BLER:SETup:MERRor on page 523

CRC Order

Selects the byte order of the checksum (CRC).

"LSB" The checksum starts with the least significant byte.
"MSB" The checksum starts with the most significant byte.

SCPI command:
:BLER:SETup:CORDer on page 521

BLER Type
Displays the CRC polynomial used. CCITT CRC 16 : G(x) = x'® + x'2 + x5 + x' is the CRC
polynomial supported.

SCPI command:
:BLER:SETup:TYPE on page 525
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Data Polarity
Sets the polarity of the feedback data blocks.

SCPI command:
:BLER:SETup:DATA[:POLarity] on page 521

Clock Slope

Sets the polarity of the active slope of the feedback clock.
SCPI command:

:BLER:SETup:CLOCk[:POLarity] on page 520

Impedance
Sets the input impedance of the BERT inputs "Clock", "Data", "Data Enable" and
"Restart".

For high clock rates, 50 Ohms should be selected.

SCPI command:
[ :SOURce] : INPut :BERT: IMPedance on page 526

Threshold
Sets high/low threshold in volts for the BERT inputs "Clock", "Data", "Data Enable" and
"Restart".

The variable threshold makes it possible to align the BERT interface with the level of
different signals. In addition, reflections and other interference can be suppressed by
selecting the appropriate threshold.

SCPI command:
[ :SOURce] : INPut : BERT : THReshold on page 527

Data Enable
Sets the polarity of the "Data Enable" signal.

The "Data Enable" signal marks the user data of the signal.
The signal is generated by the DUT and fed in at the "Data Enable" input of the BERT

interface.

"High" If the "Data Enable" signal is at a high level, the data bits at the BERT
data input are interpreted as user data. During a low level of the "Data
Enable" signal, they are interpreted as checksum bits.

"Low" If the "Data Enable" signal is at a low level, the data bits at the BERT

data input are interpreted as user data. During a high level of the "Data
Enable" signal, they are interpreted as checksum bits.

SCPI command:
:BLER:SETup:DENable on page 521

|
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4.5 RF Signal and Analog Modulations - RF Block

4.5.1 Overview of RF Signal

Settings for the RF output signal and analog modulation are made under "RF Signal" and
"Analog Modulations". These settings can be accessed in the block diagram by way of
the "RF/A MOD" function block, or by means of the menu with the same name which is
opened using the MENU key.

i

The function block is available for the basic unit (R&S SMU + frequency option R&S SMU-
B10x) without additional equipment options. An additional frequency option (R&S
SMU-20x) is required for a two-path instrument.

For instruments equipped with one of the frequency options it is possible to install the
option High Power (R&S SMU-B3x options) separately for both RF paths.

4.51.1 RF Output

To activate and deactivate the RF output signal, use one of the following alternatives:

e directly using the TOGGLE ON/OFF key (the function block must be highlighted
beforehand)

e by means of the RF ON/OFF key (the current entry focus is irrelevant)

e by changing the state of the "RF/A Mod" functional block (see "State RF"
on page 191)
e by enabling/disabling the RF in the "Configure" menu of the "RF/A Mod" block.

Both RF output signals are always deactivated in the case of two-path instruments. The
previous state is restored when the signals are reactivated.

The current state of the RF output (activated and deactivated) is indicated in the block
diagram by means of the different block color and the status of the "On" checkbox.

The disconnected connection to the output is additionally shown when the output is
deactivated.

Active analog modulation is also indicated in the block.
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RF/A Mod A
config... || T JaN
d B 5
[~ On [v|

To query the impedance of the RF outputs, use the command : OUTPut<hw>:
TMPedance on page 560.

State RF
Activated/deactivates the RF output by changing the state of the "RF" functional block.

Alternatively, the RF ON/OFF key can be used.
In case of two-path instrument, this affects the selected path.

SCPI command:
:OUTPut<hw>[:STATe] on page 561
:0OUTPut:ALL[:STATe] on page 557

RF Output State
Activated/deactivates the RF output by enabling/disabling the RF in the "Configure" dia-
log of the "RF" block.

RF

Frequency ! Phase...

SCPI command:
:OUTPut<hw>[:STATe] on page 561

4.51.2 Overview of the RF Signal Settings

The CW, Sweep and List modes are available for generating the RF signal.

e CW
The RF signal is generated with the set frequency and level. This is the default mode.

e Sweep
The RF signal is generated as a sweep with the set parameters.
It is not possible to activate frequency, level and LF sweep simultaneously.

e List Mode

The RF signal is generated on the basis of a list of predefined frequency and level
values. The duration of the individual steps can be predefined.

Instruments connected downstream can be taken into consideration when setting the
frequency and level by entering a frequency and/or level offset.

Automatic level control ("ALC") ensures maximum level accuracy, even with 1/Q modu-
lation.

User-specific lists which contain level correction values for any frequency range ("User
Correction") can be created to, for example, compensate the cable attenuation in a test
assembly setup.

|
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The R&S Signal Generator generates the RF signal in unmodulated or analog form. The
signal generator is equipped therefore with the following sources for analog modulations:

e aninternal LF generator
e the external modulation input EXT MOD at the rear of the instrument

An external trigger signal for the analog modulations, the sweeps and the LIST mode can
be provided at the INST TRIG input.

In case of two-path instrument, both paths are triggered separately. The BNC connector
INST TRIG is assigned to Path A, and the pin INST TRIG B of the AUX /O interface is
assigned to Path B.

The input REF IN is used to input an external instrument reference, and the output REF
OUT serves as the output of the reference frequency (internal or external).

The RF signals in the case of two-path instruments are generated independently of each
other. Both RF paths are, however, synchronized to the same reference frequency (inter-
nal or external).

RF Frequency Settings

The value of the RF frequency is displayed in the header of the instrument's display
("Freq"). This field provides the direct input of the RF frequency.

IFrqu | hoo.oo0 000 00 [MHz J

Freq B | 1.000 000 000 00 IGHz -]

Be aware, that there is a difference between the displayed RF frequency in the header
and the RF output frequency set in the "Frequency/Phase" dialog.

RF frequency vs. RF output frequency

The frequency entered and displayed in the frequency field in the header of the display
takes any set frequency offset into consideration, e.g. an offset set for a downstream
instrument. This means that with a frequency offset the frequency displayed in the header
does not correspond to the frequency at the RF output, but rather to the frequency at the
output of the downstream instrument.

A set frequency offset is indicated by the "FREQ OFFSET" status message.

This instrument allows the desired frequency at the output of a downstream to be entered
in the frequency field. The R&S Signal Generator changes the RF output frequency
according to the entered offset.

However, the frequency entered and displayed in the "Frequency/Phase" dialog of the
"RF" function block always corresponds to the RF output frequency. Any frequency offset
is not taken into consideration.

The frequency offset is entered in the "Frequency/Phase" dialog. Here it is also possible
to set the frequency without taking the offset into consideration, to set the step width for
the frequency entry using the rotary knob, and to set the phase for the RF output signal.

|
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The correlation between the RF frequency, the RF output frequency and the frequency
offset is as follows:

"Freq" (in header) = "RF output frequency" (Frequency in menu) + "Freq offset" (Offset
in menu)

Frequency offset by the instrument
{.Offset” in the Freguency menu)

L[ *

Frequency at the output of

thﬁt
.I}lauov

) 2 ] the instrument
- i~ | oo _..— M + g
e {,Freq”in the header area
RF output frequency of the screen}

(Frequency” in the Freguency menu)

Configuring RF frequency

To change the RF frequency, press the FREQ key and enter the desired frequency.
Changes to the RF frequency have an immediate effect (without confirmation with the
ENTER key) on the output signal.

In the case of two-path instruments, adjustment of the RF frequency affects the respective
path. To change the RF frequency of the Path B, press the FREQ key again.

RF Freq
Enters the RF frequency, considering the frequency offset.

Note: The SCPI command sets the level of the "Freq" display, i.e. an entered frequency
offset is taken into consideration in the frequency value.

SCPI command:
[ :SOURce<hw>] : FREQuency [ :CW| : FIXed] on page 728

Frequency Menu
The instrument provides an acess to the frequency settings in the combined "Frequency/
Phase" dialog.

To open the"Frequency/Phase" dialog, select "RF/A Mod > Configure > Frequency" or
use the MENU key under "RF/A Mod".

RF ——
+ RF ON
Frequency | Phase...

The "Frequency/Phase" dialog is divided into the several sections.

Frequency and offset of the RF output signal are set in the "Frequency Settings" section
in the upper part of the group menu.

Freguency Settings
Frequency | 1.000 000 000 00 IGHz |

Offset | 0.00 |Hz |
Phase Continuous Frequency Settings
Phase Continuous Active [~ On

|
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"Phase Continuous Frequency Settings" can be activated in the respective section and
are described in chapter 4.5.3.2, "Phase Continuous Frequency Setting", on page 196.

The step width which is used when setting the frequency using the rotary knob (with
"Variation Active On") is set in the "User Variation" section.

User Yariation
Variation Active I

Variation Step | 1.000 000 00 [MHz  ~|

The phase of the output signal can be changed in the "Phase Settings" section. The
"Phase Settings" menu is described in chapter 4.5.3, "Phase Settings", on page 195.

The part concern the settings of the reference oscillator and are described in chap-
ter 4.5.4, "Reference Oscillator", on page 200.

The lower parts concern the settings of the local oscillator (LO) and are described in
chapter 4.5.5, "Local Oscillator - LO Coupling", on page 202.

Frequency Settings

The frequency and offset are set in the top section of the menu.

Frequency - RF Signal

Sets the RF frequency of the RF output connector. The frequency entered and displayed
here corresponds to the frequency at the RF output, i.e. any offset entry is not taken into
consideration.

Note: The SCPI command SOUR: FREQ sets the frequency of the "FREQ" display, i.e.
the frequency containing offset.

SCPI command:
n.a.

Frequency Offset - RF Signal
Sets the frequency offset relative to the RF frequency. The frequency offset of a down-
stream instrument (e.g. a mixer) is entered.

The entry does not change the value of the RF frequency at the RF output. It only changes
the RF frequency displayed in the display header. The value of the RF frequency in the
header corresponds to the frequency at the output of the downstream instrument.

SCPI command:
[ :SOURce<hw>] : FREQuency: OFFSet on page 730
Phase Continuous Frequency Settings

A phase continuous mode can be enabled in the "Phase Continuous Frequency Set-
tings" section (see chapter 4.5.3.2, "Phase Continuous Frequency Setting",
on page 196).

User Variation

If the frequency is set using the rotary knob, the step width is defined in the "User Var-
iation" section.
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RF ——
v RF ON

Frequency / Phase...

RF Signal and Analog Modulations - RF Block

Variation Active - RF Signal
Activates the user-defined step width used when varying the frequency value with the
rotary knob.

"ON" The frequency value set with the rotary knob is varied using the user-
defined step width which is entered under "Variation Step".

"OFF" The frequency value set with the rotary knob is varied in steps of one unit
at the cursor position (standard operating mode).

SCPI command:
[ :SOURce<hw>] : FREQuency: STEP : MODE on page 735

Variation Step - RF Signal

Sets the user-defined step width. This step width is used when entering the RF frequency
using the rotary knob. Frequency variation with this step width must also be activated
with "Variation Active".

SCPI command:
[ : SOURce<hw>] : FREQuency:STEP [ : INCRement ] on page 734

Phase Settings

The phase of the RF output signal can be changed in the "Phase Settings" section of the
"RF Frequency/Phase" menu.

Phase Menu

To open the "Frequency/Phase" menu, select "RF/A Mod" > "Configure" > "Frequency/
Phase" or use the MENU key under RF/A Mod.

Phase Settings
Delta Phase | 0.0 |deg =]

Reset Delta Phase Display|

Delta Phase - RF Signal

Sets the phase of the RF signal. The current phase of the signal is used as the reference.
This function allows, for example, the phase of the output signal to be synchronized with
the phase of a signal from a second signal generator.

SCPI command:
[ :SOURce<hw>] : PHASe on page 776

Reset Delta Phase Display - RF Signal
Resets delta phase value. The set phase is adopted as the new current phase, i.e. the
delta phase value is reset to 0.

SCPI command:
[ :SOURce<hw>] : PHASe:REFerence on page 777

|
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Phase Continuous Frequency Setting

The phase continuous mode can be enabled in the "Phase Continuous Frequency Set-
tings" section of the "Frequency" menu. In this mode, the output sinewave is phase con-
tinuous, i.e. there is no phase discontinuity or glitch when changing the frequency.

At the transition from one frequency to another an intermediate frequency (switching
transient) occurs, which causes spurs (see figure below). The transient is due to changes
of the synthesizer settings (e.g. dividers, filters, phase detectors).

Signal - 03.07.2007 17:49:07 TE A:E00,0ps
[ CHL:-z00, OmW +DC

5 Probe:l
- ™ . I N ) CHZ: 5,0V +IC

LY d b " bW Probe:l
o Edgeh: CHZ DC

NEG NORM

Lot
L
|
|t

Cursor 1:
CHL:-Z1,6Z5ul
CHZ:Z , 83FW

Cursor Z:
CH1:378, 375mW
CHZ:Z,832V

Cursor 1-2
CHL:-400, 0nW¥
CHZ:0W

dt:-250, Ops
1/dr:4,0kHz

Fig. 4-7: Transition for a 1 kHz step at 1 GHz without phase continuous mode active. For the graphical
display the signal is down converted into the kHz range.

The phase continuous mode freezes the settings of the synthesizer (e.g. dividers, filters,
phase detectors) which could generate phase discontinuities when changed. The fre-
quency change is effectively performed by changing the fine resolution synthesizer. This
allows a phase continuous change from one frequency to another without any transients
(see figure below).

|
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Fig. 4-8: Transition for a 1 kHz step at 1 GHz with phase continuous mode active. For the graphical
display the signal is down converted into the kHz range.

The available frequency range for phase continuous settings is limited by the fine reso-
lution synthesizer used and varies with the RF frequency setting at the point of activating
the phase continuous mode.

Depending on the instrument equipment - with or without option R&S SMU-B22 - the fine
resolution synthesizer used is a DDS (Direct Digital Synthesizer, with option R&S SMU-
B22) or a Fractional N-Synthesizer (without option R&S SMU-B22). The DDS provides
generally a wider frequency range for phase continuous settings. In addition, two modes
(narrow and wide) allow a selection either in favor of higher signal quality or in favor of
an especially wide frequency range.

@ When phase continuous frequency setting is active, data sheet values no longer apply

Activating frequency or phase modulation deactivates phase continuous settings and vice
versa.

Setting a Phase Continuous Frequency Sweep
1. In the "RF Frequency Sweep" Menu, if the sweep is active, switch it off.

2. Inthe "RF Frequency" Menu under the "Phase Continuous Frequency Settings" dia-
log
a) If the "Phase Continuous Frequency Mode" is Active, switch it off
b) Set "Frequency Range" to “Narrow”
c) Select the RF frequency
d) Check displayed Frequency Range
e) If the "Frequency Range" is corresponds with the selected frequency range,
check the Phase Continuous Active box

|
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f) If "Frequency Range" in Narrow Mode does not, select “Wide” for the Frequency
Range and check the Phase Continuous Active box

3. Inthe "RF Frequency Sweep" dialog

a) Modify the "Start Freq" and "Stop Freq" or "Center Frequency" and "Span" as
needed.
b) Set the RF frequency sweep State to “ON”.

Optimum user settings for the phase continuous frequency sweep

In the "RF Frequency Sweep" dialog there are some settings that will improve the phase
continuous sweep results for both "Narrow" and "Wide" mode choices.

1. "Step Lin": low step size
In order to get the best spur performance during frequency change, it is recommen-
ded to reduce the step size and (if necessary) increase the sweep speed by decreas-
ing the Dwell Time. Effectively, the sweep will be performed in the same amount of
time, but with smaller step sizes.

2. "Shape": Triangle sweep
The triangle sweep offers a uniform forward sweep and return to the beginning fre-
quency. The saw tooth sweep produces a uniform forward sweep with an abrupt reset
to the starting frequency. The abrupt reset can generate spurs.

Phase Continuous Frequency Settings Menu

The "Phase Continuous Frequency Settings" are available in the middle section of the
"Frequency/Phase" dialog.

Phase Continuous Active I
Frequency Range Narrow -

Frequency Range In [HZl:
[ I 998 720 930.23 : 1003 720 93023 |

Phase Conti Frequency Settings

Phase Continuous Active

Activates/deactivates phase continuous frequency settings. For a given RF frequency
setting, phase continuous frequency changes are possible in a limited frequency range.
An overview of the frequency ranges is provides the table in "Frequency Range - RF
Signal" on page 199.

For instrument without option B22:

The range is typically +/-0.5 MHz in the main synthesizer octave of 750 MHz to 1.5 GHz.

Note: If "Phase Continuous" is "Active" a setting of the "RF Frequency" outside the avail-
able "Frequency Range" causes an error. A settings conflict is displayed.

For instrument with option B22:

The frequency range is indicated in the table table in section "Frequency Range - RF
Signal" on page 199. The range indication is active even if phase continuous frequency
setting is not yet activated. Thus, the desired range can be determined before activating
the function. Two modes are available.

|
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Note: If "Phase Continuous" is "Active" a setting of the "RF Frequency" outside the indi-
cated "Frequency Range" is only possible for mode Wide. A settings conflict is displayed.

SCPI command:
[ : SOURce<hw>] : FREQuency: PHASe : CONTinuous: STATe on page 732

Frequency Range - RF Signal
(instruments with R&S SMU-B22 option only)

Selects the mode for determining the frequency range for the phase continuous signal.

The frequency range depends on the selected mode.

RF frequency Typ . range without Range with R&S SMU- | Range with R&S SMU-
[MHZ] R&S SMU-B22 B22 Narrow mode B22 Wide mode
f<=6.6 125 kHz 625 kHz 2.5 MHz

6.6 <f<=11.71875 7.813 kHz 39.625 kHz 156.25 kHz
11.71875 < f <= 23.4375 | 15.625 kHz 78.125 kHz 312.5 kHz
23.4375 < f <= 46.875 31.25 kHz 156.25 kHz 625 kHz

46.875 < f<=93.75 62.5 kHz 312.5 kHz 1250 kHz
93.75<f<=187.5 125 kHz 625 kHz 2.5 MHz
187.5<f<=375 250 kHz 1250 kHz 5 MHz

375 <f<=750 500 kHz 2.5 MHz 10 MHz

750 < f <= 1500 1 MHz 5 MHz 20 MHz

1500 < f <= 3000 2 MHz 10 MHz 40 MHz

3000< f <= 6000 4 MHz 20 MHz 80 MHz

"Narrow"

The available frequency range is smaller than with setting wide. It is
asymmetrical around the RF frequency set at the point of activating the
phase continuous settings (see table above).

In the narrow mode, a DDS frequency of 15 MHz to 20 MHz is used as
reference signal to the phase detector. This provides a tuning range of
5 MHz in the main synthesizer octave from 750 MHz to 1.5 GHz. When
activating the phase continuous settings, the current setting of the DDS
is anywhere between 15 and 20 MHz, e.g. 17 MHz. Thus, the distribution
around the center frequency most likely is asymmetrical, e.g. - 2 MHz
and + 3 MHz for the 17 MHz. Signal quality is high because the larger
mixing products are filtered by the low-pass filter (IF max. 20 MHz).
The narrow mode is recommended whenever possible due to the better
signal quality (spectral purity).

Itis not possible to set frequencies outside the available frequency range.
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"Wide" The wide mode provides a larger frequency range. The frequency range
is symmetrical around the RF frequency set at the point of activating the
phase continuous settings (see table above).

Due to an additional divider by 8 in the PLL the signal quality is reduced
in this mode. At some frequencies non -harmonics will be present.
Setting frequencies outside the available frequency range is possible,
however, a settings conflict is indicated. The usable overrange depends
on the currently set RF frequency, e.g. at 1 GHz it reaches from 850 MHz
to 1030 MHZ.

SCPI command:
[ : SOURce<hw>] : FREQuency: PHASe : CONTinuous :MODE on page 732

Frequency Range in [Hz] - RF Signal
(instruments with R&S SMU-B22 option only)

Displays the frequency range for phase continuous settings. The available frequency
range depends on the mode selection ("Narrow" or "Wide").

The range indication is active even if phase continuous frequency settings are not yet
activated. Thus, the desired range can be determined before activating the function.
SCPI command:

[ : SOURce<hw>] : FREQuency: PHASe : CONTinuous : HIGH on page 731

[ :SOURce<hw>] : FREQuency: PHASe : CONTinuous : LOW on page 731

4,54 Reference Oscillator

In the internal reference mode the internal reference signal is available at the REF
OUT connector. The frequency of the internal reference signal is permanently set to 10
MHz.

The frequency of the internal reference oscillator can be impaired by means of the EXT
TUNE input (AUX 1/Q connector at rear of instrument) (Frequency Adjustment; see data
sheet for technical information).

External impairment is possible in both "Adjustment State" states (On or Off).

In the external reference mode, an external signal with selectable frequency and defined
level must be input at the REF IN connector. This signal is output at the REF OUT con-
nector. The "EXT REF" status message appears in the display header.

The reference frequency setting is effective for both paths.

\ The settings of the reference oscillator are not influenced by an instrument preset
/ ("PRESET" key).

4.541 Reference Oscillator Dialog

RF To open the "Reference Oscillator" dialog, select "RF/A Mod > Configure > Reference

v RFON Oscillator" or use the MENU key under "RF/A Mod".

Frequency | Phase...

|
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The reference oscillator is set in the lower area of the group menu "Frequency/Phase".
The upper areas are for setting the frequency and phase of the RF output signal. For
more information, see chapter 4.5.2.3, "Frequency Menu", on page 193 and chap-

ter 4.5.3, "Phase Settings", on page 195 respectively.

The menu is used to select the source, to enter the frequency of an external reference
signal and to adjust the reference frequency.

External Reference Frequency

Source I External j

Deactivate RF Qutput (if external reference is missing) ¥ On

External Reference Frequency |10 MHz j

Synchronisation Bandwidth IWide ~|
Adjustment

Adjustment Active Il

Adjustment DAC Value | 1400

Source - Reference Oscillator
Selects the source of the reference frequency.

"Internal” The internal reference signal of 10 MHz is used, comprising either the
calibrated or a user-defined adjustment value.

"External” An external reference signal is used. The frequency of the external ref-
erence signal must be selected under "External Reference Frequency".

SCPI command:
[:SOURce] :ROSCillator:SOURce on page 792

Deactivate RF Output - Reference Oscillator
Determines if the RF output is switched off in case of a missing external reference signal
for selection external source.

If enabled, this setting ensures that no improper RF signal due to the missing external
reference signal is output and used for measurements.

In addition to the error message "Ext Ref missing", the information "RF output deactiva-
ted" is indicated.

This setting is not influenced by a reset.

SCPI command:
[:SOURce] :ROSCillator:EXTernal :RFOFf: STATe on page 790

External Reference Frequency
Selects the frequency of the external reference signal. An external reference signal with
a frequency of 5 MHz, 10 MHz or 13 MHz can be used.

SCPI command:
[:SOURce] :ROSCillator:EXTernal : FREQuency on page 790

Synchronization Bandwidth - RF Signal
(Source External only)
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Selects the synchronization bandwidth for an external reference signal. The wideband
setting is provided for using very good reference sources of high spectral purity.

"Narrow" Synchronization bandwidth is 1 Hz.
"Wide" Synchronization bandwidth is 750 Hz.

SCPI command:
[:SOURce] :ROSCillator:EXTernal:SBANdwidth on page 791

Adjustment Active - Reference Oscillator
Selects adjustment mode.

"OFF" The calibrated adjustment value of the internal reference frequency is
used. This value is determined at one of the R&S service shops during
calibration.

"ON" A user-defined adjustment value is used. The value is entered under
"Adjustment DAC Value".

This allows the frequency to be impaired freely, for example to simulate
a frequency error.

The instrument is no longer in the calibrated state. However, the cali-
bration value is not changed and the instrument resumes the calibrated
state after switching the "Adjustment State" to Off.

SCPI command:
[:SOURce] :ROSCillator[:INTernal] :ADJust[:STATe] on page 792

Adjustment DAC Value
Enters a user-defined adjustment value for the internal reference frequency. This value
is not used unless "Adjustment Active On" is selected.

SCPI command:
[:SOURce] :ROSCillator[:INTernal] :ADJust:VALue on page 791

4.5.5 Local Oscillator - LO Coupling

The LO Coupling function allows a distribution of the local oscillator signal in way that
multiple RF signals can be driven by the same LO signal. This is mandatory for minimizing
the phase drift between these RF signals.

The LO Coupling function is available only for instruments equipped with the option R&S
SMU-B90 (Phase Coherence).

The local oscillator signal is available at the LO OUT connector (rear of instrument).

In the external local oscillator mode, an external signal must be input at the LO IN con-
nector.

4.5.5.1 Phase Coherence

Phase coherence of two RF signals means that there is a defined and stable phase rela-
tionship between two (or more) RF carriers, i.e. there is a fixed delta phase A® between
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the carriers. Strictly speaking, phase coherence is only defined for CW carriers with the
same frequency (or for CW carriers at frequencies that are multiples of each other).

(|
I
|

)

RF 1

|
I "t
Lo

Lo

- RF 2

[ \/ Ll

2

If two signal generators are coupled via their 10 MHz reference, they are generating

exactly the same frequency but only from the long term perspective. Having a closer look

into the instantaneous differential phase (“delta phase”) of these two RF signals, this is

quite instable due to:

e phase noise of the two synthesizers

e “weak” coupling at 10 MHz and a long synthesis chain up to the RF domain

e temperature differences which cause a change of the effective electrical length of
some synthesizer components

Most critical for a stable delta phase is the thermal RF phase drift between multiple RF
synthesizers. This drift can be minimized down to 0.1° by use of a common synthesizer,
i.e. a common local oscillator (LO) signal, for all RF carriers. Only if this LO signal (which
is internally used for upconverting the baseband signal to the RF) is the same for all
carriers, a stable phase between the RF signals can be achieved.

4.5.5.2 Typical Applications

The LO Coupling function can be used to generate a MxN MIMO signal.
e Generation of 2xN MIMO signal with two R&S Signal Generators, working in External

mode.
LO N/ \_|_,J Lo ouT LO N '«.,t’ L_ALOouUT
3 Signal Generator 1 1 RE&S Signal Generator 2
Synih A = 10 Mod A Synth A 10 Mod A
E0UR: FREQ: LOSC i MODE INT S0UR: FREQ: LOSC:MODE EXT
SOUR: FREQ :: LOSC :QOUTP: 5TAT QN

e Generation of 2xN MIMO signal with one R&S Signal Generator, working in Coupled
A->B mode.

|
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LOIN_/ ki;u:lc:l_rr
[

R&S Signal Generator
Synth A | 10 Mod A
Synth B L IO Mod B
SOUR:FEEQ :: LOSC i MODE COUEP

e Generation of 4xN MIMO signal with two R&S Signal Generators, R&S Signal Gen-
erator 1 working in Coupled A->B mode and R&S Signal Generator 2 working in
External Coupled A->B mode.

LOINy Lo ouT LO IN\i,J v ALOOUT
A I
RA&S Signal Generator 1 R&S Signal Generator 2
Synth A = 110 Mod A Synth A | 10 Mod A
Synth B L /O Mod B Synth B L /0 Mod B
SOUR: FREQ: LOSC :MODE COUP SOUR:FREQ:LOSC:MODE ECO

SOUR:FREQ:LOSC:QUTE: STAT ON

4.5.5.3 LO Coupling Menu

RF

L rron To open the "LO Coupling" menu, select "RF/A Mod > Configure > LO Coupling" or use
Frequency /Phase... the MENU key under "RF/A Mod".

The menu is available only for instruments equipped with the option R&S SMU-B90.
This option enables phase coherent RF outputs of two or more RF paths.

The local oscillator coupling is set in the lower area of the group menu "Frequency/
Phase". The menu is used to select the mode of the LO coupling and the state of the local
oscillator output.

For more information about the upper areas, see:

e chapter 4.5.2.3, "Frequency Menu", on page 193

e chapter 4.5.3.1, "Phase Menu", on page 195

e chapter 4.5.4.1, "Reference Oscillator Dialog", on page 200

ocal Oscillator {L0) Coupling
IMude | External

Out State [On

Mode - LO Coupling
Selects the mode of the local oscillator coupling.

Operating Manual 1007.9845.32 — 16 204



R&S®SMU200A

Instrument Function

"Internal”

"External"

"Coupled A ->
Bll

RF Signal and Analog Modulations - RF Block

This mode corresponds to a normal operation.
The internal local oscillators are used for each RF path.

An external signal is used.

In case of a two-path instrument, the internal local oscillator signal is used
for path B.

Note: Selection of LO Coupling "External" mode, disables all parameters
in the "Frequency/Phase/Ref Osc" menu.
In case of two-path instrument, this affects the same path.

(the parameter is enabled for two-path instruments only)
The local oscillator signal of path A is used also for path B (see also
section chapter 4.5.5.2, "Typical Applications", on page 203).

F RF A

BERT
config...

LO
[T on
BERT
S

Note: Selection of LO Coupling Coupled A->B mode, disables all param-
eters in the Frequency/Phase/Ref Osc menu of the other path.The fre-
quency of path A will be set to the smaller of both frequencies of path A
and B.

|
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"External Cou- (the parameter is enabled for two-path instruments only)

pled A->B"  An external signal is input on the LO IN connector and used for the cou-
pled paths A and B (see also chapter 4.5.5.2, "Typical Applications",
on page 203).

LO N

e

v

—

BERT
config...

LO
[T on
BERT
S

Note: Selection of LO Coupling External "Coupled A->B "mode, disables
all parameters in the "Frequency/Phase/Ref Osc" menu of both paths.

SCPI command:
[ :SOURce<hw>] : FREQuency:L0OSCillator:MODE on page 726

Out State - LO Coupling
Switches on/off the LO output.

"On" The internal local oscillator signal is also available on the LO OUT con-
nector (in order to couple two instruments).
"Off" The LO OUT signal is switched off.

SCPI command:
[ :SOURce<hw>] : FREQuency:LOSCillator:0UTPut:STATe on page 727

NRP-Z Power Viewer

Up to four R&S NRP power sensors can be connected to the generator. The SENSOR
connector for the first R&S NRP power sensor is on the front panel, further R&S NRP
power sensors can be connected via the USB interfaces on the front and rear panel. The
connection via USB requires an USB adapter R&S NRP-Z3 or R&S NRP-Z4. The instru-
ment automatically detetcts connected R&S NRP power sensors and indicates them in
the "NRP-Z Power Viewer" dialog.

The output signals of the two RF signal path with the set RF level as refererence level
can be measured. It is also possible to select any signal source.

The average signal power is continuously measured by the R&S NRP power sensor(s)
and indicated in the "NRP-Z Power Viewer" dialog. The dialog also provides setting the
permanent display of the results in the block diagram.

|
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The signal generator supports the use of R&S NRP power sensors for the acquisition of
level correction data. The acquired level correction data is used to create and activate
lists in which level correction values predefined by the user are freely assigned to RF
frequencies. Correction is performed by the user-defined table values being added to the
output level for the respective RF frequency (see chapter 4.5.9, "User Correction",

on page 220).

Refer to the corresponding R&S NRP-Zxx power sensor manual for detailed information
on the used power sensor.

4.5.6.1 NRP-Z Power Viewer Settings

o #— Toopen the "NRP-Z Power Viewer" menu, select "RF/A Mod > Configure > NRP-Z Power
Frequency.-‘Phése... Viewer" or use the MENU key under "RF/A Mod".

The menu is structured like a table showing the values for sensor 1 in the left "column"
and the values of the second/third sensor in the middle/right "column”. The instrument
detects connected sensors automatically and indicates them in the dialog.

"Sensor 1" is fixed to the sensor on the circled SENSOR socket. If no sensor is connected
to this socket, the fields remain unaccounted. The sensors no. 2 ... 4 represent the sen-
sors at the USB ports, according to the sequence of connection.

Sensor 1 2=

Type |NRPZB1 S/N 900004 INRP-ZE'I S/N 900007

Level (Peak) | -2228 |dBm _|

Level (Avi.) I -52 47 I(IBm j I -70.61 I(IBm j

Show Level Permanent [~ Level Permanent r
Zero | Zero |

Source I RF A j I RF A j

Frequency

Levelofset |Off ~| [ 0.00[aB -| [off ~|[ 0.00[aB -]

Filter IAuto j I 32 IAuto j I 128

Use SParameter [~ SParameter =

Sensor - Power Viewer
Indicates the connector used for the detected sensors. The values listed below belong
to the respective sensor.

In remote control, the sensors are set up using the SENSe commands. The remote mea-
surement is triggered by the READ query which also provides the measurement results.
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The sensor is selected by suffix 1, 2, 3 or 4 in key word SENSe or READ of the command
header.

Suffix 1 denotes the sensor connected to SENSOR, suffix 2 the one at the first USB
interface, and suffix 3 and 4 are assigned to the sensors at the following USB interfaces.
The suffix is identical to the index which is assigned automatically to each sensor upon
connection.

Note: The software version of the connected power sensor can be retrieved by means
of the remote control command : SENS: POW: TYPE?.

Use the "Setup >" chapter 4.2.3.6, "NRP-Z Info/Update", on page 131 dialog to update
the sensor software.

SCPI command:
SENSe<ch>[:POWer] : STATus [ :DEVice] on page 570

Type - Power Sensors
Indicates the type and the serial number of the connected R&S NRP power sensor. The
sensor type is automatically detected.

SCPI command:
SENSe<ch>[:POWer] : TYPE on page 570
SENSe<ch>[:POWer] : SNUMber on page 569

State - Power Sensors
Activates/deactivates level measurement by the power sensor.

The local state is set with the INIT command. Switching the local state off enhances the
measurement performance.

In remote control, the sensors are set up using the SENSe commands. The remote mea-
surement is triggered by the READ query which also provides the measurement results.
The state is not influenced by these commands, measurements results can be retrieved
with local State on or off.

The sensor is selected by suffix 1, 2, 3 or 4 in key word SENSe or READ of the command
header.

Suffix 1 denotes the sensor connected to SENSOR, suffix 2 the one at the first USB
interface, and suffix 3 and 4 are assigned to the sensors at the following USB interfaces.

The suffix is identical to the index which is assigned automatically to each sensor upon
connection.

To query the availability of a sensor at a given connector, use the command
SENSe<ch>[:POWer] : STATus [ :DEVice] on page 570.

SCPI command:
INITiate<ch>[:POWer] :CONTinuous on page 563

Level (Peak) - Power Sensors
With certain power sensors only, e.g. R&S NRP-Z81.

Indicates the measured peak level value with the selected unit.

SCPI command:
READ<ch>[:POWer] on page 564

|
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Level (Avg.) - Power Sensors
Indicates the measured level value with the selected unit.

SCPI command:
READ<ch>[:POWer] on page 564

Unit - Power Sensors
Selects the unit used for result display.

The power sensor provides the measured value in Watt.

In which unit the measured value is indicated is selected here and might be Watt, dBm
or dBuV.

SCPI command:
SENSe<ch>:UNIT[:POWer] on page 571

Permanent Display State - Power Sensors

Activates the permanent indication of the power measurement result in the upper right
corner of the block diagram. The instrument shows the type of sensor, the corresponding
connector, the measurement source and - if set - the offset.

It is possible to switch the permanent display active for several sensors. The instrument
indicates the values of a maximum of two sensors simultaneously, in ascending order of
connected channels. If you activate the display of a third sensor, the instrument fades
out the values of the last highest channel number automatically.

2 [E=] NRP-0815 -3041dBm RFA

3 [c=3] NRP-0815 -30.62dBm RFB

SCPI command:
SENSe<ch>[:POWer] :DISPlay:PERManent: STATe on page 565

Display Priority - Power Sensors
Selects whether the average or the peak power measurement result is indicated when
permanent display is active.

SCPI command:
SENSe<ch>[:POWer] :DISPlay:PERManent:PRIority on page 565

Zero - Power Sensors
Activates the auto zero function.

Zeroing calibrates the external power sensor by adjusting its reading at zero signal power.
For this purpose, the RF power source must be switched off or disconnected from the
sensor (see tips below). R&S power sensors automatically detect the presence of any
significant input power. This aborts zeroing and generates an error message. Zeroing
can take a few seconds, depending on the sensor model; refer to the documentation of
your external power sensor for more information.

Tips for zeroing

Zeroing should be performed:

e During warm-up after switching on or connecting the instrument

e After a substantial change of the ambient temperature

e After fastening the power sensor module to an RF connector at high temperature
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e After several hours of operation

e When very low-power signals are to be measured, e.g. less than 10 dB above the
lower measurement limit.

e Switch off the RF power source for zeroing; do not disconnect it from the power sen-
sor. In this way you will maintain the thermal equilibrium, and zeroing will also com-
pensate for the noise superimposed on the measured signal (e.g. from a broadband
amplifier).

SCPI command:

SENSe<ch>[:POWer] : ZERO on page 571

Source - Power Sensors
Selects the source for measurement.

"RF" Measurement source is the RF signal of the generator. The RF frequency
is used as the measurement frequency of the sensor and the corre-
sponding correction factor is used.

In this mode the RF frequency of the generator is send to the sensor
automatically if changed.

If two sensors are connected, both sensor can be allocated the same
path, e.g. for measurements before and after the DUT.

For single path instruments, only selection RF A is offered.

"User" Measurements source is any freely selectable source. The frequency is
entered manually under frequency (e.g. for measurement of amplifier
gain with 2 sensors).

SCPI command:
SENSe<ch>[:POWer] : SOURce on page 569

Frequency - Power Sensors
Source User only

Enters the frequency for measurement source "User".

SCPI command:
SENSe<ch>[:POWer] : FREQuency on page 568

Level Offset - Power Sensors

Activates and defines a level offset which is added to the measured value. This allows
e.g. an attenuator in the signal path to be taken into account. The offset is always entered
in dB, irrespective of the selected unit for result display.

SCPI command:
SENSe<ch>[:POWer] :OFFSet: STATe on page 569
SENSe<ch>[:POWer] : OFFSet on page 568

Filter Length - Power Sensors
Selects the filter length used for measurement. The filter length is the multiplier for the
measurement time and thus directly influences it.
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The averaging filter is used to reduce fluctuations in the measured result to the extent
desired. Such fluctuations can be caused by inherent noise of the measuring instrument,
modulation of the measurement signal or beats from the superposition of adjacent car-
riers. A more stable display has to be traded off against longer measurements. The mea-
surement result is obtained from a two-stage averaging process.

Note: Longer measurements does not mean that it takes longer to display a new result,
but rather that it takes longer for the result to settle when the power changes.

Measurements are continuously repeated in a predefined time window. The measure-
ment result is obtained by averaging the measured values for the last 2N time windows.
The number N is the filter length, the factor of 2 arises because the output signals from
the microwave detector to suppress low-frequency noise are chopped at the same rate
as the time windows, which means that an independent measured value can only be
obtained from two consecutive values. As the filter length is the multiplier for the time
window it directly influences the measurement time.

The filter length can be selected automatically or can be manually set to a fixed value.
As a preliminary, you should always check if the auto mode is giving satisfactory results
because you will always have to adjust an optimal, manual filter-length setting if the power
is not constant.

Selection "Fixed Noise" is offered for reaching defined measurement accuracy.

"Auto" The filter length is automatically selected and adapted to the currently
measured value. With very high signals the filter length and therefore the
measurement time can be short. With very low signal levels the filter
length and therefore the measurement time is increased in order to
reduce noise. The used filter length is indicated in the field to the right.

"User" The filter length is set manually.
The filter length is entered in the entry window to the right. As the filter
length works as a multiplier for the time window, this results in a constant
measurement time. Values 1 and 2*n are settable.

Note: The time window varies depending on the used sensor. For most
sensors it is fixed to 20 ms. For the R&S NRP-Z81 sensor it is 10 us.
Therefore, the user filter length for the R&S NRP-Z81 has be about 1000
times larger than the filter length for other sensors in order to achieve the
same filtering result.

The "Auto Once" button can be used to search for the optimum filter
length for the current measurement conditions. The found filter length is
indicated in the field to the right.

|
Operating Manual 1007.9845.32 — 16 211



R&S®SMU200A

Instrument Function

45.7

45.71

RF Signal and Analog Modulations - RF Block

"Fixed Noise" The averaging factor is selected so that the sensor's intrinsic noise (2
standard deviations) does not exceed the specified noise content.
The desired noise content is entered in the entry field to the right.
To avoid very long settling times when the power is low, the averaging
factor can be limited with the "Timeout" parameter.

SCPI command:

SENSe<ch>[:POWer] :FILTer: TYPE on page 567

]
SENSe<ch>[:POWer] : FILTer: LENGth:AUTO on page 565
SENSe<ch>[:POWer] : FILTer : SONCe on page 567
SENSe<ch>[:POWer] :FILTer:LENGth[:USER] on page 566
SENSe<ch>[:POWer] : FILTer:NSRatio on page 566
SENSe<ch>[:POWer] : FILTer :NSRatio:MTIMe on page 566

Use SParameter - Power Sensors
Activates the use of the S-Parameters correction data of the connected power sensor.
For sensor with attenuator this checkbox is automatically checked.

Refer to the manual of the connected R&S NRP-Zxx power sensor for a description on
how to use the s-parameters table.

SCPI command:
SENSe<ch>[:POWer] : CORRection:SPDevice: STATe on page 564

Use Sensor for RF Lev. Control - Power Sensors
Enables/disables controlling of the RF level via the power sensor.

SCPI command:
n.a.

RF Level/EMF

Overview RF Level Settings

N\ Message "Level overrange/underrange”

! If this message appears in the status line, the following parameter is in the overrange

(see data sheet):
e the setlevel ("Level")
e the displayed peak envelope power ("PEP") for Digital Modulation or Digital Standard

The correct level setting cannot be guaranteed for the entire frequency range if the set
level is in the overrange/underrange.

The value of the RF level is displayed in the level field in the header of the instrument's
display and the easiest way to set the RF level is to set it directly in this field.

|
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Pepa[ 30.00 dbm ILevAI 20.00 | aBm J

PEPBI 30.00 dBm LexB| 20.00 IdBm 'I

The center line ("Level") and, to the left of this, the peak envelope power ("PEP") of the
modulated RF output signal is displayed in the case of digital modulation or digital stand-
ard.

A two-line display appears in the case of two-path instruments. The frequency and level
of Path A are shown in the top line, and the frequency and level of Path B in the bottom
line.

\ The "Level" display does not consider the power difference between both paths based

/ on unequal steering matrix, i.e. the displayed power level has to be reduced by a special
MIMO Fading Power Correction value (see "MIMO Fading Power Correction - Digital
Impairments - Measurement" on page 319).

Be aware, that there is a difference between the RF level displayed in the header and
the RF output level set in the "Level/EMF" dialog of the "RF" block.

RF level vs. RF output level

The level entered and displayed in the "Level" field takes the offset of any downstream
attenuators/amplifiers into consideration by way of calculation. This means that with a
level offset the level displayed in the header does not correspond to the level at the RF
output, but rather to the level at the output of the downstream instrument.

This allows the desired level at the output of downstream instruments to be entered. The
R&S Signal Generator changes the RF output level according to the set offset.

However, the level entered and displayed in the "Level" menu of the "RF" function block
always corresponds to the RF output level. Any level offset is not taken into consideration.

The level offset is entered in the "Level" menu. Here it is also possible to set the level
without taking the offset into consideration, and to make other settings, such as level
offset, attenuator mode, power-on state.

The correlation is as follows:

"Level" (in header) = "RF output level" (Level in menu) + "Level offset” (Offset in menu)

Level offset by the instrument
{Offset” in the Level menu)

BF 53
’ .
2l -
gy o
il PP ==

@~ | o

Level at the autput

»| Attenuationigain  |—me of the instrument
{Lev® in the header area

RF output level of the screen)
(Amplitude” in the Level menu)

The RF output is protected against overloading by an external signal applied to the RF
output (see "Overvoltage Protection", on page 217).
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Setting the RF level

To change the RF level, press the LEVEL key and enter the desired level. Changes to
the RF level have an immediate effect (without confirmation with the Enter key) on the
output signal.

In the case of two-path instruments, adjustment of the RF level affects the respective
path. To change the RF frequency of the Path B, press the LEVEL key again.

RF Level
Enters the RF level, considering the level offset.

dBm, dBuV, mV and uV can be used as the level units. The 4 unit keys are labeled with
these units.

Note: The SCPI command sets the level of the "Level" display, i.e. an entered level offset
is taken into consideration in the level value.

SCPI command:
[ :SOURce<hw>] : POWer [:LEVel] [ : IMMediate] [ :AMPLitude] on page 782

4.5.7.2 RF Level

S ron #— To open the "RF Level/EMF" dialog, select "RF/A Mod > Configure > Level/EMF" or use
Frequency / Phase... the MENU key under "RF/A Mod".

Reference Oscillator...

LO Coupling...

The combined menu "RF Level / EMF" is divided into the several sections.

The top sections of this dialog provide access to the level settings.

The offset-free level, level offset and level limit are set in the top section of the menu. The
attenuator mode is set in the "Attenuator Settings" section.

The step width which is used when setting the level using the rotary knob (with "Variation
Active On") is set in the "User Variation" section.

&5 RF Level / EMF / ALC / UCOR A A=

Level Seftings———————————————

Amplitude I -30.00 IdBrr‘I vl
Limit I 20.00 IdBrr‘I vl
Offset I 0.00 IdB vl

Attenuator Settings
Mode [Auto ~|
Fixed Range (PEP)In: [ 31.00 .. [ -1.00 dBm
User Variation
Variation Active r

Variation Step I 1.00 IdB vI

The power-on behavior of the instrument and the level display in the display header are
set in the "Power-On / EMF Settings" section (see chapter 4.5.7.3, "Power-On/EMF Set-
tings", on page 217).
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The lower sections provide access to the "Automatic Level Control" settings and to func-
tion User Correction settings. For more information about this functions, see chap-

ter 4.5.8, "Automatic Level Control - ALC", on page 218 and chapter 4.5.9, "User Cor-
rection”, on page 220.

Level Settings

The offset-free level, attenuation mode, level offset and level limit are set in the top section
of the menu.

Amplitude - RF Signal
Sets the RF level of the RF output connector.

The level entered and displayed here corresponds to the level at the RF output, i.e. any
offset entry is not taken into consideration.

Note: The SCPl command [ : SOURce<hw>] : POWer [:LEVel] [ :IMMediate] [:
AMPLitude] sets the level of the "Level" display, i.e. the level containing offset.

SCPI command:
[ :SOURce<hw>] : POWer : POWer on page 786

Limit - RF Signal
Sets the level limit.

The value specifies the upper limit of the level at the RF output connector. A message
appears if an attempt is made to set a level above this limit and the level at the RF output
is confined to the upper limit. However, the level indication is not influenced.

The value is not affected by an instrument preset (PRESET key), *RST and the "Save/
Recall" function. This parameter is influenced only by the Factory Preset and its factory
value is equal to the upper limit.

SCPI command:
[ :SOURce<hw>] :POWer:LIMit [ :AMPLitude] on page 783

Offset (Level) - RF Signal
Sets the level offset relative to the RF level.

The level offset of a downstream instrument (e.g. an attenuator or amplifier) is entered.

The entry does not change the value of the RF level at the RF output. It only changes the
RF level displayed in the display header. The value of the RF level in the header corre-
sponds to the level at the output of the downstream instrument.

SCPI command:
[ : SOURce<hw>] : POWer [:LEVel] [: IMMediate] : OFFSet on page 782

Attenuator Settings
The attenuator mode is set in the Attenuator Settings section.

Attenuator Mode - RF Signal
Sets the attenuator mode at the RF output.

The selection of Normal and High Power is only available when the instrument is equip-
ped with the high-power output option (R&S SMU-B31 or R&S SMU-B36).

|
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"Auto" Standard mode.
The electronically switching attenuator switches with a 5 dB step width
at fixed switching points.
With high-power output option: The entire level range is available. The
level settings are made in the area of the electronically switching attenu-
ator as well as the relay-switched option (longer switchover time, wear).

"Normal" (Option High Power only)
The level settings are made only in the area of the electronically switching
attenuator. The high level ranges are not available.
This setting is wear-free, as the relays are not switched.

"High Power" (Option High Power only)
The level settings are made only in the area of the high-power bypass.
Only the high level range is available. The relays are not switched.

"Fixed" The level settings are made without switching the attenuator and the
relays.
When this operating mode is switched on, the attenuator and the relays
are fixed in their current positions and the resulting variation range is
defined. The range is displayed under "Attenuator Fixed Range".
If automatic level control is activated ("ALC State = On"), the level set-
tings are made without interruption.
If the normal variation range is overranged or underranged, level errors
increase considerably and the warning "Level under/overrange" appears
in the info line. The spectral purity of the output signal decreases with
high attenuation.

SCPI command:
:OUTPut<hw>:AMODe on page 558

Fixed Range (PEP) In

Displays the level range in which the level is set without interruption for the "Attenuator
Mode fixed" setting.

SCPI command:

:OUTPut<hw>:AFIXed:RANGe:UPPer on page 558
:0UTPut<hw>:AFIXed:RANGe:LOWer on page 557

User Variation
If the level is set using the rotary knob, the step width is defined in the "User Variation"
section.

Variation Active - RF Level
Activates the user-defined step width used when varying the level value with the rotary

knob.

"ON" The level value set with the rotary knob is varied using the user-defined
step width which is entered under "Variation Step".

"OFF" The level value set with the rotary knob is varied in steps of one unit at

the cursor position (standard operating mode).

SCPI command:
[ :SOURce<hw>] : POWer: STEP:MODE on page 787
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Variation Step - RF Level
Sets the user-defined step width for entering the RF level using the rotary knob. Level
variation with this step width must also be activated with "Variation Active".

SCPI command:
[ :SOURce<hw>] : POWer:STEP [ : INCRement] on page 787
Overvoltage Protection

The R&S Signal Generator (all frequency options) is equipped against overloading by an
external signal applied to the RF output.

O An R&S SMU with serial number lower than 103001 requires:

/ e additional Option Overvoltage Protection and High Power - R&S SMU-B32 (Path A)
and R&S SMU-B37 (Path B) or

e additional Option Overvoltage Protection -R&S SMU-B30 (Path A) and R&S SMU-
B35 (Path B).

The overload protection is tripped when the power of the external signal becomes too
high. A relay opens and interrupts the connection between the RF output and attenuator.
This condition is indicated in the display header by the "OVERLOAD" status message.

Overvoltage

If an "Overload" status message is indicated in the display header, reset the overload
protection by pressing the RF ON/OFF key.

The RF input is activated when the overload protection is reset.

SCPI command:

:OUTPut<hw>:PROTection:TRIPped on page 561
:0UTPut<hw>:PROTection:CLEar on page 560

:OUTPut<hw>[:STATe] on page 561

4.5.7.3 Power-On/EMF Settings

#—  The power-on behavior of the R&S SMU and the level display in the display header are

+ RF ON

frequency Pnase.. Set in the "Power-On / EMF Settings” section of the "RF Level/EMF/ALC/UCOR" dialog.

Reference Oscillator...
LO Coupling...

To open the "RF Level/lEMF" dialog, select "RF/A Mod > Configure > Level/EMF" or use
the MENU key under "RF/A Mod".

Power-On | EMF Settings

Power-On State IPre\rious Setting vl

Display Level as Voltage of EMF v

Power-On State - RF Signal
Selects the state which the RF output is to assume after the instrument is switched on.

"RF Off" The output is deactivated when the instrument is switched on.
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"Previous Set- When the instrument is switched on, the output assumes the same state
ting" as it had when the instrument was switched off.

SCPI command:
:OUTPut<hw>[:STATe] : PON on page 561

Display Level as Voltage of EMF - RF Level
Activates display of the signal level as voltage of the EMF (no-load voltage). If this setting
is deactivated, the level is displayed as a voltage over a 50 Ohm load (preset state).

SCPI command:
n.a.

4.5.8 Automatic Level Control - ALC

Automatic level control (Automatic Level Control) can be used with almost all applica-
tions, especially 1/Q modulation and amplitude modulation. It only has to be deactivated
for certain settings in the baseband and when 1/Q impairments (Impairments State On)
are activated. This is indicated under the respective function.

The level control status is permanently displayed as a status message in the info line.
| A AltFixed, ALC-On | B: ALC-S&H Info |

In the standard mode, the level control is active to provide the highest level accuracy.

By default, the instrument operates in "Auto" mode and automatically adjusts the level
control to the operating conditions.

Level control can be switched to "Sample&Hold" or "On" for particular applications. The
"Sample&Hold" state (level control Off) is recommended if in CW mode the signal/inter-
modulation ratio is to be improved for multi-transmitter measurements.

If "Sample&Hold" is selected, the level is recalibrated for every level and frequency set-
ting. For this purpose, level control is activated briefly at a defined signal, the level adjuster
is then held at the attained value and level control is activated.

If "On" and "Attenuator Mode Fixed" is selected, the level is recalibrated for every level
and frequency setting.

For this purpose, level control is activated briefly at a defined signal, the level adjuster is
then held at the attained value and level control is activated the uninterrupted level set-
tings are made.

N\ Automatic Level Control is deactivated with pulse modulation!

/ When pulse modulation is activated, the ALC state of the R&S SMU is automatically
changed to "ALC OFF" ("Sample & Hold"). In this state, the ALC loop is opened and the
output level is not regulated but the level modulator is set directly. In order to set the
correct output level, a sample & hold measurement is executed after each frequency or
level setting.

The level is decreased by 30 dB during "Sample&Hold" measurement.
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4.5.8.1 Automatic Level Control Settings

To open the "Automatic Level Control" dialog, select "RF/A Mod > Configure > Automatic
Level Control" or use the MENU key under "RF/A Mod".

RF

+ RF ON
Freguency / Phase...
Reference Oscillator...
LO Coupling...
NRP-Z Power Viewer...
Level | EMF...
. Automatic Level Control.,,
User Correction...

The combined dialog "ALC / UCOR" is divided into the several sections and provides
access to the "Automatic Level Control" settings and to function "User Correction”, see
chapter 4.5.9, "User Correction", on page 220).

The top sections of the dialog provide access to the level and attenuator settings (see
chapter 4.5.7.3, "Power-On/EMF Settings", on page 217 and chapter 4.5.7.2, "RF
Level", on page 214).

External Level Control is possible using R&S NRP power sensors, see chapter 4.5.6,
"NRP-Z Power Viewer", on page 206.

&5 RF Level / EMF / ALC / UCOR A A=l
Automatic Level Control
State Auto A
Search Once | _|
Protect RF Output v
kd
State - ALC

Activates/deactivates internal level control.

Note: Automatic Level Control is deactivated with pulse modulation!. When pulse mod-
ulation is activated, the ALC state of the R&S SMU is automatically changed to "ALC
OFF" ("Sample & Hold"). In this state, the ALC loop is opened and the output level is not
regulated but the level modulator is set directly. In order to set the correct output level, a
sample & hold measurement is executed after each frequency or level setting.

in Auto mode if the level is in the High Power range, i.e. the mechanical relay bypass is
switched.

The level is decreased by 30 dB during "Sample&Hold" measurement.
"Off (Sample & Internal level control is deactivated.

Hold)"

"Auto" Default state. Level control is automatically adapted to the operating
states.

"On" Internal level control is permanently activated.

SCPI command:
[ : SOURce<hw>] : POWer :ALC[:STATe] on page 781
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Search Once - ALC
Manually activates level control briefly to allow the level to be calibrated (the "Sam-
ple&Hold" setting must be selected).

SCPI command:
[ :SOURce<hw>] : POWer :ALC: SONCe on page 781

Protect RF Output - ALC

The signal is attenuated for about 40 dB to protect external devices against internal sig-
nals, if the following prerequisites are fulfilled

e ALC state is On or AUTO

e High-Power Mode is Off

e 1/Q Modulator is On

e Baseband is armed

SCPI command:
:OUTPut<hw>:PROTection:STATe on page 560

User Correction

The "User Correction" function is used to create and activate lists in which level correction
values predefined by the user are freely assigned to RF frequencies. Correction is per-
formed by the user-defined table values being added to the output level for the respective
RF frequency.

With frequencies which are not contained in the list, the level correction is determined by
interpolation of the closest correction values.

The lists are created in the "List Editor". Each listis stored in its own file with the predefined
file extension *. uco. The name of the User Correction file can be freely selected. The
files are loaded from the "Lists..." file manager. Externally created tables with pairs of
frequency and level values can be converted into User Correction files using the import
function. The external files must have the file extension * . txt or *.csv. These file
formats are provided e.g. by the Microsoft Excel program. The separators for table col-
umns and for decimal floating-point numerals can be set. In addition, internally created
User Correction data can be exported into ASCII files using the export function.

The amplitude can also be linearized automatically by means of an R&S NRP power
sensor connected to one of the generator output signals. With the aid of the "Fill with
Sensor" function, a table with correction values for external test assemblies can be auto-
matically determined, e.g. for compensating the frequency response of cables. The User
Correction list with the correction values acquired by the sensor is generated in the "Edit
User Correction List" menu. The correction values can be acquired any time irrespective
of the modulation settings of the generator.

Multi level measurements allow to take into account the changing VSWR for the different
attenuator settings.

If user correction is activated, the "UCOR" display (User Correction) is shown in the
header together with the "Level" display. The RF output level is the sum of both values.

"Level" + "UCOR" = Output level

|
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If activated, user correction is effective in all operating modes.

User Correction Menu

To open the "User Correction" menu, select "RF/A Mod > Configure User Correction" or
use the MENU key under "RF/A Mod".

The combined menu "ALC/UCOR" is divided into the several sections.

The top sections provide access to the level and attenuator settings, see chapter 4.5.7.2,
"RF Level", on page 214, and to the automatic level control settings, see chapter 4.5.8,
"Automatic Level Control - ALC", on page 218.

User Correction Settings

The "User Correction" settings are set in the most lower section of the combined dialog;
this section is used to activate/deactivate user correction, and to create, select and acti-

vate the lists.

B RF Level / EMF / ALC / UCOR A =13

—User Correction Settings

Use Multi Level Correction I

User Correction I 0.00 dB

User Cor. Data... | manual_multi_level
Edit User Cor. Data... |

ImportExport >>> |

State - User Correction
Activates/deactivates user correction.

The "UCOR" status message appears in the frequency and level display.

SCPI command:
[ :SOURce<hw>] : CORRection[:STATe] on page 722

Use Multi Level Correction - User Correction

Activates the use of the multi level correction data (see chapter 4.5.9.3, "Filling the Cor-
rection List with Power Sensor Measurement Data", on page 227) if checked. Otherwise
the Single Level Correction measurement data is used.

SCPI command:
[ : SOURce<hw>] : CORRection:MLEVel : STATe on page 721

User Correction Value - User Correction
Indicates the current value for level correction.

SCPI command:
[ :SOURce<hw>] : CORRection:VALue on page 722

|
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User Cor. Data - User Correction
Calls the "File Select" menu for selecting and creating a list or the "File Manager".

Select User Correction Data
Mew User Correction Data
File Manager...

SCPI command:
[ :SOURce] :CORRection:CSET:DELete on page 716
[ :SOURce<hw>] : CORRection:CSET[:SELect] on page 721

Edit User Cor. Data - User Correction
Calls the editor for editing the selected user correction list.

A list consists of any number of frequency/level value pairs. The currently selected list is
displayed.

Each listis saved as a separate file with extension * . uco. The file name and the directory
to which the file is saved are user-selectable.

Multi level lists which are filled automatically using the Fill with sensor function consist of

nine level columns, one for each attenuator stage (see chapter 4.5.9.3, "Filling the Cor-
rection List with Power Sensor Measurement Data", on page 227).

Note: Save list only after filling both columns (frequency and level), otherwise the entries

are lost.
& Edit User Correction Data A z28-10M_6G_10M-2d EEX)
Frequency / Power / Power [1] @ HP/ Power [2] @ 0 dB/ Power [3] @ 5 dB/
Hz dB dB dB dB
1 10 000 000.00 3.00 3.56 3.51 352
2 20 000 000.00 3.96 352 390 3.96
3 30 000 000.00 4.07 3.79 4.07 4.06
4 40 000 000.00 3.70 3.84 3.73 3.70
5 50 000 000.00 3.38 3.56 335 338
G 60 000 000.00 3.59 3.68 3.58 359
T 70 000 000.00 4.04 4.02 4.06 4.04
i 80 000 000.00 4.06 3.90 4.12 4.15
a 90 000 000.00 3.88 358 382 388
10 100000 000.00 3.64 3.84 3.68 3.63
1 110 000 000.00 379 4.26 3.85 3.79
12 120 000 000.00 417 4.03 4.07 4.16
13 130000 000.00 4.36 358 4.27 4.35
14 140 000 000.00 4.18 394 4,27 4.18
15 150 000 000.00 3.85 4.48 3.96 3.84
16 160 000 000.00 3.91 4.25 3.80 3.90
17 170000 000.00 4.29 3.71 4.15 428 |
< | >
Goto Edit IRIINEAE Save As... | Save |
Sensor

"Frequency/ Enters the frequency to which the level correction value applies.

Hz" Note: The "Fill..." function allows to automatically enter any number of
frequencies with freely selectable range and increment.
Using the "Fill With Sensor" function of the "Edit" sub menu requires only
the entry of the frequency values. The level values are automatically
acquired by the connected power sensor.

|
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"Power / Enters the level correction value to which the specified frequency applies.
Power[1..91 @ The values can be entered manually or automatically with the "Fill With
HP.. 35 dB" Sensor" function (available in the "Edit" sub menu).
"Goto" Selects row for editing.
Goto First
Goto Last
Goto Row...
If Goto row is selected, a window opens for entering the requested row.
OK | Cancel |
"Edit" Calls a selection of possible actions described below.
Insert Row
Insert Range...
Fill...
Fill With Sensor...
Delete Row
Delete Range...
"Insert Row" Insert a new row before the marked row.
"Insert Range" Insert new rows before the marked row. The number of rows to be inser-
ted can be defined in an entry window.
IRows to Insert I I
ok | cancer |
"Fill..." Opens a sub menu for defining a set of list values to be automatically
entered in the ucor list (see chapter 4.5.9.2, "Filling the Correction List
automatically", on page 225).
"Fill With Sen- Calls the menu to activate the filling of the user correction list with level
sor" values acquired by the selected power sensor (see chapter 4.5.9.3, "Fill-
ing the Correction List with Power Sensor Measurement Data",
on page 227).
"Delete Row" Deletes the marked row.
"Delete Allows to delete any number of rows starting with the marked row. The
Range..." number of rows to be deleted can be defined in an entry window.
IRuws to Delete I | I
ok | cancer |
"Save as" Open the file menu to save the list under a new name.

Note: Save list only after filling both columns (frequency and level), oth-
erwise the entries are lost.

Each list is saved to the R&S Signal Generator hard disk as a separate
file with the file prefix * . uco. The file name and the directory to which
the file is saved are user-selectable.
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"Save" The list is saved under its current name.

SCPI command:

[ :SOURce<hw>] : CORRection:CSET[:SELect] on page 721

[ : SOURce<hw>] : CORRection:CSET:DATA: FREQuency on page 714
[ :SOURce<hw>] : CORRection:CSET:DATA: POWer on page 714

Import/Export

User correction list can be imported from externally created files or exported into text or
CSV-files. The import/export settings are available after clicking the "Import/Export" but-
ton.

Import/Export >>>
Expands the menu with the area for import and export of user correction files.

Externally edited Excel tables with any number of frequency/level value pairs can be
imported as text or CSV-files and used for user correction.

Multi level lists which are filled automatically using the "Fill with sensor" function consist
of nine level columns, one for each attenuator stage (see chapter 4.5.9.3, "Filling the
Correction List with Power Sensor Measurement Data", on page 227).

Conversely, you can also export internally created user correction lists as text or CSV-
files.

Hide Tmport/Export

Import / Export List Files

Mode I Import j
ASCIH File Settings

Extension | TXT j

Decimal Point | Point j

Column Separator | Semicolon j
Select ASCll Source | d:testd.txt
Select Destination | d:testd

Import |

Mode - User Correction
Selects if user correction lists should be imported or exported. The settings offered
depend on the selected mode.

SCPI command:
[ : SOURce<hw>] : CORRection:DEXChange :MODE on page 720

Extension - User Correction
Selects the file extension of the ASCII file to be imported or exported. Selection "TXT"
(text file) or "CSV" (Excel file) is available.

SCPI command:
[ :SOURce<hw>] : CORRection:DEXChange:AFILe:EXTension on page 717
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Decimal Point - User Correction
Selects the decimal separator used in the ASCII data between "' (decimal point) and ')’
(comma) with floating-point numerals.

SCPI command:
[ :SOURce<hw>] : CORRection:DEXChange:AFILe:SEParator:DECimal
on page 719

Column Separator- User Correction
Selects the separator between the frequency and level column of the ASCII table the user
correction list is exported to or imported from.

SCPI command:
[ :SOURce<hw>] : CORRection:DEXChange:AFILe:SEParator:COLumn
on page 718

Select ASCII Source / Destination - User Correction
Calls the "File Manager" for selecting the ASCII file to be imported into a user correction
list (source) or the ASCII file the user correction list is exported (destination) in.

SCPI command:
[ :SOURce<hw>] : CORRection:DEXChange:AFILe:SELect on page 718

Destination / Source - User Correction
Calls the "File Manager" for selecting the user correction list to be exported (source) into
an ASCII file or the destination for the ASCII file to be imported (destination) in.

SCPI command:
[ : SOURce<hw>] : CORRection:DEXChange:SELect on page 720

Import / Export - User Correction
Starts the export or import of the selected file.

When import is selected, the ASCII file is imported as user correction list.
When export is selected, the user correction list is exported into the selected ASCII file.

SCPI command:
[ :SOURce<hw>] : CORRection:DEXChange:EXECute on page 719

Filling the Correction List automatically

The "Fill Table" menu enables you to automatically set the level correction values.

|
Operating Manual 1007.9845.32 — 16 225



R&S®SMU200A Instrument Function

RF Signal and Analog Modulations - RF Block

EZ Fill Table

From | 1
Range | 3
Select column to fill | Frequency /Hz j
Start Value | 100 000.00 [Hz |
End Value | 100 000.00 [Hz |
Increment Value | 0.00 Hz ~|

|F Fill I

The start line and the number of rows to be filled are defined under "From" and "Range."

The column to be filled is selected under "Select column to fill". Depending on the selec-
tion here, the default for start, end, and increment value are set. As the settings are
interdependent, a change of one parameter may result in the automatic change of one
or more of the other parameters. The filling of the column with the selected value settings
is started with button "Fill".

@ The correction list entries are only computed when the "Fill" button is pressed.

From
Sets the start value of the index range.

SCPI command:
n.a.

Range
Sets the range for filling the table.

SCPI command:
n.a.

Select column to fill
Selects either the frequency or the level column to be filled with the value defined below.

SCPI command:
n.a.

Start value
Sets the start value for the frequency or the level entries.

SCPI command:
n.a.

End value
Displays the end value for the frequency or the level entries.

SCPI command:
n.a.

Operating Manual 1007.9845.32 — 16 226



R&S®SMU200A

Instrument Function

4.5.9.3

RF Signal and Analog Modulations - RF Block

Increment value
Sets the increment for the frequency or the level entries.

SCPI command:
n.a.

Fill
Fills the selected column in the set range with values, starting with the start value and
using the set increment.

SCPI command:
n.a.

Filling the Correction List with Power Sensor Measurement Data

The level correction values for the user correction list can be acquired by means of R&S
NRP power sensors. The R&S NRP sensors are connected to either the SENSOR con-
nector or to one of the USB interfaces. Configuration of the connection is performed in
the "Power Sensor" menu (see chapter 4.5.6, "NRP-Z Power Viewer", on page 206). The
filling of the ucor list with measurement data is performed in the ucor list editor (see "Edit
User Cor. Data - User Correction” on page 222).

In the editor, the frequencies for which the correction values are to be acquired are
entered in the frequency column (either manually or by means of the "Fill..." menu).

Do not save the list at this point, because the frequency entries are lost as long as there

/ are no entries for the level column also. In the following these entries are automatically

acquired by the connected power sensor.

All level correction values for the given frequency values are measured using the Power
Sensor and automatically filled in the selected list after the "Execute” button is pressed.
The list is automatically stored and recalled again after filling.

Fill User Correction Data with Sensor Settings

The "Fill with Sensor" button of the "Edit User Correction Data" menu opens the associ-
ated menu.

|
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B Fill User Correction Data With Sensor EEIE
Sensor | No Sensors Found J
List To Fill |c:.-"user_corr

Execute

Used SMU Settings For Measurement
RF Source IA J
Modulation |off (cw)

Amplitude | 30.00 [dBm |
Use SParameter | Off
IMuIti Level Measurement & |
Attenuator Mode Path 1 IAutu J
Level Range:[ |-145.00 |dBm | ; [ 20.00 |dBm |

The menu indicates the relevant generator settings.

Fill User Correction Data with Sensor
All settings are read-only, except the "Sensor" and "Multi Level Measurements".

In case more than one sensor is connected to the instrument, the sensor can be selected
in the "Sensor" field of the menu; "Multi Level Correction" can be activated.

The "RF Source" (RF A or RF B) is defined by the path for which the correction menu
settings are made.

The "Execute" button is only enabled if a sensor is detected and the user correction list
contains at least one frequency value.

SCPI command:
[ :SOURce<hw>] :CORRection:CSET:DATA[ : SENSor<ch>] [ :POWer] : SONCe
on page 716

Multi Level Correction

When "Multi Level Correction" is activated, separate measurements are made for the
different attenuator settings up to 35 dB. Thus, the changes in VSWR for the different
settings are taken into account, the level accuracy increases. For ranges from 40 dB on
the changes in VSWR are negligible. The reference level is set internally and cannot be
controlled by the user. The measurement results are entered into additional columns of
the "User Correction” list.

|
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5 Edit User Correction Data A z28-10M_6G_10M-2d [E
Frequency / Power / Power [1] @ HP/ Power [2] @ 0 dB/ Power [3] @ 5 dB/ Power [4] @
Hz dB dB (B dB dB
1 10 000 000.00 353 3.56 3.51 3.52 3.54
2 20 000 000.00 3.96 3.52 3.00 3.96 3.95
3 30 000 000.00 4.07 3.79 4.07 4.06 4.05
4 40 000 000.00 370 384 373 370 372
5 50 000 000.00 338 3.56 3.35 338 342
L3 60 000 000.00 3.59 3.68 3.58 3.59 3.62
T 70 000 000.00 4.04 4.02 4.06 4.04 4.06
3 80 000 000.00 4.15 3.90 4.12 4.15 4.19
q | o
Goto Edit | LRI 1ER Save Bs.. | Save |
Sensor

The Multi Level Correction measurements are made in addition to a Single Level Cor-
rection measurement. When the user correction list is activated, it is possible to select
which of the measurements is to be used for level correction.

Multi Level Values

The measurement values for the different attenuator settings are retrieved separately.
The numeric suffix at MLEV correlates to the index of the column, e.g. suffix 3 denotes
the column with the values for attenuator setting 5 dB.

SCPI command:
[ : SOURce<hw>] : CORRection:CSET:DATA:POWer :MLEVel : STATe on page 716

[ : SOURce<hw>] : CORRection:CSET:DATA: POWer :MLEVel<ch> on page 715

4.5.10 Overvoltage Protection

The R&S Signal Generator (all frequency options) is equipped against overloading by an
external signal applied to the RF output.

M\ An R&S SMU with serial number lower than 103001 requires:
/ e additional Option Overvoltage Protection and High Power - R&S SMU-B32 (Path A)
and R&S SMU-B37 (Path B) or
e additional Option Overvoltage Protection -R&S SMU-B30 (Path A) and R&S SMU-
B35 (Path B).

The overload protection is tripped when the power of the external signal becomes too
high. A relay opens and interrupts the connection between the RF output and attenuator.
This condition is indicated in the display header by the "OVERLOAD" status message.

Overvoltage
If an "Overload" status message is indicated in the display header, reset the overload
protection by pressing the RF ON/OFF key.

The RF input is activated when the overload protection is reset.
SCPI command:

:OUTPut<hw>:PROTection:TRIPped on page 561
:OUTPut<hw>:PROTection:CLEar on page 560
:OUTPut<hw>[:STATe] on page 561
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4.511 Analog Modulations

45111 Overview

The R&S Signal Generator provides the analog modulations amplitude modulation (AM),
broadband amplitude modulation (BB-AM) and pulse modulation (Pulse) for the basic
unit (R&S SMU+ frequency option R&S SMU-B10x) without additional equipment options.

Two-path instruments require a second RF path (R&S SMU-B20x option).

However, the analog modulations frequency modulation (FM) and phase modulation
(PhiM) require option R&S SMU-B20 (FM/PhiM Modulator) or R&S SMU-B22 (FM/PhiM
Modulator and Low Phase Noise).

Settings for the modulation are made in separate modulation menus. These menus can
be accessed in the block diagram by way of the "RF/A Mod" function block, or by means
of the menu with the same name which is opened using the MENU key.

Enabling/Disabling Analog Modulations using the MOD On/Off Key
The MOD ON/OFF key switches the modulations on and off.

MOD ON/OFF
Press the MOD ON/OFF key to enable/disable analog modulations.

In the two-path mode, this key switches all modulations off.

Pressing the key again restores the status that was active before the last switch-off. "MOD
OFF" is displayed in the info line of the header next to the "Level" field.

SCPI command:
[ :SOURce<hw>] :MODulation[:ALL] :STATe on page 775

Modulation Sources

The following modulations use internal and external modulation sources:
e Amplitude modulation

e Pulse modulation

e Frequency modulation

e Phase modulation

Only external modulation sources can be used for a BB-AM.

Internal Modulation Sources

The LF generator is available as internal modulation source. The generator supplies
sinusoidal signals in the frequency range 0.1 Hz to 1 MHz. With pulse modulation, the
sinusoidal signal from the LF generator is formed internally into a rectangular signal used
to actuate the pulse modulator.

With two-path instruments, the frequency settings are always effective for both paths
since an LF generator is available for both paths in the instrument.

The noise generator supplies white noise with selectable bandwidth and level distribution.
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See also chapter 4.5.12.1, "LF Generator Overview", on page 243.

External Modulation Sources

The EXT MOD input at the rear of the instrument is provided as the external modulation
source for amplitude, pulse, frequency and phase modulation. The external signal for
broadband amplitude modulation is fed in via the I-input.

The external modulation signal at the input must have a voltage of Ug =1V (Uggr = 0.707
V)in order to achieve the displayed modulation depth and range. The input voltage should
not exceed 1.1 Vs, otherwise modulation distortions might occur. With external pulse
modulation, the switching point is max. 2.4 V and the voltage at the input should not
exceed 5 V. The maximum modulation frequency is 10 MHz for frequency and phase
modulation.

Simultaneous Operation of Several Modulations or Other Operating Modes

The table shows the modulations and operating modes which can be activated simulta-
neously (+) or which deactivate each other (-).

AM |FM |PhiM |Pulse |BB-AM |l/Q DM |ARB
Amplitude modulation (AM) / + + + - - - -
Frequency modulation (FM) + / - + + + + +
Phase modulation (PhiM) + - / + + + + +
Pulse modulation + + + / + + + +
Broadband AM (BB-AM) - + + + / - - -
Vector modulation (1/Q) - + + + - / - -
Digital modulation (DM) - + + + - - / -
ARB - + + + - - - /

Amplitude Modulation (AM)

An internal or external source can be selected for amplitude modulation. The LF GEN
modulation generator is available as the internal source. The 1/Q modulator is used for
amplitude modulation. Two-tone AM is possible by simultaneously switching on the
external and internal source.

The EXT MOD input connector for external feed of analog modulation signals is at the
rear of the instrument. The coupling mode of the input (AC or DC) can be selected.

It is not possible to use AM simultaneously with:

e broadband AM,

e 1/Q modulation,

e arbitrary waveform generation,

e digital modulation and

e digital standards.

|
Operating Manual 1007.9845.32 — 16 231



R&S®SMU200A Instrument Function
|

RF Signal and Analog Modulations - RF Block

The AM modulation depth is limited by the maximum peak envelope power (PEP).

Amplitude Modulation Menu

To open the "Amplitude Modulation" menu, select "RF/A Mod > Configure > Amplitude
Modulation" or use the MENU key under "RF/A Mod".

Analog Mod
Amplitude Modulation...
Broadband Amplitude Modulation...
Frequency Modulation...
Phase Modulation...
Pulse Modulation...

The middle section of the combined menu "Pulse/Amplitude Modulation/Broadband
AM" provides access to the amplitude modulation settings.

The top section provides access to the pulse modulation settings, see chapter 4.5.11.6,
"Pulse Modulation (PM)", on page 241.

The lower section provides access to the broadband amplitude modulation settings, see
chapter 4.5.11.3, "Broadband Amplitude Modulation (BB-AM)", on page 234.

—— Amplitude Modulation——————————
AM Source IInternaI + External j
AM Depth | 300[% |
AM Sensitivity [ 300 % perVolt
AM External Coupling |AC j
Input Connector EXT MOD
External Input Impedance |5I] 4] j
LFGen Frequency [ 130000 |KkHz |

State

Activates/deactivates AM modulation.

Activation of AM deactivates:

BB AM,

I/Q modulation,

arbitrary waveform generation,
digital modulation and

digital standards.

SCPI command:
[ :SOURce<hw>] :AM: STATe on page 575

AM Source

Selects the source for the AM signal.

"Internal” Selects the internal LF generator as the source for AM modulation.
"External” Selects the external source.

The external signal is input via the EXT MOD connector.
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"Intern + Selects the internal and external source at the same time. This setting
Extern" enables two-tone AM modulation.

SCPI command:
[ : SOURce<hw>] : AM: SOURce on page 575

AM Depth
Sets the modulation depth in percent.

SCPI command:
[ :SOURce<hw>] :AM[ :DEPTh] on page 573

LF Gen Frequency
Sets the frequency of the LF generator.

This setting affects all analog modulations which use the LF generator as the internal
modulation source.

With two-path instruments, the setting affects both paths.

SCPI command:
[ :SOURce] : LFOutput : FREQuency on page 755

AM Sensitivity
(Source External only)

Displays the input sensitivity of the EXT MOD input in %/V.

The modulation depth entered under "AM Depth" is reached with 1 volt modulation of the
input.

SCPI command:
[ : SOURce<hw>] : AM: SENSitivity on page 574

AM External Coupling
(Source External only)

Selects the coupling mode (AC or DC) for external feed.

Note: Coupling for external feed via input EXT MOD can be set independently for all
modulations with external source.

SCPI command:
[ : SOURce<hw>] :AM:EXTernal : COUP1ing on page 574

AM Input Connector
Displays the modulation input. The display only appears in the case of external modula-
tion.

SCPI command:
n.a.

External Input Impendance
(Source External only)

Selects the impedance for external feed via the EXT MOD input.
Selection 50 Ohm and high (>100 kOhm) is available.
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Note: This setting affects all analog modulations which use the external modulation
source.

SCPI command:
[ :SOURce<hw>] : INPut :MODext : IMPedance on page 736

Broadband Amplitude Modulation (BB-AM)

With broadband amplitude modulation the 1/Q modulator is used for amplitude modula-
tion.

Broadband amplitude modulation (BB-AM) is only possible for Path A.

An external source is always used. The modulation input is the I-input of the 1/Q modu-
lator. The sensitivity for broadband amplitude modulation is 0.25V / 100% modulation
depth. It is not possible to set a modulation depth for BB-AM.

It is not possible to use BB-AM simultaneously with:

o AM,

e |/Q modulation,

e arbitrary waveform generation (ARB),
e digital modulation and

e digital standards.

The upper level limit for BB-AM is the same as that for I/Q modulation. PEP is up to 6 dB
above the display value, depending on the modulation depth.

Broadband Amplitude Modulation Menu

To open the "Broadband Amplitude Modulation" menu, select "RF/A Mod > Configure >
Broadband Amplitude Modulation" or use the MENU key under "RF/A Mod".

Analog Mod
Amplitude Modulation...
Broadband Amplitude Modulation...
Frequency Modulation...
Phase Modulation...
Pulse Modulation...

The combined menu "Pulse Modulation/Amplitude Modulation /Broadband AM" provides
access to the Broadband AM configuration in the bottom section.

The top section provides access to the pulse modulation settings; see chapter 4.5.11.6,
"Pulse Modulation (PM)", on page 241.

The middle section provides access to the amplitude modulation settings; see chap-
ter 4.5.11.2, "Amplitude Modulation (AM)", on page 231.

Broadband AM

AM Sensitivity 0.25 Vfor 100% AM

Input Connector 1
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State
Activates/deactivates broadband AM modulation. Activation of broadband AM deacti-
vates AM, I/Q modulation, digital modulation and digital standards.

SCPI command:
[ :SOURce<hw>] :AM:BBANd [ : STATe] on page 573

AM Sensitivity

Displays the input sensitivity of the | IN input in V/100% modulation depth. The input
sensitivity cannot be influenced in the case of broadband AM since it is not possible to
set the range.

SCPI command:
[ : SOURce<hw>] : AM: BBANd: SENSitivity on page 573

Input Connector
Displays the modulation input (I-input connector of the 1/Q modulator).

SCPI command:
n.a.

Frequency Modulation (FM)

Frequency modulation (FM) requires option R&S Signal Generator-B20 (FM/PhiM Mod-
ulator) or R&S Signal Generator-B22 (FM/PhiM Modulator and Low Phase Noise). These
options are available for Path A only.

Aninternal and/or external source can be selected for frequency modulation. The LF GEN
modulation generator is available as the internal source. Two-tone FM is possible by
simultaneously switching on the external and internal source.

The EXT MOD input connector for external feed is at the rear of the instrument. The
coupling mode of the input (AC or DC) and 50 Ohm or high (> 10 kOhm) impedance can
be selected.

Selection between Low Noise mode (with better signal/noise ratio, but reduced setting
range for modulation bandwidth and deviation, see data sheet) and standard mode is
possible (option R&S SMU-B22 only).

It is not possible to use frequency modulation simultaneously with phase modulation.

Frequency Modulation Settings

To open the "Frequency Modulation" menu, select "RF/A Mod > Configure > Frequency
Modulation" or use the MENU key under "RF/A Mod".

Analog Mod
Amplitude Modulation...
Broadband Amplitude Modulation...
Frequency Modulation...
Phase Modulation...
Pulse Modulation...
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The top section of the combined menu "Frequency/Phase Modulation" provides access
to the frequency modulation settings.

The the lower section of the combined menu provides access to phase modulation, see
chapter 4.5.11.5, "Phase Modulation (PhiM)", on page 238

& Frequency f Phase Modulation A

Frequency Modulation————————
FM Source IInternaI + External j
FM Mode | Normal j
FM Deviation | 100000 kHz -]
FM Sensitivity I 100000 Hz/\Volt
AdiustFmOffset |
FM External Coupling IAC j
External Input Impedance |5IJ 0 j
LFGen Frequency | 13.0000 kHz |
State

Activates/deactivates FM modulation.
Activation of FM deactivates phase modulation.

SCPI command:
[ :SOURce<hw>] : FM: STATe on page 725

FM Source
Selects the source for the FM signal.
"Internal” Selects the internal LF generator as the source for FM modulation.
"External” Selects the external source.

The external signal is input via the EXT MOD connector.
"Internal + Selects the internal and external source at the same time.
External" This setting enables two-tone FM modulation.

SCPI command:
[ : SOURce<hw>] : FM: SOURce on page 724

FM Mode

Selects the mode for the frequency modulation.

"Normal" The maximum range for modulation bandwidth and FM deviation is avail-
able.
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"Low Noise"  (requires option R&S Signal Generator-B22)
Frequency modulation with phase noise and spurious characteristics
close to CW mode. The range for modulation bandwidth and FM devia-
tion is reduced (see data sheet).

SCPI command:

[ : SOURce<hw>] : FM: MODE on page 723

FM Deviation
Sets the modulation deviation in Hz.

The deviation is given as the absolute deviation in relation to the set center frequency,
e.g. a deviation 5 MHz at a center frequency of 1 GHz leads to a frequency modulation
between 995 MHz and 1005 MHz.

The maximal deviation depends on the RF frequency set and the selected modulation

mode (see data sheet). It is possible to enter a deviation that is too high for a certain RF
frequency or to vary the RF frequency to a range in which the deviation can no longer be
set. In this case the maximally possible deviation is set and an error message is displayed.

The deviation of the internal source must not exceed the deviation of the external source
in case of modulation source "Int+Ext".

SCPI command:
[ :SOURce<hw>] :FM[:DEViation] on page 723

LF Gen Frequency
Sets the frequency of the LF generator.

This setting affects all analog modulations which use the LF generator as the internal
modulation source.

With two-path instruments, the setting affects both paths.

SCPI command:
[ :SOURce] : LFOutput : FREQuency on page 755

FM Sensitivity

(Source External only)

Displays the input sensitivity of the EXT MOD input in Hz/V.

The modulation depth entered under "FM Depth" is reached with 1 Volt (= U,) of the
input signal.

Note: The input voltage should not exceed 1.1V, otherwise modulation distortions might
occur.

SCPI command:
[ :SOURce<hw>] : FM: SENSitivity on page 724

Adjust FM Offset
Starts the adjustment for the FM/PhiM modulator. The option is adjusted with respect to
DC-offset.

SCPI command:
:CALibration<hw>:FMOFfset[:MEASure] on page 528
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FM External Coupling
(Source External only)

Selects the coupling mode (AC or DC) for external feed.

Note: Coupling for external feed via input EXT MOD can be set independently for all
modulations with external source.

"AC" The d.c. voltage content is separated from the modulation signal.
"DC" The modulation signal is not altered.

SCPI command:
[ :SOURce<hw>] :FM:EXTernal : COUP1ling on page 723

External Input Impendance
(Source External only)

Selects the impedance for external feed via the EXT MOD input.
Selection 50 Ohm and high (>100 kOhm) is available.

Note: This setting affects all analog modulations which use the external modulation
source.

SCPI command:
[ : SOURce<hw>] : INPut :MODext : IMPedance on page 736

4.511.5 Phase Modulation (PhiM)

Phase modulation (PhiM) requires option R&S SMU-B20 (FM/PhiM Modulator) or R&S
SMU-B22 (FM/PhiM Modulator and Low Phase Noise). These options are available for
Path A only.

It is not possible to use phase modulation simultaneously with frequency modulation.

An internal and/or external source can be selected for phase modulation. The LF GEN
modulation generator is available as the internal source.

The EXT MOD input connector for external feed of analog modulation signals is at the
rear of the instrument. The coupling mode of the input (AC or DC) and the impedance
can be selected.

Selection between the following modulation modes is possible:

e "High Bandwidth" mode with full setting range for modulation bandwidth and limited
PhiM deviation.

e "Low Noise" mode with better signal/noise ratio, but reduced setting range for mod-
ulation bandwidth and deviation (see data sheet)

e "High Deviation" mode with full setting range for PhiM deviation and a reduced setting
range for modulation bandwidth. Phase noise is reduced in the lower modulation
frequency range compared to the default mode.
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Phase Modulation Menu

To open the "Phase Modulation" menu, select "RF/A Mod > Configure > Phase Modula-
tion" or use the MENU key under "RF/A Mod".

Analog Mod
Amplitude Modulation...
Broadband Amplitude Modulation...
Frequency Modulation...
Phase Modulation...
Pulse Modulation...

The lower section of the combined menu Frequency/Phase Modulation provides access
to the phase modulation settings.

The upper section provides access to the frequency modulation, see chapter 4.5.11.4,
"Frequency Modulation (FM)", on page 235

Phase Modulation——————————————
®M Source IInternaI + External j
©M Mode | High Bandwidth R
®M Deviation | 1000000 rad -]
DM Sensitivity I 1.000 000 rad per Volt
®M External Coupling IAC j
External Input Impedance ISI] 0 j
LFGen Frequency | 13.0000 [kHz |

State

Activates/deactivates PhiM modulation.
Activation of PhiM deactivates frequency modulation.

SCPI command:
[ :SOURce<hw>] : PM: STATe on page 780

PhiM Source
Selects the source for the PhiM signal.
"Internal” Selects the internal LF generator as the source for PhiM modulation.
"External" Selects the external source.
The external signal is input via the EXT MOD connector.
"Internal + Selects the internal and external source at the same time.
External"

SCPI command:
[ :SOURce<hw>] : PM: SOURce on page 779

PhiM Mode
Selects the mode for the phase modulation.
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"High Band-  The maximum range for modulation bandwidth is available. However,
width" phase noise is increased for low frequencies. The range for PhiM devi-
ation is limited.
This mode is recommended for high modulation frequencies.

"High Devia- The maximum range for PhiM deviation is available. Phase noise is

tion" improved for low frequencies compared to the default mode. The range
for modulation frequency is limited (see data sheet).
This mode is recommended for low modulation frequencies and/or high
PhiM deviation.

"Low Noise"  (with option R&S SMU-B22 only)
Phase modulation with phase noise and spurious characteristics close
to CW mode. The range for modulation bandwidth and PM deviation is
limited (see data sheet).
This mode is useful for generating a tailed CW signal.

SCPI command:

[ : SOURce<hw>] : PM: MODE on page 778

PhiM Deviation
Sets the modulation depth in RAD or degrees.

The maximal deviation depends on the RF frequency set and the selected modulation

mode (see data sheet). It is possible to enter a deviation that is too high for a certain RF
frequency or to vary the RF frequency to a range in which the deviation can no longer be
set. In this case the maximally possible deviation is set and an error message is displayed.

SCPI command:
[ :SOURce<hw>] :PM[:DEViation] on page 777

LF Gen Frequency
Sets the frequency of the LF generator.

This setting affects all analog modulations which use the LF generator as the internal
modulation source.

With two-path instruments, the setting affects both paths.

SCPI command:
[ :SOURce] : LFOutput : FREQuency on page 755

PhiM Sensitivity
(Source External only)

Displays the input sensitivity of the EXT MOD input in RAD/V.

The modulation depth entered under "PhiM Depth" is reached with 1 volt (=U ) of the
input signal.

Note: The input voltage should not exceed 1.1V, otherwise modulation distortions might
occur.

SCPI command:
[ :SOURce<hw>] : PM: SENSitivity on page 779

Mod External Coupling
Selects the coupling mode (AC OR DC) for external feed.
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Note: Coupling for external feed via input EXT MOD can be set independently for all
modulations with external source.

"AC" The DC voltage content is separated from the modulation signal.
"DC" The modulation signal is not altered.

SCPI command:
[ :SOURce<hw>] :PM:EXTernal : COUP1ling on page 778

External Input Impendance
(Source External only)

Selects the impedance for external feed via the EXT MOD input.
Selection 50 Ohm and high (>100 kOhm) is available.

Note: This setting affects all analog modulations which use the external modulation
source.

SCPI command:
[ : SOURce<hw>] : INPut :MODext : IMPedance on page 736

Pulse Modulation (PM)

Pulse modulation is available for the basic unit (R&S SMU + frequency option R&S SMU-
B10x) without additional equipment options.

An additional frequency option (R&S SMU-B20x) is required for a two-path instrument.

An internal or external source can be selected for pulse modulation. A simple rectangular
signal with selectable repetition frequency is available as the internal signal. This signal
is formed from the sinusoidal signal supplied by the LF generator.

The external signal is input via the EXT MOD connector at the rear of the instrument. The
polarity of the external pulse modulation can be selected. If Polarity is set to Normal, the
RF level is ON if the level is HIGH at the modulation input.

\ Automatic Level Control is deactivated with pulse modulation!
/ When pulse modulation is activated, the ALC state of the R&S SMU is automatically

changed to "ALC OFF" ("Sample & Hold"). In this state, the ALC loop is opened and the
output level is not regulated but the level modulator is set directly. In order to set the
correct output level, a sample & hold measurement is executed after each frequency or
level setting.

The level is decreased by 30 dB during "Sample&Hold" measurement.

Pulse Modulation Settings

To open the "Pulse Modulation" menu, select "RF/A Mod > Configure > Pulse Modula-
tion" or use the MENU key under "RF/A Mod".
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Analog Mod
Amplitude Modulation...
Broadband Amplitude Modulation...
Frequency Modulation...
Phase Modulation...
Pulse Modulation...

In the upper section of the menu, the modulation source is selected and the modulation
switched on. The configuration of the selected external and/or internal modulation source
is performed in the lower section of the menu.

The menu varies according to the selected modulation source.

& Pulse / Amplitude Modulation / Broadband AM A (2 ][51[X]

Pulse Modulation
ISnurce | External J
Polarity I Normal j
External Input Impedance ISI] 0 j
State

Activates/deactivates pulse modulation.
Activation of pulse modulation deactivates ALC and power ramping.

SCPI command:
[ : SOURce<hw>] : PULM: STATe on page 789

Source
Selects the source for the pulse modulation signal.

"Internal” Selects the internal source. The LF generator generates a rectangular
pulse with the set frequency.

"External" Selects the external source.
The external modulation signal is input via the PULSE EXT connector.

SCPI command:
[ : SOURce<hw>] : PULM: SOURce on page 789

LFGen Frequency - Pulse Modulation
Sets the repetition frequency of the internal signal.

This setting affects all analog modulations which use the LF generator as the internal
modulation source.

With two-path instruments, the setting affects both paths.

SCPI command:
[ :SOURce] : LFOutput : FREQuency on page 755

External Input Impendance
(Source External only)

Selects the impedance for external feed via the EXT MOD input.
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Selection 50 Ohm and high (>100 kOhm) is available.

Note: This setting affects all analog modulations which use the external modulation
source.

SCPI command:
[ :SOURce<hw>] : INPut :MODext : IMPedance on page 736

Polarity
(External Source only)

Selects the polarity of the modulation signal.
"Normal" The RF signal is On while the level is high at the modulation input.
"Inverted" The RF signal is Off while the level is high at the modulation input.

SCPI command:
[ :SOURce<hw>] : PULM: POLarity on page 789

LF Generator and LF Output - Mod Gen

LF Generator Overview

The internal LF generator is available as the internal source for the analog modulations
AM, FM / PM and Pulse, and also as the signal source for the LF output at the rear of the
instrument.

The frequency setting for the LF generator can be made both in the modulation menus
and in the "LF Output" menu.

A change to the frequency of the LF generator automatically has an effect on modulation
if the LF generator is selected as the modulation source (i.e. "Internal" is selected as
"Source").

With two-path instruments, the frequency setting is always effective for both paths since
an LF generator is available for both paths in the instrument.

The LF Sweep mode is activated in the "LF Sweep" dialog (see chapter 4.5.13.4, "LF
Frequency Sweep", on page 259). "RF frequency" and "RF Level" sweeps are activated
in the respective menus of the RF block.

LF Output

To open the "LF Output" dialog, select "RF/A Mod > Configure > LF Output" or use the
MENU key under "RF/A Mod".

The combined menu "LF Output/LF Frequency Sweep" provides access to the LF output
configuration in the bottom section. The top sections provide access to the LF Sweep
mode settings, see chapter 4.5.13.4, "LF Frequency Sweep", on page 259.
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Output Voltage | 1.000 [V ~|

LFGen Frequency | 13.0000 | kHz ~|

LF Output Menu

State - LF Output
Activates/deactivates the LF output. This setting has no effect on the modulations.

The modulation signal is output at the LF OUTPUT connector of the instrument.

SCPI command:
[ :SOURce] : LFOutput [:STATe] on page 757

Output Voltage - LF Output
Sets the output voltage of the LF output. The entered value determines the peak voltage.

SCPI command:
[:SOURce] : LFOutput :VOLTage on page 762

LF Gen Frequency
Sets the frequency of the LF generator.

This setting affects all analog modulations which use the LF generator as the internal
modulation source.

With two-path instruments, the setting affects both paths.

SCPI command:
[ :SOURce] : LFOutput : FREQuency on page 755

4513 Sweep Mode

4.513.1 Overview

The R&S Signal Generator offers three different sweep types (frequency sweep, level
sweep and LF sweep) to be activated alternatively. Each type has 6 modes which differ
with respect to the sweep cycle mode (continuous, individual and step-by-step) and trig-
gering mode (automatic, internal and external).

@ Sweeps and List mode can not be activated simultaneously, they deactivate each other.

A phase continuous frequency sweep can be generated after activating the phase con-
tinuous mode, see "Setting a Phase Continuous Frequency Sweep" on page 197.
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Setting a sweep

A sweep is set in five basic steps which are shown below taking a frequency sweep as
an example.

1. Set the sweep range ("Start Freq" and "Stop Freq" or "Center Freq" and "Span").
2. Select linear or logarithmic sweep spacing ("Spacing").

3. Set the step width ("Step Lin/Log") and dwell time ("Dwell Time").

4. Activate the sweep ("Mode" to Auto, Single, Step or Extern Single, Extern Step).
5. Trigger the sweep, except for Auto mode ("Execute Single Sweep", Current Fre-
quency or External Trigger Signal).

N\ It is recommended to switch off the GUI update for optimum sweep performance espe-
/ cially with short dwell times (see chapter 4.2.3.4, "Gui Update", on page 130).

4.513.2 RF Frequency Sweep

The dialog is used to activate and configure a sweep for the RF frequency.

To open the "Frequency Sweep" menu, select "RF/A Mod > Configure > RF Frequency

t?ﬁ:‘f::;'s::_ Sweep" or use the menu tree of the MENU key under "RF Signal".

In the top section of the menu, the RF sweep mode is activated and the sweep mode is
selected.

The buttons are used to reset the RF sweep (all sweep modes) or to execute the RF
sweep ("Single" mode).

The sweep range, sweep spacing and dwell time are set in the bottom section.

The sweep range of the RF sweep can be entered in two ways, either by entering the
"Start" and "Stop" value or by entering the "Center" and "Span".

The two sets of parameters influence each other in the following way:

e "Start Freq" = "Center Freq" - "Span"/2

e "Stop Freq" = "Center Freq" + "Span"/2

e "Center Freq" = ("Start Freq" + STOP FREQ)/2

e "Span" ="Stop Freq" - "Start Freq"
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B RE Frequency Sweep A BEE

-

Mode |Auto j

Reset Sweep |

A

StartFreq | 100.000 000 00 [ MHz ~|

Stop Freq |  500.000 000 00 [ MHz ~|

4

Center Freq | 300.000 000 00 [ MHz ~|

4

Span | 400.000 000 00 | MHz ~|

4

Current Freq |  387.000 000 00 | MHz |

Spacing | Linear |
Shape | Sawtooth =]
StepLin |  1.000 000 00 | MHz ~|
Dwell Time | 100 |ms ~|

Global Trigger/Clock Settings... |

User Marker | AUX 110 Settings.. | B

RF Frequency Sweep Settings

State - Frequency Sweep
Activates/deactivates RF sweep mode.

Note: Activating the RF-Sweep mode automatically disables other sweep modes, and
the list mode.
In case of two-path instrument, this affects the respective path.

SCPI command:
[ : SOURce<hw>] : FREQuency : MODE on page 729

Mode - Frequency Sweep
Selects the sweep instrument operating mode and the sweep mode.

"Auto" Sets an automatic repeated sweep cycle. If a different sweep mode was
activated prior to the "Auto" mode, the cycle continues from the current
sweep setting.

The "Reset Sweep" button resets the sweep to the start frequency.

Example:
SOUR: SWE : FREQ:MODE AUTO
TRIG:FSW:SOUR AUTO
SOUR:FREQ:MODE SWE
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"Single" Sets a single sweep cycle. The sweep is triggered by the "Execute Single
Sweep" button.
If a different sweep mode was activated prior to the "Single" mode, the
current sweep is stopped. The "Single" sweep always starts at the start
frequency when triggered.
The "Reset Sweep" button resets the sweep to the start frequency.

Example:
SOUR: SWE : FREQ:MODE AUTO
TRIG:FSW:SOUR SING
SOUR: FREQ:MODE SWE
SOUR: SWE : FREQ: EXEC

"Step" Sets a step-by-step sweep cycle.
If this mode is activated, the cursor moves to the value displayed for
"Current Freq". Any variation to the "Current Freq" value triggers a sweep
step. The step width is set below at entry field "Step Lin" or "Step Log".
If a different sweep mode was activated prior to the "Step" mode, the
current sweep is stopped. The "Step" sweep starts at the current RF

frequency when triggered.
The "Reset Sweep" button resets the sweep to the start frequency.

Example:

SOUR: SWE : FREQ :MODE MAN

SOUR:FREQ:MODE SWE

SOUR:SWE: FREQ:SPAC LIN

SOUR:SWE:FREQ:STEP:LIN 0.5E4

SOUR:FREQ:MAN 1GHz

The value entered with command SOUR: SWE : FREQ: STEP: LIN | LOG
sets the step width.

The value entered with command SOUR: FREQ : MAN has no effect, the
command only triggers the next sweep step. However, the value has to
be in the currently set sweep range (start to stop). In remote control only
a step-by-step sweep from start to stop frequency is possible.
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"Extern Single" Sets a single sweep cycle. The sweep is triggered by an external trigger
signal.
If a different sweep mode was activated prior to the "Extern Single" mode,
the current sweep is stopped. The "Extern Single" sweep always starts
at the start frequency when triggered.
Refer to the description of the rear panel for information about the con-
nectors for external trigger signal input (see chapter 1.2, "Rear Panel
Tour", on page 23).
The BNC connector INST TRIG is provided for Path A, and the pin INST
TRIG B on the AUX I/O interface for Path B.
The "Reset Sweep" button resets the sweep to the start frequency.

Example:

SOUR: SWE : FREQ:MODE AUTO
TRIG:FSW:SOUR EXT
SOUR:FREQ:MODE SWE (External trigger)

"Extern Step" Sets a step-by-step sweep cycle. Each sweep step is triggered by an
external trigger signal (trigger source as described under "Extern Sin-
gle"). The step width is set below at entry field "Step Lin" or "Step Log".
If a different sweep mode was activated prior to the "Extern Step" mode,
the current sweep is stopped. The "Extern Step" sweep always starts at

the start frequency when triggered.
The "Reset Sweep" button resets the sweep to the start frequency.

Example:

SOUR: SWE: FREQ:MODE STEP
SOUR: SWE: FREQ:SPAC LIN

SOUR: SWE:FREQ:STEP:LIN 1MHz
TRIG:FSW:SOUR EXT
SOUR:FREQ:MODE SWE (External trigger)
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"Extern Start/ Sets an automaticly repeated sweep cycle that is started, stopped and
Stop" restartet by subsequent external trigger events.
The first external trigger signal starts the sweep (Start).
The next external trigger signal stops the sweep at the current frequency
(Stop).
The third external trigger signal starts the sweep at the start frequency
(Start).
If a different sweep mode was activated prior to the "Extern Start/Stop"
mode, the current sweep is stopped and the "Extern Start/Stop" sweep
starts at the start frequency when triggered.
The "Reset" button resets the sweep to the start frequency.
Refer to the description of the rear panel for information about the con-
nectors for external trigger signal input.
The external trigger signal is input at the rear of the instrument (BNC
connector INST TRIG).

Example:

SOUR: SWE : FREQ : MODE AUTO
TRIG:FSW:SOUR EAUT
SOUR:FREQ:MODE SWE (External trigger)

SCPI command:

[ :SOURce<hw>] : SWEep [ : FREQuency] : MODE on page 794
:TRIGger<hw>:FSWeep: SOURce on page 819

[ :SOURce<hw>] : FREQuency : MODE on page 729

Execute Single Sweep - Frequency Sweep
Triggers the sweep manually. A manual sweep can only be triggered if "Mode Single" is
selected.

SCPI command:
[ :SOURce<hw>] : SWEep [ : FREQuency] : EXECute on page 794

Reset Sweep - Frequency Sweep
Resets the sweep. The start frequency is set and the next sweep starts from there.

SCPI command:
[ :SOURce<hw>] : SWEep:RESet [ :ALL] on page 802

Start Freq - Frequency Sweep
Sets the start frequency.

SCPI command:
[ : SOURce<hw>] : FREQuency: STARt on page 733

Stop Freq - Frequency Sweep
Sets the stop frequency.

SCPI command:
[ : SOURce<hw>] : FREQuency: STOP on page 734

|
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Center Freq - Frequency Sweep
Sets the center frequency.

SCPI command:
[ :SOURce<hw>] : FREQuency : CENTer on page 726

Span - Frequency Sweep
Sets the span.

SCPI command:
[ :SOURce<hw>] : FREQuency : SPAN on page 733

Current Freq - Frequency Sweep
Displays the current frequency.

If "Step" is set, the frequency for the next frequency step of the sweep is entered here.

SCPI command:
[ :SOURce<hw>] : FREQuency :MANual on page 729

Spacing - Frequency Sweep
Selects linear or logarithmic sweep spacing.

"Linear" With the linear sweep, the step width is a fixed frequency value which is
added to the current frequency. The step width is entered below.

"Logarithmic"  With the logarithmic sweep, the step width is a constant fraction of the
current frequency. This fraction is added to the current frequency. The
logarithmic step width is entered below in %.

SCPI command:
[ : SOURce<hw>] : SWEep [ : FREQuency] : SPACing on page 796

Shape - RF Frequency Sweep
Selects the cycle mode for a sweep sequence (shape).

i
sawlooth shape
slop L e  — — —

frequency - P
-~ -~ o
.’"" .".-' .'"-'
o~ -~ -
.’"’" .'l'" ."'".
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ey

oD trigngle shape
B Lsan oy ",
siart o -
Hsqancy = — — — — —— — — — e = ————
T -
"Sawtooth" One sweep runs from start to stop frequency. Each subsequent sweep

starts at the start frequency, i.e. the shape of the sweep sequence
resembles a sawtooth.
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"Triangle" One sweep runs from start to stop frequency and back, i.e. the shape of

the sweep resembles a triangle. Each subsequent sweep starts at the
start frequency.

SCPI command:
[ :SOURce<hw>] : SWEep [ : FREQuency] : SHAPe on page 796

Step Lin/Log - Frequency Sweep
Sets the step width for the individual sweep steps. This entry is effective for all sweep

modes.

"Step Lin" or "Step Log" is displayed depending on whether "Spacing Lin" or "Log" is
selected.

"Step Lin" With the linear sweep, the step width is a fixed frequency value which is

added to the current frequency. The linear step width is entered in Hz.
SCPI command:
[ : SOURce<hw>] : SWEep [ : FREQuency] : STEP [ : LINear] on page 797
"Step Log" With the logarithmic sweep, the step width is a constant fraction of the

current frequency. This fraction is added to the current frequency. The
logarithmic step width is entered in %.

SCPI command:
[ :SOURce<hw>] : SWEep [ : FREQuency] : STEP: LOGarithmic on page 798

Dwell Time - Frequency Sweep
Sets the dwell time. The dwell time determines the duration of the individual sweep steps.
L

.

| Setting, Dwell time
| time | (effective)
i* N g

Signal Level

T

. Time

Ll }

Ll
-

Dwell Time"
(set by the user)

The "Dwell Time" set by the user is used as the step time of the sweep. The effective net

dwell time is shorter, reduced by the setting time. This setting time may be greater than
the time specified in the data sheet.

Note:

It is recommended to switch off the GUI update for optimum sweep performance espe-
cially with short dwell times (see chapter 4.2.3.4, "Gui Update", on page 130).

SCPI command:
[ :SOURce<hw>] : SWEep [ : FREQuency] : DWEL1 on page 793
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Global Trigger/Clock Settings
Calls the "Global Trigger/Clock Settings" dialog. This dialog is used among other things
for setting the polarity of the active slope of an applied instrument trigger.

In the case of two-path instruments this setting is valid for both paths. It affects the INST
TRIG input (BNC connector at the rear of the instrument, instrument trigger for Path A)
and the INST TRIG B input of the AUX I/O interface at the rear of the instrument, instru-
ment trigger for Path B).

See chapter 4.2.3.10, "Global Trigger/Clock/External Input Settings", on page 135.

User Marker / AUX I/O
Calls the menu for configuring the AUX I/O and user interfaces (see chapter 4.2.3.12,
"User Marker / AUX 1/0O Settings", on page 138).

The pin assignment of the AUX |/O interface is shown in the "User Marker / AUX 1/O
Configuration" menu; the assignment of the USER pins 2...4 and USER 1 BNC connector
can be changed.

With two-path instruments, the current assignment to the respective path is given in
addition to the pin assignment.

RF Level Sweep

To open the "Level Sweep" menu, select "RF/A Mod > Configure > Level Sweep" or use
the MENU key under "RF/A Mod".

RF Level Sweep Settings

The "RF Level Sweep" dialog is used to activate and configure a sweep for the RF level.

In the top section, the Level Sweep is activated and the sweep mode is selected. The
buttons are used to reset the level sweep (all sweep modes) or to execute the level sweep
("Single" mode).

The level range for the sweeps is selected for instruments with Option High Power.

The sweep range, sweep spacing and dwell time are set in the bottom section.

Operating Manual 1007.9845.32 — 16 252



R&S®SMU200A Instrument Function

RF Signal and Analog Modulations - RF Block

B Level Sweep 4 |Z||§|b__(|
Mode I Single 'l

Execute Single Sweep |

Reset Sweep |

Start Level I 3I].I]I]| dBm 'l
Stop Level I -1I].I]I]| dBm VI
Current Levell -3I].I]I]| dBm I

Step I 1.I]I]| dB vl
Dwell Time I 1I].I]| ms 'I

Global Trigger/Clock Settings... |

User Marker { AUX 1O Settings... |

State - Level Sweep
Activates Level Sweep mode.

Note: Activating the RF level sweep mode automatically disables other sweep modes,
and the list mode.
In case of two-path instrument, this affects the respective path.

SCPI command:
[ : SOURce<hw>] : POWer : MODE on page 785

Mode - Level Sweep
Selects the level sweep instrument operating mode and the sweep mode.

"Auto" Sets an automatically repeated sweep cycle. If a different sweep mode
was activated prior to the "Auto" mode, the cycle continues from the cur-
rent sweep setting.

The "Reset Sweep" button resets the sweep to the start level.

Example:
SOUR: SWE : POW: MODE AUTO
TRIG:PSW:SOUR AUTO
SOUR: POW:MODE SWE
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"Single" Sets a single sweep cycle. The sweep is triggered by the "Execute Single
Sweep" button.
If a different sweep mode was activated prior to the "Single" mode, the
current sweep is stopped. The single sweep always starts at the start
level.
The "Reset Sweep" button resets the sweep to the start level.

Example:
SOUR: SWE: POW:MODE AUTO
TRIG:PSW:SOUR SING
SOUR: POW:MODE SWE
SOUR: SWE : POW: EXEC

"Step" Sets a step-by-step sweep cycle.
If this mode is activated, the cursor moves to the value displayed for
"Current Level". Each sweep step is triggered by a variation of the value
in the "Current Level" entry window. The step width is set below at entry
field "Step".
If this mode is activated, the cursor moves to the value displayed for
"Current Level". If a different sweep mode was activated prior to the
"Step" mode, the current sweep is stopped. The step sweep starts at the
current level value.
The "Reset Sweep" button resets the sweep to the start level.

Example:

SOUR: SWE : POW:MODE MAN

SOUR:SWE: POW:STEP 0.5

SOUR: POW:MODE SWE

SOUR:POW:MAN -16

The value entered with command SOUR: SWE : POW: STEP sets the step
width.

The value entered with command SOUR : POW : MAN has no effect, the
command only triggers the next sweep step. However, the value has to
be in the currently set sweep range (start to stop). In remote control only
a step-by-step sweep from start to stop frequency is possible.
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"Extern Single" Sets a single sweep cycle. The sweep is triggered by an external trigger
signal.
If a different sweep mode was activated prior to the "Extern Single" mode,
the current sweep is stopped. The "Extern Single" sweep always starts
at the start level.
Refer to the description of the rear panel for information about the con-
nectors for external trigger signal input (see chapter 1.2, "Rear Panel
Tour", on page 23).
The BNC connector INST TRIG is provided for Path A, and the pin INST
TRIG B on the AUX I/O interface for Path B.
The "Reset Sweep" button resets the sweep to the start level.

Example:

SOUR: SWE : POW:MODE AUTO
TRIG:PSW:SOUR EXT

SOUR: POW:MODE SWE (External trigger)

"Extern Step" Sets a step-by-step sweep cycle. Each sweep step is triggered by an
external trigger signal (trigger source as described under "Extern Sin-
gle"). The step width corresponds to the step width of the rotary knob.
If a different sweep mode was activated prior to the "Extern Step" mode,
the current sweep is stopped. The "Extern Step" sweep always starts at

the start level.
The "Reset Sweep" button resets the sweep to the start level.

Example:

SOUR: SWE : POW:MODE STEP
SOUR:SWE:POW:STEP 0.5
TRIG:PSW:SOUR EXT

SOUR: POW:MODE SWE (External trigger)
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"Extern Start/ Sets an automatically repeated sweep cycle that is started, stopped and
Stop" restartet by subsequent external trigger events.
The first external trigger signal starts the sweep (Start).
The next external trigger signal stops the sweep at the current frequency
(Stop).
The third external trigger signal starts the sweep at the start frequency
(Start).
If a different sweep mode was activated prior to the "Extern Start/Stop"
mode, the current sweep is stopped and the "Extern Start/Stop" sweep
starts at the start frequency when triggered.
The "Reset" button resets the sweep to the start level.
Refer to the description of the rear panel for information about the con-
nectors for external trigger signal input (see chapter 1.2, "Rear Panel
Tour", on page 23).

Example:
SOUR: SWE : POW:MODE AUTO
TRIG:PSW:SOUR EAUT
SOUR: POW:MODE SWE (External trigger)
SCPI command:
[ : SOURce<hw>] : SWEep : POWer : MODE on page 799
:TRIGger<hw>:PSWeep: SOURce on page 821.
[ : SOURce<hw>] : POWer : MODE on page 785

Reset Sweep - Level Sweep
Resets the sweep. The start level is set and the next sweep starts from there.

SCPI command:
[ :SOURce<hw>] : SWEep:RESet [ :ALL] on page 802

Execute Single Sweep - Level Sweep
Triggers the sweep manually. A manual sweep can only be triggered if "Mode Single" is
selected.

Example:
SOUR: SWE : POW: MODE AUTO
TRIG:PSW:SOUR SING
SOUR: POW:MODE SWE
SOUR: SWE : EXEC

SCPI command:
[ : SOURce<hw>] : SWEep: POWer : EXECute on page 799

Start Level - Level Sweep
Sets the start level.

SCPI command:
[ : SOURce<hw>] : POWer : STARt on page 786

|
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Stop Level - Level Sweep

Sets the stop level.

SCPI command:

[ :SOURce<hw>] : POWer: STOP on page 788

Current Level - Level Sweep
Displays the current level.

If "Step" is set, the level for the next level step of the sweep is entered here.

SCPI command:
[ :SOURce<hw>] : POWer : MANual on page 784

Shape - RF Level Sweep
Selects the cycle mode for a sweep sequence (shape).

"Sawtooth" One sweep runs from the start level to the stop level. The subsequent
sweep starts at the start level again, i.e. the shape of sweep sequence
resembles a sawtooth.

"Triangle" One sweep runs from start to stop level and back, i.e. the shape of the
sweep resembles a triangle. Each subsequent sweep starts at the start
level again.

SCPI command:

[ : SOURce<hw>] : SWEep: POWer : SHAPe on page 800

Step - Level Sweep
Sets the step width for the individual sweep steps. This entry is effective for all sweep
modes.

With the level sweep, the logarithmic step width is a constant fraction of the current level.
This fraction is added to the current level. The logarithmic step width is entered in dB.
SCPI command:

[ :SOURce<hw>] : SWEep:POWer: STEP [ :LOGarithmic] on page 801

Dwell Time - Level Sweep
Enters the dwell time and determines the duration of the individual sweep steps.
L

.

| Sefting, Dwell time
| fime | (effective) |
i* it *

Signal Level

r

. Time
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Dwell Time"
(set by the user)
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The "Dwell Time" set by the user is used as the step time of the sweep. The effective net
dwell time is shorter, reduced by the setting time. This setting time may be greater than
the time specified in the data sheet.

Note:
It is recommended to switch off the GUI update for optimum sweep performance espe-
cially with short dwell times (see chapter 4.2.3.4, "Gui Update", on page 130).

SCPI command:
[ :SOURce<hw>] : SWEep: POWer : DWEL1 on page 799

Global Trigger/Clock Settings
Calls the "Global Trigger/Clock Settings" dialog. This dialog is used among other things
for setting the polarity of the active slope of an applied instrument trigger.

In the case of two-path instruments this setting is valid for both paths. It affects the INST
TRIG input (BNC connector at the rear of the instrument, instrument trigger for Path A)
and the INST TRIG B input of the AUX I/O interface at the rear of the instrument, instru-
ment trigger for Path B).

See chapter 4.2.3.10, "Global Trigger/Clock/External Input Settings", on page 135.

User Marker / AUX 1/O
Calls the menu for configuring the AUX I/O and user interfaces (see chapter 4.2.3.12,
"User Marker / AUX 1/0O Settings", on page 138).

The pin assignment of the AUX |/O interface is shown in the "User Marker / AUX 1/O
Configuration" menu; the assignment of the USER pins 2...4 and USER 1 BNC connector
can be changed.

With two-path instruments, the current assignment to the respective path is given in
addition to the pin assignment.

Attenuator Mode - Level Sweep with High Power Option
(High Power Option only)

Sets the ranges of level settings for the level sweep. The sweep is either performed in
the low level (electronically switching attenuator) or in the high level (relay-switched high-
power-bypass) ranges.

Parameter "Attenuator Mode" is only available when the instrument is equipped with the
high-power output option,R&S SMU-B31 or R&S SMU-B36.

Note: An error message is generated and the best possible level is set if the level setting
for the current sweep step is outside the selected range.

"Normal " The level settings for the level sweep are made in the area of the elec-
tronically switching attenuator. The high level ranges are not available.

"High Power " The level settings for the level sweep are made in the area of the option.
Only the high level range is available.

SCPI command:
[ :SOURce<hw>] : SWEep: POWer : AMODe on page 798

|
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4.513.4 LF Frequency Sweep

Sweeps —
RF Frequency Sweep...

The "LF Frequency Sweep" dialog is used to activate and configure a sweep for the LF
frequency.

To open the "LF Frequency Sweep" menu, select "RF/A Mod > Configure > LF Frequency
Sweep" or use the MENU key under "RF/A Mod".

With two-path instruments, the frequency settings are always effective for both paths
since an LF generator is available for both paths in the instrument.

The top sections of the combined menu "LF Output / LF Frequency Sweep" provide
access to the "LF Frequency Sweep" mode settings.

In the top section, the LF Sweep mode is activated and the sweep mode is selected. The
buttons are used to reset the LF sweep (all sweep modes) or to execute the LF sweep
("Single" mode).

The sweep range, sweep spacing and dwell time are set in the bottom of the section.

& LF Frequency Sweep / LF Output E||E|Pg|
LF Frequency Sweep

Mode ISingIe VI

Execute Single Sweep |

Reset Sweep |

Start Freq Imlm
Stop Freq Iwm
Current Freq IWIW
Spacing m
Shape lm
Step Lin Imlm
Dwell Time [ 100]ms ~]

Global Trigger/Clock Settings... |

User Marker / AUX 110 Settings... |

The lower section provides access to the "LF Output" settings, see chapter 4.5.12.2, "LF
Output", on page 243.

State - LF Sweep
Activates LF Sweep mode.

Note: Activating the LF frequency sweep automatically deactivates the list mode, RF
level sweep and RF frequency sweep.
In case of two-path instrument, this affects the respective path.

SCPI command:
[ :SOURce] : LFOutput : FREQuency : MODE on page 756
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Mode - LF Sweep
Selects the Sweep instrument operating mode and Sweep mode.

"AUtO"

"Single"

llStepll

Sets are automatic repeated sweep cycle. If a different sweep mode was
activated prior to the "Auto" mode, the cycle continues from the current
sweep setting.

The "Reset Sweep" button resets the sweep to the start frequency.

Example:

SOUR:LFO: SWE : FREQ:MODE AUTO

TRIGO:SWE:SOUR AUTO

SOUR:LFO:FREQ:MODE SWE

Sets a single sweep cycle. The sweep is triggered by the "Execute Single
Sweep" button.

If a different sweep mode was activated prior to the "Single" mode, the
current sweep is stopped. The "Single" sweep always starts at the start

frequency.
The "Reset Sweep" button resets the sweep to the start frequency.

Example:
SOUR:LFO:SWE:FREQ:MODE AUTO
TRIGO:SWE:SOUR SING
SOUR:LFO:FREQ:MODE SWE
SOUR:LFO:SWE:FREQ:EXEC

Sets a step-by-step sweep cycle. Each sweep step is triggered by a var-
iation of the value in the "Current Freq" entry window.

If this mode is activated, the cursor moves to the value displayed for
"Current Freq". If a different sweep mode was activated prior to the
"Step" mode, the current sweep is stopped. The "Step" sweep starts at
the current LF frequency.

The "Reset Sweep" button resets the sweep to the start frequency.

Example:

SOUR:LFO: SWE: FREQ:MODE MAN
SOUR:LFO:FREQ:MODE SWE
SOUR:LFO:SWE:FREQ:SPAC LIN
SOUR:LFO:SWE:FREQ:STEP:LIN 1E34
SOUR:LFO:FREQ:MAN 12 kHz

The value entered with command
SOUR:LFO:SWE:FREQ:STEP:LIN|LOG sets the step width.

The value entered with command SOUR: LFO: FREQ : MAN has no effect,
the command only sets the next sweep step. In remote control only a
step-by-step sweep from start to stop frequency is possible

|
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"Extern Single" Sets a single sweep cycle. The sweep is triggered by an external trigger
signal.
If a different sweep mode was activated prior to the "Extern Single" mode,
the current sweep is stopped. The "Extern Single" sweep always starts
at the start frequency.
The external trigger signal is input at the BNC connector INST TRIG.
The BNC connector INST TRIG is provided for Path A, and the pin INST
TRIG B on the AUX I/O interface for Path B.
The "Reset Sweep" button resets the sweep to the start frequency.

Example:

SOUR:LFO:SWE: FREQ:MODE AUTO
TRIGO:SWE: SOUR EXT
SOUR:LFO:FREQ:MODE SWE (External trigger)

"Extern Step" Sets a step-by-step sweep cycle. Each sweep step is triggered by an
external trigger signal (trigger source as described under "Extern Sin-
gle"). The step width corresponds to the step width set for the rotary knob.
If a different sweep mode was activated prior to the "Extern Step" mode,
the current sweep is stopped. The "Extern Step" sweep always starts at
the LF start frequency.

The "Reset Sweep" button resets the sweep to the start frequency.

Example:

SOUR:LFO:SWE : FREQ:MODE AUTO
TRIGO:SWE:SOUR EXT
SOUR:LFO:FREQ:MODE SWE (External trigger)
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"Extern Start/ Sets an automatically repeated sweep cycle that is started, stopped and
Stop" restartet by subsequent external trigger events.
The first external trigger signal starts the sweep (Start).
The next external trigger signal stops the sweep at the current frequency
(Stop).
The third external trigger signal starts the sweep at the start frequency
(Start).
If a different sweep mode was activated prior to the "Extern Start/Stop"
mode, the current sweep is stopped and the "Extern Start/Stop" sweep
starts at the start frequency when triggered.
The "Reset" button resets the sweep to the start frequency.
The external trigger signal is input at the BNC connector INST TRIG.

Example:
SOUR:LFO:SWE: FREQ:MODE AUTO
TRIGO:SWE:SOUR EAUT
SOUR:LFO:FREQ:MODE SWE (External trigger)
SCPI command:
[:SOURce] : LFOutput:SWEep [ : FREQuency] : MODE on page 758
:TRIGger<hw>[:SWEep] : SOURce on page 822
[ :SOURce] : LFOutput : FREQuency : MODE on page 756

Execute Single Sweep - LF Sweep
Triggers the sweep manually. A manual sweep can only be triggered if "Mode Single" is
selected.

SCPI command:
[:SOURce] : LFOutput:SWEep [ : FREQuency] : EXECute on page 758

Reset Sweep - LF Sweep
Resets the sweep. The start frequency is set and the next sweep starts from there.

SCPI command:
[ :SOURce<hw>] : SWEep:RESet [ :ALL] on page 802

Start Freq - LF Sweep
Sets the start frequency.

SCPI command:
[:SOURce] : LFOutput: FREQuency: STARt on page 756

Stop Freq - LF Sweep
Sets the stop frequency.

SCPI command:
[ :SOURce] : LFOutput: FREQuency: STOP on page 757

Current Freq - LF Sweep
Displays the current frequency.

|
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If "Step" is set, the frequency for the next frequency step of the sweep is entered here.

SCPI command:
[:SOURce] : LFOutput: FREQuency :MANual on page 755

Spacing - LF Sweep
Selects linear or logarithmic sweep spacing.

SCPI command:
[:SOURce] : LFOutput:SWEep [ : FREQuency] : SPACing on page 760

Shape - LF Frequency Sweep
Selects the cycle mode for a sweep sequence (shape)

f
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"Sawtooth" One sweep runs from start to stop frequency. Each subsequent sweep
starts at the start frequency, i.e. the shape of the sweep sequence
resembles a sawtooth.

"Triangle" One sweep runs from start to stop frequency and back, i.e. the shape of

the sweep resembles a triangle. Each subsequent sweep starts at the
start frequency.

SCPI command:
[:SOURce] : LFOutput:SWEep [ : FREQuency] : SHAPe on page 760

Step Lin/Log - LF Sweep

Sets the step width for the individual sweep steps. This entry is effective for all sweep
modes.

"Step Lin" or "Step Log" is displayed depending on whether "Spacing Lin" or "Log" is
selected.

"Step Lin" With the linear sweep, the step width is a fixed frequency value which is
added to the current frequency. The linear step width is entered in Hz.

SCPI command:
[:SOURce] : LFOutput:SWEep [ : FREQuency] : STEP [ : LINear] on page 760

"Step Log" With the logarithmic sweep, the step width is a constant fraction of the
current frequency. This fraction is added to the current frequency. The
logarithmic step width is entered in %.

SCPI command:
[ :SOURce] : LFOutput:SWEep [ : FREQuency] : STEP: LOGarithmic on page 761

|
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Dwell Time - LF Sweep
Sets the dwell time. The dwell time determines the duration of the individual sweep steps.
3

.
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Dwell Time"
{set by the user)

The "Dwell Time" set by the user is used as the step time of the sweep. The effective net
dwell time is shorter, reduced by the setting time. This setting time may be greater than
the time specified in the data sheet.

Note:

It is recommended to switch off the GUI update for optimum sweep performance espe-
cially with short dwell times (see chapter 4.2.3.4, "Gui Update", on page 130).

SCPI command:

[:SOURce] : LFOutput:SWEep [ : FREQuency] : DWEL1 on page 758

Global Trigger/Clock Settings
Calls the "Global Trigger/Clock Settings" dialog. This dialog is used among other things
for setting the polarity of the active slope of an applied instrument trigger.

In the case of two-path instruments this setting is valid for both paths. It affects the INST
TRIG input (BNC connector at the rear of the instrument, instrument trigger for Path A)

and the INST TRIG B input of the AUX I/O interface at the rear of the instrument, instru-
ment trigger for Path B).

See chapter 4.2.3.10, "Global Trigger/Clock/External Input Settings", on page 135.

User Marker / AUX I/O

Calls the menu for configuring the AUX 1/0O and user interfaces (see chapter 4.2.3.12,
"User Marker / AUX 1/0O Settings", on page 138).

The pin assignment of the AUX I/O interface is shown in the "User Marker / AUX 1/O
Configuration" menu; the assignment of the USER pins 2...4 and USER 1 BNC connector
can be changed.

With two-path instruments, the current assignment to the respective path is given in
addition to the pin assignment.
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4.5.14 List Mode

Similar to a sweep, a series of previously defined frequency and level points is processed
in List mode. In contrast to a sweep, however, a list with freely selectable value pairs
(frequency and level) can be created. The value range for frequency and level covers the
entire configurable value range of the instrument.

N\ List mode and sweeps can not be activated simultaneously, they deactivate each other.

The lists can be created in the "List Editor". Each list is stored in its own file with the
predefined file extension * . 1sw. The name of the list file can be freely selected. The files
are loaded from the "Lists..." file manager. Externally created tables with pairs of fre-
quency and level values can be converted into List files using the import function. The
external files must have the file extension * . txt or * . csv. These file formats are pro-
vided e.g. by the Microsoft®?Excel program. The separators for table columns and for
decimal floating-point numerals can be set. In addition, internally created List data can
be exported into ASCII files using the export function.

The necessary hardware settings are calculated the first time a list is processed. With
long dwell times, this calculation can be performed while the list is being processed; the
entered dwell times are observed. With very short dwell times, calculation of the hardware
settings increases the dwell time for the initial processing cycle; the entered value is only
observed from the second processing cycle onwards. In this case a message appears to
inform the user that there is a deviation between the current and set dwell times. No
further calculations are required after the first run through a list. The current dwell times
will definitely no longer deviate from the set dwell times.

The list is processed from the beginning to the end of the list (modes "Auto", ("Exter-
nal") "Single", ("External") "Step").

45141 List Mode Dialog

o5 To open the "List Mode™ menu, select "RF/A Mod > Configure > List Mode” or use the
MENU key under "RF/A Mod".

The menu is used to activate/deactivate the operating mode List, to create, select and
activate the lists, and to select the trigger mode and the dwell time.

|
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B2 List Mode A

State ort |
Mode | Auto |
Dwell Time | 10.000 | ms ~|
Current Index | 0

Learn List Mode Data |

List Mode Data... | None

Edit List Mode Data... |

List Range In: [ I 0 .. I 01

Global Trigger/Clock Settings... |

User Marker / AUX /0 Settings... |

Import/Export >>=

General Settings

State - List Mode
Activates/deactivates the List mode. The currently selected list is processed.

In case of a new or modified list, the necessary hardware settings are automatically
determined on activation of the list mode. The data determined in this way is stored along
with the list and is available whenever the list is used again.

This means that when activating the list mode, the system checks whether any hardware
settings are present. If so, the list is started immediately, but if not they are automatically
determined (the list is learnt).

A "Learn List Mode Data" button is available for deliberately activating list learning.

Note: Activating the list mode automatically deactivates all sweeps. During list mode the
frequency and level indications do not display the currently set values.

SCPI command:
[ : SOURce<hw>] : FREQuency : MODE on page 729

Attenuator Mode — List Mode with High Power Option
(High Power Option only)

Sets the ranges of level settings for the level sweep. The sweep is either performed in
the low level (electronically switching attenuator) or in the high level (relay-switched high-
power-bypass) ranges.

Parameter "Attenuator Mode" is only available when the instrument is equipped with the
high-power output option,R&S SMU-B31 or R&S SMU-B36.

Note: An error message is generated and the best possible level is set if the level setting
for the current sweep step is outside the selected range.

"Normal " The level settings for the level sweep are made in the area of the elec-
tronically switching attenuator. The high level ranges are not available.
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The level settings for the level sweep are made in the area of the option.
Only the high level range is available.

SCPI command:
[ :SOURce<hw>] : LIST:POWer : AMODe on page 773

Mode - List Mode
Selects the cycle mode of the List mode.

"AUtO"

"Single"

llSteplv

"Extern Single"

"Extern Step"

Cycle from the beginning to the end of the list with automatic restart at
the beginning. If a different mode was activated prior to the Auto mode,
the cycle continues from the beginning of the list. The duration of a list
step is determined by the set dwell time.

Button "Reset" restarts the list at the starting point.

Single cycle from the beginning to the end of the list. If "Single" is
selected, the cycle is not started immediately. The "Execute Single" but-
ton appears under the "Mode" line. The cycle is started with this button.
The duration of a list step is determined by the set dwell time.

Button "Reset" restarts the list at the starting point.

|Ih|ode | Single J
| Execute Single |

Manual, step-by-step processing of the list. Activating "Step" stops the
current list and the cursor moves to the value displayed for "Current
Index". Itis now possible to scroll up and down in the list in discrete steps
by varying the index. The duration of a list step is determined by the time
between two index entries.

Button "Reset" restarts the list at the starting point.

ICurrent Index | 0 I

Single cycle from the beginning to the end of the list as with "Single", but
started by an external trigger.

The external trigger signal is input at the BNC connector INST TRIG.
The BNC connector INST TRIG is provided for Path A, and the pin INST
TRIG B on the AUX I/O interface for Path B.

Button "Reset" restarts the list at the starting point.

Step-by-step cycle using the external trigger signal. Each trigger event
starts a single step. The duration of a list step is determined by the time
between two trigger events.

The external trigger signal is input at the BNC connector INST TRIG.
The BNC connector INST TRIG is provided for Path A, and the pin INST
TRIG B on the AUX /O interface for Path B.

Button "Reset" restarts the list at the starting point.

SCPI command:
[ :SOURce<hw>] : LIST :MODE on page 772
[ :SOURce<hw>] :LIST:TRIGger: SOURce on page 775
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Execute Single - List Mode

Triggers the list manually. This button is available only if mode "Single" is selected.
SCPI command:

[ :SOURce<hw>] :LIST:TRIGger:EXECute on page 774

Reset - List Mode

Resets the list to the starting point.

SCPI command:

[ :SOURce<hw>] : LIST:RESet on page 774

Dwell Time - List Mode
Enters the dwell time. The dwell time determines the duration of a list step in list operating

modes "Auto", "Single" and "Extern Single". In these modes a complete list is processed
either once or continuously.

In list operating modes "Step" and "Extern Step", the set dwell time does not affect signal

generation. In this case, the duration of a list step is determined by the time between two
(internal or external) trigger events.

1
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| Sefting, Dwell time
| fime | (effective) |
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} . Time
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The "Dwell Time" set by the user is used as the step time of the list mode. The effective
net dwell time is shorter, reduced by the setting time. This setting time may be greater
than the time specified in the data sheet.

SCPI command:

[ :SOURce<hw>] :LIST:DWELL on page 769

Current Index - List Mode

Sets the list index in "Step" mode.

SCPI command:

[ :SOURce<hw>] :LIST:INDex on page 770

Blank RF Output (Default ON) - List Mode

Activates/deactivates RF output blanking. If activated, blanking occurs on all frequency
changes. If deactivates, blanking is always disabled.

SCPI command:
:OUTPut<hw>:BLANk:LIST:STATe on page 559
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Learn List Mode Data... - List Mode
Starts the determination of the hardware setting for the selected list. The data determined
in this way is stored along with the list.

It may be necessary to deliberately activate list learning in the event of greatly altered
environmental conditions that require new hardware settings.

If this is not done, a previously learned hardware setting will continue to be used when
list mode is switched on ("State = On"). If no setting is available, e.g. when the list is used
for the first time, learning is automatically activated.

SCPI command:
[ :SOURce<hw>] :LIST:LEARnN on page 772

List Mode Data... - List Mode
Calls the "File Select" menu for selecting and creating a list or the "File Manager".

SCPI command:

[:SOURce<hw>] :LIST:SELect on page 774

[ :SOURce<hw>] :LIST:DELete On page 764

[ :SOURce<hw>]:LIST:DELete:ALL on page 765

Edit List Mode Data... - List Mode
Calls the editor for editing the selected list. A list consists of any number of frequency/
level value pairs. The currently selected list is displayed.

& Edit List Mode Data A demofile =T

Frequency / Power / =
Hz dBm

1 1 000 000 000.00 -25.00

2 1100 000 000.00 -25.00

3 1200 000 000.00 25,00

: [/

Goto Edit | Save As.. | Save ||

"Frequency/ Enter the frequency of the frequency/power value pair.
Hz"

SCPI command:
[ :SOURce<hw>] : LIST: FREQuency on page 769

"Power /dBm" Enter the level of the frequency/power value pair.

SCPI command:
[ :SOURce<hw>] :LIST:POWer on page 772

|
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"Edit"

"Insert Row"
"Insert Range"

"Fill...."

"Delete Row

"Delete
Range..."

"Save as"

"Save"

List Range In -

RF Signal and Analog Modulations - RF Block

Selects row for editing.

Gotofirst
Goto last

If "Goto row" is selected, a window opens for entering the requested row.

OK | Cancel |

Calls a selection of possible actions described below.

Insert Row
Insert Range...
Fill...

Delete Row
Delete Range...

Inserts a new row before the marked row.

Inserts new rows before the marked row. The number of rows to be
inserted can be defined in an entry window.

IROWS to Insert I I

ok | cancer |

Opens a sub menu for defining a set of list values to be automatically
entered in the List Mode table (see chapter 4.5.14.2, "Filling the List
Mode Data automatically", on page 272).

Deletes the marked row.

Allows to delete any number of rows starting with the marked row. The
number of rows to be deleted can be defined in an entry window.

IRuws to Delete I II

OK | Cancel |

Open the file menu to save the list under a new name.

Each list is saved to the instrument's hard disk as a separate file with the
file prefix * . 1sw. The file name and the directory to which the file is saved
are user-selectable.

The list is saved under its current name.

List Mode

Defines an index range in the current list by setting the start and stop index. Only the
values in the selected index range are processed in List mode, all other list entries are

ignored.

SCPI command:
[ :SOURce<hw>] :LIST:INDex:STARt on page 771
[ :SOURce<hw>] :LIST:INDex:STOP on page 771
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Global Trigger/Clock Settings
Calls the "Global Trigger/Clock Settings" dialog. This dialog is used among other things
for setting the polarity of the active slope of an applied instrument trigger.

In the case of two-path instruments this setting is valid for both paths. It affects the INST
TRIG input (BNC connector at the rear of the instrument, instrument trigger for Path A)
and the INST TRIG B input of the AUX I/O interface at the rear of the instrument, instru-
ment trigger for Path B).

See chapter 4.2.3.10, "Global Trigger/Clock/External Input Settings", on page 135.

User Marker / AUX I/O
Calls the menu for configuring the AUX I/O and user interfaces (see chapter 4.2.3.12,
"User Marker / AUX 1/0O Settings", on page 138).

The pin assignment of the AUX |/O interface is shown in the "User Marker / AUX 1/O
Configuration" menu; the assignment of the USER pins 2...4 and USER 1 BNC connector
can be changed.

With two-path instruments, the current assignment to the respective path is given in
addition to the pin assignment.

Import/Export

Lists can be imported from externally created files or exported into text or CSV-files. The

import/export settings are available after clicking the "Import/Export" button.

Import/Export - List Mode
Expands the menu with the area for import and export of list mode files.

Import / Export List Files

Mode I Import j
ASCH File Settings

Extension | TXT j

Decimal Point | Point j

Column Separator | Semicolon j
Select ASCIH Source | ih:testd.tx
Select Destination | d:testd

Import |

Externally edited Excel tables with frequency/level pairs can be imported as text or CSV-
files and used for list mode.

On the other hand, internally created list mode lists can be exported as text or CSV-files.

Mode - List Mode
Selects if list mode lists should be imported or exported. The settings offered below
depend on the selected mode.

SCPI command:
[ :SOURce<hw>] : LIST:DEXChange : MODE on page 768
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Extension - List Mode

Selects the file extension of the ASCII file to be imported or exported. Selection TXT (text
file) or CSV (Excel file) is available.

SCPI command:

[:SOURce<hw>] :LIST:DEXChange:AFILe:EXTension on page 766

Decimal Point - List Mode
Selects the decimal separator used in the ASCII data between '." (decimal point) and ',
(comma) with floating-point numerals.

SCPI command:
[ :SOURce<hw>] :LIST:DEXChange:AFILe:SEParator:DECimal on page 767

Column Separator- List Mode
Selects the separator between the frequency and level column of the ASCII table.

SCPI command:
[ : SOURce<hw>] :LIST:DEXChange:AFILe:SEParator:COLumn On page 766

Select ASCII Source / Destination - List Mode
Calls the "File Manager" for selecting the ASCII file to be imported into a list mode list
(source) or the ASCII file the list mode list is exported (destination) in.

SCPI command:
[ :SOURce<hw>] :LIST:DEXChange:AFILe:SELect on page 766

Select Destination / Source - List Mode
Calls the "File Manager" for selecting the list mode list to be exported (source) into an
ASCII file or the destination for the ASCII file to be imported (destination) in.

SCPI command:
[ :SOURce<hw>] : LIST:DEXChange: SELect on page 768

Import / Export - List Mode
Starts the export or import of the selected file.

When import is selected, the ASCII file is imported as list mode list.
When export is selected, the list mode list is exported into the selected ASCII file.

SCPI command:
[ :SOURce<hw>] : LIST:DEXChange :EXECute on page 768

Filling the List Mode Data automatically

The "Fill List Mode Data" menu enables you to automatically set the values in the List
Mode table.

|
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B Fill List Mode Data A

From |71

Range |—3

Select column to fill IW

Start Value | 100 000.00 | Hz ~|

End Value | 300 000.00 [Hz ~|

Increment Value | 100 000.00 [Hz ~|
Fill

The start line and the number of rows to be filled are defined under "From" and
"Range".

The column to be filled is selected under "Select column to fill". Depending on the selec-
tion here, the default for start, end, and increment value are set. As the settings are
interdependent, a change of one parameter may result in the automatic change of one
or more of the other parameters.

The filling of the column with the selected value settings is started with button "Fill".

@ The list entries are only computed when the "Fill" button is pressed.

From
Sets the start value of the index range.

SCPI command:
n.a.

Range
Sets the range for filling the table.

SCPI command:
n.a.

Select column to fill
Selects either the frequency or the level column to be filled with the value defined below.

SCPI command:
n.a.

Start value
Sets the start value for the frequency or the level entries.

SCPI command:
n.a.

End value
Sets the end value for the frequency or the level entries.

SCPI command:
n.a.
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Increment value
Sets the increment for the frequency or the level entries.

SCPI command:
n.a.

Fill
Fills the selected column in the set range with values, starting with the start value and
using the set increment.

SCPI command:
n.a.

4.6 1/Q Modulation - 1/Q Mod Block

The R&S Signal Generator offers I/Q modulation with:
e external analog I/Q signals,

e external digital signals,

e internal digital signals.

Either the external analog signal (Path A only) or the externally or internally generated
baseband signal (Path A and B) is fed into the 1/Q modulator ("I/Q Mod A/B" function

block).
112
ouT
AWGNI/IMP A [ 1 [ ]
RF &
config... config... config...
= confg.. §|  feonra.. | P
[~ On
Path A

I/Q modulation with an external analog 1/Q signal is possible for the basic unit (R&S SMU
with frequency option R&S SMU-B10x) without additional equipment options.

The basic equipment configuration for generating an internal baseband signal includes
the options R&S SMU-B13 (Baseband Main Module) and R&S SMU-B9/B10/B11 (Unicod
and ARB).

Externally generated realtime baseband signals can be fed into the digital signal path via
the digital interface (digital signals) or the analog inputs (analog signals) (Option R&S
SMU-B17, Baseband Input).

Path B

External signals cannot be fed into the I/Q modulator. The second I/Q modulator is avail-
able if the option R&S SMU-B20x (Path B), a second R&S SMU-B13 option (Baseband
Main Module), and one of the options R&S SMU-B9/B10/B11 (Baseband Generator),

|
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R&S SMU-B17 (External Baseband Input) or R&S SMU-K62 (Noise Generator) are
installed.

The external signal is input via the | and Q connector and transferred directly to the 1/Q
modulator of Path A (I/Q Mod function block).

The internally generated baseband signal is configured in the Baseband function block
(see chapter 4.8, "Baseband Signal - Baseband Block", on page 320). Before the signal
is fed into the 1/Q modulator, noise can be added and/or the signal can be impaired.
Impairment at this point along the signal flow is offered to allow a signal to be output at
the 1/Q-OUT outputs (a signal which, for example, compensates signal distortion in a
connected test object (DUT)).

Prior to impairing and noise adding, the signal can also be faded in he Fading function
block.

Impairment is integrated in the basic unit. The generation of noise requires the option
R&S SMU-K62 (AWGN).

In the case of two-path instruments, the baseband signals of both paths can be added
with or without frequency offset.

Impairments can also be set in the I/Q Mod menu to allow an externally applied analog
I/Q signal to be impaired. An internal baseband signal can thus be impaired both digital
(in the Impairment block in the Impairment menu) and analog in the I/Q modulator. If
impairments are set in both menus, they superimpose each other in the signal.

4.6.1 1/Q Modulator

To select the input signal of the 1/Q modulator and to open the "I/Q Settings" menu, select
"1/Q Mod > Configure".

The "I/Q Settings" menu containing the modulation settings is opened in the top section
(see chapter 4.6, "I/Q Modulation - I/Q Mod Block", on page 274).

Use the the "I/Q Mod In" section to select the input signal:

e select "Analog Wideband I/Q In", if the external analog signal is fed into the 1/Q mod-
ulator.
The maximum available RF bandwidth is described in the instruments specifications
(see data sheet).

e select "Internal Baseband 1/Q In", if the internally generated baseband signal is used.
The RF bandwidth is reduced (see data sheet).

e select"Internal Baseband I/Q In", in case the external analog signal fed into the digital
signal path.
The RF bandwidth is reduced (see data sheet).

Alternatively, the input signal can be selected in the "I/Q Settings" menu (see chapter 4.6,
"1/Q Modulation - I/Q Mod Block", on page 274).
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1/Q Mod In
Analog Wideband 1/Q In

+ Internal Baseband 1/Gl In

I/Q Modulation - I/Q Mod Block

1/Q Settings

To open the menu for setting the I/Q modulation parameters, select "I/Q Mod > Configure
> |/Q Settings" or use the MENU key.

N\ System error correction of the I/Q modulator permits precise and repeatable measure-

/ ments. The correction routine should be called in the case of temperature fluctuations of

several degrees. To call the routine, press the SETUP key and select "System > Internal
Adjustment " and execute the desired adjustment procedure.

It is not possible to activate an 1/Q modulation with an external analog signal ("Analog
Wideband 1/Q In") simultaneously with:

o AM,

e digital modulation,

e (digital standards,

e fading,

e external baseband input,

® noise,

e arbitrary waveform generation and
e multi carrier CW

I/Q modulation is activated and the source entered in the top section of the menu.

Source |Ana log Wideband I/Q Input j

1/Q impairment for specific impairment of the I/Q modulation is set in the "Impairments"
section.

Impairments

State I~ on
| Offset | 0.00 % |
QOffset | 0.00 % |
Gain Imbalance | 0.000 |dB |
Quadrature Offset [ 0.00 [deg |

I/Q control can be swapped in the lower section of the menu and the optimized settings
for wideband modulation signals can be activated.

11Q Swap [~ On

1IIQ Wideband [~ On

The bottom section of the menu differs depending on the selected input signal ("Analog
Wideband 1/Q Input" or "Internal Baseband").

The crest factor is input for the external signal.
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The gain is selected for the internal and external signal.

Analog Wideband I'Q Input
Crest Factor | 0.00 IdB ~|
Gain |3dB:Best For High 3GPP ACLR) ~|

4.6.2.1 General I/Q Mod Settings

1Q Source - 1/Q Mod
Selects the input signal for the I/Q modulator.

This selection is only available for path A.

"Analog Wide- Selects an external analog signal as the input signal. The signal must be
band I/Q In"  applied at the inputs | and Q.

"Internal Base- Selects the internal baseband signal as the input signal. This setting
band 1/Q In" requires the additional equipment options for generating the various
baseband signals.

SCPI command:
[ :SOURce<hw>] : IQ:SOURce on page 741

State - 1/Q Mod
Activates/deactivates 1/Q modulation.

If "Analog Wideband 1/Q In" is selected, the I/Q modulator is also deactivated and acti-
vated.

If "Internal Baseband I/Q In" is selected, the 1/Q modulator is always activated automat-
ically as soon as signal generation is activated in the "Baseband" block. It can, however,
be deactivated later, e.g. if only the baseband signal which is output at the 1/Q outputs is
relevant.

SCPI command:
[ :SOURce<hw>] : TQ:STATe on page 742

4.6.2.2 Impairements

I/Q impairment for specific impairment of the 1/Q modulation is set in the "Impairments"
section.

State - Impairments 1/Q Mod
Activates/deactivates 1/Q impairment.

If activated, the settings for leakage, 1/Q imbalance and quadrature offset become effec-
tive.

Whether or not I/Q impairment is activated is indicated in the function block.
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Note: It is advisable to switch automatic level control to the Sample&Hold mode, as oth-
erwise level errors may occur (see chapter 4.5.8, "Automatic Level Control - ALC",
on page 218).

SCPI command:
[ :SOURce<hw>]:IQ:IMPairment[:STATe] on page 741

Offset - 1/Q Mod
Sets the carrier offset (in percent) of the amplitudes (scaled to the peak envelope power
(PEP) for the | and/or Q signal component.

An ideal I/Q modulator suppresses the carrier offset completely (offset = 0 percent). If an
offset value is entered for a component, a carrier offset with fixed amplitude is added to
the signal. In the diagram, all | values or Q values are offset by a fixed amplitude value
depending on the entered percentage.

|§ Graphics: Wector Diagram
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Fig. 4-9: Effect of offset for the | component
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Fig. 4-10: Effect of offset for the Q component
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Fig. 4-11: Effect of an identical offset for both signal components

SCPI command:
[ :SOURce<hw>]:IQ:IMPairment:LEAKage: I on page 740
[ :SOURce<hw>]:IQ:IMPairment:LEAKage:Q on page 740

Gain Imbalance - 1/Q Mod
Sets the imbalance of the | and Q vector.

The entry is made in dB (default) or %, where 1 dB offset is roughly 12 % according to
the following:

Imbalance [dB] = 20log ( | GainQ | / | Gainl |)

An ideal I/Q modulator amplifies the | and Q signal path by exactly the same degree. The
imbalance corresponds to the difference in amplification of the | and Q channel and
therefore to the difference in amplitude of the signal components. In the vector diagram,
the length of the | vector changes relative to the length of the Q vector.

Positive values mean that the Q vector is amplified more than the | vector by the corre-
sponding percentage.

Operating Manual 1007.9845.32 — 16 280



I/Q Modulation - 1/Q Mod Block

Fig. 4-12: Effect of a positive gain imbalance

Negative values mean that the | vector is amplified more than the Q vector by the corre-
sponding percentage:
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Fig. 4-13: Effect of a negative gain imbalance

SCPI command:
[ :SOURce<hw>] :IQ:IMPairment:IQRatio[:MAGNitude] on page 739

Quadrature Offset - 1/Q Mod
Sets the quadrature offset.

An ideal 1/Q modulator sets the phase angle to exactly 90 degrees. With a quadrature
offset, the phase angle between the | and Q vector deviates from the ideal 90 degrees,
the amplitudes of both components are of the same size. In the vector diagram, the
quadrature offset causes the coordinate system to shift.

A positive quadrature offset means a phase angle greater than 90 degrees:
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Fig. 4-14: Effect of a positive quadrature offset

A negative quadrature offset means a phase angle less than 90 degrees:
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Fig. 4-15: Effect of a negative quadrature offset

SCPI command:
[ :SOURce<hw>]:IQ:IMPairment:QUADrature: [ANGLe] on page 740

1/Q Swap and 1/Q Wideband

The 1/Q control can be swapped and the optimized setting for wideband signals can be
selected in the middle section of the menu.

1/1Q-Swap - 1/Q Mod
Selects normal or swapped I/Q control for an external analog signal. The modulation
sidebands are inverted by swapping the | and Q signals.

This parameter enables 1/Q modulation to be performed on signals according to 1S2000
(cdma2000 standard) and the majority of all other standards. As a result, an I/Q demod-
ulator defined according to 1IS2000 can also be used for demodulating the generated
signals.

The 1/Q modulator defined in the IS2000 standard differs from the definition in the R&S
Signal Generator. The definition on which the R&S Signal Generator is based is used by
virtually all digital communication standards (except IS95 and 1S2000).

In the final step, the filtered 1/Q signal is modulated to the desired RF in a different way
in the 1/Q modulator:
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:m.IZ::I*TI lu'\lé.‘tfl ]

s(t R&S Signal st

152000 Generator

sin(2=l_t) sin(2xf_1)

Fig. 4-16: Definition of I/Q modulator in 1IS2000 and R&S Signal Generator f

According to 1IS2000, the RF signal s(t) is derived from the baseband 1/Q signal as follows:
s(t)=i(t)cos(2pif t)+q(t)sin(2pif.t)

The instrument family is based on the following definition:
s(t)=i(t)cos(2pif.t)-q(t)sin(2pif.t)

"1/Q Swap" must now be set to "On" so that an I/Q modulator defined according to IS2000
can cope with the RF signal generated by the R&S Signal Generator.

"Off" 1/Q control is normal.

"On" The | and Q signals are swapped.

SCPI command:
[ :SOURce<hw>] :IQ:SWAP[:STATe] on page 742

1/Q-Wideband - I/Q Mod
Optimized setting for wideband modulation signals (>5 MHz). Optimized setting for wide-
band modulation signals (>5 MHz).

The modulation frequency response is decreased at the expense of poorer harmonic
suppression. This is achieved by shifting the switching frequencies of the lowpass filters
in the output section.

SCPI command:
[ :SOURce<hw>] : IQ:WBSTate on page 742

4.6.2.4 Analog Wideband 1/Q Input

In the bottom section of the menu the crest factor is input for the external signal and the
gain is selected for the internal and external signal ("Analog Wideband 1/Q Input" or
"Internal Baseband").

Crest Factor - 1/Q Mod
(Analog Wideband 1/Q Input only)

Sets the crest factor of the external analog signal.
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The crest factor gives the difference in level between the peak envelope power (PEP)
and average power value (RMS) in dB.

This value is necessary to allow the correct output power to be generated at the RF output.
When the set output power is generated, the R&S Signal Generator uses this value to
compensate the average power which is lower compared to the peak power.

The maximum input voltage at the I/Q input is equated to the peak power and is used as
the "reference" for setting the level of the output signal. Since the signal does not usually
supply the peak power at a constant level and instead supplies a lower average power,
the crest factor specifies how many dB have to be added internally so that the correct
output power is achieved.

Note: The crest factor of vector modulation for an external signal that is fed into the
baseband path is entered in the "Baseband Input" menu ("BB Input block", option R&S
SMU-B17).

See also chapter 4.9, "External Baseband Signal - Baseband Input", on page 442.

SCPI command:
[ :SOURce<hw>] :IQ:CREStfactor on page 738

Baseband Gain-Gain - 1/Q Mod
Optimizes the modulation of the I/Q modulator for any measurement requirement.

The modulation is determined by selecting the gain.

Note:
The remote-control commands to be used depend on the selected 1/Q input signal
(SOURce:IQ:SOURce ANALog | BASeband).
e For the Analog Wideband I/Q input signal, the commands of system
SOURce:IQ:GAIN are valid.
e For the internal or external Baseband I/Q input signal (SOURce: IQ: SOURce
BASeband), the commands of system SOURce : BB: IQGain are valid.
"Auto" (digital baseband signal only)
With this setting, the modulation is automatically optimized for the inter-
nally set baseband signal.
"- 3dB (Low Dis-Activates -3 dB gain. With this setting, signal distortions are minimized.
tortion)"

"0 dB (Stand- Activates 0 dB gain
ard)"

"3 dB (High Activates 3 dB gain. This setting is recommended for 3GPP signals with
3GPP ACLR)" very high adjacent channel power ratio (ACPR).

"6dB (Low Activates 6 dB gain. With this setting, signal noise is minimized.
Noise)"

SCPI command:

[ :SOURce<hw>] : TQ:GATIN on page 739 (for analog I/Q signal)

[ :SOURce<hw>] :BB: 1QGain on page 742 (for digital I/Q signal)

|
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4.7 Impairment of Digital 1/Q Signal and Noise Generator -
AWGN/IMP Block

The R&S SMU allows the digital I/Q signal to be impaired before it is passed on to the I/
Q modulator, and also noise to be added to the signal. The noise generator can also be
used to generate a pure noise signal.

These settings are available in the block diagram in the "AWGN/IMP" function block as
well as in the menu with the same name which is opened using the MENU key.

The equipment options for the basic unit (R&S SMU with frequency option R&S SMU-
B10x) include the option R&S SMU-B13 (Baseband Main Module) for Impairments and
the option R&S SMU-K62 (Noise Generator) for "AWGN".

Two-path instruments require a second RF path (option R&S SMU-B20x) and a second
R&S SMU-B13 option (Baseband Main Module) for impairment of a signal on Path B.
Noise can be generated alternately for both paths using an option R&S SMU-K62 (Noise
Generator). Simultaneous noise generation on both paths requires a second option.

In case of two-path instruments, the output connectors can be assigned either to path A
or path B.

Impairments
1'0 Impairments (Digital Baseband)...
AWGN

AWGN...

Analog 10 Ot
Settings...

W 10 Out from A

10 Out from B

Digital 1/Q Ot
Settings...

140 Level

Info...

Selecting the menu item "I/Q Impairments (Digital Baseband)..." opens the 1/Q impair-
ment settings dialog. This dialog covers the settings for 1/Q impairment, like carrier leak-
age, imbalance and quadrature offset.

To access the AWGN settings, select "AWGN...". This dialog containing the settings of
the RFI signal generator, noise level configuration and CW interfering parameters.

Selecting the menu item "I/Q Out Settings" opens a dialog with the parameters for the I/
Q output signal.

The "I/Q Out Settings" dialog is available for analog and digital I/Q output signals. These
dialogs are accessable under the menu sections with the corresponging names.

In case of two-path instruments, the analog I/Q output signal can be assigned either to
path A or path B.

The settings for the digital 1/Q output signal are available for path A only.
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"Info..." opens a dialog, displaying information on the baseband signal level.

The single ended or differential output requires option R&S SMU-B16, Differential Output.

Impairments

Impairment of the digital I/Q signal can be used, for example, to compensate the distortion
of a test object or to check the effect of a disturbed signal on a test object. For this purpose,
the 1/Q signal can be output at the I/Q OUT outputs. On the other hand, the I/Q impair-
ments used internally for compensating signal distortion can be deactivated by the 1/Q
modulator in order to, for example, test its own baseband components.

Equipped with the R&S SMU RF and Baseband Correction Toolkit (option R&S SMU-
K63) signal distortion of the 1/Q signal output or, deterioration in the quality of modulation
or the spectral properties of multi carrier signals can be corrected. The correction data
are created by Matlab software and stored on the instrument's hard disk.

For two path instruments, equipped with two baseband main modules (option R&S SMU-
B13) and two RF paths, a second option R&S SMU-K63 is required for signal correction
in the second path.

In addition to impairment of the digital I/Q signal, the R&S SMU also allows impairment
of the analog signal to be set in the 1/Q modulator. The relevant settings are made in the
I/Q Mod function block (see chapter 4.6, "I/Q Modulation - I/Q Mod Block", on page 274).

4711

Impairment Settings Menu

To access the "Impairment Settings" menu for setting the digital I/Q impairments, select
"AWGN/IMP > Configure > I/Q Impairements" or use the MENU key under "AWGN/
IMP".

Impairmems
10 Impairments (Digital Basebanl)...
AWGN

AWGN...
Analog 10 Ot
Settings...
W 10 Ot from A
1/ Onrt from B
Digital 1:G Ourt
Settings...

110 Lewvel
Info...

I/Q impairment is activated and set in the "I/Q Impairments" section.
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IIQ Impairments
State o |
| Offset | 0.00 [% ~|
Q Offset | 0.00 [% ~|
Gain Imbalance | 0.000 |dB ~|
Quadrature Offset | 0.00 [deg -

"Internal compensation” of signal distortions of the RF output can be activated / deacti-
vated.

[v Optimize Internal I/Q Impairments For RF Qutput

Optimization Mode IFast j

Correction Files for user defined correction of the RF output, supported by the R&S SMU
RF and Baseband Correction Toolkit (option R&S SMU-K63) can be loaded in the
lower section of the dialog box.

The R&S SMU-K63 File Info section displays header information on the loaded frequency
response correction file.

Optimization Mode | User Correction j
| Loaa correction Fite.. | T153607_A_Resp_Norm_1500-1300MHz_m10-104em|
Correction File Status OK
Carrection File Info
Type RF Image
Accuracy Normal
Frequency Range 15000 GHz .. 18000 GHz
Level Range -0 dBm .. 10 dBm
Include ATT Fixed . off
External Devices on
Bandwidth 5 MHz
Frequency Offset 0 Hz
Level Offset 10 dB

1/Q Impairments

In the "I/Q Impairments" section the parameters for carrier leakage, imbalance and quad-
rature offset can be set and I/Q impairment is activated.

State - Digital Impairments
Activates/deactivates digital I/Q impairment.

When activated, the settings for carrier leakage, 1/Q imbalance and quadrature offset
become effective.

|
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Internal predistortion for compensating the I1/Q modulator is not influenced by this setting.

SCPI command:
[ :SOURce<hw>] :BB:IMPairment:STATe on page 678

1/Q Offset - Digital Impairments
Sets the carrier leakage (in percent) of the amplitudes (scaled to the peak envelope power
(PEP)) for the | and/or Q signal component.

An ideal 1/Q modulator suppresses the carrier leakage completely (offset = 0 percent). If
an offset is entered for a component, a carrier leakage with fixed amplitude is added to
the signal. In the diagram, all | values or Q values are offset by a fixed amplitude value
depending on the entered percentage.

|§ Graphics: Wector Diagram

n.g-
0E- |
0.4-
n.2-

-0.0-

(uadrature q[t]

0.2-

04-

0B~

08—

-1.0-

il 1 1 1 1 1 1 1 1

1.1 08 06 04 02 00 02 04 0B OB 1.1
Inphase i[t]

Fig. 4-17: Effect of offset for the | component
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Fig. 4-18: Effect of offset for the Q component



R&S®SMU200A Instrument Function

Impairment of Digital 1/Q Signal and Noise Generator - AWGN/IMP Block

Graphics: Yector Diagram

lifes
1.0-

0.8-

0.6~

0.4-

n.2-

-0.0-

(uadrature q[t]

0.2

4=

0.6~

-0.8-

fmng L,
s
I

A1 g 0F 04 02 00 02 04 06 0% 14
Inphase i[t]

Fig. 4-19: Effect of an identical offset for both signal components

SCPI command:
[ :SOURce<hw>] :BB: IMPairment:LEAKage: I on page 671
[ :SOURce<hw>] :BB: IMPairment: LEAKage:Q on page 672

Gain Imbalance - Digital Impairments
Sets the imbalance of the | and Q vector.

The entry is made in dB (default) or %, where 1 dB offset is roughly 12 % according to
the following:

Imbalance [dB] = 20log ( | GainQ | / | Gainl |)

An ideal I/Q modulator amplifies the | and Q signal path by exactly the same degree. The
imbalance corresponds to the difference in amplification of the | and Q channel and
therefore to the difference in amplitude of the signal components. In the vector diagram,
the length of the | vector changes relative to the length of the Q vector.

Positive values mean that the Q vector is amplified more than the | vector by the corre-
sponding percentage.
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Fig. 4-20: Effect of a positive gain imbalance

Negative values mean that the | vector is amplified more than the Q vector by the corre-
sponding percentage:
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Fig. 4-21: Effect of a negative gain imbalance

SCPI command:
[ :SOURce<hw>] :BB: IMPairment:IQRatio on page 671

Quadrature Offset - Digital Impairments
Sets the quadrature offset.

An ideal 1/Q modulator sets the phase angle to exactly 90 degrees. With a quadrature
offset, the phase angle between the | and Q vector deviates from the ideal 90 degrees,
the amplitudes of both components are of the same size. In the vector diagram, the
quadrature offset causes the coordinate system to shift.

A positive quadrature offset means a phase angle greater than 90 degrees:
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Fig. 4-22: Effect of a positive quadrature offset

A negative quadrature offset means a phase angle less than 90 degrees:
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Fig. 4-23: Effect of a negative quadrature offset

SCPI command:
[ : SOURce<hw>] :BB: IMPairment:QUADrature[:ANGLe] on page 678

Internal Compensation

"Internal compensation" of signal distortions "of the RF output "can be activated / deac-
tivated.

Optimize internal IQ-Impairments for RF Output - Digital Impairments

Activates or deactivates internal compensation of signal distortions of the RF output.
Signal distortions can be either optimized for the RF output (active) or for the differential
I/Q output (not active).

SCPI command:
[ :SOURce<hw>] :BB: IMPairment:0PTimization:STATe on page 672

Optimization Mode - Digital Impairments
Selects the optimization mode.

"Fast" Optimization is reached by compensation for 1/Q skew.

"High Quality" Optimization is reached by compensation for I/Q skew and frequency
response correction.
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"User Correc- Note: User correction can be operated if the instrument is equipped with
tion" an R&S SMU-K63.

Optimization is reached by data generated with the R&S SMU RF and
Baseband Correction Toolkit.

SCPI command:
[ :SOURce<hw>] :BB:IMPairment:0PTimization:MODE on page 672

Frequency Response Correction

Correction Files for user defined correction of the RF output, supported by the R&S
SMU RF and Baseband Correction Toolkit (option R&S SMU-K63) can be loaded in the
lower section of the dialog box.

The R&S SMU K63 File Info section displays header "information on" the loaded "fre-
quency response correction file".

Load Correction File... - I/Q Impairments (Digital Baseband)
Opens the standard file dialog box used to load and store lists or data, i.e. in this particular
case files containing correction data. Each file is stored with the predefined file extension
*  frc (Frequency Response Correction). The standard directory for frequency correc-
tion files is D: \SMxRFandBBCorrectionTooolkit\SMxK63.

Note: The frc parameters get values from this file. If the file is not existing or corrupted
the info parameters will not be updated. An error message is displayed in the info line of
the status bar. If no further user correction file is loaded the default corrections will be
applied in high quality mode.

SCPI command:
[ :SOURce<hw>] :BB: IMPairment :OPTimization:UCORrection:FILE
on page 674

Correction File Status - I/Q Impairments (Digital Baseband)
Displays whether the frequency response correction file * . frc could be loaded properly.

"OK" File type and data of the correction file are ok. The file can be used for
frequency response correction.

"Missing" File not found.
Error message, displayed in the info line: "There are no valid data avail-
able for optimization mode "high quality". Therefore an optimization is
NOT possible."

"Incompatible” The file is not compatible with the instrument or the path and could not
be loaded.
Error message, displayed in the info line: "The selected frequency
response correction file is incompatible - due to wrong device and serial
number and path".

"Corrupt” The frequency response correction data is corrupt and the file could not
be loaded.

SCPI command:
[ :SOURce<hw>] :BB: IMPairment :OPTimization:UCORrection:FILE:STATusS
on page 675

|
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Correction File Info - 1/Q Impairments (Digital Baseband)
Displays the most important header information on the loaded frequency response cor-

rection file.
Cormrection File Info
Type RF Image
Accuracy Hormal
Frequency Range 1.5000 GHz .. 18000 GHz
Lewval Range -0 dBm .. 10 dBm
Include ATT Fixed - CHif
External Davices O
Bandwidth 5 MHz
Frequency Offset 0 Hz
Level Offset 10 B
"Type" Displays the type of the baseband frequency response correction data.

SCPI command:

[ :SOURce<hw>] :BB: IMPairment :OPTimization:UCORrection:TYPE

on page 678

"Accuracy" Displays the accuracy of the baseband frequency response correction
data.

SCPI command:

[ :SOURce<hw>] :BB:IMPairment:0PTimization:UCORrection:ACCuracy
on page 673

"Frequency Displays the frequency range (maximum and minimum frequency val-
Range" ues) of the baseband frequency response correction data.

SCPI command:

[ :SOURce<hw>] :BB:IMPairment:0PTimization:UCORrection:FREQuency:
MAX on page 675

[ :SOURce<hw>] :BB: IMPairment :OPTimization:UCORrection:FREQuency:
MIN on page 676

"Level Range" Displays the level range (maximum and minimum level values) of the
baseband frequency response correction data.

SCPI command:

[ :SOURce<hw>] :BB: IMPairment :OPTimization:UCORrection:LEVel :MAX
on page 677

[ :SOURce<hw>] :BB: IMPairment :0OPTimization:UCORrection:LEVel :MIN
on page 677
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"Include ATT Displays the status of the attenuator, included in the frequency response

Fixed" correction data. When the operating mode Fixed is switched on, the
attenuator is fixed in its current position and the resulting variation range
is defined.

SCPI command:
[ :SOURce<hw>] :BB: IMPairment :OPTimization:UCORrection:IAFixed
on page 676

"External Devi- Set to On the parameters bandwidth, frequency offset and level offset
ces" are indicated below.

SCPI command:
[ :SOURce<hw>] :BB: IMPairment :OPTimization:UCORrection:EDEVices
on page 674

"Bandwidth"  Displays the bandwidth of the frequency response correction data in 10
MHz or 5 MHz intervals.

Note: Bandwidth is displayed if external devices are activated.
SCPI command:
[ :SOURce<hw>] :BB: IMPairment :OPTimization:UCORrection:BWIDth
on page 673
"Frequency Off-Displays the frequency offset of the baseband frequency response cor-
set" rection data.

Note: Frequency offset is displayed if external devices are activated.
SCPI command:
[ :SOURce<hw>] :BB:IMPairment:0PTimization:UCORrection:FREQuency:
OFFSet on page 676

"Level Offset" Displays the level offset of the baseband frequency response correction
data.

Note: Level offset is displayed if external devices are activated.
SCPI command:

[ :SOURce<hw>] :BB:IMPairment :OPTimization:UCORrection:LEVel:
OFFSet on page 677

4.7.2 AWGN - Noise Generator

The noise generator generates an AWGN signal (Additive White Gaussian Noise) in the
digital baseband, i.e. the noise power density has a Gaussian distribution and is distrib-
uted evenly across the frequency. This noise signal superimposes the (interference-free)
useful signal ("Additive Noise" mode). Typical applications for the noise generator are
bit-error or block-error measurements, depending on the set S/N or C/N ratio.

The Gaussian noise is generated by means of feedback shift registers with subsequent
probability transformation. The switching configuration is such that virtually ideal statis-
tical characteristics are achieved:

e | and Q paths are decorrelated from each other.
e The crest factor of 18 dB allows very small probabilities to be realized.
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e The period of the noise signal depends on the selected system bandwidth. The rela-
tionship of period P to system bandwidth B, is approximated:
P =1*10"3/ By
This results in periods between 317 years with minimum bandwidth and approxi-
mately 2 days with maximum bandwidth.
This results in a period of approximately one month for 3GPP FDD with a bandwidth
of 3.84 Mcps, and a period of 427 days for GSM with 270.833 ksps.

Scalable low-pass filters are used to produce a noise level with both a broad dynamic
range and a broad bandwidth range (from 1 kHz to 60 MHz).

Apart from the "Additive Noise" mode, there are also the "Noise Only" and the "CW Inter-
ferer" mode. In the "Noise Only" mode a pure noise signal is generated and modulated
to the carrier. In the "CW Interferer mode", a sinusoidal signal with an adjustable fre-
quency offset to the baseband signal is generated and added to the baseband signal by
means of a counter instead of a shift register.

AWGN Settings Dialog

To open the "AWGN Settings" menu for setting the noise generator, select "AWGN/IMP
> Configure > AWGN" or use the MENU key under "AWGN/IMP".

Impairments
1/Q Impairments (Digital Baseband)...
AWGN

AWGN...

Analog 110 Cut
Settings...
v 110 Out from A
10 Out from B
Digital 1/Q Ot
Settings...

1/ Lewvel
Info...

The "AWGN Settings" menu is divided into the following sections.

The RFI signal generator is activated, the mode selected and the interfering signal is
configured in the top section of the menu.

The level of the interfering signal is configured in the "Noise Level Configuration And
Output Results" section.

In "Additive Noise" and "CW interferer" mode, the interfering level can be defined and the
resulting total level displayed here.

In "Noise Only" mode, only the noise level can be set here.

AWGN Settings

The RFI signal generator is activated, the mode selected and the interfering signal is
configured in the top section of the menu.
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State - AWGN
Activates/deactivates the RFI signal generator. The interferer (AWGN or CW interferer,
depending on the selected mode) is generated as after the generator is activated.

SCPI command:
[ :SOURce<hw>] : AWGN: STATe on page 584

Mode - AWGN
Selects the mode for generating the interfering signal.

"Additive Noise"The AWGN noise signal with selectable system bandwidth is added to
the baseband signal.

"Noise Only"  The pure AWGN noise signal with selectable system bandwidth is modu-
lated to the carrier. The connection to the baseband is interrupted.

"CW Interferer" A sine with a defined frequency offset is added to the baseband signal.
The calculation of E./N, ratio is omitted.

SCPI command:
[ : SOURce<hw>] : AWGN : MODE on page 580

System Bandwidth - AWGN
(Additive Noise and Noise Only)

Sets the RF bandwidth to which the set carrier/noise ratio relates.

Within this frequency range, the signal is superimposed with a noise signal whose level
corresponds exactly to the set C/N or S/N ratio.

Note: The noise signal is not generated arbitrarily for a particular bandwidth, but instead
it is generated in steps. Noise therefore also occurs outside the set system bandwidth.

SCPI command:
[ : SOURce<hw>] : AWGN : BWIDth on page 576

Minimum Noise/System Bandwidth Ratio - AWGN
(Additive Noise and Noise Only)

Sets the ratio of minimum noise bandwidth to system bandwidth.

Note: The noise signal is not generated arbitrarily for a particular bandwidth, but instead
it is generated in steps. Noise therefore also occurs outside the set system bandwidth.

With this parameter the minimum real noise bandwidth can be set as required by some
standards. It does not influence the calculation of level from the set C/N or S/N ratio in
relation to system bandwidth.

The overall bandwidth is calculated as follow and may not exceed 80 MHz.
Overall Bandwidth = System BW x Minimum Noise/System BW Ratio

SCPI command:
[ :SOURce<hw>] : AWGN: BWIDth:RAT1o on page 577

Noise Bandwidth - AWGN
(Additive Noise and Noise Only)

Indicates the real noise bandwidth. The value is only indicated for "State On".
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Note: The noise signal is not generated arbitrarily for a particular bandwidth, but instead
it is generated in steps. Noise therefore also occurs outside the set system bandwidth.

SCPI command:
[ :SOURce<hw>] : AWGN:BWIDth:NOISe on page 577

Display Mode - AWGN
Sets the display mode to Baseband or RF.

SCPI command:
[ : SOURce<hw>] : AWGN : DISP: MODE on page 578

Display Output Results For - AWGN
(Additive Noise and Noise Only)

Selects the display of output results for the analog (DACIF) or the digital (BBOUT) signal
path.

Note: This selection field is only available with the option R&S SMU-B18, Baseband
Digital I/Q Out. If the instrument is not equipped with this option the parameters of the
analog signal path are displayed.

"Analog Output"The parameters of the analog signal path are displayed.
"Digital Output" The parameters of the digital signal path are displayed.

SCPI command:
[ :SOURce<hw>] : AWGN:DISP:ORESults on page 578

Target CW Frequency - AWGN
(CW Interferer mode only)

Sets the desired frequency of the sine in "CW Interferer" mode.

SCPI command:
[ :SOURce<hw>] : AWGN: FREQuency : TARGet on page 579

Resulting CW Frequency - AWGN
(CW Interferer mode only)

Indication of the actual CW frequency of the sinusoidal signal in "CW Interferer" mode.

The actual frequency may differ from the desired frequency, since the resolution is limited
to 0.7 Hz.

Tip: The desired frequency constellation can be precisely set with an accuracy of up to
0.01 Hz by selecting a suitable frequency offset of the baseband source (e.g. Custom
Dig Mod) and by correcting the RF frequency by the difference between Resulting and
Target CW Frequency.

SCPI command:
[ : SOURce<hw>] : AWGN: FREQuency :RESult on page 579
Noise/Interferer Level Configuration And Output Results

The interfering signal is configured in the "Noise/Interferer Level Configuration and Out-
put Results" section.
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Set Noise Level via - AWGN
(Additive Noise only)

Selects the mode for setting the noise level

"C/N ""S/N" The noise level is set on the basis of the value entered for the carrier/
noise or signal/noise ratio.
Whether a selection of C/N or S/N is enabled, depends on the selected
"Display Mode".
With digital modulation, the associated E,/N, value is determined and
displayed.

"Ep/Ng" The noise level is set on the basis of the value entered for the ratio of bit
energy to noise power density.
The associated C/N or S/N value is displayed. The correlation between
the two values is as follows:
C/N or SIN = (Ey/No)*(fyi/Bsys), Where
fyit is the Bit rate (Symbol rate x Modulation value)
Bsys is the System bandwidth
With "Custom Dig Mod" signals, the bit rate used for calculation is defined
by the selected standard in the "Custom Digital Mod" dialog.
With "Digital Standard" signals, the bit rate to be used for calculating the
E,/Ng can be entered at "Bit Rate".
Some test cases with the 3GPP base station tests (TS 25.141) specify,
for example, E/N settings that apply to channel-coded data or block seg-
ments.

SCPI command:
[ : SOURce<hw>] : AWGN : POWer : MODE on page 581

Reference Mode - AWGN
(Additive Noise and CW Interferer, Display Mode set to RF)

Select reference mode if the C/N or Eb/NO ratio is changed.

"Carrier" If the C/N value or E,/N, value changes, the carrier level is kept constant
and the noise level is adjusted. This is the standard procedure for meas-
uring the bit error rate versus the noise power.

"Noise" If the C/N value or E,/Ng value changes, the noise level is kept constant

and the carrier level is adjusted.

Some test cases of 3GPP Base Station Tests (TS 25.141) specify, for
example, that the noise power be permanently set as a function of the
base station power class, whereas the carrier power is variable.

SCPI command:
[ : SOURce<hw>] : AWGN : POWer : RMODe on page 582

Bit Rate - AWGN
(Additive Noise only)

Sets or indicates the bit rate used for converting C/N or S/N to E,/N,.

With "Custom Digital Mod" signals, the bit rate used is indicated here. It is defined by the
choice of the standard in the "Custom Digital Mod" menu.
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With "Digital Standard" signals, the bit rate used for converting C/N or S/N to E,/N, is set
here.

When generating a "Digital Standard", it is thus possible to select which bit rate is to be
used for calculating the ratio of bit energy to noise power density, e.g. the bit rate before
or after channel coding.

SCPI command:
[ : SOURce<hw>] : AWGN : BRATe on page 576

Carrier/Noise Ratio / Signal/Noise Ratio
(Additive Noise and CW Interferer only)

Sets the carrier/noise, signal/noise or signal/inerferer ratio.

Whether a configuration of C/N or S/N is enabled, depends on the selected "Display

Mode".

e In"Carrier Reference Mode", this entry determines the RFI power and thus the power
of the output signal. It does not affect the power of the useful signal, i.e. the carrier
power remains constant.

e In "Noise Reference Mode", this entry determines the power of the useful signal, i.e.
the carrier power. The RFI power remains constant.

e The level of the noise signal which is derived from the entered C/N or S/N value is
displayed in the menu under "Noise Level". The value is displayed automatically in
the units of the useful signal.

e The level of the useful signal is displayed in the menu under "Carrier Level" and can
also be changed there. The displayed value corresponds to the value in the "Level"
display field.

e The level of the output signal is displayed under "Carrier Level + Noise".

If "Set Noise Level via E/Ny" is selected, the associated C/N or S/N value is displayed

here.

SCPI command:
[ : SOURce<hw>] : AWGN :CNRatio on page 577

Ey/N, - AWGN
(Additive Noise only)
Sets the ratio of bit energy to noise power density in "Additive Noise" mode.

e In"Carrier Reference Mode", this entry determines the noise level and therefore also
the level of the output signal. It does not affect the level of the useful signal, i.e. the
carrier level is kept constant.

e In "Noise Reference Mode", this entry determines the level of the useful signal, i.e.
the carrier level. the noise level is kept constant.

e Thelevel of the noise signal which is derived from the entered E, /N, value is displayed
under "Noise Level". The value is displayed automatically in the units of the useful
signal.

e The level of the useful signal is displayed in the menu under "Carrier Level". The
displayed value corresponds to the value in the "Level" display field.

e The level of the output signal is displayed under "Carrier Level + Noise".
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If "Set Noise Level via C/N or S/N" is selected, the associated E,/N, value is displayed
here.

SCPI command:
[ :SOURce<hw>] : AWGN: ENRatio on page 579

Carrier Level / Signal Level
(Additive Noise and CW Interferer)

The name of this parameter depends on the selected "Display Mode".

e In "Carrier Reference Mode", this parametr sets the carrier level. This entry corre-
sponds to the level entered in the Level header.

The level of the noise signal which is derived from the entered C/N or S/N value is
displayed under "Noise Level". The value is displayed automatically in the units of
the useful signal.

e In"Noise Reference Mode", this parameter indicates the carrier level which is derived
from the entered C/N or S/N value. This indication corresponds to the level indicated
in the "Level" header.

The nsoise level can be set under "Noise Level".

Note: The peak envelope power (PEP) specified in the header corresponds to the PEP
value of the carrier. The PEP value of the overall signal is displayed in the menu under
"Carrier+Noise PEP".

SCPI command:
[ :SOURce<hw>] : AWGN: POWer : CARRier on page 580

Noise Level (System Bandwidth) / Interferer Level
(Additive Noise, Noise Only, CW Interferer)

e "Noise Only" mode
Sets the level of the noise signal. This entry corresponds to the level entered in the
"Level" header.
e "Additive Noise" mode
— "Noise Reference Mode"
Sets the level of the noise signal. The level of the carrier is derived from the
entered C/N or S/N or Eb/NO value.
— "Carrier Reference Mode"
Displays the level of the noise signal in the system bandwidth. The level of the
noise signal is derived from the entered C/N or S/N or Eb/NO value. The carrier
level is entered under "Carrier Level"; respectively the signal level is displayed
under "Signal Level".
e "CW Interferer" mode
"Noise Reference Mode"
Sets the level of the interfering signal. The level of the carrier is derived from the
entered C/N or S/N value.
— "Carrier Reference Mode"
Displays the level of the interfering signal. The level of the interfering signal is
derived from the entered C/N or S/N value. The carrier level is entered under
"Carrier Level".
Note: The noise signal is not generated arbitrarily for a particular bandwidth, but instead

it is generated in steps. Noise therefore also occurs outside the set system bandwidth.
This means that the total measurable noise level (see below) usually exceeds the value
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displayed here. Correct measurement of the noise level within the system bandwidth is
possible by means of channel power measurement using a signal analyzer.

Carrier Signal

Moke Signal

: MMJ' I.M”Ilu. |

System B andnidth

SCPI command:
[ :SOURce<hw>] : AWGN: POWer : NOTI Se on page 581

Noise Level (Total Bandwidth) - AWGN
Displays the level of the noise signal in the total bandwidth in "Noise Only" and "Additive
Noise" mode.

SCPI command:
[ : SOURce<hw>] : AWGN: POWer :NOISe:TOTal on page 582

Carrier + Noise Level / Signal + Noise Level (System Bandwidth) / Carrier + Inter-
ferer Level / Signal + Interferer Level
(Additive Noise and CW Interferer)

Displays the overall level of the noise/interferer signal plus useful signal.

Tip: In the mode "Additive Noise" the "Display Output Results For" (analog or digital) has
to be set before.

The name of this parameter depends on the selected "Display Mode".

SCPI command:
[ : SOURce<hw>] : AWGN : POWer : SUM on page 583

Carrier + Noise PEP / Signal + Noise PEP (Total Bandwidth) / Carrier + Interferer
PEP / Signal + Interferer PEP
(Additive Noise and CW Interferer)

Displays the peak envelope power of the overall signal comprised of noise signal plus
useful signal.

The name of this parameter depends on the selected "Display Mode".

Note: The peak envelope power (PEP) specified in the header corresponds to the PEP
value of the carrier.

In the mode "Additive Noise" the "Display Output Results For" (analog or digital) has to
be set before.

SCPI command:
[ : SOURce<hw>] : AWGN: POWer: SUM: PEP on page 583
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4.7.3 Output of the Baseband Signal - 1/Q Out

The R&S Signal Generator provides various outputs of the baseband signal.

The digitally modulated signal can either be output directly or converted to an analog I/
Q baseband output signal. The analog baseband signal can be output single-ended or
differential (non-inverted).

The single ended or differential output requires option R&S SMU-B16, Differential Output.

The signal is output at the I/Q output connectors | OUT/I OUT BAR and Q OUT/
Q OUT BAR on the rear panel of the instrument.

In case of two-path instruments, these connectors can be assigned either to Path A or
Path B.

The output of the digital baseband signal requires the option R&S SMU-B18, Digital I/
Q Out. The signal is output at the standardized (LVDS) digital I/Q interface on the rear
panel.

Digital signal output is possible for path A only.

4.7.3.1 1/Q Out Settings Menu

The settings dialogs for the analog and digital signal output are available in the block
diagram in the "AWGN/IMP" function block as well as in the menu with the same name
which is opened using the MENU key.

Impairments
1'0 Impairments (Digital Baseband)...
AWGN

AWGN...
Analog 10 Ot
Settings...
W 10 Out from A
1'Q Out from B
Digital 1'Q Ot
Settings...

1/ Level
Info...

Selecting the menu item "I/Q Out Settings" opens a dialog with the parameters for the I/
Q output signal.

The "I/Q Out" Settings dialog is available for analog and digital I/Q output signals. These
dialogs are accessable under the menu sections with the corresponging names.
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In case of two-path instruments, the analog 1/Q output signal can be assigned either to
path A or path B.

The settings for the digital I/Q output signal are available for path A only.

1/Q Out - AWGN/IMP
Selects the path to which the 1/Q output connectors are assigned (two-path instruments
only).

"Settings...."  Opens the submenu to set the output type and voltages, see chap-
ter 4.7.3.2, "Analog 1/Q Output", on page 308.
The menu is only available when option Differential Outputs (R&S SMU-
B16) is fitted.

"1/Q Out from A"The 1/Q output connectors are assigned to Path A.
"1/Q Out from B"The 1/Q output connectors are assigned to Path B.

SCPI command:
[ :SOURce] :BB:IQOutput: SOURce oOn page 744

4.7.3.2 Analog I/Q Output

The differential output of the R&S Signal Generator provides symmetrical signals for dif-
ferential inputs of DUTs without the need of additional external electric network.

The operating point of the inputs can be set by a definable DC-voltage (bias). In addition
an offset between inverting and non-inverting output can be set to balance a difference
of the best operating points.

The differential output can be assigned either to Path A or Path B ("Impairment > 1/Q
Out").

The equipment options for the basic unit (R&S SMU with frequency option R&S SMU-
B10x) include the option R&S SMU-B13 (Baseband Main Module) and the option R&S
SMU-B16 (Differential Output) for "I/Q Out...".

N\ Option R&S SMU-B16 (Differential Outputs) cannot be fitted together with options R&S
/ SMU-B81/B82 (Rear Panel Connectors), because they use the same connectors.
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& Analog I/Q Output Settings A |Z| |§| [‘5__<|
Optimize 1/Q Signals For RF Output v
IIlrQ Output Type |pifferential jl

Mode I\.fariable vl
1'Q Level Vp(EMF) I 2.000 |\.r vl
Resulting 1/Q Level Vp(EMF) I 2.000 Iu vl

r

Couple 1Q Bias

| Settings

Bias (EMF) I 1.700 IV vl
Offset (EMF) I 0.0 Im\lr vl

@ Settings

Bias (EMF) | 0 Im\f v[
Offset (EMF) | 0.0 Im\f v[

Optimize 1Q-Signals for RF Output
Activates/deactivates optimization of level accuracy and imbalance for RF Output.

Level accuracy and imbalance can be either optimized for RF output (active) or for dif-
ferential outputs (not active).

With a second option Baseband Main Module (R&S SMU-B13) it is possible to optimize
a signal for RF output in one path and for the differential output in the other path.

SCPI command:
[:SOURce<hw>] :TQ:0UTPut:BIAS:0PTimization[:RF]:STATe on page 745

1/Q Output Type

Selects the type of output. The analog outputs can be operated in "Single Ended" mode
or "Differential" (non-inverted) mode. The menu changes depending on the selected out-
put mode

|
Operating Manual 1007.9845.32 — 16 309



R&S®SMU200A Instrument Function

Impairment of Digital 1/Q Signal and Noise Generator - AWGN/IMP Block

"Differential"  Differential output at | OUT and | OUT BAR or Q OUT and Q OUT BAR.
The analog I/Q signal components are output at I/Q OUT and I/Q OUT
BAR. A bias to set the operating point of DUT can be defined. In addition
an offset between inverting and non-inverting output can be set to bal-
ance a difference of the best operating points.

T Ll / \"’“_T_

'Offset (posi

\ / T \ / —
\ \\H_“_#// 1 OUT BAR

0 .“,.“ Bias {posifive)

Bias (negative
/1 \ { // O\
-— — —— - — —— -— f — — - -
Offzet {pmltwej

/ paa——— \ a———
-4V, A4 \"-.__._.-/ | OUT BAR

"Single Ended" Single-ended output at | OUT and Q OUT.
A bias between I/Q OUT and ground can be defined (requires the option
R&S SMU-B16, Differential 1/Q Output).

SCPI command:

[:SOURce<hw>] : TQ:0UTPut: TYPE on page 748

ov 7

Output Mode
Selects the mode for setting the outputs - independent or together. The menu changes
depending on the selection here.

"Fixed" The settings for the 1/Q signal components are fixed and cannot be
changed.

o "Level Vp (EMF)" (Single ended) = 1.0V
e "Level Vp (EMF)" (Differential) = 2.0 V

e "Bias"=0V

e "Offset"=0V

"Variable" The settings for the I/Q signal components are not fixed and can be
modified.

SCPI command:
[ :SOURce<hw>] : TQ:0UTPut : MODE on page 746
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1/Q Level Vp EMF

Sets the output voltage for both signal components. Small differences at the inputs can
be taken into account via impairment settings (see chapter 4.7.1.1, "Impairment Settings
Menu", on page 288).

Single ended Output:

e Valuerange: 20 mV ... 2V EMF.

e The maximum overall output voltage ("Levelgye" + |"Biasgye"|) is 3.7 V.

Differential Output:
e Valuerange: 40 mV ... 4V EMF.
e The maximum overall output voltage ("0.5" * "Levelgye" + |"Biasgye”| + "0.5" * "Off-

set")is 3.7 V.

SCPI command:
[ :SOURce<hw>] :IQ:0UTPut [:ANALog] : POWer : PEP On page 745

Resulting 1/Q Level Vp EMF
Displays the resulting output off-load voltage of both signal components at the rear panel.

SCPI command:
[ :SOURce<hw>] :IQ:0UTPut [ :ANALog] : POWer: PEP:RESult on page 746

Couple I1Q Bias
(Variable output mode only)

Activates/deactivates coupling of bias setting of the I-signal and Q-signal component. For
activated coupling, the setting can be made for the I-signal component, it automatically
applies to the Q-signal component as well. The fields for setting the Q-signal component
are shaded.

SCPI command:

[ :SOURce<hw>] : TQ:0UTPut:BIAS:COUPling[:STATe] on page 744

Bias (EMF)
Sets the bias. A DC voltage is superimposed upon the | or Q signal. The maximum overall
voltage ("Levelgye" + "Biasgye" + "Offsetgye") is 3.7 volts.

This way, the operating point of a DUT can be set.

SCPI command:
[ :SOURce<hw>]:IQ:0UTPut:BIAS: I on page 744
[ :SOURce<hw>] : TQ:0UTPut :BIAS:Q on page 745

Offset (EMF)
(available only for output type "Differential" only)

Sets an offset between the inverting and the non-inverting output.

The value range is dynamically adjusted in order to respect the following constrains:
The maximum overall voltage ("Levelgye" + "Biasgy" + "Offset") is 3.7 V.

The set value is set half in the positive and half in the negative direction:

e A positive offset is set with half of the value in positive direction at the non-inverting
outputs, in negative direction at the inverting outputs, respectively.
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For example, if a 100.0 mV offset value is set for the | signal component, the output
signal at "l OUT" will have a 50.0 mV offset and the output signal at "I OUT Bar" will
have a 50 OmV offset.

jraac

|’
! ; f 10UT BAR

L # "'- i
u\f." ""--..__..-" \"-.__._..-J',

e Anegative offset is set with half of the value in negative direction at the non-inverting
outputs, in positive direction at the inverting outputs, respectively.

37V, . - - .

o L ¢ L
¥ L} L]

H N /1 OUT BAR

T .
% . Oﬁsetwegatlve] ' '
Y -‘r J.I' '\\ ’J'

N - I oUT
ov |

SCPI command:
[ :SOURce<hw>] :IQ:0UTPut:0FFSet: I on page 747
[ :SOURce<hw>] :IQ:0UTPut:0FFSet:Q on page 747

4.7.3.3 Digital I/Q Output Settings
The digital baseband signal is output at a standardized (LVDS) digital 1/Q interface.

To access the settings for the digital 1/Q output:

1. select "Block Diagram > AWGN/IMP > Config... > Digital I/Q Out > Settings" or
2. press the MENU key and select "AWGN/IMP > Digital 1/Q Output > Settings".
The output of the digital baseband signal is available with the option R&S SMU-B18,

Digital I/Q Out. Two-path instruments require a second option R&S SMU-B18, Digital I/
Q Out for digital output.

|
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E= | Digjtal 10 Output Settings A A=l

Sample Rate

Source | Digital /O Out |

Value [100.000 000 000 | MHz - |

FIFO Status OK
Signal Output
Set Level Via | PEP Rd|

PEP | 0.00| dBFS ~|

Level | 0.00| dBFS |

User Variation
Variation Active Il

Variation Step | 100/ B ~|

Signal Monitoring

No Overflow o

Overflow Hold o Reset

Power On Settings
Power-On State | 1/Q Qut Off j

Connected Device

ON\ If an "R&S EX-1Q-Box" is connected the R&S SMU recognizes this module automatically.

\ / Then, the button "EX-I/Q-Box Settings..." is displayed in the "Digital 1/Q Output Set-
tings" dialog for configuring the parameters of the R&S EX-IQ-Box (see "R&S EX-1Q-
BOX" Manual). Additionally the components of the recognized R&S EX-IQ-Box are listed
in the Hardware Config, section Baseband Assembly.

Digital I/Q Output General Settings

State - Digital 1/Q Output
Switches On/Off the digital 1/Q output signal.

"On" Switches on the digital 1/Q output signal of the currently selected path.
"Off" Switches off the 1/Q output signal of the currently selected path.

SCPI command:
[ :SOURce<hw>] :IQ:0UTPut:DIGital:STATe on page 753

EX-l/Q-Box Settings... - Digital I/Q Output
(With a connected R&S EX-IQ-Box only)

Opens the main settings dialog of the R&S EX-IQ-BOX.

SCPI command:
n.a.
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Sample Rate

In the "Sample Rate" section the sample rate for the digital 1/Q output signal can be set
and the state of signal transmission is indicated by the FIFO Status.

Sample Rate Source - Digital 1/Q Output
Selects the source for the sample rate of the digital I/Q output signal.

Note: With a connected R&S EX-IQ-Box either the internal clock source (User defined)
or an external clock (Digital I/Q In) can be selected in the settings dialog of the R&S EX-
IQ-Box. Therefore, the sample rate source is only indicated in this field.

"User Defined" The internally generated clock reference signal is used. The sample rate
is calculated and displayed in the field "Value".

"Digital I/Q In" An external clock reference signal is used. The clock signal is fed in via
a "Baseband Input Module" (option R&S SMU-B17). The sample rate is
estimated and displayed in the field "Value".

"Digital 1/Q Out"An external clock reference signal is used. The clock signal is directly fed
in via pin CLK2 of the digital output interface (option R&S SMU-B18,
Digital I/Q Out). The sample rate is estimated and displayed in the field
"Value".

SCPI command:
[ :SOURce<hw>]:IQ:0UTPut:DIGital:SRATe: SOURce on page 753

Sample Rate Value - Digital 1/Q Output

Sets or displays the sample rate of the digital I/Q output signal, depending on the selected
sample rate "Source".

SCPI command:

[ :SOURce<hw>] :IQ:0UTPut:DIGital:SRATe on page 752

FIFO Status - Digital I/Q Output
Indicates the state of the signal transmission.

"OK" Resampling is working properly.

"OFL = Over- The external sample rate frequency is too high which causes an overflow
flow" in signal transmission.

"URUN = The external sample rate is too low which causes an underrun in signal
Underrun" transmission.

SCPI command:
[ :SOURce<hw>]:1Q:0UTPut:DIGital :SRATe:FIFO[:STATus] on page 752

Signal Output
The level of the output signal is set in the "Signal Output" section. For entering the value,

level type "PEP" or "Level" can be chosen.

Set Level Via - Digital 1/Q Out
Selects the level type (PEP/Level) that is used to set the signal level of the currently
selected path. Either the PEP or the Level entry field can be edited.

|
Operating Manual 1007.9845.32 — 16 314



R&S®SMU200A Instrument Function
|

Impairment of Digital 1/Q Signal and Noise Generator - AWGN/IMP Block

"PEP" The signal level is expressed in terms of a peak envelope power value
(PEP).
The level entry fields and the corresponding units are displayed in the
status bar.

"Level" The signal level is expressed in terms of an rms value.
The level entry fields and the corresponding units are displayed in the
status bar.

SCPI command:
[ :SOURce<hw>] :IQ:0UTPut:POWer:VIA on page 752

PEP - Digital 1/Q Out
The signal level is expressed in terms of a peak envelope power value (PEP).

The level entry fields and the corresponding units are displayed in the status bar. The
level display always refers to both signal components (SQR(I12+Q?)).

SCPI command:
[ :SOURce<hw>] :IQ:0UTPut:DIGital:POWer: PEP on page 751

Level - Digital /Q Out
The signal level is expressed in terms of an rms level value.

The level entry fields and the corresponding unit are displayed in the status bar. The level
display always refers to both signal components (SQR(I12+Q?)).

SCPI command:
[ :SOURce<hw>] :IQ:0UTPut:DIGital:POWer:LEVel on page 750

User Variation
If the level is set using the rotary knob, the step width is defined in the User Variation
section.

Variation Active - Digital 1/Q Out
Activates the user-defined step width that is used by varying the level value with the rotary

knob.

"On" The level value set with the rotary knob is varied using the user-defined
step width which is entered under "Variation Step".

"Off" The level value set with the rotary knob is varied in steps of one unit at

the cursor position (standard operating mode).

SCPI command:
[ :SOURce<hw>] :IQ:0UTPut:DIGital : POWer: STEP:MODE on page 751

Variation Step - Digital 1/Q Out
Sets the user defined step width for entering the level value using the rotary knob. Level
variation with this step width must be activated with "Variation Active ON".

SCPI command:
[ :SOURce<hw>] :IQ:0UTPut:DIGital :POWer:STEP[: INCRement] on page 751
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Signal Monitoring

The section "Signal Monitoring" indicates digital signal clipping.

Overflow - Digital I/Q Out
Indicates that the I/Q output signal is currently clipped. This indication also appears in
the block diagram close to the digital I/Q Out connector.

Overload may occur, e.g. if the level of the output signal, or the noise level (AWGN) are
too high.

SCPI command:
[:SOURce] : IQ:0UTPut:DIGital :OFLow: STATe on page 750

Overflow Hold - Digital I/Q Out
Indicates an overflow since last reset.

The overflow hold state can be reset via the "Reset" button next to the LED, or is reset
automatically by starting a new signal generation or by setting new values to the output
level.

SCPI command:
[:SOURce] : IQ:0UTPut:DIGital :OFLow:HOLD: STATe on page 749

Reset - Digital 1/Q Out
Executes a reset of the overflow hold state and LED.

SCPI command:
[:SOURce] : IQ:0UTPut:DIGital :OFLow:HOLD:RESet on page 749

Power On Settings

The power on behaviour of the R&S SMU is set in the "Power On Settings" section.

Power-On State - Digital 1/Q Out
Selects the state which the digital I/Q Output is to resume after the instrument is switched
on.

"I/Q Out Off"  The output is deactivated when the instrument is switched on.

"Previous Set- When the instrument is switched on the digital I/Q output resumes to the
ting" status that was active before the last switch off.

SCPI command:
[ :SOURce<hw>] : IQ:0UTPut:DIGital:PON on page 750

Connected Device - Digital 1/Q Out
Indicates the ID of an externally connected R&S Instrument or R&S Device.

SCPI command:
[:SOURce<hw>] :TQ:0UTPut:DIGital :CDEVice on page 749

1/Q Level - Info...

The signal levels and the crest factor of the baseband signal at the 1/Q output connectors
are indicated in the dialog box "Baseband Signal Level".

|
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This information is needed by the user, for example, in order to use the 1/Q signal exter-
nally and to adjust the level correctly there, or to see how the signal is modulated.

Up to baseboard version DacBoard 1141.8090.xx the calculated signal levels are dis-
played. From “DacBoard 1141.8190.02” or higher monitoring the measurement with or
without interfering is provided.

Information on the baseband 1/Q signal during measurement is indicated in the section
"Baseband Signal Level Measurement”. Level, crest factor and duration of the measure-
ment can be displayed for the signal either with or without interfering.

version “DacBoard 1141.8190.02” or higher. Up to baseboard version DacBoard

@ Monitoring the measurement of the digital I/Q baseband signal requires the baseboard
1141.8090.xx only the calculated signal levels are provided.

The currently equipped DacBoard is listed in the dialog "Setup > System > Hardware
Config, section Baseband Assembly" (see chapter 4.2.3.2, "Hardware Config",
on page 128).

To open the "Info..." dialog for information on the baseband 1/Q signal during measure-
ment, select "AWGN/IMP > Configure > Info" or use the MENU key under "AWGN/

IMP".

Impairmemts

1'G Impairments (Digital Baseband)...
AWGN

AWGN...

Analog 10 Ot
Settings...

" 10 Ot from A
10 Owt from B
1/ Level

Info...

4.7.41 Baseband Signal Level

The signal levels and the crest factor of the baseband signal at the 1/Q output connectors
are indicated in the dialog box "Baseband Signal Level".

5 Baseband| Info A

Baseband Signal Level

State

Crest Factor 0.00 B
Peak Level 0.00 dBFS
Signal Level (RMS) 0.00 dBFS

Crest Factor - Digital Impairments
Indicates the crest factor of the baseband signal.

The crest factor is calculated from the two level parameters as follows:
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Crest[dB]=Peak_Level[dBFs]/Signal_Level[dBFs]

SCPI command:
[ :SOURce<hw>] :BB:CFACtor on page 704

Peak Level - Digital Impairments
Indicates the peak level of the baseband signal relative to full scale of 0.5 V (in terms of

dB full scale).

SCPI command:
[ :SOURce<hw>] :BB: POWer : PEAK on page 704

Signal Level (RMS) - Digital Impairments
Indicates the rms level of the baseband signal relative to full scale of 0.5 V (in terms of

dB full scale).

SCPI command:
[ : SOURce<hw>] :BB: POWer : RMS on page 704

Baseband Signal Level Measurement

Information on the baseband 1/Q signal during measurement is indicated in the section
"Baseband Signal Level Measurement". Level, crest factor and duration of the measure-
ment can be displayed for the signal either with or without interfering.

& Baseband Info A

Basehand Signal Level Measurement

Signal Source I Baseband w/o AWGN j

Duration [HH:MM:SS] II]I]:I]I]:I]1

Remaining Time [HH:MM:55] 00:00:00
Crest Factor 0.00 dB
Peak Level 0.00 dBFS
Signal Level (RMS) 0.00 dBFS
IMIMO Fading Power Correction 0.00 dB |

State - Digital Impairments - Measurement
Activates/deactivates the measurement of the digital I/Q baseband signal.

When activated, information on the peak level, rms level and crest factor are indicated.
Additionally the duration of the measurement can be set.

SCPI command:
[ : SOURce<hw>] :BB:MEASurement [ : STATe] on page 703

Signal Source - Digital Impairments - Measurement

Selects the signal for the measurement. The signal level and crest factor can be retrieved
either from the interference-free digital I/Q baseband signal or the signal superimposed
by the noise generator AWGN.

|
Operating Manual 1007.9845.32 — 16 318



R&S®SMU200A Instrument Function

Impairment of Digital 1/Q Signal and Noise Generator - AWGN/IMP Block

"Baseband w/o Activates the measurement of the interference-free baseband signal.

AWGN"
"Baseband with Activates the measurement of the baseband signal after an AWGN noise
AWGN" signal is added.

SCPI command:
[ : SOURce<hw>] :BB:MEASurement : SOURce on page 702

Duration - Digital Impairments - Measurement
Enters the time for the measurement of the digital 1/Q baseband signal in the range of 1
s ... 3 h. The time is to be entered in format "hh:mm:ss".

SCPI command:
[ :SOURce<hw>] :BB:MEASurement : DURation on page 701

Remaining Time - Digital Impairments - Measurement
Indicates the remaining time until the measurement of the digital I/Q baseband signal is
completed. The time is displayed in format "hh:mm:ss".

SCPI command:
[ :SOURce<hw>] :BB:MEASurement : RTIMe on page 702

Crest Factor - Digital Impairments - Measurement
Indicates the crest factor of the baseband signal during measurement.

SCPI command:
[ : SOURce<hw>] :BB:MEASurement : CFACtor on page 701

Peak Level - Digital Impairments - Measurement
Indicates the peak level of the baseband signal relative to full scale of 0.5 V (in terms of
dB full scale) during measurement.

SCPI command:
[ : SOURce<hw>] :BB:MEASurement : POWer : PEAK on page 701

Signal Level (RMS) - Digital Impairments - Measurement
Indicates the rms level of the baseband signal relative to full scale of 0.5 V (in terms of
dB full scale) during measurement.

SCPI command:
[ :SOURce<hw>] :BB:MEASurement : POWer : RMS on page 701

MIMO Fading Power Correction - Digital Impairments - Measurement
The MIMO Fading Power Correction represents the relative power offset of the selected
path compared to the power level of the other path.

The resulting power level of the selected path is then the RF level displayed on the header
of the instrument reduced by the MIMO Fading Power Correction value.

The MIMO Fading Power Correction is necessary in case a MIMO Fading mode with
unequal steering matrix's elements is selected in the Fading block (see section "Multiple
Input Multiple Output" in the description "Fading Simulator"). Such a steering matrix is
used to simulate antennas with different power level.

|
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While working in a 4x2 or 3x2 MIMO mode that requires two two-path R&S Signal Gen-
erators, the MIMO Fading Power Correction for path A of both instruments is identical
and respectively this correction coefficient is identical for both B paths.

However, for two R&S Signal Generators connected and configured to simulate a 2x4 or
2x3 MIMO configurations, there are individual MIMO Fading Power Correction coeffi-
cients for each path and the resulting power level of each of the paths has to be calculated
separately.

Example:
SOUR:FSIM:MIMO:TAP:MATR:ROW1:COL1:RAT 0.9
SOUR:FSIM:MIMO:TAP:MATR:ROW2:COL2 |3 ]4:RAT 1
SOUR:FSIM:MIMO:TAP:MATR:ACC

SOUR:BB:MFPC?

Response: 0.23

SOURZ2 :BB:MFPC?

Response: 0

The signal of path B is with 0.23 dB stronger than the signal of path A.

SCPI command:
[ : SOURce<hw>] :BB:MFPCorrection on page 703

Baseband Signal - Baseband Block

The R&S Signal Generator provides you with the ability to generate digital modulation
signals in accordance with the definitions in the digital standards or with user-definable
characteristics. Signals are generated in realtime or from a data store with the aid of
external and internal data. You can also load externally computed modulation signals into
the R&S Signal Generator in the form of waveform files.

Several digital standards are provided, plus digital modulation with user-definable signal
characteristics, generation of waveforms with the aid of the Arbitrary Waveform Gener-
ator and generation of multi carrier CW signals with the aid of Multi Carrier CW.

The settings for digital modulation can be accessed in the block diagram via the "Base-
band" function block or with the aid of the MENU key.

arker

1: =l timing
2 =lat timing

Trig In 1

The equipment layout for generating the internal, digital modulation signals includes the
options Baseband Main Module (B13) and one of the options Baseband Generator (B9/
B10/B11) .The three Baseband Generator options feature different ARB memory sizes
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Frequency Offset
0.00 Hz

Phase Offset
0.0 deg

Path Gain
0.0 dB

Signal Routing

v route to path A
route to path B
route to path A and B

Baseband Signal - Baseband Block

(see data sheet). Apart from the memory size, however, the options offer the same func-
tionality, either one can be installed.

In addition, the appropriate option is required for the digital standards. These options are
specified in the description of the respective standard.

The minimum equipment for a two-path instrument is a second R&S SMU-B9/B10/B11
option. This can be used simultaneously on the second path to generate a modulation
signal which can either be routed via path A or added to the signal on path A with a
frequency offset that can be set. In the case of a fully two-path layout, path B can be
operated as a second signal generator independently of path A (see also data sheet).

If the appropriate options are fitted, externally supplied real-time baseband signals can
be added to the internally generated signals.

In the subsequent signal route the baseband signals can be frequency-shifted, faded,
detuned or loaded with noise (see chapter 4.9, "External Baseband Signal - Baseband
Input", on page 442, chapter 4.7, "Impairment of Digital I/Q Signal and Noise Generator
- AWGN/IMP Block", on page 287 and the description "Fading Simulator").

Working with the Baseband Signal

In the case of two-path instruments, signal routing, frequency offset and path gain defi-
nition are defined at the topmost menu level in the "Baseband" block or by using the
MENU button under "Baseband".

The upper part of the "Baseband" dialog is used for selecting digital standards, digital
modulation and waveform generation. These menus are described in the respective
chapters relating to the modulation systems.

The lower part of the "Baseband" dialog can be used to define a frequency offset a path
gain, a phase offset, and the signal routing for two-path instruments.

Frequency Offset
Enters the frequency offset for the baseband signal.

The frequency offset shifts the baseband frequency interval and provides a quick way to
shift the used frequency band in the RF frequency section without modifying the RF set-
tings.

Freq Offset 407 |Hz -

Wenn a frequency offset is defined, an icon is displayed in the signal flow right to the
baseband block.

Note: For sample rates of exactly 100 MHz (Mode Digital Input (Native100MHz)) it is
not possible to enter a frequency offset. The digital signal is fed into the signal path directly
and not routed to the resampler where the frequency offset takes place. This type of entry
is also prohibited if the noise generator ("AWGN" block) is on.
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The complex I/Q bandwidth of the shifted useful signal must not exceed 80 MHz in total.
The following applies:
fottset = fuse/2 >= - 80MHz/2 and fygeet + fuse/2 <= + 80MHZz/2

fuse = the complex useful bandwidth of the I/Q signal before the offset.
forrset = frequency offset.

The following graph illustrates the setting range for the frequency offset.

i

setting

-40 MHz foser foret  +40 MHz
Fig. 4-24: Setting range for frequency offset
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Example:
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Fig. 4-25: 3GPP FDD signal (chip rate 3.84 Mcps, root-cosine filter 0.22).

The complex useful bandwidth of a signal which has been filtered using a root-cosine
filter with roll off alpha is calculated as follows:

fuse = (1+ alpha) * fsympol

fsymbol = the symbol rate or chip rate of the signal.

In the example the complex useful bandwidth is calculated as follows:
fuse = (1+ 0.22) * 3.84 MHz = 4.6848 MHz.

So as to comply with the condition requiring a maximum 1/Q bandwidth of 40 MHz, the
valid range of values for the frequency offset is then:

-40MHz + 4.6848MHz/2 <= f e <= 40MHz - 4.6848MHz/2 or
-35.3152MHz <= f g0<= 35.3152MHz

In the case of ARB signals, the output clock rate can be used for estimating the maximum
I/Q bandwidth of the waveform.

SCPI command:
[ :SOURce<hw>] :BB: FOFFset on page 585

Phase Offset
Enters the phase offset for the baseband signal of the selected path compared to the
baseband signal of the other path.

|IPhaseOlTset | n.nmldeg v||

For instruments equipped with an external baseband input ("BB Input"), this parameter
also enters the phase offset of the baseband signal of the selected path compared to the
external baseband input.

The phase offset affects the signal on the "Baseband block" output.

SCPI command:
[ :SOURce<hw>] :BB: POFFset on page 586
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Path Gain
Enters the path gain for the baseband signal of the selected path compared to the base-
band signal of the other path.

In case an external baseband input ("BB Input") is used, this parameter also determines
the path gain for the baseband signal of the selected path compared to the baseband
signal of this external data source.

The gain affects the signal on the "Baseband block" output.

Note: In case the baseband signal is additionally faded and routed at the output of the
fading simulator, so that the faded signals from both paths are summed, the real path
gain is measured at the output of the "Fading" block and set with the fading parameter
"Summation Ratio A/B" (see description “Fading Simulator”, section “Summation Ratio
A/B”).

The relative gain set with the parameter "Path Gain" in the "Baseband" block is ignored.
The "Path Gain" of the different baseband sources define the relative gain of the asso-
ciated signals. The real gain depends on the following parameters along with the set path
gain:

e Signal characteristics, in particular the crest factor

o Number of baseband sources

e Overall RF output level.

The sum baseband signal can be verified in the spectrum display in the "Graphics" block.

SCPI command:
[ :SOURce<hw>] :BB: PGAin on page 586

Signal Routing
Selects the signal route for the baseband signal of a two-path instrument.

The following table shows the combination of signal routes allowed for two-path instru-
ments.

s AWGNIIMP A | I
- e I ot o I o SN
5 :brgE> . - -
Graphics
confg...
T oon
AWGN/IMP B G Mod B
e I ey o B e Y
= T T oom Toon o =

|
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Table 4-3: Combinations of signal routings for two-path instruments
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Rout- | Rout- | Block diagram

ing ing
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A B
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"Route to path The baseband signal is introduced into path A. The signals from both

All

paths are summed if necessary.

"Route to path The baseband signal is introduced into path B. The signals from both

Bll

paths are summed if necessary.
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"Route to path AThe baseband signal is introduced into path A and path B. The signals
and B" from both paths are summed if necessary.

SCPI command:

[ :SOURce] :BB: PATH:COUNt on page 585

[ :SOURce<hw>] :BB:ROUTe on page 586

Data and Signal Sources in Baseband

This section describes the common characteristics of the signals used for generating the
baseband signal for all standards, including for example all listed data sources. The
selection in the digital menus at any given time depends on the parameter and standard
concerned and is clear from the selection list offered in the menu. The external data
sources may therefore not be available in certain cases.

Characteristics which are uniquely specific to particular standards are described in the
corresponding manual.

For instruments equipped with option Baseband Input, R&S SMU-B17, externally gen-
erated analog baseband signals can be fed into the digital signal path via the analog I/Q
input "l IN" and "Q IN".

The following input signals are used when digital modulation signals are being generated:
e Modulation data

e Clock signals

e Control signals

The input signals can be both internally generated and supplied from an external source.

The internally generated data and clock signals are output not only on the DATA and
CLOCK connectors but also on the corresponding pins of the AUX I/O interface.

In the case of two-path instruments, the external data and clock sources are permanently
allocated to path A, and data output is always for path A.

Likewise control signals and also trigger signals for triggering signal generation in the
R&S Signal Generator can be internally generated or supplied from an external source.

Up to four marker output signals for synchronizing external instruments can be user-
defined for each path.

Externally computed waveform files can be loaded in the instrument using computer
interfaces or IEC bus.

Waveform files are processed with the aid of the Arbitrary Waveform Generator (ARB),
see chapter 4.8.4, "Arbitrary Waveform Generator ARB", on page 382.

Internally the "Multi Carrier CW" menu for defining multi carrier waveforms is available
(see chapter 4.8.5, "Multi Carrier Continuous Wave", on page 428).

|
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4.8.2.1 Internal PRBS Data and Data Patterns

PRBS generators deliver pseudo-random binary sequences of differing length and dura-
tion. They are known as maximum length sequences, and are generated with the aid of
ring shift registers with feedback points determined by the polynomial.

By way of example, the diagram below shows a 9-bit generator with feedback to registers
4 and 0 (output).

EXOR

F

SER DATA

3*?—16|—'5—F4J9{3|—>2—h1—)~[] »

Fig. 4-26: 9-bit PRBS generator

For PRBS15 and PRBS23, a CCITT V.52-compliant data inversion is performed in the
feedback path automatically as shown below:

Xf XXPXEX"X'IX XXX XXX XXX

D15‘ '/;k l/D13k 'D12\‘—>‘ Dﬁ\ D10“ ’g\ D8 N b7 | ’g ?5 ‘/g‘ ?3 /E ;
|—', D14 | D13 { D12 1 D11 5|10 »| D9 5 D3 [» D7 »{ D » D5 v D4 ¥ \H_ W T

The pseudo-random sequence from a PRBS generator is uniquely defined by the register
number and the feedback. The following table describes all the available PRBS genera-
tors:

Table 4-4: PRBS generators

PRBS generator Length in bits Feedback to Menu selection
9-bit 29 -1 =511 Registers 4, 0 PRBS 9

11-bit 211 -1 = 2047 Registers 2, 0 PRBS 11

16-bit 216 -1 = 65535 Registers 5, 3, 2, 0 PRBS 16

20-bit 220 -1 = 1048575 Registers 3, 0 PRBS 20

21-bit 221 -1=2097151 Registers 2, 0 PRBS 21

The "Data Source" selection for PRBS data from the menus is "PN11, ...".

Simple data patterns such as binary 0 strings or 1 strings can also be used as internal
modulation data. The "Data Source" selection from the menus is "ALL 0", "ALL1". A var-
iable bit string with a maximum length of 64 bits can be entered in an input field by
selecting "Pattern.”

4.8.2.2 Internal Modulation Data from Lists

Internal modulation data can be generated and stored in the form of binary lists. A sep-
arate file is created for each list and held on the instrument's hard disk.
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The file name can be defined by the user.

The "Data Source" selection from the menus is "Data List". When this menu item is
chosen the "Select Data List" button appears; this opens the file-selection window for
data lists. A list can be created and edited in the "Data List Editor", which is accessed
from the menu via the "List Management" or "Data List Management" button.

i Data list - data,_cdma

Offset 0, Len 685136, data_cdma rep

0 fo11 0001 0000 0000 0000 000D 0000 000D 1111 1110
40 0101 1111 0000 1111 0000 OOOO OOOO OOOO OOOO OOOO
80 o101 0101 0101 0101 0101 0101 0101 0101 0101 0101
120 0101 0101 0101 0101 0101 0101 0101 0101 0101 0101
160 0101 0101 0101 0101 0101 0101 0101 0101 0101 0101

NN NAN4 N4N4 N4AN4 0404 N4N4 0404 N4nd 0404 nand N4 n4

GoTo HEX

The maximum length of a data list is determined by the size of the data list memory (see
data sheet). There is no restriction on the number of lists that can be stored.

External Synchronous Modulation Data

External Serial Modulation Data via the DATA Connector

For "Custom Digital Modulation", serial modulation data can be supplied bit-by-bit via the
DATA connector. The "Data Source" selection from the menu is "Extern Serial".

In the case of two-path instruments the DATA input is permanently allocated to path A.

Data Source——————
iData Source | Extern serial |
In the case of modulation modes with more than 1bit/symbol, the most significant bit
(MSB) must be fed in first (MSB first).

The clock reference (symbol clock) used to read in the data can be either internal or
external.

External serial data is output on the PARDATA pins of the AUX |/O interface as parallel
data LSB-justified.

The maximum data rate for serial data processing can be found in the data sheet.

External Parallel Modulation Data via the AUX I/O Interface

For "Custom Digital Modulation", parallel data can be supplied symbol-by-symbol via the
AUX I/O interface (D0 — D9). The "Data Source" selection from the menu is "Extern Par-
allel".

In the case of two-path instruments the data lines from the AUX I/O interface are allocated
to pathA permanently.

[ Data Source
fpata source | Extern Parallel (AUX 110) ~|

|
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In the case of modulation modes with fewer than 10bits/symbol, the data must be applied
LSB-justified. In the case of 8-PSK modulation for example (3bits/symbol) only data lines
DO, D1 and D2 are used.

The clock reference (symbol clock) used to read in the data can be either internal or
external.

External parallel data is output on the DATA connector serially. However, there is a max-
imum data rate above which serial data processing becomes impossible and the DATA
connector becomes high-impedance. The maximum data rate for parallel data processing
is shown in the data sheet.

Clock Signals

The clock reference used for generating the timing pulse can be either internal or external
("Clock Source" selection from the menu: "Internal / External").

Internal clock reference

Clock Setlings
ICIDck Source [ Internal ~|l

The table bellow gives an overview of the generated clock signals and the connectors
they are output at for the case a internal clock reference is selected.

Connector Location Clock Mode

CLOCK front panel Bit clock

CLOCK OUT rear panel Choice of bit clock or symbol clock
BITCLK AUX I/O interface, rear panel Bit clock

SYMBCLK AUX I/O interface, rear panel Symbol clock

If required, in the case of two-path instruments the internal bit clock or symbol clock from
path B can be output on one of the USER interfaces.

The clock output signals are assigned in the menu sequence "Setup > Environment >
Global Trigger/Clock/External Inputs > USER Marker /AUX I/O Settings".

External clock reference

Clock Settings

ICIul:k Source | External ’ jll ‘l

An external clock is always supplied via the CLOCK connector. When the external clock
reference is selected, the internal clock is synchronized to it. The table bellow gives an
overview of the connectors the internal clocks are output at.

|
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Connector Location Clock Mode

CLOCK OUT rear panel Choice of bit clock or symbol clock
BITCLK AUX I/O interface, rear panel Bit clock

SYMBCLK AUX I/O interface, rear panel Symbol clock

The active edge of the external clock signal on the CLOCK input is selectable (menu
"Setup > System > Global Trigger/Clock/External Inputs"). Internally the rising edge is
always taken as the active edge. The active rising edge of the internal clocks is therefore
synchronized with either the rising or the falling edge of the external clock reference. A
symbol clock can be supplied externally or, if internally generated or externally asyn-
chronous data is being fed in, a multiple of a symbol clock can be supplied.

In the case of two-path instruments the external clock signal is applied to path A.

In order for the clock synthesizer on the R&S SMU to be synchronized correctly, the
external clock reference must first be applied and the correct symbol rate must then be
set. Until this has been done the external clock source must not be selected ("Clock
Source External").

\ The symbol rate set must not deviate from the symbol rate of the external signal by more
than 2% (see also data sheet).

The synchronization of data signals and clock signals for the various data sources and
clock sources is described in chapter 4.8.2.5, "Synchronizing Data Signals and Clock
Signals", on page 332.

4.8.2.5 Synchronizing Data Signals and Clock Signals

When selecting data signals and clock signals, the following operating modes are pos-
sible:

e Internal clock and internal data

e Internal clock and external synchronous data

e External clock and external synchronous data

e External clock and either internal data or external asynchronous data

Internal Clock and Internal Data

When internal data is selected for path A, this data is output in serial mode on the DATA
connector or in parallel mode on the PARADATA pins of the AUX I/O interface ("Custom
Digital Modulation").

In modulation modes with fewer than 10bits/symbol, the parallel data is output LSB-jus-
tified. In the case of 8-PSK modulation for example (3bits/symbol) only data lines DO, D1
and D2 are used.

The internal data of path B is not output in two-path instruments. For synchronization
purposes, however, it is possible to output the bit clock or symbol clock from this path to
one of the USER connectors.
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In the following example, the diagram shows the output signals of an 8-PSK modulation
(3 bits per symbol) on the serial DATA interface. The positive edge of the clock is always
used when outputting data. The data source is a data list with 15 bits =001 010 100 101
110 (5 symbols).

e I o T T o TN o T o T o T o T o T o T o e T o O o O o T

CLLE ECIOT {momimlclach aw) — i — — I

| | | |
TRTAfim. dew ew) LEB LEE HIEB LER HEE LEE F niEn | L&
Thin ymimls L L) ik Ll Lk

Fig. 4-27: Output signal on the serial data interface and clock output signals on the AUX I/O interface

There is a maximum data rate above which serial data processing becomes impossible.
This data rate can be found in the data sheet. If the rate is exceeded the DATA connector
becomes high-impedance, and the output on the CLOCK connector is the symbol clock
instead of the bit clock.

In the following example, the diagram shows the output signals of an 8-PSK modulation
(3 bits per symbol) on the parallel interface. The data source is a data list with 15 bits =
001 010 100 101 110 (5 symbols).

SYMHCLE (ryzinl chrk usf] .r_h — — f_fl F
9 (. i Bust] | | i
O f. e ) | i i I
O3 fp. damd nut !

|

R
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Fig. 4-28: Data and clock output signals on the parallel AUX I/O interface

In order for parallel external data to be retrieved correctly the rising edge of the symbol
clock must be used, since the timing between the falling edge of the symbol clock and
the data switch on the parallel interface is undefined.

Internal Clock and External Synchronous Data

External serial data

When serial data for "Custom Digital Modulation" is being fed in via the DATA connector
on the front panel, the symbol clock acts as a scanning pulse (strobe) so as to mark the
least significant bit in a symbol.

The clock signals are output on the CLOCK and CLOCK OUT connectors (front panel
and rear panel respectively, choice of bit clock or symbol clock on the latter) and on the
BITCLK or SYMBCLK pins on the AUX I/O interface. Optimum timing is achieved from
using the output signal on the CLOCK connector on the front panel. The setup and hold
times (see following diagram, tsetup and thold) that must be maintained in the R&S Signal
Generator to ensure that the serial data is accepted correctly can be found in the data
sheet.

The following diagram illustrates the timing ratios between data and clock when serial
data is being supplied from an external source and the internal clock source is being used.

|
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CLOCK (bit clock out) 2 [+ |2 |
CLOCK QUT (symbaol clock aut) : / \
DATA (ser. data in) 58 Y e X } ST |

Fig. 4-29: External serial data and the clock signals which are output (bit clock and symbol clock). The
setup time (t_setup) and hold time (t_hold) can be found in the data sheet.

External parallel data

When parallel data for "Custom Digital Modulation" is being fed in via the AUX I/O inter-
face (DO — D9), the internal symbol clock is used.

The symbol clock is output on the CLOCK OUT connector (rear panel, choice of bit clock
or symbol clock) and on the SYMBCLK pin on the AUX I/O interface. Optimum timing is
achieved by using the symbol clock on the SYMBCLK pin on the AUX I/O interface. The
setup and hold times (see following diagram, tsetup and thold) that must be maintained
in the R&S Signal Generator to ensure that the serial data is accepted correctly can be
found in the data sheet.

The following diagram illustrates the timing ratios between data and clock when parallel
data is being supplied from an external source and the internal clock source is being used.

t
00...D9 (par. data in) R 1 ¥ X
SYME CLK (symbol clock autput) ; | ; | ;

Fig. 4-30: External parallel data, internal clock signal and the clock signal that is output on the AUX I/
O interface The setup time (t_setup) and hold time (t_hold) can be found in the data sheet.

External Clock and External Synchronous Data

When synchronous modulation data is being fed in from an external source for "Custom
Digital Modulation", clock generation in the R&S Signal Generator can be synchronized
on the rising or falling edge of an external symbol clock. The clock reference is supplied
on the CLOCK connector (front panel).

The clock signals generated as a result are output on the CLOCK OUT connector (rear
panel, choice of bit clock or symbol clock) and on the BITCLK or SYMBCLK pins on the
AUX /O interface.

External serial data

The following diagram illustrates the timing ratios between data and clock when serial
data is being supplied from an external source and an external reference clock is being
used.

|
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CLOCK (symbol clock in) : |
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Fig. 4-31: External serial data and external symbol clock - 3 bits/symbol with high and low active symbol

clock for marking the LSB. The data and the symbol clock must change state simulta-
neously. The setup time (tsetup) and hold time (thold) can be found in the data sheet.

A bit clock is generated from the externally supplied symbol clock and is used for reading
the serial data into the R&S Signal Generator. The active edge of this bit clock is located
ahead of the symbol clock.

External parallel data

The following diagram illustrates the timing ratios between data and clock when parallel
data is being supplied from an external source and an external reference clock is being
used.

Lonp

DO, D3 (par. datain) - & X

CLOCK (symbol dlockin) [+ | [ L
SYME CLE (symbal clock out) ; : I l_l_

Fig. 4-32: External parallel data with high and low active external symbol clock. The setup time (tsetup)
and hold time (thold) can be found in the data sheet.

The R&S Signal Generator uses the externally supplied symbol clock to generate an
internal symbol clock that defines the sampling points at which the parallel data is read
into the R&S Signal Generator. These sampling points are also located a little ahead of
the external symbol clock.

External Clock and Internal or External Asynchronous Data

If the modulation data is generated internally or supplied asynchronously from an external
source, clock generation in the R&S SMU can be synchronized on an external symbol
clock, or a multiple thereof, which is fed in on the CLOCK connector (front panel). Syn-
chronization can be based on the rising edge or falling edge according to choice. The
maximum permissible multiple symbol clock can be found in the data sheet.

4.8.2.6 Control Signals

The following control signals are processed in the R&S SMU:
e "Burst Gate" for power ramping
e "Level Attenuation" for power ramping

e "CW" for controlling the CW (continuous wave) mode
The "CW" signal turns off digital modulation. The signal is output in unmodulated form.

Operating Manual 1007.9845.32 — 16 335



R&S®SMU200A Instrument Function

Baseband Signal - Baseband Block

In case of standards in which it is possible to switch between different modulation
modes, the signal is output only and cannot be supplied from an external source. In
such cases it indicates the modulation mode internally (standard GSM: signal high
(1) = modulation mode GMSK and signal low (0) = modulation mode 8PSK EDGE).

The CW control signal is generated internally and fed to the AUX I/O interface. The control
signals for power ramping can be provided externally for Custom Digital Modulation only.
When generated internally the signals are output on the AUX I/O interface.

A dedicated internal "Control Data Editor" is provided for defining the control signals. This
editor with its intuitive graphical interface can be used to define and save control signals.
Definition by generating or editing a binary list is no longer necessary (though it is still
possible via the IEC bus).

A separate file with the file extension * . dm 1iqc is created for each defined control signal
and held on the R&S Signal Generator hard disk.

If the "Component Data Editor" is used, the "Control Data Editor" is integrated with it. The
defined control data is not held separately, but stored with the data structure. This applies
both to signals of the Data Editor Realtime and the Data Editor Offline.

Power Ramping and Level Attenuation

In TDMA radio networks it is necessary to control the RF output signal envelope syn-
chronously for the purpose of digital modulation. The signals "Burst" Gate and "Lev Att"
are used for this. These signals are internally generated.

In case of "Custom Digital Modulation", they can also be supplied from an external source
via the AUX I/O interface.

When power ramping is enabled, a ramp is generated whenever there is a data switch
on the "Burst" signal (from high to low or low to high). The steepness of this ramp can be
adjusted. Power ramping is enabled and configured in the "Power Ramp Control" sub-
menu.

The "Lev_Att" signal is used to control a defined level attenuation. If level attenuation is
enabled, the modulation signal level is attenuated by a defined value if the "Lev_Att"
signal is high. The level attenuation value is defined in the "Power Ramp Control" menu.
For the "GSM/EDGE" standard a maximum of 7 different level attenuation values can be
defined and allocated separately to the 8 slots quite independently of one another. Level
attenuation is enabled either in the "Power Ramp Control" menu (Custom Digital Modu-
lation) or in the "Burst Editor" (GSM/EDGE).

ISIot Level |Aﬂenuated i

Slot Attenuation |7.0dB (D) d|

Level attenuation enables to simulate radio stations located at various distances.

The diagram below shows an example of how the power ramping signals work.

|
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Fig. 4-33: Signal behavior when power ramping is enabled. The Burst Gate signal defines the start of
the rising and falling edges of the envelope, and the Lev Att signal defines the start and
end of level attenuation. The level attenuation value is defined in the Power Ramp Control
menu.

4.8.2.7 Trigger Signals

In the R&S Signal Generator, trigger signals are internally generated or externally sup-
plied signals which start signal generation at a particular point in time.

Signal generation can also take place without triggering, in which case the signal is then
generated in full after modulation is powered up. A trigger event either has no effect on
signal generation (menu setting "Trigger Mode Auto") or triggers a signal restart (menu
setting "Trigger Mode Retrigger").

If signal generation is triggered, the signal is continuously generated after the first trigger.
In the "Armed_Auto" mode, a further trigger event has no effect. In the "Armed_Retrig"
mode, every additional trigger event triggers a restart of the signal. In both cases, trig-
gering can be reset to the initial state ("armed"), i.e. signal generation is stopped and the
instrument waits for the next trigger to start signal generation anew.

The status of signal generation ("Running" or "Stopped") is displayed for all trigger modes
in the corresponding trigger menu of the digital standard currently switched on. The signal
generation status particularly with an external trigger can thus be checked.

Internal and external trigger sources are available for triggering.

e Internally, triggering is carried out manually by pressing the "Execute Trigger" button
(menu selection "Internal”).

e In the case of two-path instruments, internal triggering can be caused by the trigger
signal on the second path (menu selection "Internal (Baseband A/B)"). This makes it
possible to synchronize the signal on one of the two paths with the signal on the
second path. Using an external trigger source, it is possible to set the trigger signal
to be delayed or suppressed.

e External trigger signals can be fed in via the TRIGGER connector (menu selection
"External").
In the case of external triggering and internal triggering by the trigger signal on the
second path, the start can be delayed by a definable number of symbols (menu setting
"Trigger Delay External"). This makes it possible to purposely simulate the time delay
between a base station signal and a user equipment signal, for example in the course
of base station tests.
The effect of a restarted trigger signal in the "Retrigger" trigger mode can be sup-
pressed for a definable number of symbols (menu setting "External Trigger Inhibit").
By this means the trigger can be suppressed for a definable number of frames, for
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example in the course of base station tests, and yet the signal can still be generated
synchronously. In each frame the base station generates a trigger which would cause
a signal generation restart every time but for the suppression.

Example:

Entering 1000 samples means that after a trigger event, any subsequent trigger signal is
ignored for the space of 1000 samples.

A signal which marks the trigger event set off by the current internal or external trigger of
path A or B can be output at the USER connectors (AUX 10 interface or USER BNC
connector).

\ The trigger mode setting, the selection of the trigger source and the setting of a delay

/ and trigger suppression in the case of external triggering are carried out independently
for each of the two paths. On the other hand configuration of the trigger connectors
(polarity and impedance) is carried out jointly for both paths.

4.8.2.8 Marker Output Signals

The R&S Signal Generator generates user-definable marker output signals which can be
used to synchronize external instruments. By this means a slot clock or frame clock can
be set, for instance, or the start of a particular modulation symbol can be marked.

Four marker outputs are available for each path. The outputs for markers 1 to 3 are
defined, but marker 4 can be placed on one of the USER outputs according to choice.

Path Marker Connector Location
Path A Markers 1/2 MARKER 1 /2 BNC connec- | front panel
tors
Marker 3 MARKER 3 pin of the AUX I/ | rear panel

O connector

Marker 4 USER1 BNC connector or rear panel
USERZ2/3/4 pins of the AUX
I/O connector

Path B Marker 1 MARKER 1B BNC connector | rear panel

Markers 2/3 MARKER 2B / 3B pins of the | rear panel
AUX I/O connector

Marker 4 USER1 BNC connector or rear panel
USER2/3/4 pins of the AUX
I/0O connector

4.8.3 Digital Modulation - Custom Digital Modulation

The R&S Signal Generator can generate digital modulation signals with user-definable
characteristics. Baseband filtering and the symbol rate can be set within wide limits.

|
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4.8.3.1 Overview and Required Options

The equipment layout for generating the digital modulation signals includes the options
Baseband Main Module (R&S SMU-B13) and Baseband Generator (R&S SMU-B9/B10/
B11).

In the case of two-path instruments, at least one further Baseband Generator (R&S SMU-
B9/B10/B11) option is needed for signal generation in the second path. Using this option
a signal can be defined in path B and then either routed via path A or added to the signal
on path A with a frequency offset that can be set. When path B is fully expanded with a
second option Baseband Main Module (R&S SMU-B13) and an RF section frequency
option (R&S SMU-B20x) the modulation signal can be output on RF output B.

When modulation is ON, a two-part level indication is shown in the header section of the
display. This displays both the average power (LEVEL) and the peak envelope power
(PEP) of the modulated output signal.

Frequency PEP Level
| 100.000 000 000 |t =] [-30.00 dém |-30.00 |dBm -]

The difference between PEP and LEVEL depends on the modulation type and the filter-
ing: Both values are pre-measured internally so that the displayed values match the true
values in the signal. When external signals are used, they are replaced by PRBS data
during pre-measurement.

4.8.3.2 Modulation Types - Custom Digital Mod

The available predefined modulation types are ASK (amplitude shift keying), FSK (fre-
quency shift keying), PSK (phase shift keying) and QAM (quadrature amplitude modu-
lation). Additionally, a user defined modulation mapping can be applied (see "User Map-
ping", on page 347).

The actual modulation procedure is described by mapping, which assigns | and Q values
(PSK and QAM) or frequency shifts (FSK) to every modulation symbol that occurs. This
is represented graphically in the constellation diagrams.

The mapping for the selected modulation type is displayed in the "More..." submenu in
the "Modulation" menu section (see "More - Modulation Type - Digital Modulation"
on page 361).

The QAM procedures 16QAM, 32QAM, 64QAM have been produced in accordance with
ETSI standard ETS 300429 for digital video broadcasting (DVB). The QAM procedures
256QAM and 1024QAM are not specified in this standard, but have been produced
according to the same basic principles.

In the case of all FSK procedures, the user can set the symbol rate fSYMB up to a max-
imum value (see data sheet). If MSK is selected, the frequency deviation (FSK deviation)
cannot be set since it is permanently set to V4 of the symbol rate.

|
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Table 4-5: Modulation type and associated mapping

ASK
1 bit per symbol
SOUR:BB:DM: FORM ASK

ASK

-1 04 0 04a 1
| Value
PSK
BPSK QPSK QPSK 45° Offset
1 bit per symbol 2 bits per symbol 2 bits per symbol, 45° rotation
SOUR:BB:DM:FORM BPSK SOUR:BB:DM: FORM QPSK SOUR:BB:DM:FORM QPSK45
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QP SK45

[ab]} I
=0 =
™ o
= =
T i e
=
[
=
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['Walug | Value
-1 -0.5 1 04 1
| Value
QPSK EDGE AQPSK OQPSK
2 bits per symbol, 3pi/4 rotation 2 bits per symbol, pi/2 rotation | 2 bits per symbol, Q offset
SOUR:BB:DM: FORM QEDGe SOUR:BB:DM:FORM AQPSk SOUR:BB:DM: FORM OQPSK
EDGE QPE AQ OQAFSK

CvValue
Q Value
1 Value

| Value
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pi/4-QPSK
2 bits per symbol pi/4rotation
SOUR:BB:DM:FORM P4QP

pi/2-DBPSK

1 bit per symbol

Differential coding, pi/2 rotation
SOUR:BB:DM: FORM P2DB

pi/4-DQPSK

2 bits per symbol

Differential coding, pi/4 rotation
SOUR:BB:DM: FORM P4DQ

o Value

o Value

H

pi/8-D8PSK

3 bits per symbol

Differential coding, pi/8 rotation
SOUR:BB:DM: FORM P8D8

8PSK
3 bits per symbol
SOUR:BB:DM:FORM PSK8

8PSK EDGE (3pi/8 8PSK)
3 bits per symbol

Edge coding, 3pi/8 rotation
SOUR:BB:DM:FORM P8ED

Ifd DR Sk

| Value
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-1 0.5 0
| Walue
QAM
16QAM 16QAM EDGE 32QAM
4 bits per symbol 4 bits per symbol, pi/4 rotation | 5 bits per symbol
SOUR:BB:DM: FORM QAM16 SOUR:BB:DM: FORM SOUR:BB:DM: FORM QAM32
QAM16EDge
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EDGE] 320AM

I I I
= = =

[ 0 [
= - =

i i i

-1 0.5 0
\ | Walue

32QAM EDGE 64QAM 128QAM

5 bits per symbol, -pi/4 rotation 6 bits per symbol 7 bits per symbol

SOUR:BB:DM:FORM QAM32EDge SOUR:BB:DM: FORM QAM64 SOUR:BB:DM:FORM QAM128
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EDGE 32 1280AM
1 1
045 s
ok
= g E
va o aaj
= 0 £ 0 =S
- - .
0.5 ns
| -1
-1 05 -1 05 0
| | Value
256QAM 1024QAM
8 bits per symbol 10 bits per symbol
SOUR:BB:DM: FORM QAM256 SOUR:BB:DM: FORM QAM1024
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MSK 2FSK 4FSK
1 bit per symbol, FSK deviation 1 bit per symbol 2 bit per symbol
SOUR:BB:DM:FORM MSK SOUR:BB:DM: FORM FSK2 SOUR:BB:DM:FORM FSK4

SOUR:BB:DM:FSK:DEV 0.1 MHz

AF Sk

Felative|freguency f,

Felative fre

In addition to the FSK modulations, a variable FSK modulation with definable deviation
per symbol is available.

[ : SOURce<hw>] :BB:DM: FORMat on page 651

User Mapping

A user defined modulation mapping file can also be selected as modulation mapping
source. The user modulation mapping file must have extension * .vam and can be cre-
ated with the R&S mapping wizard. The mapping wizard (mapwiz) is a tool from Rohde
& Schwarz designed for editing modulation schemes (e.g. QPSK, 32QAM). Its main pur-
pose is the assignment of logical symbol numbers to constellation points and the selection
of modulation specific parameters. Beyond this it supports the creation of nearly any
arbitrarily chosen constellation diagram. The output of mapwiz is a mapping file

(* .vam) that can be imported on a R&S SMU. The program was developed on a 32-bit
Microsoft Windows platform under MATLAB. For more information, refer to the descrip-
tion "Introduction to "mapwiz" Mapping Editor" on the Rohde&Schwarz Internet page.
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4.8.3.3

Coding - Custom Digital Mod

Instrument Function
|

Baseband Signal - Baseband Block

Modulation symbols are coded directly before | and Q values or frequency shifts are
assigned. Coding is thus directly related to modulation methods, which is the reason why
codings are not freely combinable with modulation methods. The following table shows
which of the coding combinations are available and defines the modulation types for
which the various coding procedures can be used.

In the notation used below an denotes the n-th input symbol and bn denotes the corre-
spondingly coded output symbol. Individual bits in the symbols from the LSB (least sig-
nificant bit) to the MSB (most significant bit) are denoted by aOn, a1n and so on. The

same applies to the output symbols.

Table 4-6: Permissible coding combinations for modulation symbols and modulation type

OFF | Differ- Phase Diff. Gray | GSM | NADC, TFTS/ INMARSAT, VDL | (FSK)
ential Diff. +Gray PDC, TETRA |ICO, WCDMA,

PHS, cdma2000
TETRA,
APCO25
(PSK),
PWT

ASK X X X X

BPSK X X X X

pi/2 DBPSK X X

QPSK X X X X X

QPSK45° X X X X X

Offset

Pi/4 QPSK X X X

Pi/4 DQPSK X X X X

8PSK X X X X X

8PSK_EDGE X

Pi/8 D8PSK X X

MSK X X X X X

2FSK X X X X X

4FSK X X X X X

16QAM X X X X X

32QAM X X X X X

64QAM X X X X X

256QAM X X X X X

1024QAM X X X X X
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Modulation type pi/4ADQPSK

With differential coding switched on at the same time, a constellation diagram is obtained
for pi/4ADQPSK which is similar to that obtained for 8PSK. Phase shifts are however

assigned to the individual modulation symbols. The following tables show the assignment
of modulation symbols to phase shifts of the I/Q vector in relation to the selected coding.

Table 4-7: Phase shifts for pi/4DQPSK

Modulation symbol a, 00 01 10 11
(binary indication: MSB, LSB)

Phase shifts without coding +45° +135° - 135° - 45°
Phase shifts with coding NADC, PDC, PHS, +45° +135° - 45° -135°
TETRA or APCO25 (PSK)

Phase shifts with coding TFTS -135° +135° -45° +45°

Coding algorithms

Common coding types are listed in the following table.

Table 4-8: Coding algorithms

Coding Coding algorithm Applicable for K bit/symbol
NONE b, =a, k=1..8
Differential b, = (a, + b,.1) modulo 2% k=1..7
Differential + Gray Gray coding with additional differ- |k =1...7
ential coding
GSM dc, = not (d,, exor d,.¢) k=1

Example: Differential coding for QPSK modulation with K = 2 bit/symbol
Decimal display; value range for modulation symbols

€ {U; 1z 3}

Recursive coding is defined as follows: b, = (a, + b,.;) modulo 4

Depending on the state of a preceding modulation symbol b,,.; the coded modulation
symbol b, is obtained for example from modulation symbol a, = 2 as follows:

an = 2 bn-1 bn
0 2
1 3

|
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2 0

3 1

By means of differential coding, the assignment between modulation symbols and phase
differences shown in the following table is generated:

Modulation sym- | 00 01 10 11
bol a, (binary,
MSB, LSB)

Phase difference | 0° 90° 180° 270°

Example: Gray and differential coding for 8PSK modulation

First, a gray coding is performed according to the gray code. Afterwards, a differential
coding is performed according to the recursive coding algorithm quoted above. The
assignment between modulation symbols and phase differences shown in the following
table is generated:

"Differential coding according to VDL" can be used for modulation types with 3 bits/sym-
bol, e.g. 8PSK.

Table 4-9: Differential coding according to VDL

Modulation symbol d,, | 000 001 010 011 100 101 110 111
(binary, MSB, LSB)
Phase difference 0° 45° 135° [ 90° 315° | 270° 180° | 225°

"Phase differential coding" INMARSAT and PHASE DIFF correspond to system stand-
ards Inmarsat-M and DVB according to ETS 300 429. The INMARSAT coding can gen-
erally be used for modulation types with 2 bits/symbol, such as QPSK. It uses the fol-
lowing algorithm.

By [NOT (a,, EXOR a, ) AND (a, EXORb, .} OR
afln e 0K [(a,, EXOR a,,) AND (a,, EXOR by, )]
CODING b=  [NOT(a, EXORa,) AND (a, EXORb, 4] OR
aln — hin [(a,, EXOR &y, ) AND (&, EXOR by, ]
(S B) MASE

Baseband Filter - Custom Digital Mod

The R&S SMU offers a wide selection of predefined baseband filters. The filter charac-
teristic for the selected filter is displayed in the "More..." submenu in the "Filter" menu
section (see "Filter", on page 363). Additionally, a user defined filter can be selected (see
"User filter", on page 353).

The following table shows the filters that are available, together with the associated
parameters and IEC bus commands. The filter characteristic is displayed in graphical
form.
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Baseband Signal - Baseband Block

Cosine
Roll Off Factor
SOUR:BB:DM:FILT:TYPE COS

SOUR:BB:DM:FILT:PAR:COS
0.99

Root Cosine
Roll Off Factor
SOUR:BB:DM:FILT:TYPE RCOS

SOUR:BB:DM:FILT:PAR:RCOS
0.99

Gauss (FSK)
BxT
SOUR:BB:DM:FILT:TYPE GAUS

SOUR:BB:DM:FILT:PAR:GAUS
2.5

Cosiner=05

Filter impulse response

Root Cosine r=0.5

Filter impulse response

e

Gauss BT=05

Filter impulse response

Pl

Pure Gauss
BxT
SOUR:BB:DM:FILT:TYPE PGA

SOUR:BB:DM:FILT:PAR:PGA
2.5

Gauss Linearized
SOUR:BB:DM:FILT:TYPE LGA

Edge Narrow Pulse Shape

SOUR:BB:DM:FILT:TYPE
ENPShape

Gauss (Pure) BT=05

Filter impulse response

Linearized Gauss

Filter impulse response

gyimol

Edge MNarrow Pulse Shape

Filterimpulse response

Pl

Edge Wide Pulse Shape

SOUR:BB:DM:FILT:TYPE
EWPShape

cdmaOne
SOUR:BB:DM:FILT:TYPE CONE

cdmaOne 705 kHz

SOUR:BB:DM:FILT:TYPE
COF705

Edge Wide Pulse Shape

Filter impulse response

msvm bol

CdmaOne

Filter impulse response

syimol

CdmaCne 705kHZ

Filter impulse response

P

cdmaOne + Equalizer
SOUR:BB:DM:FILT:TYPE COE

cdmaOne 705 kHz + Equalizer

SOUR:BB:DM:FILT:TYPE
COFE228

cdma2000 3X
SOUR:BB:DM:FILT:TYPE DM3x
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CdmaOne with equalizer

Filter impulse response

CdmaOne 705 kHz with equalizer

Filter impulse response

gyimol

Cdma2000 3X

Filter impulse response

Pl

APCO25
Roll Off Factor

SOUR:BB:DM:FILT:TYPE
APCO25

SOUR:BB:DM:FILT:PAR:APC
0.5

Split Phase
BxT
SOUR:BB:DM:FILT:TYPE SPH

SOUR:BB:DM:FILT:PAR:SPH
0.15

Rectangular
SOUR:BB:DM:FILT:TYPE RECT

APCO251=05

o
=

o
=

Filter impulse response
=) o
o =

Splitphase BT=05

Filter impulse response

Rectangular

o
o

o
o

02

Filterimpulse response
o
I

eymbol

Lowpass ACP opt.

SOUR:BB:DM:FILT:TYPE
LPASs

SOUR:BB:DM:FILT:PAR:LAPS
0.5

Lowpass EVM opt.
BB:DM:FILT:TYPE LPASSEVM

BB:DM:FILT:PAR:LAPSSEVM
0.5

Dirac

SOUR:BB:DM:FILT:TYPE
DIRac

Ideal Lowpass (0.25), ACP optim.

Filter impulse response

Ideal Lowpass (0.25), EVM optim.

Filter impulse response

LS.

Dirac

=
o

=
=)

02

Filter impulse response
o
=

Pl




R&S®SMU200A Instrument Function

Baseband Signal - Baseband Block

EUTRA/LTE

SOUR:BB:DM:FILT:TYPE
LTEFilter

EUtra/LTE

Filter impulse response
o b @
—
==

User filter

The user filter file must have extention * .vaf and can be created with the R&S filter
wizard.

The filter wizard (filtwiz) is a tool from Rohde & Schwarz designed for creating filter files
that can be imported on a R&S SMU. Its main purpose is the conversion of user-defined
finite impulse response (FIR) filters into the filter format (* . va£). Beyond this filtwiz pro-
vides designs for standard filters, e.g. Root Raised Cosine, Gaussian.

The program was developed on a 32-bit Microsoft Windows platform under MATLAB.

For more information, refer to the description "Introduction to "filtwiz" Filter Editor" on the
Rohde&Schwarz Internet page.

4.8.3.5 Conflicting Settings - Custom Digital Mod

Having selected a modulation procedure, not every combination is possible when select-
ing the settings for the modulation parameters "Symbol Rate" and "Coding". These
restrictions inevitably give rise to conflicting settings if a parameter is changed and leads
to a prohibited combination.

A conflicting setting is indicated by a message on the Info line in the display. The R&S
SMU displays the setting entered by the user, but the modulation signal actually gener-
ated does not correspond to this display. A conflict of settings can be triggered if the user
changes a parameter inappropriately. The message disappears as soon as a conflict-
free setting is entered.

A list of the possible settings conflicts and messages in digital modulation can be found
in chapter 8, "Error Messages", on page 849.

4.8.3.6 Custom Digital Mod User Interface
smemmeamee 1 he menu for setting digital modulation can be opened either in the "Baseband” block or

ARB... in the menu tree under "Baseband".
Multicarrier CW
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The "Custom Digital Modulation" menu enables direct selection of the data source,
standard, symbol rate, coding, modulation type and filter. All other settings are entered
in submenus which are called via "More" buttons.

The upper part of the menu is used for powering up digital modulation as well as for calling
the default settings and user-defined standards.

& Custom Digital Modulation A E||E|E|
IState Off I
Set to Default | SaveRecall... |

The data source is selected and set in the "Data Source" section.

The "List Management" button opens a submenu for calling the data editor and the file

manager.
Data Source
Data Source I PRBS j
PRBS Type | PRES 9 |
Select Control List... | None
List Management.. |

The middle part of the menu is used for selecting the standard, the symbol rate and the
coding.

Set acc to standard I GSM j

SaveRecall User... |

Symbol Rate | 270.833 333 | ksymss ~|

Coding [ Gsm =]

The modulation type is set in the "Modulation" section.

The "More" button opens a submenu that displays the mapping for the selected modu-
lation.

This submenu can also be used to enable switching the signal between modulated and
unmodulated.

Modulation
Modulation Type | MSK |

More... |

The filter is set in the "Filter" section. The "More" button opens a submenu where the filter
characteristic of the selected filter is displayed.

Filter
Filter | Gauss (FSK) |

BT | 0.30

More...

|
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The buttons in the lower part of the menu open submenus for power ramping and for
configuring triggers, markers and clocks.

Power Ramp Control... | Off / Cosine / 1.00 sym
Trigger Marker... | Auto
Clock... | Internal

In each case the current setting is displayed next to the button.

General Settings

The upper part of the menu is used for powering up digital modulation as well as for calling
the default settings and user-defined standards.

State - Digital Modulation
Enables/disables digital modulation.

Switching on digital modulation turns off all the other digital standards.
In case of two-path instruments, this affects the same path.

The digital modulation is generated in realtime (no precalculated signal), and therefore
all parameter changes (in the ON state) directly affect the output signal.

SCPI command:
[ :SOURce<hw>] :BB:DM: STATe on page 635

Set To Default - Digital Modulation
Calls default settings. The values are shown in the following table.

Parameter Value

State Not affected by Set to Default
Data Source PRBS 9

Standard GSM

Symbol Rate 270.833 ksymb/s

Coding GSM

Modulation Type MSK

Filter Gauss (FSK)

Filter Parameter BxT 0.3

Power Ramp Control

Attenuation 15 dB
Ramp Time 1 sym
Ramp Function Cosine
Fall Delay 0
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Parameter Value

Rise Delay 0

Source Internal

State Off

Trigger Mode Auto, Source Internal
Clock

Source Internal

Mode Symbol

SCPI command:
[ :SOURce<hw>] :BB:DM: PRESet on page 633

Save/Recall - Digital Modulation
Calls the "Save/Recall" dialog.

From the "Save/Recall" dialog the "File Select" windows for saving and recalling the
complete settings in the "Custom Digital Modulation™ menu can be called.

& Recall DigMod Settings

¢:/_lists/cust_dig_mod

=@ _gem "
a _gsm J

EQ _lists

- -0 winigsim2

| | File
= Manager.__.

The Digital Modulation Settings are stored as files with the predefined file extension
* _dm. The file name and the directory they are stored in are user-definable.

The complete settings in the "Custom Digital Modulation "menu are saved and recalled.
SCPI command:

[ :SOURce<hw>] :BRB:DM: SETTing:CATalog on page 665

[ :SOURce<hw>] :BB:DM: SETTing:DELete on page 665

[ :SOURce<hw>] :BB:DM: SETTing:LOAD on page 666

[ :SOURce<hw>] :BB:DM: SETTing:STORe on page 666

Data Source

The data source is selected and set in the "Data Source" section. The parameters offered
depend on the data source selected. The More button opens a submenu for calling the
data editor and the file manager.

|
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Data Source - Digital Modulation
Selects the data source (see chapter 4.8.2, "Data and Signal Sources in Baseband",
on page 328).

You may choose from the following data sources:
"All O, All 1" 0 data or 1 data is internally generated.
"PRBS, PRBS PRBS data in accordance with the IUT-T with period lengths between

Type" 29-1 and 223-1 are internally generated.
The length is selected in the "PRBS Type" input box.
|PrBS Type [PRBS 9 il

SCPI command:
[ :SOURce<hw>] :BB:DM: PRBS [ : LENGth] on page 632

"Pattern" A user-definable bit pattern with a maximum length of 64 bits is internally
generated.
The bit pattern is defined in the "Pattern” input box.

IPatlern 000 0000 0000 00Op 0011
1111 1111 1111 1111

List Managementy

Set acc to standard

"Data List ..., Data lists will be used.

Select Data" Data lists can be generated internally in the data editor or externally.
Data lists are selected in the "File Select" window, which is called by
means of the "Select Data" button.

| ssiseivaiaT | Big]

The "File" "Manager" is used to transmit external data lists to the R&S
Signal Generator, and can be called within every "File" Select window by
means of the "File" "Manager" button.

SCPI command:
[ :SOURce<hw>] :BB:DM:DLISt:SELect on page 663

"External External serial data is supplied via the DATA connector.
Serial"

"External Paral-External parallel data is supplied externally via the PARDATA pins on
lel (AUX I/O)" the AUX I/O interface.

SCPI command:
[ :SOURce<hw>] :BB:DM: SOURce on page 633

List Management - Digital Modulation
Calls the menu for managing data and control lists (see "List Management",
on page 365).

|
Operating Manual 1007.9845.32 — 16 357



R&S®SMU200A Instrument Function

Baseband Signal - Baseband Block

g Dig. Mod. A: Data Source

I Data List._. data_cdmal

Edit Data List...

Control List... all_up
Edit Control List...

SCPI command:
n.a.

Standard, Symbol Rate, Coding

The middle part of the menu is used for selecting the standard, the symbol rate and the
coding.

Set acc. to Standard - Digital Modulation
Selects a standard.

After selection, modulation parameters "Modulation Type", "Symbol Rate", "Filter" and
"Coding" are automatically set in accordance with the standard.

If one of these parameters is subsequently altered, the display changes to User. The User
setting can be saved to a file so that it can be recalled at some later time ("Save/Recall
User.." button).

The following table shows the standards that are available, together with the associated
settings of the modulation parameters.

Table 4-11: Standards - Custom Digital Modulation

Standard Modulation Symbol Rate Filter Coding Parameter for
IEC command
Bluetooth 2FSK, Devia- 1.0 Msym/s Gauss, B*T = OFF BLUetooth
tion 160.0 kHz 0,5
DECT 2FSK, Devia- 1.152 Msym/s | Gauss, B*T = OFF DECT
tion 288.0 kHz 0,5
ETC (ARIB STD | ASK, ASK 1.024 Msym/s | Split Phase, B*T | OFF ETC
T55) Depth 100% =20
GSM MSK 270.833333 Gauss, B*T = GSM GSM
ksym/s 0.3
GSM EDGE 8PSK EDGE 270.833333 Gauss linear OFF GSMEdge

(3pi/8 8PSK) | ksym/s

NADC pi/4 DQPSK 24.3 ksym/s Root Cosine, NADC NADC
alpha = 0.35

PDC pi/4 DQPSK 21.0 ksym/s Root Cosine, PDC PDC
alpha = 0.50

PHS pi/4 DQPSK 192.0 ksym/s Root Cosine, PHS PHS
alpha = 0.50

TETRA pi/4 DQPSK 18.0 ksym/s Root Cosine, TETRA TETRa
alpha = 0.35
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Standard Modulation Symbol Rate Filter Coding Parameter for
IEC command
WCDMA 3GPP | QPSK 45° Off- | 3.84 Msym/s Root Cosine, WCDMA 3GPP | W3GPp
set alpha = 0.22
TD-SCDMA QPSK 45° Off- | 1.28 Msym/s Root Cosine, OFF TCSCdma
set alpha = 0.22
cdma2000 For- | QPSK 1.2288 Msym/s | cdmaOne + cdma2000 CFORward
ward Equalizer
cdma2000 Offset QPSK 1.2288 Msym/s | cdmaOne cdma2000 CREVerse
Reverse
Worldspace QPSK 1.84 Msym/s Root Cosine, OFF WORLdspace
alpha = 0.40
TFTS pi/4 DQPSK 22.1 ksym/s Root Cosine, TFTS/ TETRA | TFTS
alpha =0.40

SCPI command:
[ :SOURce<hw>] :BB:DM: STANdard on page 634

Save/Recall User - Digital Modulation
Calls the "Save/Recall User" menu.

From the "Save/Recall User Standard" menu the "File Select" windows for saving and
recalling user-defined standards and the "File Manager" can be called.

Save User Standard
File Manager...

User standards are stored as files with the predefined file extension *.dm stu. The file
name and the directory they are stored in are user-definable.

SCPI command:

[ :SOURce<hw>] :BB:DM: STANdard:ULISt:CATalog on page 666

[ :SOURce<hw>] :BB:DM: STANdard:ULISt:DELete on page 667
[ : SOURce<hw>] :BB:DM: STANdard:ULISt : LOAD on page 667
[ :SOURce<hw>] :BB:DM: STANdard:ULISt : STORe on page 667

Symbol Rate - Digital Modulation
Selects the symbol rate.

The value range is dependent on the selected modulation type.

When the modulation type changes, the range is automatically redefined. If the set sym-
bol rate is outside this range, an error message is generated and the maximum value for
the newly chosen modulation type is automatically set.

SCPI command:
[ : SOURce<hw>] :BB:DM: SRATe on page 634

Coding - Digital Modulation
Selects the coding (see chapter 4.8.3.3, "Coding - Custom Digital Mod", on page 348).

|
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The menu offers only the coding settings that are permissible for the chosen modulation
type. The other coding methods are grayed out.

If the system is subsequently switched to a modulation type for which the selected coding
is not available, coding is automatically set to OFF.

SCPI command:
[ :SOURce<hw>] :BB:DM:CODing on page 650

Modulation

The modulation type is set in the "Modulation section". The parameters offered depend
on what is currently selected. The "More..." button opens a submenu for displaying the
user-defined mapping.

Modulation Type - Digital Modulation

Selects a modulation type.

The associated symbol mapping is displayed in the "More..." submenu (see chap-

ter 4.8.3.2, "Modulation Types - Custom Digital Mod", on page 339).

If the "coding" that is set is not possible with the chosen modulation type, "coding" is set
to "Off".

For selection "Variable FSK", the deviation of each symbol can be set in the "More..."
submenu.

SCPI command:
[ :SOURce<hw>] :BB:DM: FORMat on page 651

Load User Mapping - Digital Modulation

Selects user defined mapping table. This opens the "Select List File User Mapping" win-
dow in which the mapping table can be selected (see "User Mapping", on page 347). The
button is only available if modulation type "USER" is selected.

The button "File Manager" calls the "File Manager" menu. The "File" "Manager" menu is
used to display and delete files.

SCPI command:

[ :SOURce<hw>] :BB:DM:MLISt:SELect on page 665

[ :SOURce<hw>] :BB:DM:MLISt:CATalog on page 657
[ :SOURce<hw>] :BB:DM:MLISt:DELete on page 664

ASK Depth - Digital Modulation
Sets the modulation depth m for ASK modulation.

m = (Amplitude,,-Amplitude,;,) / (Amplitude ., +Amplitude ;)

SCPI command:
[ :SOURce<hw>] :BB:DM:ASK:DEPTh on page 650

FSK Deviation - Digital Modulation
Sets the frequency deviation for FSK modulation. The range of values depends on the
chosen symbol rate (see data sheet).

|
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Whenever "MSK" is selected, the deviation corresponds to 1/4 of the symbol rate and
cannot be set.

SCPI command:
[ :SOURce<hw>] :BB:DM:FSK:DEViation on page 651

Angle Alpha
For AQPSK modulation, sets the angle alpha between the point (0,0) and the | axis.
Q

i

(19, 00

AN "0

AN _."ll I\\ -~ ’
1,

SCPI command:
[ :SOURce<hw>] :BB:DM:AQPSk:ANGLe on page 650

More - Modulation Type - Digital Modulation
Calls the submenu which displays the mapping of the currently selected modulation type
and the digital modulation delay in the case of an external data source.

Modulation
Current Modulation Type:
640AM

*
*
*
*
*
*
*
*

* ¥ ¥ ¥ ¥ ¥ ¥ ¥
* ¥ ¥ ¥ ¥ ¥ ¥ ¥
* ¥ ¥ ¥ ¥ ¥ ¥ ¥
* ¥ ¥ ¥ ¥ ¥ ¥ ¥
* ¥ ¥ ¥ ¥ ¥ ¥ ¥
* ¥ ¥ ¥ ¥ ¥ ¥ ¥
* ¥ ¥ ¥ ¥ ¥ ¥ ¥

The "Modulation - CW Switching" section can be used to enable switching of the signal
between modulated and unmodulated.

Modulation === CW¥¥ Swilching
State [

Source Internal ~

In case of selection "Variable FSK", the FSK type and the deviation for each symbols is
set in the "Variable FSK" section.
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Variabhle FSK

FSK Type [aFsK ~]

Deviation 0000 -135.416 5 I kHz

Deviation 0001 45138 8 | kHz

Lol Lef Lo Lo

|
|

Deviation 0010 | 45.138 8 | kHz
|

Deviation 0011 135416 5 I kHz

FSK Type - Digital Modulation
(Variable FSK only)

Selects the FSK modulation type for selection "Variable FSK".
You may choose from 4FSK, 8FSK and 16FSK.

SCPI command:
[ :SOURce<hw>] :BB:DM:FSK:VARiable: TYPE on page 652

Deviation xxxx - Digital Modulation
(Variable FSK only)

Set the deviation of the associated symbol. The number of symbols depends on the
selected modulation type. The value of each symbol is indicated in binary format.

SCPI command:
[ :SOURce<hw>] :BB:DM:FSK:VARiable:SYMBol<ch>:DEViation on page 652

Modulation Delay - Digital Modulation
(Data Source ext serial and ext parallel only)

Displays the digital modulation delay from the data input to the 1/Q output.

The value is displayed only if an external synchronous data source is selected. In this
case the value represents the delay between the active clock edge for data and the cor-
responding peak 1/Q value (associated with this data item) on the 1/Q connectors.

SCPI command:
[ :SOURce<hw>] :BB:DM:MDELay on page 653

Current Modulation Type - Digital Modulation
Displays the currently selected modulation type together with its associated mapping.

SCPI command:
n.a.

Modulation - CW Switching
The "Modulation <=> CW Switching" section is used to enable switching the signal
between modulated and unmodulated.

State Mod - CW - Digital Modulation
Enables switching between a modulated and an unmodulated signal.

|
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Switching is carried out by a control signal (CW) that is defined internally in the control
list or supplied from an external source via a user-defined input.

SCPI command:
[ :SOURce<hw>] :BB:DM: SWITching:STATe on page 635

Source Mod - CW - Digital Modulation
Selects the CW control signal for switching between a modulated and an unmodulated

signal.
"Internal" The CW signal in the control list is used for the control.

The internal signal can be output on one of the user interfaces.
"External” The control signal on the CW pin of the AUX I/O connector is used.

For two path instruments, path A and B.

SCPI command:
[ :SOURce<hw>] :BB:DM: SWITching:SOURce on page 635

Filter

The filter is set in the Filter section.

Filter - Digital Modulation
Selects the baseband filter (see chapter 4.8.3.4, "Baseband Filter - Custom Digital
Mod", on page 350).

SCPI command:
[ :SOURce<hw>] :BB:DM:FILTer:TYPE on page 649

Filter Parameter - Digital Modulation
Sets the filter parameter.

The filter parameter offered ("Roll Off Factor" or "B x T") depends on the currently selected
filter type.

SCPI command:

[ :SOURce<hw>] :BB:DM:FILTer:PARameter:APCO25 on page 648

[ :SOURce<hw>] :BB:DM:FILTer:PARameter:COSine on page 648
[ :SOURce<hw>] :BB:DM:FILTer:PARameter:GAUSs on page 648

[ :SOURce<hw>] :BB:DM:FILTer:PARameter: PGAuss on page 648

[ :SOURce<hw>] :BB:DM:FILTer:PARameter :RCOSine on page 648
[ :SOURce<hw>] :BB:DM:FILTer:PARameter: SPHase on page 648

Cut Off Frequency Factor - Digital Modulation

(available for filter parameter Lowpass only)

Sets the value for the cut off frequency factor. The cut off frequency of the lowpass filter
(ACP and EVM optimization) can be adjusted to reach spectrum mask requirements.
SCPI command:

[ :SOURce<hw>] :BB:DM:FILTer : PARameter: LPASs on page 648

[ :SOURce<hw>] :BB:DM:FILTer :PARameter: LPASSEVM on page 648
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Oversampling - Digital Modulation

Determines the upsampling factor. If the check box is activated, the most sensible param-
eter values are selected. The value depends on the coherence check. If the check box
is deactivated, the values can be changed manually.

SCPI command:
[ :SOURce<hw>] :BB:DM:FILTer :0SAMpling:AUTO on page 648
[ :SOURce<hw>] :BB:DM:FILTer :0SAMpling on page 648

More - Filter - Digital Modulation
Calls the menu for displaying the filter characteristic of the currently selected filter.

Load User Filter- Filter - Digital Modulation

Calls the menu "Select List File User Filter" for selecting a user-defined filter file with
extansion * . vaf (see "User filter", on page 353). The button is only available if filter type
"USER" is selected.

The button "File" "Manager" calls the "File" "Manager" menu. The "File" "Manager" menu
is used to display and delete files.

SCPI command:

[ :SOURce<hw>] :BB:DM:FLISt:SELect on page 664

[ :SOURce<hw>] :BB:DM:FLISt :CATalog on page 657

[ :SOURce<hw>] :BB:DM:FLISt:DELete on page 663

Current Filter Response
Displays the filter characteristic of the currently selected filter.

Filter

Current Filter Response:

1000

Gauss

a00

SCPI command:
n.a.

Power Ramp

The lower part of the Custom Digital Modulation menu is used for setting triggers, marker
and clocks, as well as for power ramp settings.

Power Ramp Control - Digital Modulation
Calls the power ramp control menu (see "Power Ramp Control", on page 372).

SCPI command:
n.a.

Trigger/Marker - Digital Modulation
Calls the "Trigger/Marker/Clock" dialog, used to select the trigger source, set the time
delay on an external trigger signal and configure the marker output signals.
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See "Trigger/Marker/Clock", on page 375.

SCPI command:
n.a.

Execute Trigger - Digital Modulation
Executes trigger manually. A manual trigger can be executed only when an internal trig-
ger source and a trigger mode other than Auto have been selected.

SCPI command:
[ :SOURce<hw>] :BB:DM: TRIGger : EXECute on page 638

Clock - Digital Modulation
Calls the "Trigger/Marker/Clock" menu. The "Trigger/Marker/Clock" menu is used to
select the clock source (see "Clock Settings”, on page 381).

SCPI command:
n.a.

List Management

The "List Management" menu is called from the "Custom Digital Modulation" main menu.

i List Management... |

&5 Dig. Mod. A: Data Source

I Data List.__. data_cdmal

Edit Data List... |

Control List... | all_up

Edit Control List... |

The data and control lists are selected and created in the "File Select" menu which is
called up by means of the "Data List..." and "Control List..." buttons.

Select Control List...
Create Control List...
File Manager...

Select Data List...
Create Data List...
File Manager...

The "File Manager" is used to copy, rename and delete files and to create directories.
For more information, see chapter 3.7, "File Management”, on page 110.

To ensure that the selected data or control list is used for generating the digital signal,
the list must be selected as the data source:

|
Operating Manual 1007.9845.32 — 16 365



R&S®SMU200A
I EEEEEEEEEEEE—————————.

Instrument Function

Baseband Signal - Baseband Block

Data Parameter Selection
Digital data "Source" DList
Marker "Marker Mode" ClList
Control signals "Source" Internal
CW, Level Attenuation and Burst

Gate

The data editor is called using the "Edit Data List..." and "Edit Control List ..." buttons.
The contents of the selected list are displayed.

Operating the list editors is described in chapter 3.5.1, "Working with List Editor",
on page 101.

Select Data/Control List - Digital Modulation

Selects data/control list. This opens the "File Select" window in which the data/control list
can be selected.

SCPI command:

[ :SOURce<hw>] :BB:DM:DLISt:SELect on page 663

[ :SOURce<hw>] :BB:DM:CLISt:SELect on page 660

Create Data/Control List - Digital Modulation
Creates new data/control list. This opens the "File Select" window in which the data/
control list can be created.

The file name has to be entered in field "File Name:". The new list contains no data, it
can be edited in the list editor.

SCPI command:
[ :SOURce<hw>] :BB:DM:DLISt:SELect on page 663
[ :SOURce<hw>] :BB:DM:CLISt:SELect on page 660

File Manager - Digital Modulation
Calls the "File Manager".

The "File Manager" is used to copy, delete and rename files and to create new directories.
For detailed description, see chapter 3.7.2, "File Manager", on page 113.

SCPI command:

SOURce<hw>] :BB:DM:DLISt:SELect on page 663
SOURce<hw>] :BB:DM:DLISt :COPY on page 658
SOURce<hw>] :BB:DM:DLISt :DELete on page 662

[: ]
[: ]
[: ]
[ :SOURce<hw>] :BB:DM:CLISt:SELect on page 660
[ :SOURce<hw>] :BB:DM:CLISt:COPY on page 658

[ :SOURce<hw>] :BB:DM:CLISt:DELete on page 660

Data List Editor

The "Data List Editor" for editing the selected data list is called up in the "List Manage-
ment" submenu of the "Custom Digital Modulation" main menu by means of the "Edit
Data List..." button.
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See chapter 3.5, "Editors", on page 101 for description on how to use the editor.

& Data list - hO_IMB =13

Offset 0, Len 3840, h0_IMB rep
0 El]11 1000 1111 0001 0000 1111 0011 1100 1010 0110 0101

44 0100 0101 1000 0100 0001 1011 0011 0010 1100 0011 0000

88 1101 1111 0011 1101 1011 1011 1000 0010 1100 0000 1000

132 0110 1011 1010 0100 1001 1111 1010 0010 0011 1001 1011

176 1000 0010 1100 0000 1011 1000 1101 0100 0011 0001 1111

220 1011 1010 0101 0101 0100 0101 1000 0100 0001 0010 0001

264 0100 0111 0001 0110 1010 1110 1100 0110 1011 0111 1010

308 0100 0100 0000 0110 1001 1000 0000 1111 1010 0110 0011

M

Start
Select

GoTo | | Copy | Paste | HEX | Save

Data List Editor

A list of binary values with a maximum length of 2*31 bits can be entered in the "Data
List Editor". This value corresponds to a file size of approx. 268 Mbyte.

To increase readability, the bits are displayed in groups of four. The current cursor posi-
tion, the length of the list and the list file name are displayed above the list. The offset
starts with the value 0 which corresponds to the bit position on the left side of the first
row, i.e. the beginning of the list. On the left edge of the editor, the last three offset posi-
tions are specified at the beginning of the row.

An existing list can be edited in the insert or overwrite mode.
SCPI command:

[ :SOURce<hw>] :BB:DM:DLISt:SELect on page 663

[ :SOURce<hw>] :BB:DM:DLISt:DATA on page 661

[ :SOURce<hw>] :BB:DM:DLISt :DATA: APPend on page 661

GoTo « Data List Editor
Opens the entry window for the bit position. The cursor marks the bit at the selected

position.
goto offset: II I
OK | Cancel |

SCPI command:
n.a.

Start Select — Data List Editor
Defines the current cursor position as the start position for the range to be marked. The
stop position is defined by entering an offset under "GoTo".

When a start position has been activated, the button will be re-labelled to "Undo
Select". When the button is clicked now, the selected range will be deactivated.

SCPI command:
n.a.
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Copy < Data List Editor
Copies the selected values.

SCPI command:
n.a.

Cut — Data List Editor
Cuts the selected values.

SCPI command:
n.a.

Paste — Data List Editor
Pastes the values that have been copied or cut before.

SCPI command:
n.a.

Hex — Data List Editor
Switchover to hexadecimal display.

E5 Data list - hO_IMB M=

Offset 0, Len 3840, h0_IMB rep
0 EB F1 OF 3C A6 54 58 41 B3 2C 30 DF 3D BB 82 CO 86 BA 49
152 FA 23 98 82 CO B8 D4 31 FB A5 54 58 41 21 47 16 AE C6 B7
304 A4 40 69 80 FA 63 45 94 A4 40 OE D1 51 BF A4 54 58 41 EA
456 20 D6 B8 5D 1D B8 CO 86 D8 OD C&8 OA F4 B7 CD E5 B2 5A F3
608 A2 54 58 41 05 49 8D 1A 76 01 C2 40 70 OF D5 CF 9B E2 C1
760 40 3B DC 46 13 A4 54 58 41 D6 53 FB D7 6F 08 BD C0 8C FD
912 47 B4 AF D6 BC CO 1F D9 B6 D3 A5 54 58 41 A5 01 45 00 E5
64 7B A9 CO B8 80 F3 D1 38 50 A9 CO 94 9F 8B E6 94 54 58 41

M|

GoTo Select

| S | Copy | Paste | | HEX Save

Each four bits are displayed as a hexadecimal value: To increase readability, the hexa-
decimal values in turn are displayed in pairs of two. The hex functions are automatically
assigned to the numeric keys at the front panel.

SCPI command:
n.a.

Save (Data List) < Data List Editor
Saves the changes made to the Data List file selected for editing.

SCPI command:
n.a.

Control and Marker List Editor

The "Control and Marker List Editor" for editing the selected control list is called up in the
"List Management" submenu of the "Custom Digital Modulation" main menu by means
of the "Edit Control List"... button.
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Edit Control List.. |

The available marker signals and the CW, Hop, Burst Gate and Level Attenuation control
signals can be defined in the "Control and Marker List Editor".

N\ The marker signals defined in the Control and Marker List Editor are activated by selecting
/) the Marker mode "CList" in the "Trigger/Marker/Clock" menu. The control signals have
to be activated by selecting an "Internal Source" in the respective setting menu, e.g. the
"Power Ramp Control" menu for the Burst Gate and Level Attenuation control signals.

The available marker/control signals are color-coded. In the left "Configure Control Sig-
nal" section, each individual signal is assigned a colour; a check in the check box shows
the marker for which the "CList" marker type has been selected and the control signal for
which the "Internal" source has been selected.

& CList Dig Mod A - c:/clist

—Configure Control Signals— Select Ramp to edit
Marker 1 I

Marker 2

Marker 3

Marker 4

Burst Gate

Lewvel Attenuation

CW Mod

Total List Length
Length 780

Hop

[FEEERRREN] RRRRRRRETI FRRRRRRRTE SRR RNNR] R NERRRRY ARRNRERRNY ARRRRRANN] RRRRAT
0 100 200 3oo 400 500 600 Position / Symbol

Preset Ramp Marker 3

Cursor Positions Marker 3 Zoom Save
Select preset type IAII down 'l Position Iﬁl]1 Edit Table... | Save |
Preset | Symbols visible |15I] Save As... |

In the "Select Ramp to Edit" section the signal characteristics are graphically displayed.
The scaling of the x-axis is always adapted to the overall length of the control list to provide
constant overview of all defined ramps.

The ramps can be assigned the exact bit position in the signal by means of
e The bit scale below the marker/control signal characteristic.

e The display of the current cursor position in the "Cursor" menu section if the cursor
marks the ramp.

The ramps can be set either graphically in the "Select Ramp to Edit" section or in the
table of the "Positions <Signal>" section in the lower right corner. To make the setting
easy, a selection of preset ramp characteristics is offered in the "Preset Ramp <Sig-
nal>" section.
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Edit Control List

The configuration of the currently selected control list is displayed. This list is either
selected in the "File Select" menu ("List Management "submenu by means of the "Control
List... "button) or via the remote-control command.

SCPI command:
[ :SOURce<hw>] :BB:DM:CLISt:SELect on page 660
[ :SOURce<hw>] :BB:DM:CLISt :DATA on page 659

Configure Control Signal - Digital Modulation
Displays the colour the marker/control signal has been assigned.

Displays whether the "CList" marker type has been selected in the Trigger/Marker/Clock
menu for this marker.

Displays whether the "Internal" source has been selected for this control signal in the
individual setting menu.

Burst Gate and Level Attenuation are set in the "Power Ramping" submenu, CW in the
"Modulation" submenu.

The source "CList/Internal" for the individual marker/control signal can be selected here
as well and will then be used in the associated menus.

SCPI command:
n.a.

Select Ramp to Edit - Digital Modulation
Graphically edit marker/control signals.

For this purpose, the cursor is set to the position where a ramp is required. The ramp is
generated by pressing Enter (e.g. clicking on the rotary knob). Any number of ramps can
be defined per marker. Each of the generated ramp positions will be saved even if the
definition of another ramp produces a low/low or high/high transition. These ramps are
displayed as dashed lines.

Existing ramps can be shifted after the cursor has been placed on the ramp and Enter
has been pressed - it then changes colour twice. The ramp is shifted by using the cursor
keys or the rotary knob. The new position is determined by pressing Enter again.

Ramps can be deleted by means of the BACKSPACE key after the cursor has been
placed on the ramp.

For detailed information on how to operate the control and marker list editor, see chap-
ter 3.5.3, "Working with Control and Marker List Editor", on page 104.

SCPI command:
n.a.

Total List Length - Digital Modulation

Enters the length of the definition range of the control list in bits. The starting value is
always bit 0. The entire definition range is displayed, i.e. the bit scale is adapted to the
entry.

With very long control lists, the displayed area can be zoomed around the current cursor
position ("Zoom in" button).

The preset functions set the ramp in the center of the currently selected area.
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If the definition range is decreased, the ramps outside the range are lost.

When used, the control list is always repeated over the length of the definition range if
the length of the data list exceeds the length of the control list.

SCPI command:
n.a.

Preset Type - Digital Modulation
Activates presetting for the ramp characteristic of the selected control signal. The pre-
setting is selected with "Preset Type" and activated by means of the "Preset" button.

You can select from:

"AllUp " The marker/control signal is continuously high.
"All Down" The marker/control signal is continuously low.
"Ramp Up" The marker/control signal contains a ramp from low to high. The ramp is

shifted to the center of the displayed signal area and can subsequently
be shifted as required.

"Ramp Down" The marker/control signal contains a ramp from high to low. The ramp is
shifted to the center of the displayed signal area and can subsequently
be shifted as required.

"Ramp Up/ The marker/control signal contains a ramp from low to high and from high
Down" to low. The ramps are symmetrically shifted around the center of the
displayed signal area and can subsequently be shifted as required.

"Ramp Down/ The marker/control signal contains a ramp from high to low and from low
Up" to high. The ramps are symmetrically shifted around the center of the
displayed signal area and can subsequently be shifted as required.

SCPI command:
n.a.

Cursor Position - Digital Modulation
Enters the cursor position.

In the graphic display, the cursor is positioned according to the entry.
Vice versa, graphically shifting the cursor will change the displayed value.

If the entered value exceeds the selected length of the definition range, the length is
adjusted automatically.

SCPI command:
n.a.

Positions Control Signal - Digital Modulation
Opens table by using the "Edit Table .. "button.

The ramps of the selected signal can be edited in the table. When the table is opened,
the current configuration of the selected marker/control signal is displayed.
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&4 Position TableDig Mod A

Ramp Positions | Ramp State -

1 70 High

2 50 Low

3 66 High

4 71 Low

5 81

6 223

T

Accept

The bit position is specified in the "Ramp Position" column, the high or low signal status
in the "Ramp State" column. At the end of the list, there is always a blank row for entering
new values.

The changes are accepted in the graphic display after pressing the "Accept" button.

SCPI command:
n.a.

Zoom/Visible - Digital Modulation
Zooms the displayed area of the control list. The designation of the button changes from
"Zoom in" to "Zoom out".

With long control lists, the displayed area can be zoomed around the current "Cursor
Position".

Parameter "Visible/Bits Visible" determines the number of symbols/bits to be displayed.
Ramps outside the displayed area are not lost by zooming.

SCPI command:
n.a.

Save/Save As - Digital Modulation
Pressing the "Save" button saves the changes made to the CList file selected for editing.

Selecting the "Save As" button creates a new control list. This opens the "Create Lists
Files Which Name?" window in which the control list can be created.

The file name has to be entered in field "File Name."

SCPI command:
n.a.

Power Ramp Control

The Power Ramp Control menu is accessed via the "Custom Digital Modulation" main
menu.

The menu is used to set the power ramping. Control signals "Burst" and "Lev_Att" are
used to control power ramping (see "Power Ramping and Level Attenuation”,
on page 336).
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\ Power ramping is possible up to a symbol rate of 5 MHz. If a higher symbol rate is set,
/ power ramping is automatically switched off and an error message is output.

State Off I

Source | Internal j
Ramp Function | Cosine j
Ramp Time | 1.00 |sym j
Rise Delay | 0.00 |sym j
Fall Delay | 0.00|sym ~|
Attenuation | 150 |aB  ~|
— Power Ramping / Level Attenuation

In Basehand Only [~ On

State - Power Ramp Control - Digital Modulation
Enables/disables power ramping.

SCPI command:
[ :SOURce<hw>] :BB:DM: PRAMp [ : STATe] on page 655

Source - Power Ramp Control - Digital Modulation
Enters the source for the power ramp control signals.

"Internal" The control signals in the internal control list are used for control purpo-
ses.
The signals are output on the LEV_ATT and BURST pin on the AUX I/O
interface of path A.

In the case of two-path instruments, the path B signal can be placed on
one of the USER interfaces.

"External DigitalThe control signal is fed in via the AUX I/O interface.

" For two-path instruments, path A = LEV-ATT pin, path B = user-definable
USER pin or USER connector.

SCPI command:
[ : SOURce<hw>] :BB:DM: PRAMp : SOURce on page 655

Ramp Function - Digital Modulation
Enters the form of the transmitted power, i.e. the shape of the rising and falling edges
during power ramp control.

"Linear" The transmitted power rises and falls linear fashion.

"Cosine" The transmitted power rises and falls with a cosine-shaped edge. This
gives rise to a more favorable spectrum than the "Linear" setting.

SCPI command:
[ : SOURce<hw>] :BB:DM: PRAMp: SHAPe on page 654
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Ramp Time - Digital Modulation
Enters the power ramping rise time and fall time for a burst. The setting is expressed in
symbols.

SCPI command:
[ :SOURce<hw>] :BB:DM: PRAMp : TIME on page 655

Rise Delay - Power Ramp Control - Digital Modulation
Sets the offset in the rising edge of the envelope at the start of a burst.

A positive value gives rise to a delay (the envelope length decreases) and a negative
value causes an advance (the envelope length increases). The setting is expressed in
symbols.

Fy Burst Control Signal

! i : :
o ! L i i
] H ! i '\\ i
3 AN
= i ! Fo 1 1
a i 1 I | |
Lo / : ! \ !
RFOut| | | | | Co
N Do
: Wi ! ' o
T I"'"- 1 " h
:4 r:1 ,:: . : X Time
Rise Ramp o (symbols)
Delay Time T

SCPI command:
[ : SOURce<hw>] :BB:DM: PRAMp : RDELay on page 654

Fall Delay - Power Ramp Control - Digital Modulation
Sets the offset in the falling edge of the envelope at the end of a burst.

A positive value gives rise to a delay, the envelope length increases and a negative value
causes an advance (the envelope length decreases). The setting is expressed in sym-

bols.
A | Burst Control Signal
I AN
[
o | | : \ |
RFOut| | | I llllﬁ |
I I [ I
i i L II, i
', ; - T >
| - ) ' Time
Ramp ) ] H Ramp (symbols)
Tirmiz Delay Time

SCPI command:
[ :SOURce<hw>] :BB:DM: PRAMp : FDELay on page 654
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Attenuation - Power Ramp Control - Digital Modulation
Sets the level attenuation relative to the average level for the signal ranges in which the
level is set to "attenuated” (LEV_ATT control signal).

The LEV_ATT control signal is defined in "the Control Data Editor" or supplied via the
LEV_ATT pin on the AUX I/O interface.

In case of two-path instruments, the LEV_ATT control signal is supplied viathe LEV_ATT
pin for path A or via a user-defined USER pin for path B.

SCPI command:
[ :SOURce<hw>] :BB:DM: PRAMp : ATTenuation on page 653

Baseband Only - Power Ramp Control - Digital Modulation
Restricts power ramping to the baseband signal.

"Off" Level attenuation is effected via the attenuator stages in the RF section;
only the remaining part is attenuated in the baseband. The signal is
issued at the RF output with the defined level values.

"On" Level attenuation is effected in the baseband only.
This setting is mandatory in the following cases: When only the baseband
signal is issued at the 1/Q outputs. It is thus ensured that, with power
ramping active, this signal is output with the defined level values.
In case of two-path instruments, when a baseband signal is applied to
two RF paths. The RF paths having separate frequency and level set-
tings, the remaining attenuation to be effected in the baseband would
have to be different for the two paths and is therefore not possible.

SCPI command:
[ :SOURce<hw>] :BB:DM: PRAMp : BBON1y [ : STATe] on page 653

Trigger/Marker/Clock

The "Trigger/Marker/Clock" dialogis accessed via the "Custom Digital Modulation™ main
menu.

The "Trigger In" section is where the trigger for the modulation signal is set. Various
parameters will be provided for the settings, depending on which trigger source - internal
or external - is selected. The current status of signal generation ("Running" or "Stop-
ped") is indicated for all trigger modes.

Trigger In-
Mode IRetrigger j
Execute Trigger |
Source IInternaI j

The "Marker Mode" section is where the marker signals at the MARKER output connec-
tors are configured.

|
Operating Manual 1007.9845.32 — 16 375



R&S®SMU200A Instrument Function

Baseband Signal - Baseband Block

Marker Mode
Marker 1 |Pattern j 10.. |
Marker 2 |onroﬂ Ratio j on Time | 1 | Samples j
Off Time | 1 | Samples j
Marker 3 [Pattern - 10... |
Markera [Pattern -] 0011... |

The "Marker Delay" section is where a marker signal delay can be defined, either without
restriction or restricted to the dynamic section, i.e., the section in which it is possible to
make settings without restarting signal and marker generation.

Marker Delay
Current Range Without Recalculation
A—
0 2000 Samples
——
0 2000 Samples
——
Harker3| U‘UOUISampIeﬁ j R R I A |
0 2000 Samples
A
Marker4| U‘UOUISampIes j R R I A |
0 2000 Samples
Fix Marker Delay To Current Range [

The "Clock Settings" section is where the clock source is selected and - in the case of an
external source - the clock type.

Clock Settings

Clock Source I Internal A l

The "Global Trigger/Clock Settings" button leads to a submenu for general trigger, clock
and external input settings.

Global TriggerClock Setfings... |

User Marker | AUX O Settings...

Trigger In

The "Trigger In" section is used to configure the trigger signal for the digital modulation.
The current status of signal generation is indicated for all trigger modes.

Trigger Mode - Digital Modulation
Selects trigger mode.

"Auto" The digital modulation signal is generated continuously.

"Retrigger" The digital modulation signal is generated continuously. A trigger event
(internal with "Execute Trigger" or external) causes a restart.
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"Armed_Auto" The digital modulation signal is generated only when a trigger event
occurs. Then the digital modulation signal is generated continuously.
Button "Arm" stops signal generation. A subsequent trigger event (inter-
nal with "Execute Trigger" or external) causes a restart.

"Armed_Retrig- The digital modulation signal is generated only when a trigger event
ger" occurs. Then the signal is generated continuously. Every subsequent
trigger event (internal with "Execute Trigger" or external) causes a
restart.
The button "Arm" stops signal generation. A subsequent trigger event
(internal with "Execute Trigger" or external) causes a restart.

"Single" The digital modulation signal is generated only when a trigger event
occurs. Then the signal is generated once to the length specified at
"Signal Duration". Every subsequent trigger event (internal with "Exe-
cute Trigger" or external) causes a restart.

SCPI command:
[ :SOURce<hw>] :BB:DM[:TRIGger] : SEQuence on page 644

Trigger Signal Duration - Digital Modulation
Enters the length of the signal sequence to be output in the "Single" trigger mode. The
input is to be expressed in symbols.

SCPI command:
[ :SOURce<hw>] :BB:DM: TRIGger : SLENgth on page 642

Running - Stopped - Digital Modulation
Displays the status of signal generation for all trigger modes. This display appears only
when Custom Dig Mod is enabled (State On).

"Running" The digital modulation signal is generated; a trigger was (internally or
externally) initiated in triggered mode.
If Armed_Auto and Armed_Retrigger have been selected, generation of
signals can be stopped with the "Arm" button. A new trigger (internally
with "Execute Trigger" or externally) causes a restart.

"Stopped" The signal is not generated, and the instrument waits for a trigger event
(internal or external).

SCPI command:
[ :SOURce<hw>] :BB:DM: TRIGger : RMODe on page 641

Arm - Digital Modulation
Stops signal generation. This button appears only with "Running" signal generation in the
"Armed_Auto" and "Armed_Retrigger" trigger modes.

Signal generation can be restarted by a new trigger (internally with "Execute Trigger" or
externally).

SCPI command:
[ :SOURce<hw>] :BB:DM: TRIGger : ARM: EXECute on page 637
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Execute Trigger - Digital Modulation
Executes trigger manually. A manual trigger can be executed only when an internal trig-
ger source and a trigger mode other than "Auto" have been selected.

SCPI command:
[ :SOURce<hw>] :BB:DM: TRIGger : EXECute on page 638

Trigger Source - Digital Modulation
Selects trigger source.

"Internal” The trigger event is executed by "Execute Trigger". As a precondition a
trigger mode other than "Auto" must be selected.

"Internal (Base- The trigger event is executed by the trigger signal from the second path
band A/B)" (two-path instruments only).

"External The trigger event is executed with the aid of the active edge of an external

(TRIGGER)" trigger signal. The trigger signal is supplied via the TRIGGER connector.
The polarity, the trigger threshold and the input impedance of the TRIG-
GER input can be set in the GLOBAL TRIGGER SETTINGS menu.

SCPI command:
[ :SOURce<hw>] :BB:DM: TRIGger : SOURce on page 642

Sync. Output to External Trigger
(enabled for "Trigger Source" External)

Enables/disables output of the signal synchronous to the external trigger event.

"On" Corresponds to the default state of this parameter.
The signal calculation starts simultaneously with the external trigger
event but because of the instrument’s processing time the first samples
are cut off and no signal is outputted. After elapsing of the internal pro-
cessing time, the output signal is synchronous to the trigger event.

l External
Trigger Event

f

\ Calculated signal

| —
,’T ",
[
T
I
[

Signal at the output
-

Processing Time
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"Off" The signal output begins after elapsing of the processing time and starts
with sample 0, i.e. the complete signal is outputted.
This mode is recommended for triggering of short signal sequences with
signal duration comparable with the processing time of the instrument.

l External
Trigger Event

| _—
- T,
A
/ | \I Calculated signal
| | ]
! \. /
/
| ~—
: /’F TN
’/ \I Signal at the output
t
I \ j
Processing Time
— rocessing Time \ /
I \\,___‘__,//

SCPI command:
[ :SOURce<hw>] :BB:DM:TRIGger:EXTernal : SYNChronize:OUTPut

on page 638

External Delay - Digital Modulation
Sets trigger signal delay in symbols on external triggering.

In case of two-path instruments, this applies on the internal triggering via the second path.

This enables the R&S SMU to be synchronized with the device under test or other external
devices.

Note: For two path instruments, the delay can be set separately for each of the two paths.
SCPI command:

[ :SOURce<hw>] :BB:DM:TRIGger [ :EXTernal<ch>] :DELay on page 643

[ :SOURce<hw>] :BB:DM: TRIGger :OBASeband:DELay on page 639

External Inhibit - Digital Modulation
(available on external triggering or triggering via the second path)

Sets the duration for inhibiting a new trigger event subsequent to triggering. The input is
to be expressed in symbols.

In the "Retrigger" mode every trigger signal causes signal generation to restart. This
restart is inhibited for the specified number of samples.

Note: For two-path instruments, the trigger inhibit can be set separately for each of the
two paths.

SCPI command:

[ :SOURce<hw>] :BB:DM: TRIGger [ :EXTernal<ch>] :INHibit on page 643

[ :SOURce<hw>] :BB:DM: TRIGger : OBASeband: INHibit on page 639

Marker Mode

The marker output signal for synchronizing external instruments is configured in the
Marker Settings section "Marker Mode".

|
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Marker x - Digital Modulation
Selects a marker signal for the associated MARKER output.

"CList" A marker signal that is defined in the selected control list is generated.

"Pulse" A regular marker signal is generated. The clock frequency is defined by
entering a divider. The frequency is derived by dividing the sample rate
by the divider. The input box for the divider opens when "Pulse "is
selected, and the resulting pulse frequency is displayed below it.

[oivider | 8.00 I

Frequency 3385417 kHz

SCPI command:
[ :SOURce<hw>] :BB:DM: TRIGger :OUTPut<ch>:PULSe:DIVider on page 647

"Pattern” A marker signal that is defined by a bit "pattern" is generated. The "pat-
tern" has a maximum length of 64 bits and is defined in an input field
which opens when "pattern” is selected.

f 0000 0000
SCPI command:
[ :SOURce<hw>] :BB:DM: TRIGger :OUTPut<ch>:PATTern On page 646

"ON/OFF ratio" A regular marker signal that is defined by an ON/OFF ratio is generated.
A period lasts one ON and OFF cycle.

Start of signal

ON time OFF time ON time OFF time:

The ON time and OFF time are each expressed as a number of symbols
and are set in an input field which opens when "ON/OFF ratio" is

selected.
IOn Time | 2 |Sym L[I
off Time | 3 {sym x|

SCPI command:
[ :SOURce<hw>] :BB:DM: TRIGger :0UTPut<ch>:0FFTime on page 645
[ :SOURce<hw>] :BB:DM: TRIGger : OUTPut<ch>:0ONTime on page 646

SCPI command:
[ :SOURce<hw>] :BB:DM: TRIGger:0UTPut<ch>:MODE on page 645

Marker Delay

The "Marker Delay" section can be used to set a delay for the markers.

Marker x Delay - Digital Modulation
Enters the delay between the marker signal at the marker outputs and the start of the

signal.
The input is expressed as a number of symbols.

|
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If the setting "Fix marker delay to dynamic range" is enabled, the setting range is restricted
to the dynamic range. In this range the delay of the marker signals can be set without
restarting the marker and signal.

The allocation of marker signals to the outputs is described in the section chapter 4.8.2.8,
"Marker Output Signals", on page 338.

SCPI command:
[ :SOURce<hw>] :BB:DM: TRIGger :OUTPut<ch>:DELay on page 640

Current Range without Recalculation - Digital Modulation
Displays the dynamic range within which the delay of the marker signals can be set with-
out restarting the marker and signal.

The delay can be defined by moving the setting mark.

SCPI command:

[ :SOURce<hw>] :BB:DM: TRIGger : OUTPut<ch>:DELay : MAXimum On page 641
[ :SOURce<hw>] :BB:DM: TRIGger :OUTPut<ch>:DELay:MINimum on page 641

Fix marker delay to current range - Digital Modulation
Restricts the marker delay setting range to the dynamic range. In this range the delay
can be set without restarting the marker and signal.

SCPI command:
[ :SOURce<hw>] :BB:DM: TRIGger:OUTPut:DELay:FIxXed on page 640

Clock Settings

The clock source is selected in the Clock Settings section.

Clock Source - Digital Modulation
Selects the clock source (also see section "Clock Signals", page 2).

"Internal” The internal clock reference is used.

"External" The external clock reference is fed in as the symbol clock or a multiple
thereof via the CLOCK connector.
The chip rate must be correctly set to an accuracy of (£ 2% (see data
sheet).
The polarity of the clock input can be changed with the aid of "Global
Trigger/Clock/External Input "Settings.
In the case of two-path instruments, this selection applies to path A.

SCPI command:
[ : SOURce<hw>] :BB:DM:CLOCk: SOURce on page 637

Clock Mode - Digital Modulation
Enters the type of externally supplied clock.

"Symbol" A symbol clock is supplied via the CLOCK connector.
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"Multiple Sym- A multiple of the symbol clock is supplied via the CLOCK connector, the
bol" symbol clock is derived internally from this.
The "Multiplier" window provided allows the multiplication factor to be
entered.

Note: This setting is not possible if the serial or parallel external data
source is selected.

"Bit" A bit clock is supplied via the CLOCK connector; the symbol clock is
derived internally from this.

Note: This setting is not possible if the serial or parallel external data
source is selected.

SCPI command:
[ :SOURce<hw>] :BB:DM:CLOCk : MODE on page 636

Symbol Clock Multiplier - Digital Modulation
Enters the multiplication factor for clock type "Multiple".

SCPI command:
[ :SOURce<hw>] :BB:DM:CLOCk:MULTiplier on page 636

Measured External Clock
Displays the measured frequency of the external clock signal. This enables the user to
permanently monitor the frequency of the externally introduced clock.

This information is displayed only if the external clock source has been selected.

SCPI command:
:CLOCk: INPut : FREQuency on page 531

Global Trigger/Clock/Input Settings - Digital Modulation

Calls the "Global Trigger/Clock/Input Settings" menu. This menu is used among other
things for setting the trigger threshold, the input impedance and the polarity of the clock
and trigger inputs.

In the case of two-path instruments, these settings are valid for both paths.

The parameters in this menu affect all digital modulations and standards, and are descri-
bed in the chapter 4.2.3.10, "Global Trigger/Clock/External Input Settings",
on page 135.

SCPI command:
n.a.

Arbitrary Waveform Generator ARB

The Arbitrary Waveform Generator (ARB) is an I/Q modulation source forming an integral
part of the R&S Signal Generator. It can be used to output any externally calculated
modulation signals or internally generated multi carrier signals or waveform files.

The Arbitrary Waveform Generator is incorporated in the Baseband Generator (R&S
SMU-B9/B10/B11) option. The Baseband Main Module (R&S SMU-B13) option is also
required.
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The three Baseband Generator options feature different ARB memory sizes (see data
sheet). Apart from the memory size, however, the three options offer the same function-
ality, either one can be installed.

In the case of two-path instruments, at least one further Baseband Generator option is
needed for waveform output in the second path. Using this option a waveform can be
read in on path B and then either routed via path A or added to the signal on path A with
a frequency offset that can be set.

When path B is fully expanded with a second option Baseband Main Module (R&S SMU-
B13) and an RF section frequency option (B20x) the waveform can be output on RF
output B.

Sources for waveform files

The R&S Signal Generator can generate ARB waveforms internally. The ARB generator
enables the calculation and the generation of multi segment and mutli carrier waveform
files. Several digital standards provide the special function "Generate Waveform File" and
enable the calculation and storage of the signal as a waveform file that can be afterwards
processed by the ARB generator.

The ARB can also process externally generated waveform files, e.g. the waveform files
generated on a PC by the Windows software package R&S WinlQSIM2 or signals cal-
culated using a mathematical program such as Matlab. For more information, see Appli-
cation Note 1TMA28, “IQWizard - I/Q Signal Measurement and Conversion”, which can be
obtained from the Rohde&Schwarz web site at http://www.rohde-schwarz.com.

The externally generated waveform files can be loaded into the instrument via one of the
available interfaces (USB, LAN or GPIB).

Multi segment and multi carrier waveforms

To fulfill the requirements of some test systems and to enable rapid alternation between
different waveforms with differing test signals, the R&S Signal Generator provides the
functionality to generate multi segment waveform files. A multi segment waveform is a
combination of multiple waveforms called segments. Each segment represents a com-
pletely independent waveform that can be output with its own marker and clock settings.
The entire multi segment waveform is loaded into memory. The segment intended to be
output at any given moment can be selected by the user. It is therefore possible to alter-
nate between the individual waveform segments without experiencing any delay due to
the loading operation.

There are however additionally requirements conserning the clock settings if some spe-
cial triggering is necessary.

If very high switchover speeds are required, the test signals can be continuously scrolled
through with the aid of an external trigger or by applying a predefined “play list”. For this
purpose the segments must have a common sample rate. If the combined waveforms
have different sample rates, they can be adapted to a common sample rate by resam-
pling. By the same procedure the instantaneous amplitude of the various waveforms can
be scaled to a common RMS level.

Typical applications for the multi segment mode are described in the section "Typical
Applications for Multi Segment Waveforms", on page 417.
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Multi carrier waveforms consisting of up to 512 carriers modulated by user-selectable
baseband signals can be created in order to simulate complex multi carrier scenarios with
different baseband signals (e.g. CDMA2000 or 3GPP FDD).

Waveform sample rate

The Arbitrary Waveform Generator includes a resampling unit that interpolates the input
samples to reach a target digital output I/Q sample rate before digital-to-analog conver-
sion (DAC). The input sample rate finput is given by the default sample rate tag of the
waveform file or is set by the user in the ARB panel.

The R&S SMU uses a 100 MHz system clock and a sample rate of 100 MSamples/s.

The resampling lowpass limits the signal bandwidth to a maximum of 1.36 x fi,p,. Within
a bandwidth of 0.68 x fi,,,« the resampler lowpass is distortion-free. Thus, an externally
created waveform file have to provide a sample rate fi,,; that is high enough for perfect
signal reconstruction.

For distortion-free resampling the lower bound of the required sample rate finput is cal-
culated by:

finput 2 Signal bandwidth / 0.68

In case of digital modulation this means that the oversampling factor (fi,,, =symbol rate
x oversampling factor) that is applied for impulse forming is high enough.

The lower bound of the oversampling factor is given by:

oversampling factor = signal bandwidth / (symbol rate x 0.68)

Example:

For the WCDMA standard 3GPP FDD with root raised cosine filter (a = 0.22) and a symbol
rate (chip rate) of 3.84 MHz the minimum oversampling factor is calculated as follow:

3.84 MHz x (1+0.22) / (3.84 MHz x 0.68) = 1.794

A modulation signal with a sample rate of 100 MHz is passed directly to the digital-to-
analog converter (DAC), i.e. the resampling unit is bypassed (see figure below). After the
DAC the signal is finally limited to a maximum bandwidth of 80 MHz.
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Resamplar filters waveform
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Waveforms generated by the R&S WinlQSIM2 software can be optimized by choosing a
suitable integer oversampling factor.

In comparison with conventional ARB generators that often assume oversampling factors
of 4, the ARB generator of the R&S Signal Generator requires low oversampling factors
(see the example above), but still providing excellent signal quality in terms of EVM and
ACP.

A reduced sample rate saves significantly the amount of memory or allows an increased
signal cycle time, vice versa.

Dependency between the number of marker signals and the waveform length

The R&S Signal Gererator provides the possibility to define marker signals, that are sent
to the marker outputs in synchronicity with the I/Q output signals. Marker singals can be
either predefined or subsequently defined; marker setting such as delay can be adjusted
in the corresponding Trigger/Marker/Clock Settings dialog.

The 1/Q data and marker data are located in separate memory areas of the SDRAM and
can be independently configured wheras each marker signal requires one bit of the avail-
able memory size. In some cases, it might be usefull to generate a modulatition signal
without additional marker signal in order to increase the maximum waveform lengt.

The example below explains the dependency between the number of enabled marker
signals, the available memory size and the resulting waveform length.

The calculation for an instrument equipped with option R&S SMU-B10 is as follow:

Memory Size 256 MB

Requred for 1/Q data 2 x 16 bits = 32 bits (16 bits per I/Q
channel)

Memory for 4 enabled markers 4 x 1 bit = 4 bits

Size total 32 + 4 = 36 bits = 4.5 bytes

Waveform Length (with 4 markers) 256 MB / 4.5 bytes ( 56 MSamples

Maximum Waveform Length 256 MB / 4 bytes = 64 MSamples
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Hence a memory size of 256 MB yields a maximum waveform length of 56 MSamples if
four markes are enabled. The maximum waveform length increases to 64 MSamples if
the internal hardware markers are used, and the complete memory is available for I/Q
data.

A maximum waveform lengt of 16 MSamples is available therefore for instruments equip-
ped with option R&S SMU-B11.

The minimum length of a waveform is 512 samples. If a waveform is shorter than this, it
is automatically repeated until it reaches the minimum length.

ARB User Interface

To access the ARB dialog, select "Baseband > ARB" or use the MENU key under "Base-
band".

Misc

Custom Digital Maod. ..

ARB...
Multicarrier CW....
—— Frequency Offset

The "ARB" dialog is divided into an upper and a lower general part together with a
"Marker" section.

The upper part of the menu is used for powering up, selecting and configuring ARB mod-
ulation.

sue o |
Set To Default |

Load Waveform... | ms_out
Waveform Info... |

Clock Freq | 10.000 000 |k|-|z ~|

The section "Multi Segment Waveform Options" is only indicated if a multi segment
waveform is loaded. In this part, the segment to be output is selected.

Multi Segment VWaveform Options:
Current Segment | arb_constwv

| 0

Next Segment | 2

Next Segment Mode INext Segment |

Execute Next Segment |

Sequencing List... | ms_sequencing

Trigger Example

Operating Manual 1007.9845.32 — 16 386



R&S®SMU200A Instrument Function

Baseband Signal - Baseband Block

The buttons in the lower part of the menu open submenus for setting triggers and clocks,
for configuring the test signal and for calculating a multi segment waveform or a multi
carrier waveform.

Trigger/Marker... | Arm Auto [ Int
Execute Trigger |
Clock... Internal
Create Test Signal. | sine ~|
Multi Segment... |
Multi Carrier... |

ARB MOD Main Menu

The upper part of the menu is used for powering up, selecting and configuring ARB mod-
ulation.

The lower part of the menu is used for setting triggers and clocks, as well as for file
management. Test signals can be output for test purposes.

Multi Segment Waveform Options

The section "Multi Segment Waveform Options" of the menu is only displayed if a multi
segment waveform is loaded.

The section comprises the settings necessary to adjust the trigger for the switch between
the segments of a multi segment waveform. The parameters displayed depend on the
selected trigger source.

The parameters in this sections are identical with the parameters in the section "Next
Segment Trigger In" in the "Trigger/Marker" dialog; for detailed information see "Next
Segment Trigger In", on page 395.

State (ARB)

Enables/disables ARB modulation.

Switching on this standard turns off all the other digital standards and digital modulation
types.

In case of two-path instruments, this affects the same path.

The output is based on the waveform file that is loaded. The name of the waveform file
is displayed next to "Load Waveform".

If a multi segment waveform is loaded the section "Multi Segment Waveform Options" is
indicated. In this section, the segment to be output is selected.

If no waveform file is loaded, ARB modulation cannot be powered up. "None" will be
displayed next to "Load Waveform". An error message asks the user to load a waveform
file:

"No waveform file loaded. ARB MOD state remains off. Please select a waveform file to
load, before switching ARB MOD state on."

SCPI command:
[ :SOURce<hw>] :BB:ARB:STATe on page 587
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Calls default settings. The values are shown in the table 4-12.

Table 4-12: Default Settings

Parameter Value
State Off

Clock Freq. 1 MHz
Trigger Mode Auto
Trigger Source Internal
Marker State Off

Marker Mode Unchanged
Clock Source Internal

SCPI command:
[ :SOURce<hw>] : BB:ARB: PRESet on page 587

Load Waveform
Calls the "File Select "menu for loading the waveform file.

The files last used are listed in the "Recent Data Sets" section. The directory can be
selected from the center left section. All waveform files (file extension * . wv) available
from the selected directory are listed on the right side. The file info (tag contents and multi
segment state) for the selected file is displayed below the file section.

The "Select..." button selects the marked file. This file is loaded when the ARB modulation
is enabled ("State On").

The "File Manager..." button leads to the file manager.

FEX

&5 Load Waveform

c:l_userllists/ARB
=% _user ;I
a3 list
=28 lists J
=) ARB
3gpp
i 3gpp_out
arb
i~ arb_const
- arb_rect
arb_sine LI

. ZER CNWEC

date: ZDN-M-DT;1 4:24:51, samples: 100 ...

Selectl File |
Manager...

SCPI command:
[ :SOURce<hw>] :BB:ARB:WAVeform:SELect on page 620

Waveform Info
Opens a dialog with detailed information about the currently selected waveform.
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The waveform information displayed in this dialog depends on whether the selected
waveform file is a multi segment one or not. All parameters are read-only.

B ARB: Multi Segment Info A - c:/_user/lists/ARB/ms_out.wv

Filename Clock Rate | Samples | Period Path Comment Info =
0 |arb_constwv 10.000 kHz| 512.000 51.200 ms Info...
1 |arb_rectwv 10.000 kHz| 600.000 60.000 ms Info...
2 |arb_sine.wv 10.000 kHz| 600.000 60.000 ms Info...

Level | Clock | Marker

Level IUnchanged vl Segment Marker Ilgnore vl
Clock Ingnest vl Sequence Restart IDlsabled vl
User Clock Rate I10m.ml!]|MH1 'l Segment Restart IDisaDIed vl

[ | 3; ClockMode: highest; LevelMode: unchanged; Seg#0: "arb_consLwy"; Seg#1: "arb_rectwv"; Seg#2: "

For non-multi segment waveform files, the values of the settings can be queried by means
of the Tag commands (see chapter 6.3, "R&S Signal Generator Waveform and List For-
mat", on page 501).

SCPI command:

n.a.

HDD Streaming
Enables/disables the streaming of modulation data direct form the hard drive (HDD).

HDD streaming is recommended for processing of large files that require more ARB
memory than the currently installed one.

HDD Streaming is enabled for waveform with"Clock Freq." <= 1 MHz and "Number of
Samples" > 16 MS.

SCPI command:
[ :SOURce<hw>] :BB:ARB:WAVeform: HDDStreaming: STATe on page 619

Streaming Buffer
(enabled for waveform with "Clock Freq." <= 1MHz and "Number of Samples" > 16MS)

Displays the filling level of the streaming buffer.
During normal operation, the streaming buffer level should have a value of 90% .. 100%.

Buffer level around 0% indicates a buffer underrun and the signal processing will be
interrupted.

Adjustment in the parameter value or state usually results in short decreasing of the
streaming buffer level but this buffer state should not be misunderstood as buffer under-
run.

SCPI command:
[ : SOURce<hw>] :BB:ARB:WAVeform: HDDStreaming:BLEVel on page 619

Clock Frequency
Displays or enters the ARB output clock rate.

When the waveform file is loaded, this value is automatically set to the clock rate defined
in the file (Clock tag). The user can subsequently alter the value if necessary.
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When intending to work with an external clock source, the frequency to be applied must
be entered here.

SCPI command:
[ :SOURce<hw>] :BB:ARB:CLOCk on page 588

Trigger/Marker
Calls the Trigger and Marker menu.

This menu is used to select the trigger source, set the time delay on an external trigger
signal and configure the marker output signals (see "Trigger/Marker/Clock Settings",
on page 391).

SCPI command:

n.a.

Execute Trigger
Executes trigger manually. A manual trigger can be executed only when an internal trig-
ger source and a trigger mode other than Auto are selected.

SCPI command:

[ :SOURce<hw>] :BB:ARB:TRIGger : SOURce on page 595

[ :SOURce<hw>] :BB:ARB[:TRIGger] : SEQuence on page 597
[ :SOURce<hw>] :BB:ARB:TRIGger :EXECute on page 590

Clock
Calls the "Clock" menu. The "Clock" menu is used to select the clock source (see "Clock
Settings", on page 403).

SCPI command:
n.a.

Create Test Signal...
Selects the form of the test signal and calls the menu for generating it. A sinusoidal,
rectangular or test signal with constant I/Q can be selected.

See the corresponding section for detailed description of the parameters for the selected
test signal:

e '"Sine Test Signals", on page 404

e "Rect Test Signal", on page 405

e "Const|Q Test Signal", on page 407

SCPI command:
n.a.

Multi Segment
Calls the menu for calculating multi segment waveforms (see chapter 4.8.4.2, "Multi
Segment Waveforms", on page 407).

SCPI command:
n.a.
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Multi Carrier
Calls the menu for calculating multi carrier waveforms (see chapter 4.8.4.3, "Multi Carrier
Waveforms", on page 418).

SCPI command:
n.a.

Trigger/Marker/Clock Settings

To access this dialog, select "Main Menu > Trigger/Marker".

The "Trigger In" section is where the trigger for the signal is set. Various parameters will
be provided for the settings, depending on which trigger source - internal or external - is
selected. The current status of signal generation ("Running" or "Stopped") is indicated
for all trigger modes.

Trigger I
Mode [Retrigger |
Execute Trigger
Source |Interna| j

The "Next Segmet Trigger In" is where the segment triggering is configured. This section
is enabled only for multi segment waferoms.

Next Segment Trigger In

Current Segment | arb_constwv
[ o

Next Segment |—1
Next Segment Mode W
Next Segment Source Im

Execute Next Segment |
Sequencing List... | ms_sequencing
Trigger Example

The "Marker Mode" section is where the marker signals at the MARKER output connec-
tors are configured.

Marker Mode
Marker1 [pattem - 10... |
Marker 2 |onfoﬂ Ratio j On Time | 1| samples j
Off Time | 1 | Samples j
Marker3 [Pattern B 10... |
Marker 4 |Pattern j 0011... |

The "Marker Delay" section is where a marker signal delay can be defined, either without
restriction or restricted to the dynamic section, i.e., the section in which it is possible to
make settings without restarting signal and marker generation.

Operating Manual 1007.9845.32 — 16 391



R&S®SMU200A Instrument Function

Baseband Signal - Baseband Block

Marker Delay
Current Range Without Recalculation
——
0 2000 Samples
——
0 2000 Samples
——
Harker3| U‘UOUISampIeﬁ j R R I A |
0 2000 Samples
A
Marker4| U‘UOUISampIes j R R I A |
0 2000 Samples
Fix Marker Delay To Current Range [

The "Clock Settings" section is where the clock source is selected and - in the case of an
external source - the clock type.

Clock Settings

Clock Source I Internal - l
The buttons in the last section lead to submenu for general trigger, clock and mapping
settings.

Global TriggerClock Setfings... |

User Marker | AUX O Settings...

Trigger In

The "Trigger In" section is where the trigger for the signal is set. Various parameters will
be provided for the settings, depending on which trigger source - internal or external - is
selected. The current status of signal generation ("Running" or "Stopped") is indicated
for all trigger modes.

Trigger Mode
Selects trigger mode.

The trigger mode determines the effect of a trigger on the signal generation.
"Auto" The signal is generated continuously.

"Retrigger" The signal is generated continuously. A trigger event (internal or exter-
nal) causes a restart.

"Armed_Auto" The signal is generated only when a trigger event occurs. Then the signal
is generated continuously.
Button "Arm" stops signal generation. A subsequent trigger event (inter-
nal with "Execute Trigger" or external) causes a restart.

"Armed_Retrig- The signal is generated only when a trigger event occurs. Then the signal
ger" is generated continuously. Every subsequent trigger event causes a
restart.
Button "Arm" stops signal generation. A subsequent trigger event (inter-
nal with "Execute Trigger" or external) causes a restart.
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"Single" The signal is generated only when a trigger event occurs. Then the signal
is generated once to the length specified at "Signal Duration".
Every subsequent trigger event (internal with "Execute Trigger" or exter-
nal) causes a restart.

SCPI command:
[ :SOURce<hw>] :BB:ARB[:TRIGger] : SEQuence on page 597

Signal Duration Unit
Defines the unit for the entry of the length of the signal sequence to be output in the
"Single" trigger mode.

SCPI command:
[ :SOURce<hw>] :BB:ARB:TRIGger: SLUNit on page 594

Signal Duration

Defines the length of the signal sequence to be output in the "Single" trigger mode. The
unit of the entry is defined under "Signal Duration Unit". It is then possible to output delib-
erately just part of the signal, an exact sequence of the signal, or a defined number of
repetitions of the signal.

SCPI command:
[ :SOURce<hw>] :BB:ARB:TRIGger: SLENgth on page 594

Running/Stopped
Displays the status of signal generation for all trigger modes. This display appears only
when signal generation is enabled ("State" On).

"Running" The waveform is output; a trigger was (internally or externally) initiated
in triggered mode.
If "Armed_Auto" and "Armed_Retrigger" have been selected, generation
of signals can be stopped with the "Arm" button. A new trigger (internally
with "Execute Trigger" or externally) causes a restart.

"Stopped" The Waveform output is stopped. The instrument waits for an internal or
external trigger event to restart. ARB modulation is disabled (State Off).

SCPI command:
[ :SOURce<hw>] :BB:ARB:TRIGger : RMODe on page 593

Arm
Stops waveform output. This button appears only with "Running"” signal generation in the
"Armed_Auto" and "Armed_Retrigger" trigger modes.

Signal output can be restarted by a new trigger (internally with "Execute Trigger" or
externally).

SCPI command:
[ :SOURce<hw>] :BB:ARB:TRIGger : ARM: EXECute on page 590

|
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Execute Trigger
Executes trigger manually. A manual trigger can be executed only when an internal trig-
ger source and a trigger mode other than "Auto" have been selected.

SCPI command:
[ :SOURce<hw>] :BB:ARB:TRIGger :EXECute on page 590

Trigger Source
Selects trigger source. This setting is effective only when a trigger mode other than
"Auto” has been selected.

"Internal” The trigger event is executed by "Execute Trigger".

"Internal (Base- (two-path instruments only)

band A/B)" The trigger event is executed by the trigger signal from the second path.
This makes it possible for instance to start the two paths synchronously
or with a defined delay.

"External The trigger event is executed with the aid of the active edge of an external
(TRIGGER 1/ trigger signal.
2)" The trigger signal is supplied via the TRIGGER connector.

The polarity, the trigger threshold and the input impedance of the TRIG-
GER input can be set in the "Global Trigger/Clock Settings" dialog.

Note: For multi segment waveforms, an external trigger source can be
used for cyclical output of the segments. Each trigger event starts the
output of the next segment. After the last segment, the first segment is
output again.

SCPI command:
[ :SOURce<hw>] :BB:ARB:TRIGger : SOURce on page 595

Sync. Output to External Trigger
(enabled for "Trigger Source" External)

Enables/disables output of the signal synchronous to the external trigger event.

"On" Corresponds to the default state of this parameter.
The signal calculation starts simultaneously with the external trigger
event but because of the instrument’s processing time the first samples
are cut off and no signal is outputted. After elapsing of the internal pro-
cessing time, the output signal is synchronous to the trigger event.

l External
Trigger Event

f

\ Calculated signal

| —
,’T ",
[
T
I
[

Signal at the output
-

Procassing Tima
I
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"Off" The signal output begins after elapsing of the processing time and starts
with sample 0, i.e. the complete signal is outputted.
This mode is recommended for triggering of short signal sequences with
signal duration comparable with the processing time of the instrument.

l External
Trigger Event

| _—
- T,
A
/ | \I Calculated signal
| | ]
! \. /
/
| ~—
: /’F TN
’/ \I Signal at the output
t
I \ }
Processing Time
— rocessing Time \ /
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SCPI command:
[ :SOURce<hw>] :BB:ARB:TRIGger:EXTernal :SYNChroni